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Overview

Clintrial™ 4 software (hereafter referred to as Clintrial software) is a
comprehensive clinical research system for the collection, management, and
review of clinical trials data. Clintrial software is designed for use by companies

that must both:
* Collect clinical data to meet regulatory requirements for conducting clinical
trials.

* Analyze data that is collected during those clinical trials.

Clintrial software enables companies to unify all of their clinical data collection
and management, regardless of source or phase of development (pre- or post-
market).

About this book

This book is written for all Clintrial software users. It explains Clintrial software
concepts and describes the tasks you can perform with Clintrial software. Other
chapters cover product installation, and setup of the Sample Studies.

About the Clintrial software documentation

The Clintrial software documentation includes books that contain conceptual
information. The Clintrial software Help contains procedures for the tasks that
you perform with the Clintrial software.

The Clintrial software documentation assumes that you know how to perform
basic tasks on your computer.
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What are the Clintrial software books?

Title:

Content:

Release Notes

Known Issues

Getting Started

Admin and Design

Secure Configuration
Guide

The Release Notes document describes enhancements introduced and
problems fixed in the current release, upgrade considerations, release history,
and other late-breaking information.

The Known Issues document provides detailed information about the known
issues in this release, along with workarounds, if available.

Note: The most current list of known issues is available on the Phase Forward
Extranet.

To sign in to the Extranet, go to https://extranet.phaseforward.com and click
Customer Login. Enter your email address and password, and navigate to the
Known Issues section. Select a product, and then enter your search criteria.

The Getting Started guide:

* Provides a summary of each Clintrial module, a description of the
relationships between modules, and descriptions of key concepts.

* Describes how to install, upgrade, and de-install the Clintrial software.

* Describes how to configure the Clintrial application.

* Provides information and procedures for customizing the Windows
Registry.

» Explains how to use the Medika Sample Studies.

The Admin and Design document describes how to use:

*  The Admin module to work with user accounts, access rights, parameters,
and system administration tools.

*  The Design module to set up and maintain Clintrial application objects,
such as protocols, panels, and study books.

The Secure Configuration Guide provides an overview of the security features
provided with the Clintrial application including details about the general
principles of application security, as well as how to install, configure, and use
the Clintrial application securely.

The Clintrial 4.7 documentation includes the documents in the following table.
All documentation is available from the Phase Forward Download Center.

About the Clintrial software documentation

xi



Title:

Content:

Reference Guide

Manage, Classify, and
Lab Loader

Enter, Resolve, and
Retrieve

Multisite

Quick Reference Card
for Enter

The Reference Guide provides:

¢ Definitions of the Oracle database tables that store Clintrial metadata and
clinical data.

*  Descriptions of the use of PL/SQL for Clintrial-specific procedures.
» Explanations of data types and naming conventions.

» Information on using SQL, setting up custom menus, and running batch
jobs.

* A glossary of terms.

The Manage, Classify, and Lab Loader document describes how to use:

* The Manage module to perform data management tasks such as coding
(including integration with Central Coding), global modification,
validation, auditing, and batch loading of clinical data.

» The Classify module to track, review and solve for values that fail
automatic coding; to audit the contents of a coding thesaurus protocol;
and to build and test effective thesaurus algorithms.

* The Lab Loader module to batch load laboratory data and to set up Lab
Loader objects.

The Enter, Resolve, and Retrieve document describes how to use:

» The Enter module to enroll subjects, enter and edit data, verify data, and
work with reports.

» The Resolve module to identify, track, and report data discrepancies, as
well as how to customize the Resolve module, including writing rules that
reference data items.

¢ The Retrieve module to extract clinical data from the database and work
with query results.

The Multisite document describes:

*  How to distribute codelists and protocols.

* How to set up a replication environment.

*  How other Clintrial modules work differently in a Multisite environment.

The Quick Reference for Enter lists Enter module menu commands and
shortcut keys.
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Conventions
The following conventions are used in the Clintrial software books:

Convention: Description:

Italics Italics are used to indicate the following:
* New terms
+ Titles of books
*  Variable names in code examples or file names

Ctrl +c¢ Key combinations where you press the first key and hold
it down while you press the second key. For example, to
copy selected text to the clipboard, you press the Ctrl
key and hold it down while pressing the ¢ key.

bold Menu names, command names, dialog box buttons, and
key names appear in bold type. Additionally, the text you
enter in fields during procedures appears in bold type.

COMMENT IS NULL Examples of programming code (such as PL/SQL) or
SQL commands are emphasized with a different font.

This caution symbol advises users that failure to take or
avoid a specified action could result in
& significant data problems.

Medika Sample Studies

The Clintrial software provides three sample studies that you can optionally
install and use as a learning aid.

For information about installing and using the sample study, see the Clintrial
Getting Started guide, Chapter 7.

About the Clintrial software documentation  xiii



Clintrial 4.7 compatibility with other Oracle Health Sciences

products

The Products Compatibility Matrix, which identifies Clintrial compatibility with
other Oracle Health Sciences products, can be downloaded from
https://extranet.phaseforward.com.

To sign in, click Customer Login. Enter your email address and password, and
navigate to the Bulletins section.

If you need assistance

If you are an Oracle customer with a maintenance agreement, you can contact
the Global Support Center for assistance with product issues.

Your maintenance agreement indicates the type of support you are eligible to
receive and describes how to contact Oracle. Additionally, the Oracle website
lists the toll-free support number for your product, location, and support level:

http://www.oracle.com/support/

In the event that our toll-free telephone service is interrupted, please use either of
the following methods to contact the Global Support Center:

* email
saasclinicalsupport ww(@oracle.com

e telephone

In the US: 1-800-633-0925
Outside of the US: +44 (0) 207 131 2801

Oracle also provides assistance with User Management, Site Assessment, and
Provisioning. Please refer to your Master Services Agreement and individual
Statement of Work to determine if you are eligible to use these services.

xiv
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Overview

This chapter introduces the basic concepts you need to use the Clintrial software.
For installation information, see Getting Started.

The information in this chapter is generally conceptual. Procedures for most of
these topics appear in the Clintrial software Basics Help that you can access
through the Help menu on any Clintrial software module. A brief overview on
how to use Clintrial software Help appears in "Using Help" on page 25.

To access the Clintrial software and its Help topics, you must start a Clintrial
software module. Instructions for starting a Clintrial software module appear in
this chapter as well as in the Clintrial software Basics Help.

Clintrial software modules

The Clintrial software consists of a set of integrated modules that can be
installed as needed. This modular approach enables you to describe, collect, and
manage clinical data according to the needs of your company’s studies.

The Clintrial software core modules

The Clintrial software includes the core modules Admin, Design, Enter, Manage,
and Retrieve.

About the Admin module

Use the Admin module to perform the system administration tasks. You can:
* Create user accounts and usergroup accounts.
* Manage passwords.

* Set up and manage access rights for users, usergroups, and protocols for all
Clintrial software modules.

* Set system parameters.
*  Monitor database space.
* Produce auditing reports for users and security.

* Produce reports about system activities.

18 Chapter 1: Introduction to the Clintrial Software



About the Design module

Use the Design module to design and create the Clintrial database and the study
books that you need to enter clinical data. You can:

Design the clinical database to model your clinical protocol and meet your
needs for storing and retrieving data.

Create online representations of your paper CRFs for data-entry, verification,
and editing.

Create and manage your metadata standards.
Produce reports about metadata.

Import/export protocols.

About the Enter module

Use the Enter module to enter clinical data in the database interactively. You can:

Add subjects to a study.

Enter clinical data interactively.

Verify clinical data.

Edit clinical data.

Add flags and notes to clinical data.
Produce reports about clinical data.
View scanned pages of your paper CRFs.

Manually create and edit discrepancies, if the Resolve extended module is
installed.

About the Manage module

Use the Manage module to perform data management tasks. You can:

Batch load and apply data-entry checks to clinical data.
Code clinical data using a coding thesaurus.

Validate and merge clinical data in the database.

Make global changes to or delete clinical data.

Edit records using an Error Log.

Track the auditing of data.

Produce reports about metadata objects.

Clintrial software modules 19



About the Retrieve module

Use the Retrieve module to access and extract clinical data from the database.
You can:

* Create queries using:

Query By Form.
— Query By Panel.
— Ad Hoc Query.
—  Query By SQL.
* Save query specifications in a query library.

« Save query results to a variety of formats, such as SAS or spreadsheet files.

The Clintrial software extended modules

In addition to the Clintrial software core modules, your company may have
purchased one or more of the following Clintrial software extended modules:
Classify, Lab Loader, Multisite, and Resolve.

About the Classify module

Use the Classify extended module to work with thesaurus protocols and
automatic coding. You can:

* Build and test complex coding algorithms.
» Find, track, and review solutions for values that fail automatic coding.

» Examine the contents of a coding thesaurus protocol, and compare different
coding thesaurus protocols.

* Audit the contents of a coding thesaurus protocol.
About the Lab Loader module

Use the Lab Loader extended module to load laboratory data into Clintrial
protocols. You can:

* Extend the batch loading capabilities provided in the Manage module.
* Build and maintain a set of lab normal ranges.

*  Process loaded lab data.

» Batch load lab data to a source protocol.

* Perform preparatory work on lab data prior to transfer to a clinical data
protocol.

» Transfer lab data into a clinical data destination protocol.

20  Chapter 1: Introduction to the Clintrial Software



About the Multisite module

Use the Multisite extended module to perform interdatabase instance operations.
You can:

+ Distribute protocols and codelists to multiple sites.

* Replicate clinical and account data between multiple sites.
* Copy functions and base tables.

» Use protocols and codelists in a global environment.

» Share tables and PL/SQL functions across multiple sites.
About the Resolve module

Use the Resolve extended module to manage discrepancy and resolution
capabilities that support the work you perform in other Clintrial software
modules. You can:

+ Identify, track, and resolve potential or actual discrepancies in clinical data
(inconsistent or missing data).

*  Check for discrepancies automatically or by manual inspection.

* Record investigation and resolution information.

Clintrial software modules 21



Starting a module

To start a module, from the Windows Start menu, select Programs. Select the
Clintrial program group, then the module.

When you start a module, the Database Connection dialog box opens:

E Database connection

Username: ||

Password: I

Database: I

“wharning: This computer program is protected by
copyright law and intemational treaties. Unauthorized
reproduction or distibution of thiz program or any portion
of it may rezult in gevere civil and criminal penalties, and
will be prozecuted ta the maximum extent pozsible under
the: law.

Clintrial” o | cancel Help

@ Copyright 2012, All Rights Reserverd.

Starting a module for the first time

The first time you start a Clintrial software module, the fields in the Database
Connection dialog box are empty. You must specify the following:

¢ Your user name
*  Your password

* The Oracle Net Service Name for the database you will be using

If you do not know your user name or password, or the database service name
that you should use, see your Clintrial software administrator.

Starting a module other than the first time

The next time you start a Clintrial software module, the user name and database
service name that you last used to start a Clintrial software module on your
computer are displayed as defaults in the Database Connection dialog box.

22 Chapter 1: Introduction to the Clintrial Software



Using a Clintrial software module

The basic tasks necessary to use a Clintrial software module are:
* Using the Switchboard

» Setting the protocol

* Switching databases

* Re-ordering columns in list windows

* Changing your password

» Exiting the module

How to use the Switchboard

You can start any of the installed Clintrial software modules from the
Switchboard Run menu. When you start the Switchboard, you provide a user
name, password, and database service name. Each time that you start a different
Clintrial software module from Switchboard, the Clintrial software uses the
database connection information that you initially provided when you started
Switchboard. More complete instructions appear in the Clintrial software Basics
Help.

Note: Although you can always start the installed Clintrial software modules
fromthe Switchboard, menu commands in the modules are available only if you
have the appropriate access rights.

How to set a protocol

A Clintrial software protocol is a logical container that organizes the objects and
clinical data for a clinical study.

When you first connect to the database, the Set Protocol dialog box opens:

Using a Clintrial software module 23



[ Set Protocol B

FELOME_AES2
KELOME_AESWOTESALD
KIRONIL

LAB1

LAMANOR

LAM_REY

LASORAL

| LatesT |

CTRESOLYEREF ;I 0K I
kAL

KALAKZ Cancel |
KALMOMER

KaALURIL Help |
KEL_TEST

KEL_TESTZ2

Select the protocol in which you want to work. If you do not know the protocol
in which you should work, see your Clintrial software administrator.

Note: The next time you start a Clintrial software module, the Clintrial software
automatically selects the protocol that your user account most recently selected.

How to switch databases

To switch from the current database to another database without exiting the
Clintrial software, close any open windows, and from the File menu, select
Connect. More complete instructions appear in the Clintrial software Basics
Help.

How to re-order columns in list windows

For windows that display list grid views, such as lists of logs in Manage or lists
of Discrepancies in Resolve, you may use the mouse to drag columns to new
positions to tailor the view to your needs. For example, you can drag and drop
the most significant columns to the left portion of the open window, or place two
related columns side-by-side in order to ease comparison of the data.

How to change your password

To modify the password for your user account, from the File menu, select
Password. More complete instructions appear in the Clintrial software Basics
Help.
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How to access the Server Registry Information

You can access the Server Register Information report from any of the Clintrial
software modules.
To open the report:

1. From the Help menu, select About.

2. Click More. The Server Registry Information opens, for example:

(4. More Clintrial 4 System Information x|

Server Registry Information

Module Yersion Patch Level Build ID
CTOR 4.7

CT 4.7 3 4.7.1.4031
TG 4.7 1 4.7.1.4031
CTY 4.7 1 4.7.1.4031
CTw 4.7 1 4.7.1.4031
CTC 4.7 1 4.7.1.4031
CTL 4.7 1 4.7.1.4031

How to exit a module

To exit a module, from the File menu, select Exit. When you exit the
application, the main window of the module closes and the Clintrial software
disconnects you from the database. More complete instructions appear in the
Clintrial software Basics Help.

Using Help

Each Clintrial software module is delivered with Help. Help includes:
» Context-sensitive Help for windows and dialog boxes
* Procedural instructions for tasks

* Brief overviews of concepts

Using Help 25



* Descriptions of menus and options

* A glossary of Clintrial software terms

A Clintrial software Help file is installed automatically for each module that you
install. In addition, the Help files that are not module-specific are always
installed on your computer.

Below is an example of the screen that appears when you choose Help: About
when you are in the Clintrial Admin module:

[#! About Clintrial Admin x|

E Clintrial Admin

BuildId: 4031
Patch Set: 1
Clintrial {tm), Copyright{c) 2012 Dracle. All rights reserved.

Yersion Patch Level Server Connection
Client: Bzl ] E | ETsvs@ct4riiia
Core Server: [.7.1 | B ]

Yarning: This computer program is protected by copyright law and international

treaties. Unauthorized reproduction or distribution of this program or any More... |
portion of it may result in severe civil and criminal penalties, and will be

prosecuted to the maximum extent possible under the law.

How to search for information

To search for information in the Help:

1. From the Help menu, select Help Topics. The Help Topics dialog box opens.
2. To find a topic in the Help:

* Click the Contents tab to view topics by category.

* Click the Index tab to view a list of index entries.

* Click the Find tab to search for specific words in the Help.

How to get help on windows and dialog boxes

To get help on an open window or dialog box, do one of the following:
*  Press F1.

¢ On the toolbar, click @

e Click Help.
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Overview

The Clintrial software Manage module is the core module that you use to
perform the following clinical data management tasks:

» Batch load data.

* Code clinical terms using industry-standard coding thesauruses.

* Validate the data.

*  Merge data (that is, move data that has passed validation to data tables).
* Globally modify or delete records.

* Review and correct errors.

* View logs and reports.

* View reports of audit data.
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Admin

Design

How Manage fits in the Clintrial software workflow

Set Up and Manage Clintrial System

The following figure shows how Manage fits in the Clintrial software workflow:

Set Up and
Maintain Users

Set Up and
Maintain Security

Design the
Database

Create Clintrial
Objects

Enter and Manage Clintrial Data

Enter

Manage

Retrieve

Verify Data

Enter and Edit Data

Merge Data

Validate and Advanced Edit

and Batch Load

Review Query
Results

Create Queries

Who are Manage users?

Manage users are generally data managers who are familiar with the Clintrial
software database structure and have the required access rights to work with
records in clinical data tables.
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Clintrial software protocols and panels

A Clintrial software protocol is a logical container that organizes the Clintrial
software objects and clinical data for a clinical study. It is an Oracle account that
consists of database tables that store:

* Metadata used to manage the data in the protocol
* Clinical data, flags, notes, and discrepancies associated with clinical data

* One or more views of the clinical data stored in the protocol

What is a panel?

A panel is a collection of logically related or clinically related items. For
example, the EXAM panel might define items for physical examination results.
When a panel is installed, three Oracle database tables are created (an update
table, a data table, and an audit table) for storing clinical data. The items in the
panel are the columns of the underlying Oracle database tables.

Panel types

As you work with Manage, you may need to know the differences between
different panel types, which are assigned in Design. The following table
summarizes the panel types:

Panel type:  Description:

0 Stores non-subject related data, such as laboratory normal ranges. No
context items are included in a Type 0 panel.

1 Stores one record per subject; that is, a single record that is collected
only once for each subject, such as demographic data. A subject item
is required for a Type 1 panel.

2 Stores multiple records per subject; that is, multiple records collected
once in a clinical study for each subject, such as previous
medications. The data is related to a single visit. A subject item is
required for a Type 2 panel.

3 Stores one record per subject visit; for example, a subject’s vital signs.
A subject item and block key item are required for a
Type 3 panel.
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Panel type:  Description:

4 Stores multiple records collected for each subject visit; for example,
adverse experiences. A subject item and a block key item are required
for a Type 4 panel.

5 Stores one record for each subject in a study, to uniquely identify the

subject. This type of panel is also called the enrollment panel.
Subjects must be enrolled before data can be entered for them. There
can be only one active enrollment panel for each protocol at any given
time. A subject item is required for a Type 5 panel.

Types of database tables

A database table is an Oracle database table that stores clinical data or metadata.
For each installed panel, the following three database tables exist:

* Update table — An Oracle database table that stores data when it is first
entered in the Clintrial software. The update table is a holding area for
clinical data while it is being manipulated. The name of the update table is
panel-name_UPDATE.

* Data table — An Oracle database table that stores data that has passed
validation. The name of the data table is panel-name DATA.

*  Audit table — An Oracle database table that stores copies of clinical data
records as they existed before modification or deletion. The name of the audit
table is panel-name_AUDIT.

A record can be in either the update table or the data table, but not in both tables.

Clintrial software items

An item is a Clintrial software object that represents a piece of data; for example,
the data that is collected in a field on a case report form (CRF).

Items are defined within panels, and each item corresponds to a column in a
table. For example, the DMG panel might contain the items SEX, AGE, and
RACE. The update table, data table, and audit table for the DMG panel would
include the columns SEX, AGE, and RACE.
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System items

A system item is one of eight items that are attached automatically to each record
to help identify and manage records. For example, the status of each record is
stored as a system item. For descriptions of the system items, see the Reference
Guide or the Design section in Admin and Design.

Context items

A context item is an item that provides context information, such as subject or
visit, for clinical data records. Context items are defined in the CONTEXT
panel.

What is the subject item?

The subject item is a context item used in enrollment that uniquely identifies the
subject in the clinical data tables in a study. Typically, the subject item is the
patient number, or another unique identifier. Internally, the Clintrial software
associates the subject item with the SUBJECT _ID system item, for which the
Clintrial software generates a unique value.

Note: In this guide and in the Manage Help, the subject item is often referred to
as the subject identifier.

What is the block key item?

The block key item is the context item that is used to access data by block within
a study book. Typically, the block key item is the visit number. For example, the
block key item might be VISITNO.

The block key value is the value given to the block key item. For example, the
block key values in a study book might be:

* 0 (Block Title: Baseline Visit)
* 1 (Block Title: Visit 1)

* 2 (Block Title: Visit 2)

* 3 (Block Title: Final Visit)
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If a study book includes repeating blocks, then a block repeat key item is used,
along with the block key item, to access data by block. The block repeat key item
uniquely identifies data in a repeating block. For example, if a block is used
more than once in the study book, then the day number could distinguish
multiple uses of the block. The block repeat key item might be DAYNO.

The following example shows a repeating block (Visit 3) that has been used
twice, once for Day 90 and once for Day 100:

Blockkey —— Visit: 3 Day: 90 Block repeat
value Page: Vitals Signs key value
Page: Joint Assessment
Page: Adverse Events Occurrence 1

Visit: 3 Day: 100

Page: Vitals Signs

Page: Joint Assessment

Page: Adverse Events Occurrence 1

What is the page key item?

The page key item is the context item that is used to access data by study page
within a block. Typically, the page key item is the page number. For example, the
page key item might be PAGENO.

The page key value is the value given to the page key item. For example, the
page key values in a study book might be:

* 1 (Page Title: Vital Signs)

* 2 (Page Title: Joint Assessment

* 3 (Page Title: Adverse Experience)

If a block includes repeating pages, then a page repeat key item is used, along
with the page key item, to access data by page within a block. The page repeat
key item uniquely identifies data in a repeating page within a block. For example,
if a page is used more than once in the block, then the page occurrence number
could distinguish multiple uses of the page.
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The following example shows a repeating page (Adverse Events) that has been

used three times, for occurrences 1, 2, and 3:

: Adverse Events Occurrence: 1

: Adverse Events Occurrence: 2
: Adverse Events Occurrence: 3

Visit: 2 Day: 60
Page: Vital Signs
Page: Joint Assessment
Page key —— Page
item Page
Page
Type 0 and Type 5 panels

For a Type 0 or Type 5 panel, a study book always includes only one block and

one page.

Page repeat
key item

Clintrial software records and record statuses

A record is the data stored in one row in a database table. Depending on the

panel type, the data collected in a study page is stored in one or more records in

the database.

The following figure shows the organization of a database table:

CT_RCID jsa % CT_RECID
Systemitem 0001.678
Exch row isa ----p 0002.009
sngle recora 0003.045

0004.379

SIBKCTisa
context item

\/

SUBJECT
100000-110
10000-120
10000-130

10000-140

VIST NUMBERand
VIST DATEaeitans
(columns) that sore dlinical
adfa values

\J \J
VISIT_NUMBER VISIT DATE
1 01-06-1999
1 02-01-1999
1 02-28-1999
1 03-15-1999

Clintrial software records and record statuses
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What is grouping?

Grouping is an automatic process performed during screening that collects
repeating records into observations for batch-loaded records. An observation is a
group of records in a page section that contains repeating items, or a group of
records in a non-subject study book that has been configured for grouping.
Grouping is only meaningful for records in a Type 0 panel (non-subject data), a
Type 2 panel, where multiple records can exist for the same subject, or a Type 4
panel, where multiple records can exist for the same subject visit.

For example, suppose you batch load data for multiple adverse events observed
during a subject visit. When the records are grouped, all the events become part
of the same observation.

The CT_RECID system item indicates whether records are part of the same
observation. For records that are part of an observation, the base of the
CT_RECID is the same and the last three digits are different. The following
example shows three records for the ADVERSE panel that are all part of the
same observation:

CT_RECID SUBJEC  VISITNO PAGENO
T-_ID

1,SQLOAD.LL?Min001.001 10 2 1

1,SQLOAD.LL?Min001.002 10 2 1

1,SQLOAD.LL?Min001.003 10 2 1

What is a record status?

The Clintrial software assigns a record status to records to track them internally
as they go through various stages of data management. The status of a record is
stored in the STATUS system item.

As you perform certain data management tasks for records in the update table,
the Clintrial software automatically changes the record status. Once the record is
in the data table, its status cannot change and will always be Validated (0).
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List of record statuses

The following table summarizes possible record statuses for records in the

update table or data table:

Status: Description: Table: Code:

Unscreened  The record was entered with batch loading, Update 3
but has not yet been screened.

Unverified The record was entered interactively, but has not yet Update 2
b ified.

(or Entered) een vere

Verified The record passed verification (for Update 1
interactively entered data) or screening
(for batch-loaded data).

Validated The record passed validation. Update 0

or Data

Validation The record failed validation or merging. Update -1

Error

Verification ~ The record failed verification (for Update -2

Error interactively entered data).

Screening The record failed screening (for batch- Update -3

Error loaded data).
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The following figure shows how record statuses change during the different
Manage tasks:

Update Table

Interactively Enter Bdfch Load
2 S 2 S
Unverified (2) Unscreened (3)
Verify* Verified ( H&e@n
Verification Error (-2) Screening Error (-3)
Vdidae
Validated ( Validation Error (-1)

Merge
Data Table
Validated (0
Vdlidate

* If verification is not required, then an Unverified record can be validated.

Data management tasks

The following data management tasks are performed in Manage:
+ Batch loading

* Screening

e Coding

* Validating
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Merging
Global changes and deletions
Error Log viewing

Auditing

Batch loading

As an alternative to interactive data entry with Enter, you can batch load data
using Manage. Batch loading is the process of taking data that is stored in an
ASCII file and placing that data directly into a Clintrial software database table.

Screening

Screening is a combination of several tasks performed from one single menu
command. You screen records after data is batch loaded into the clinical data
protocol. When you screen records, Manage performs the following tasks:

Updates the system items. Updating the system items in all records that were
successfully batch loaded into the database table supplies values for the
internal items that the Clintrial software uses to uniquely identify records.

Groups the records into observations, if grouping items are indicated in
Design. Grouping the records organizes batch-loaded records into
observations. An observation is a group of records in a page section that
contains repeating items, or a group of records in a non-subject study book
that has been configured for grouping. For example, you might group
multiple blood tests that were taken on one sample into a single observation.

Applying data checks to batch-loaded data. Applying data checks to batch-
loaded data applies the same checks that are applied to interactively entered
data.

Screening also ensures that the batch-loaded data is entered correctly
in the update table.

Once data passes screening, you can validate, edit, and merge the records in the
same way that you do data that is entered interactively.
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Coding

Coding is the process of assigning a standard code from a coding thesaurus to a
value that has been entered for an item. Your designer decides which items in
panels can be coded and which thesauruses will be used. The Clintrial software
provides a means to use industry-standard thesauruses, such as the MedDRA
(Medical Dictionary for Drug Regulatory Affairs) dictionary.

Validation, also called data cleaning, is the process of running a validation
procedure on clinical data to apply any derivations defined and to check for logic

Each panel has one associated validation procedure. The validation procedure is
a PL/SQL procedure that is built automatically from the derivations and rules

» Derivations calculate values of items that the designer has set up as
“derived” based on constants or on the values of other items.

* Rules check that the clinical data meets the requirements of the clinical

Validation
and consistency. Data either passes or fails validation.
associated with the panel:
protocol.
Merging

Merging is the process of moving data that has passed validation from the update
table to the data table. Only data that has passed validation can be merged.

Global change and global deletion

Global change is the process of changing the value of one or more items in
multiple records. Global deletion is the process of deleting multiple records.
Before making actual changes or deletions, you can preview the results.

Error Log

The Error Log, available from the Reports menu, is a cumulative log of errors
that occurred during screening, validation, merge, global change, and global
deletion. If you have appropriate privileges, you can edit a record that you select
from the Error Log.
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Auditing

Auditing is the process of tracking changes made to clinical data and of tracking
notes associated with clinical data. The designer determines which Clintrial
software panels and tasks are audited.

The audit report shows differences between the record as it was before a change
and the record as it is after a change. It also shows records that have been deleted
from the update table or data table when auditing is in effect.

Sample Manage workflow

The activities performed in Manage do not necessarily follow a linear workflow.
Most activities may be performed at any time, or simultaneously.

Global changes and deletions are included, although they are not necessarily part
of the typical workflow, and you can make them at any time. Coding can also be
performed at any time.
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The following figure shows a typical workflow within Manage:

Batch Load Data

3

Screen Data

¥

Code Data

3

j

Validate Data > Error Log

Audit Data l

Make Global
Changes and -==
Deletions

3

Merge Data F=---

3

View Logs and
Reports
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Required access rights and access levels

After you set up a protocol for use with Manage, you assign access rights to
users for the protocol in Admin. An access right is a predefined set of Clintrial
software activities that can be associated with a usergroup or a user. Some access
rights relate to activities that require access to protocols and must be associated
with a protocol as well as with a usergroup or user.

Access levels determine what type of access users have to the activities defined
by an access right. By selecting an appropriate access level, you grant users or
usergroups the ability to perform certain activities.

For more information on access rights and access levels, see the Admin section in
Admin and Design.

List of Manage protocol access rights

The following table lists the Manage protocol access rights and access levels:

Access right:  User can: Access levels:
Coding Code data using values from a Full — Can code, view coding
coding thesaurus. reports, and purge coding
reports.

Read — Can view coding
reports, but cannot code or
purge coding reports.

None — Cannot code or view
coding reports.

Note: Coding access cannot be
applied to View protocols.
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Access right:  User can:

Access levels:

Global Make global changes and
deletions.

Full — Can make global
changes and deletions, view
global change and global
deletion reports, and purge
global change and global
deletion reports.

Read — Can view global
change and global delete
reports, but cannot perform
global changes or global
deletions or purge global
change and global deletion
reports.

None — Cannot make

global changes and

deletions, view global change
and global delete reports, or
purge global change and global
deletion reports.

Note: Global access cannot be
applied to View protocols.
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Access right:  User can: Access levels:

Other Perform Manage activities other Full — Can perform all
than code or make global changes =~ Manage tasks. Can generate
and deletions. Audit Subjects Reports. Can

view reports, except Coded
Item Report. Can purge reports,
except Global Change Report,
Global Delete Report, Coded
Item Report.

Read — Can view reports for
other tasks, but cannot perform
these tasks or purge reports.
Can create and print Audit
Subjects Reports. Cannot view
Coded Item Report.

None — Cannot perform these
Manage tasks, or view reports
for these tasks.

Note: Other access cannot be
applied to View protocols.

Note: If you plan to edit records directly from the Error Log, you must also have
the Unmerged protocol access right for Enter, with the Full access level. If you
plan to edit records in the data table from the Error Log, you must have the
Merged protocol access right for Enter, with the Full access level.

Setting your user preferences

System parameters define characteristics of the work environment for all users
of an Oracle database instance to which the users connect through the Clintrial
software.

You set system parameters in Admin.
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User preferences are a subset of system parameters. Default values for user
preferences come from corresponding system parameters. Each user can change
the default values of the parameters for use in their account by changing the user
preferences.

Your Clintrial software administrator will set default user preferences in Admin
when the Clintrial software is installed. You can change the default Manage user
preferences in Manage.

Manage user preferences

The following table lists the user preferences that are available in ~~ Manage:

User preference: Description:
ERRLOG DISPLAY- Name of an additional item to be displayed in the Error
_ITEM Log for Type 0 panels.

Default: None

SELECT BY_PAGE If Yes, records are selected by study page for validation

Default: No and merge.

If No, records are selected by panel.

AUDIT ITEM_LIST Name of an additional context item to be included in the
Audit Report. The subject item, block key item, block
repeat key item, page key item, and page repeat key item
are included by default.

Default: None
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Overview

Batch loading is the process of taking data that is stored in an ASCII file and
placing that data directly into a Clintrial software database table. You can batch

load any type of data; for example, clinical data, thesaurus data, or enrollment
data.

The batch-loading process includes the following steps:

1. Create a control file. The control file specifies the relationship between the
data in the input file and the items in the Clintrial software database.

2. Batch load the data (that is, the input file).

3. Screen the batch-loaded data. The screening process:

* Updates the system items.

» Groups the records into observations, if grouping items are specified in
Design.

» Applies data checks to batch-loaded data.
4. Optionally, edit or delete the unscreened data.

Update table and data table

When you batch load data, it is stored initially in the update table for the
specified panel. After the data has passed screening, you can validate the data,
and then merge it (that is, move the data to the data table).

Caution: Enrollment data must be in the data table for the Clintrial software to

& recognize that a subject is enrolled. Therefore, after batch loading enrollment
data for new subjects, you must screen, validate, and merge the enrollment data
before other data can be entered for the new subjects.

What is an input file?

An input file is an ASCII file that contains lab data to be batch loaded into the
Clintrial software. Each line in the file represents a record composed of fields.
Each field contains data that, when it has been batch loaded into the Clintrial
software, will be stored as an item in the update table for the panel into which it
was loaded. The input file may use a delimiter, such as a comma, to separate
values for fields.
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The following example shows how the values in a two-line input file would be
stored as items in the update table after batch loading:

Input file Update table

SUBID VISTNO WGHT HGHT
100,0,130,68 > 100 0 130 68
120,0,170,72 —————————— > 120 0 170 72

Creating a control file

A control file serves as the interface between the input file and the Clintrial
software database table. The control file:

* Interprets the organization and format of data in the input file for Oracle SQL
Loader.

* Provides instructions on how Oracle SQL Loader loads data from the input
file into the database table.

You can create multiple control files for a panel. Also, you can use the same
control file to load one or more input files into the update table for a specified
panel.

Note: You can only select one panel at a time for which to create a control file.
Data can only be batch loaded into one panel at a time, and the data must be
loaded into the panel’s update table. To load data from an input file into more
than one panel, you must create multiple control files and run the batch load for
each panel.

What is the default control file?

When you create a control file, the Clintrial software creates a default version of
the control file, based on the panel definition. You must edit the control file to
match the structure and order of the data that you will be batch loading.

File formats

You can create a control file in either of the following formats:
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* Fixed format

In a fixed format input file, the data values have a specified length, and each
value begins at a fixed location in the record. No delimiters separate the
values.

» Variable format

In a variable format input file, the data values do not have to be a specified
length, and may not begin at the same location in each record. Delimiters that
you specify, such as commas, separate the values. The same delimiter must
be used for all records in the input file.

How to begin

To create a default control file, from the Load menu, select Control File
>> New. The Select options for control file dialog box opens:

#. Select options for control file E

File Format

& Fixed Format
~ Variable Format

1] 4 I Cancel | Help |

Select the panel for which you are creating the control file, and the format of the
control file. The Clintrial software creates and displays a default control file for
the panel. You can edit the control file as described in "Editing a control file" on
page 56. If you indicate that you want to save the file, you can specify a location
for it.

Fixed format control file

The following is an example of a fixed format control file:

-- Control file for loading data into:
--  MEDIKA CLINICAL.LAB UPDATE
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LOAD DATA

APPEND
INTO TABLE MEDIKA_CLINICAL.LAB_UPDATE

TRAILING NULLCOLS

(STATUS constant 3,

CT _RECID sequence (count),

SUBJECT ID constant 0,

SUBJECT position(1:10)  "RTRIM(LTRIM(:SUBJECT))",

VISNO position(11:20)  "RTRIM(LTRIM(:VISNO))",

PAGENO position(21:30)  "RTRIM(LTRIM(:PAGENO))",

PAGERPT position(31:40)  "RTRIM(LTRIM(:PAGERPT))",

VISRPT position(41:50)  "RTRIM(LTRIM(:VISRPT))",

PROTID position(51:60)  "RTRIM(LTRIM(:PROTID))",

VISDATE position(61:74)  DATE "YYYYMMDDHH24MISS"
NULLIF VISDATE=BLANKS,

SUBJINIT position(75:84)  "RTRIM(LTRIM(:SUBJINIT))",

DAYNO position(85:94)  "RTRIM(LTRIM(:DAYNO))",

LABNAME position(95:104)  "RTRIM(LTRIM(:LABNAME))",

TEST UNITS HEM position(105:114)
"RTRIM(LTRIM(:TEST_UNITS_HEM))",

RELEV position(115:122)  NULLIF RELEV=BLANKS,

RESULT position(123:132)  "RTRIM(LTRIM(:RESULT))",

TEST TYPE position(133:142)  "RTRIM(LTRIM(:TEST TYPE))",
TEST NAME position(143:152)  "RTRIM(LTRIM(:TEST NAME))",
LABNO position(153:162)  "RTRIM(LTRIM(:LABNO))",
URNGUIDE position(163:172)  "RTRIM(LTRIM(:URNGUIDE))",

TEST UNITS CHM position(173:182)
"RTRIM(LTRIM(:TEST_UNITS_CHM))"

)

Variable format control file

The following is an example of a variable format control file:

-- Control file for loading data into:
--  MEDIKA CLINICAL.LAB UPDATE
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LOAD DATA

APPEND
INTO TABLE MEDIKA_CLINICAL.LAB_UPDATE

-- Note: Change @ to your file's separator character and adjust the 'ENCLOSED BY'
clause

FIELDS TERMINATED BY '@ OPTIONALLY ENCLOSED BY "

TRAILING NULLCOLS

(STATUS constant 3,

CT_RECID sequence (count),

SUBJECT 1D constant 0,

SUBJECT "RTRIM(LTRIM(:SUBJECT))",

VISNO "RTRIM(LTRIM(:VISNO))",

PAGENO "RTRIM(LTRIM(:PAGENO))",

PAGERPT "RTRIM(LTRIM(:PAGERPT))",

VISRPT "RTRIM(LTRIM(:VISRPT))",

PROTID "RTRIM(LTRIM(:PROTID))",

VISDATE DATE "YYYYMMDDHH24MISS" NULLIF
VISDATE=BLANKS,

SUBJINIT "RTRIM(LTRIM(:SUBJINIT))",

DAYNO "RTRIM(LTRIM(:DAYNO))",

LABNAME "RTRIM(LTRIM(:LABNAME))",

TEST UNITS HEM "RTRIM(LTRIM(:TEST_UNITS HEM))",
RELEV NULLIF RELEV=BLANKS,

RESULT "RTRIM(LTRIM(:RESULT))",

TEST TYPE "RTRIM(LTRIM(:TEST _TYPE))",

TEST NAME "RTRIM(LTRIM(:TEST_NAME))",
LABNO "RTRIM(LTRIM(:LABNO))",

URNGUIDE "RTRIM(LTRIM(:URNGUIDE))",

TEST _UNITS _CHM "RTRIM(LTRIM(:TEST_UNITS_CHM))"

)
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Editing a control file

Once the default control file is built, you can edit it to meet the input file
requirements. For example, if the data type, width, position, or format of data in
the input file differs from those in the control file, you can edit the control file, if
necessary, to correspond to the input file.

How to begin

From the Load menu, select Control File >> Edit.

When you finish editing the control file, you must save the control file. The
default file name extension for the control file is panel-name.ctl; for example,
lab.ctl.

Items in the control file

The default control file lists all items in the panel. The control file must include
specifications for some of the system items, although values for the system items
are not included in the input file. When you load the input file, the Clintrial
software assigns values to the system items of the batch-loaded data. You will
then need to screen the data to update the system items as described in
“Screening batch-loaded data” on page 61.

Changes you may want to make

When you edit the default control file, you can make the following changes:

* If necessary, reorder the items in the control file to match the order of values
in the input file.

* Delete items for which the input file does not contain values. For example, if
the input file does not contain any values for the item BIRTH DATE, you
could delete BIRTH DATE from a fixed format control file.

* Add conversion instructions, such as instructions for converting date
formats.

* Adjust the ENCLOSED BY clause to contain the character that is used in the
input file to indicate character strings.

* For a variable format control file, change the delimiter from ‘@’ to the
character that is used as a field delimiter in the input file. For example, °,’.

» For a fixed format control file, change an item’s fixed size.
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Note: You do not need to batch load every field from the records in the input
file.

Delimiters

A variable format control file must indicate the delimiter that is used in the input
file.

For example, if the input file is a comma-separated (.csv) file, then the delimiter
is a comma. In the control file, replace the default delimiter (@) with a comma:

FIELDS TERMINATED by *,

Trailing null values

By default, a control file includes the following line:

TRAILING NULLCOLS

This line indicates that if not enough values are supplied by the record in the
input file, then the items in the panel will be given the value Null when the
record is batch loaded.

Date format

The control file must specify the date format that is used in the input file.

For example, if the input file contains the date 03-17-1999 00:00:00, then the
control file must specify the date format of the item as:

DATE “MM-DD-YYYY HH24:MI:SS”

Character strings

The control file must specify the character that is used to indicate character
strings in the input file. In the control file, you must enclose the character in
single quotation marks.

For example, if the double quotation mark is used to indicate character strings in
the input file, then the control file must specify:
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OPTIONALLY ENCLOSED by “”

NULLIF clause

For items of the data type NUMBER or DATE, the default control file contains a
NULLIF clause. The default NULLIF clause treats an item as Null if the value in
the input file is blank.

You can edit the NULLIF clause in the control file so that an item is treated as
Null if the value in the input file is another value; for example, a period (.).

LTRIM and RTRIM clauses

For items of the data type TEXT, the default control file includes the
following:

* An LTRIM clause, which trims leading blanks
* An RTRIM clause, which trims trailing blanks

Loading the data

To batch load data, you must have the Oracle SQL Loader tool installed on your
computer. You must use the 32-bit version of SQL Loader.

Before batch loading, you may want to check a sampling of records in each input
file to ensure that the positions and formats match the corresponding control file.

For more information on supported versions of SQL Loader with the Clintrial
software, see the Reference Guide.
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How to batch load data

From the Load menu, select Load Data. The Batch SQL Loader dialog box

opens:
. Batch SOL Loader | %]
Database: @ctd2
Control File: IC:\CT42\medika_clinical_lab_val.l: Browse._..
Cancel
Advanced.._
Data: IC:\medika_sDulce.lxt Browse. .. | Help |
Log: |l3:\ET42\medika_clinical_lah_vad.I.
Bad: IC:\medika_suulce.BAD
Discard: IC:\medika_sDulce.DlS

In this dialog box, you specify the names and locations of the control file and
input file. The Clintrial software saves the files in this dialog box as defaults for
the next session. You can change these defaults.

You can also specify the names and locations of the following files, which will
be created by the batch-load process:

File:

Description:

Log file

Bad file

Provides information about the batch-loading process, such as the
number of records loaded into the update table, and the number of
errors that occurred. This file is optional, but recommended.

The default name of the file is the control file name, followed by the
extension .log. By default, the file is stored in the same directory as
the control file. You can change the default file name and location.

Lists records that were rejected by SQL Loader; for example, if a
value exceeds its maximum length or the data is invalid for the data
type. These records are not loaded into the update table. This file is
optional.

You may want to manually edit this file, rename it, and reload it as an
input file.

The default name of the file is the input file name, followed by the
extension .BAD. By default, the file is stored in the same directory as
the input file. You can change the default file name and location.
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File:

Description:

Discard file

Lists records that did not meet the selection criteria for batch loading.
The records are not loaded into the update table. This file is optional.

The default name of the file is the input file name, followed by the
extension .DIS. By default, the file is stored in the same directory as
the input file. You can change the default file name and location.

Advanced SQL Loader options

If you click Advanced in the Batch SQL Loader dialog box, then the Advanced
Batch Loader Options dialog box opens:

) Advanced Batch Loader Options

Records to Skip:
Records to Load:
Fows per Commit:
Maximum Errors:

Maximum Discards:

jo

IW Cancel |
IB“— Defaults |
|5I]—

[izswserss

Maximum Bind Array: IW Bytes

The following table describes the options that you can set in the Advanced Batch
Loader Options dialog box:

Option:

Description:

SQL
Loader
parameter:

Records to Skip

Records to Load

Rows per Commit

The number of logical records from the
beginning of the file that should not be
loaded. Use this option to continue loads that
have been interrupted.

The number of logical records to load after
skipping the number of records specified in
Records to Skip.

The number of rows in the bind array.

SKIP

LOAD

ROWS
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SQL

Loader
Option: Description: parameter:
Maximum Errors The number of insert errors to allow before ERRORS
SQL Loader terminates with an error.
Maximum The number of discards to allow before SQL DISCARDM
Discards Loader terminates with an error. AX
Maximum Bind The maximum size of the bind array BINDSIZE

Array (in bytes).

How to check results

To determine whether the batch load completed successfully, you must view the
log file. From the Reports menu, select Batch Load Log.

Screening batch-loaded data

Screening is a combination of several tasks performed from one single menu
command. You screen records after data is batch loaded into the clinical data
protocol. When you screen records, Manage performs the following tasks:

Updates the system items. The system items are internal items within every
record that the Clintrial software uses to uniquely identify the records.
Updating the system items assigns values to the items CT_RECID and
SUBJECT _ID. The values assigned are equivalent to the values assigned
when you interactively enter records through Enter.

Groups the records into observations, if grouping items are indicated in
Design. Grouping the records organizes batch-loaded records into
observations. An observation is a group of records in a page section that
contains repeating items, or a group of records in a non-subject study book
that has been configured for grouping. For example, you might group
multiple blood tests that were taken on one sample into a single observation.
Records grouped into a single observation are displayed as a repeating group
in a study page in Enter, and exist collectively in the update and data tables.

Applies data checks to batch-loaded data. Applying data checks applies the
same checks that are applied when you interactively enter data in Enter. The
data checks are:

— Confirming that subjects are enrolled.
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— Confirming that subject, block, and page keys are defined.

— Confirming that block repeat and page repeat keys are defined, if they
will be used.

— Confirming that subset keys are defined, if they will be used.
— Confirming that a master record exists for a detail record.
— Confirming that the master key is unique.

— Confirming that grouping items have values, if grouping items are
defined for Type 0 panels. Confirms that default grouping items have
values for Type 2 and Type 4 panels.

— Confirming that values are provided for mandatory items.

— Confirming that a code for an item with an attached codelist exists in the
codelist.

— Applying the range checks (upper and lower limits) that are defined for
items.

— Confirming that a value exists in the checklist for an item with an
attached checklist.

Additionally, each record for a non-Type 0 panel must have a SUBJECT ID
system item other than 0, and each record must minimally have a valid block key
and page key.

About system item assignment

When you first batch load a record, the Clintrial software assigns values to
system items as follows:

* The MERGE DATETIME value is initially the same as the
ENTRY_ DATETIME.

* The STATUS value is Unscreened (3).

* The ENTRY ID is assigned by the Clintrial software, and is the batch-load
account associated with the protocol into which you are batch loading data.

* The ENTRY DATETIME value is the date and time that the record was
batch loaded.

* The CT_RECID is a one-part unique identifier generated from a sequence
during the initial load by Oracle SQL Loader.

* The SUBJECT IDis 0.
* The DB _ID is the identifier of your database instance.
*  The CTSSREASON value is blank.

For descriptions of the system items, see the Reference Guide or the Design
section in Admin and Design.
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How system item assignment is changed

When you screen records, the following system items change for each record:
* The ENTRY_ID becomes the user account that screened the records.

* The MERGE DATETIME becomes the date and time that the records were
screened.

* The CT_RECID changes to the four-part identifier assigned by the
Clintrial software.

» For panel types 1 through 4, the SUBJECT ID becomes the value of the
SUBJECT _ID that is associated with the subject in the enrollment panel. For
Type 5 panels, it becomes a unique value in the enrollment panel.

The following example shows the values of system items for four batch-loaded
records for which system items have not yet been updated:

STATU ENTRY- SUBJEC

S _ID MERGE CT_RECID DB ID T-_ID

3 CTSLOAD 10/1/99 1 1 0
12:31:12

3 CTSLOAD 10/1/99 2 1 0
12:31:12

3 CTSLOAD 10/1/99 3 1 0
12:31:12

3 CTSLOAD 10/1/99 4 1 0
12:31:12

The following example shows the values of the same four records after system
items have been updated:

STATU  ENTRY- SUBJEC

S D MERGE CT_RECID DB ID T-ID

3 SMITH 10/3/99 1,SQLOAD.LL?Min001.0 1 10
14:00:06 01
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STATU  ENTRY- SUBJEC
S 1D MERGE CT_RECID DBID T-ID
3 SMITH 10/3/99 1,SQLOAD.LL?Min002.0 1 10
14:00:06 01
3 SMITH 10/3/99 1,SQLOAD.LL?Min003.0 1 10
14:00:06 01
3 SMITH 10/3/99 1,SQLOAD.LL?Min004.0 1 129
14:00:06 01
About grouping
Grouping is an automatic process performed during screening that collects
repeating records into observations for batch-loaded records. An observation is a
group of records in a page section that contains repeating items, or a group of
records in a non-subject study book that has been configured for grouping.
Grouping is only meaningful for records in a Type 0 panel (non-subject data), a
Type 2 panel, where multiple records can exist for the same subject, or a Type 4
panel, where multiple records can exist for the same subject visit.
For example, suppose you batch load data for multiple adverse events observed
during a subject visit. When the records are grouped, all the events become part
of the same observation.
Grouping for Type 0 panels (non-subject data) uses the user-defined grouping
keys and subset keys specified in Design, and optionally, the grouping key items
for subject data.
Grouping for Type 1-5 panels (subject data) uses:
e Subject item
* Block key item
* Page key item
* Block repeat key item
* Page repeat key item
e Subset key item
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CT RECIDs and observations

The CT_RECID system item indicates whether records are part of the same
observation. For records that are part of an observation, the base part of the
CT_RECID, called the stem, is the same and the last three digits, called the
observation sequence, are different.

The following example shows four records for the ADVERSE panel. Three of
the records are for the same SUBJECT ID, VISITNO, and PAGENO.

SUBJECT
CT_RECID _ID VISITNO PAGENO
1,SQLOAD.LL?Min001.001 10 2 1
1,SQLOAD.LL?Min002.001 10 2 1
1,SQLOAD.LL?Min003.001 10 2 1
1,SQLOAD.LL?Min004.001 10 3 1

Assuming that there are no block repeats or page repeats defined, the Clintrial
software changes the CT_RECIDs of grouped records as part of the screening
process to reflect that they are part of the same observation. In the following
example, the records have been grouped based on SUBJECT ID, VISITNO, and
PAGENO. Thus, the three records that have the same SUBJECT _ID, VISITNO,
and PAGENO are given a CT_RECID that is the same, except for the last three

digits.

SUBJECT
CT_RECID _ID VISITNO PAGENO
1,SQLOAD.LL?Min001.001 10 2 1
1,SQLOAD.LL?Min001.002 10 2 1
1,SQLOAD.LL?Min001.003 10 2 1
1,SQLOAD.LL?Min004.001 10 3 1

Screening batch-loaded data
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About auditing

Records with the status Unscreened (3) and Screening Error (-3) are not eligible
for auditing.

Oracle does not audit unscreened batch-loaded data because it does not meet
the definition of electronic record per our interpretation of CFR Part 11.
Screening process converts eligible database records into Clintrial electronic
records. In order for a record to become the Clintrial record the data has to
comply with our requirements, that is at the very least there has to be a unique
constant identifier to track each record, which in case of Clintrial it is the
CT_RECID field. This field is changed by screening process which makes any
prior auditing of no value.

For a detailed description of what is happening during screening when the raw
data you batch loaded is converted into the Clintrial electronic records, see
"Loading the data" on page 58. During loading Oracle looks at nothing but
datatypes, therefore data loaded could contain invalid keys (context items). That
could also make freshly loaded records unsuitable for auditing because they do
not comply with existing metadata definitions. If it is necessary to record every
alteration to the data after it was loaded the process should be adjusted so that
loading is immediately followed by screening.

How to begin

From the Load menu, select Screen. The Screen dialog box opens:

Panels 50L Restriction

A0 fa

CONMED

DMG

DRGADM

DRGCMP [—

EMROLL

EXCLUS

INCLUS ¥ Submit Batch

INVESTIGATORS

Submit at: IU3/1 24193312533

" Release for Validation Submit every: IDD E H
[~ Ovemide Checks

ok | Cancel | soL. | Help |

Select the panels for which you want to screen data.

66  Chapter 3: Batch Loading Data



How to restrict records

To restrict records based on a SQL restriction, click the SQL Restriction box, or
click SQL. For more information on restricting records, see the Reference
Guide.

How to perform screening as a batch job

You can perform screening either interactively or as a batch job. If you perform a
task interactively, you cannot use Manage for other tasks until the current task is
completed. For information about batch jobs, see the Manage Help.

How to release records for validation

If you check Release for Validation, then the status of records that pass screening
will change to Verified (1), and the records will be eligible for validation. The
status of the records that fail screening will change to Screening Error (-3).

If you clear Release for Validation, then the status of records that pass or fail
screening will not change; therefore, the records will not be eligible for
validation. However, errors in these records will be recorded in the Error Log.

Before releasing records for validation, you may want to ensure that all records
will pass screening to avoid potential problems later. To do so:

Clear Release for Validation and screen the records.
Review the Error Log to determine which records failed screening.
Edit the records that failed screening.

Screen records again, with Release for Validation still cleared.

A

When all records pass screening, check Release for Validation and then
screen the records.

How to override data-entry checks

If you check Override Checks, you can override the following checks for items:
« For an item with an attached checklist, the value must exist in the checklist.

* The value must be within any upper or lower bounds that have been defined
for the item.
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Eligibility

Records with the status Unscreened (3) or Screening Error (-3) are available for
screening.

Effect on the record status

If a record passes screening and was released for validation (described on page
67), then the record status changes from Unscreened (3) to Verified (1).

If a record fails screening and was released for validation, then the record status
changes from Unscreened (3) to Screening Error (-3).

If the record was not released for validation, then the record status does not
change as a result of passing or failing screening. However, errors that occur
during screening are recorded in the Error Log.

The following figure shows the possible status changes for batch-loaded records
when Release for Validation is checked:

Update Table Betch Load

2

Unscreened (3)

Verified (1) H’Q , Record Fail's Sreening
Fasses

Screening Error (-3)

How errors appear in the Error Log

Errors that occur during screening are reported in the Error Log with the Error
Type SCREEN.
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Screen Log

The Screen Log is a cumulative report that describes the screening results for the
most recently screened panels.

From the Reports menu, select Screen Log >> View. The following table
describes the information in the Screen Log:

Report column:

Description:

Panel

Table

Status

Remarks

Selected

Modified

Reported

Rejected

Batch Id

User Id

Start

End

Restriction

Source panel for which batch-loaded records were screened.

Oracle table in which batch-loaded records were screened.
This value will always be UPDATE, as screening is only
performed on data in the UPDATE table.

NORMAL indicates that screening completed successfully;
ERROR indicates screening did not complete successfully.

COMPLETED if status is NORMAL,; an error message if
status is ERROR.

Number of records for which screening was attempted.
Number of records that were screened successfully.

If you are overriding data checks during screening, then the
number of data checks that failed, but passed screening
because checks were overridden.

Number of data checks that failed screening.

Oracle batch job queue ID, if screening was run as a batch
job.

User account that submitted or ran the screening.
Date and time that screening began.
Date and time that screening completed.

SQL WHERE clause that was used to select records.
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The following example shows a portion of the Screen Log:

0g iy |m] 4
Panel Table | Status Remarks Selected Modified Reported Rejected |Batch Id| = |
ADY UPDATE NORMAL |COMPLETED 24 24
ADY UPDATE NORMAL |COMPLETED 24 24 23z
ADY UPDATE NORMAL |COMPLETED 24 24 28
DRGCMP UPDATE WORMAL |COMPLETED 0 0 261
JNTSLIR UPDATE MORMAL \COMPLETED g g
JNTASH UPDATE MORMAL |COMPLETED 1.020 1.020
LAR UPDATE NORMAL |COMPLETED 2,332 2,332 94K
CONMED UFPDATE MORMAL (COMPLETED a a
CONMED UPDATE WORMAL |COMPLETED 2g 2g -
DRGCMP UPDATE MORMAL \COMPLETED 224 224
DRGADM UPDATE NORMAL |COMPLETED 352 352
WITAL UPDATE NORMAL |COMPLETED 220 220
JNTASM UFPDATE MORMAL (COMPLETED 1.020 1.020
CONMED UPDATE WORMAL |COMPLETED 2g 2g
WITAL UPDATE MORMAL \COMPLETED 220 220
JNTASH UPDATE MORMAL |COMPLETED 1.020 1.020
JNTASM UPDATE \NORMAL |COMPLETED 1.020 1.020

How to work with the Screen Log

You can view the Screen Log, purge all entries from it, or purge selected entries
based on the following criteria:

* Panel name

» User account

* Type of database table (UPDATE or DATA)

« Status (NORMAL or ERROR)

* Range of the date and time that the screening started

* Range of the date and time that the screening ended

You can use the View menu to filter or sort a displayed Screen Log, and the File
menu to save or print the log.

Editing unscreened records

When records fail screening, you should edit them and screen them again. You
can also edit unscreened records.

Note: You can also edit unscreened records, or records that have failed
screening, by performing a global modification as described in Chapter 7.
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Eligibility

Records with the status Unscreened (3) or Screening Error (-3) are available for
editing.

Effect on the record status

The record status does not change as a result of editing an unscreened record.

How to begin

From the Load menu, select Unscreened Records >> Edit. The Select panel
dialog box opens:

&, Select panel E
COMMED
DG Cancel |
DRGADM
DRGCMP Help |

EMROLL
EXCLUS
INCLUS
INVESTIGATORS
NTASM
NTSUM
LA
LaB_MORMS LI

After you select a panel and type of database table, the Edit Unscreened Records
window opens. You can modify the value of any item except the system items.

If you modify the value of a grouping item, then the record will be regrouped as
part of the rescreening process. This will prolong the rescreening process.

If you modify the value of a subject item or subject-related item, then the
rescreening will be prolonged. The SUBJECT ID system item is then updated
during the rescreening process.
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Deleting unscreened records

Screening batch-loaded records could potentially produce numerous errors. You
may decide to edit the input file and rerun the batch-load process rather than
editing all the records that produced an error. Before batch loading the data
again, you should delete all unscreened, batch-loaded records for the panel.

Note: You can also delete unscreened records, or records that have failed
screening, by performing a global deletion as described in Chapter 7.

Eligibility

Records with the status Unscreened (3) or Screening Error (-3) are available for
deletion.

How to begin

From the Load menu, select Unscreened Records >> Delete. The Delete
Unscreened Records dialog box opens:

i Delete Unscieened Records
Panel 50L Restriction
my e
COMMED J

DG
DRGADM
DRGCMP
EMROLL

LI [~ Include Failed Screen

— Results
Records
Panel Deleted

Delete | LClose I Help |

Select the panel in which the records were batch loaded.

How to include records that failed screening

If you check Include Failed Screen, then records with the status Screening Error
(-3) are included in the deletion.
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If you clear Include Failed Screen, then records with the status Screening Error (-
3) are not included in the deletion.

How to restrict records

To restrict records based on a SQL restriction, click the SQL Restriction box. For
example, you could use a SQL restriction to delete only records that were loaded
during a particular time period. For more information on restricting records, see
the Reference Guide.
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Overview

Coding is the process of assigning a standard code from a coding thesaurus to a
value that has been entered for an item. For example, an entered drug could be
assigned a standard code from the WHODRL thesaurus. Coding provides the
following benefits to clinical data management:

» It standardizes the use of terminology describing information, such as
adverse events data, that is collected during clinical studies.

» It reduces the time and effort that is required to manually look up and select
terms in a coding thesaurus.

The designer determines which items will be coded. Typical items to be coded
are clinical events, drugs, or diseases.

What is verbatim text?

The text entered by the user is referred to as verbatim text. The verbatim text is
the entered text for which you want to assign a standard code from a coding
thesaurus. For example, the following verbatim text might be entered for clinical
events:

Clinical Event Onset Date End Date
Verbatim text Pain in eye 3/1/99 3/6/99
Patient had rash 3/12/99 4/28/99

Coding methods

There are two methods of coding:

* In automatic coding, the Clintrial software uses an algorithm to search the
coding thesaurus for the term matching the verbatim text and assign an
appropriate code to the verbatim text if the search is successful.

* Ininteractive coding, you can search the coding thesaurus in various ways,
and manually assign an appropriate code to the verbatim text.

You must perform automatic coding, and then use interactive coding for items
that were not successfully coded automatically.
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Types of thesauruses

The Clintrial software provides a means to use industry-standard thesauruses,
such as:

» International Classification of Diseases, 9th Revision (ICD-9-CM)
*  World Health Organization Drug Reference List (WHODRL)

*  World Health Organization Adverse Reaction Terminology (WHOART)
dictionary

* Coding Symbols for a Thesaurus of Adverse Reaction Terminology
(COSTART)

* Medical Dictionary for Drug Regulatory Affairs (MedDRA)

The Clintrial software also provides a means to use user-defined thesauruses,
which the designer can set up in Design.

What is the TERMS panel?

The TERMS panel contains codes and terms. A ferm is a standard word or
phrase that describes a clinical event, such as a disease or drug.

This chapter refers to the TERMS panel. A view onto the TERMS panel, rather
than the panel itself, is used during coding. Also, this chapter assumes that the
name of the panel is TERMS. If the TERMS panel is called something other than
TERMS, then the view must still be called TERMS.

For example, the TERMS panel might contain the following code and term:

Code: Term:

PYORRHEA PERIODONTITIS

In some coding thesauruses (such as COSTART), codes are alphanumeric. In
other coding thesauruses (such as WHOART), the codes are numeric.

The designer can set up a code to have from one to three parts. For example, the
WHOART dictionary contains two-part codes like 568.01.

What is the SYNONYMS panel?

The SYNONYMS panel contains synonyms of terms in the TERMS panel.
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Note: This chapter refers to the SYNONYMS panel. A view onto the
SYNONYMS panel, rather than the panel itself, is used during coding. Also, this
chapter assumes that the name of the panel is SYNONYMS. If the SYNONYMS
panel is called something other than SYNONYMS, then the view must still be
called SYNONYMS.

A row in the SYNONYMS panel corresponds to the associated row in the
TERMS panel, with the exception of the value of the term.

For example, the SYNONYMS panel might contain the following two synonyms
for the term PERIODONTITIS, which in the TERMS panel is associated with

the code PYORRHEA:

Code: Term:
PYORRHEA GUM DISEASE
PYORRHEA RECEDING GUMS

What is the STOPWORDS panel?

The STOPWORDS panel contains words that might commonly be part of
verbatim text, but that do not have medical meaning that must be preserved.
Examples are articles and prepositions, such as “the” or “she,” and words, such
as “subject” or “complained.”

Note: This chapter refers to the STOPWORDS panel, although a view onto the
STOPWORDS panel, instead of the panel itself, is used during coding. Also, this
chapter assumes that the panel name is STOPWORDS. If the STOPWORDS
panel is called something other than STOPWORDS, then the view must still be
called STOPWORDS.

The TERMS, SYNONYMS, and STOPWORDS panels exist in the thesaurus
protocol.

Coding-related items

The panel in the clinical data protocol that contains the verbatim text must also
contain the following items:

e An item to store the code

e A workflow item
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The designer may have set up a panel to include other optional coding- related
items, such as:

* The second and third part of a 3-part code.

* The number of matches found during automatic coding.
» The name of the user account that performed coding.

* The date that coding was performed.

» The confidence level, that is, the step of the thesaurus algorithm that resulted
in a code being assigned during automatic coding.

* An item to store normalized text. That is, the verbatim text at the point that
the thesaurus algorithm finishes; either by successfully coding, or by
completing all steps without successfully coding. This is only relevant to
automatic coding.

What is the workflow item?

Each item to be coded must have an associated workflow item, which identifies
the type of coding that was performed. When coding occurs, the workflow item
receives one of the following values:

¢  AUTO — If automatic coding was performed and was successful. If the
system parameter AUTOCODE SET FAIL is set to No and automatic
coding fails, then the workflow item receives the value AUTO.

*  FAIL — If the system parameter AUTOCODE_SET FAIL is set to Yes and
automatic coding fails, then the workflow item receives the value FAIL.

¢ INT — If interactive coding was performed and was successful.

What is the number of matches found?

Each item to be coded may have an associated item to store the number of
matches found during automatic coding. The system parameter
AUTO_FULL _CNT determines the value that will be stored for this item if
multiple matches are found:

« IfAUTO FULL CNT is set to Yes, then the actual number of matches found
is stored.

+ If AUTO_FULL CNT is set to No, then”>1" is stored as the number of
matches found.

Note: Automatic coding will be performed faster if this parameter is set to
No.

The number of matches found per item is only relevant to automatic coding.
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What is the confidence level?

Each item to be coded may have an associated item to store the confidence level,
which identifies the step number of the thesaurus algorithm that resulted in a
code being assigned. The confidence level item is only relevant to automatic
coding.

For more information, see "How the thesaurus algorithm works" on page 84.

Normalized Text

The text remaining after the thesaurus algorithm completes, either by
successfully coding or by unsuccessfully coding, will be stored in this item. The
normalized text item is only relevant to automatic coding.

Coding setup

To use interactive or automatic coding, you must set up the thesaurus protocol
and the clinical data protocol. You then batch load and prepare your thesaurus
data.

Setting up the thesaurus protocol

To set up the thesaurus protocol for use with the default thesaurus algorithm, you
must minimally perform the following tasks in Design:

1. Have the thesaurus data files available for batch loading, or be prepared to
define your own thesaurus data.

2. Create the thesaurus protocol.

3. Create three specialized Type 0 panels to receive the thesaurus data:
a. TERMS
b. SYNONYMS
c. STOPWORDS

Note: 1f you use a customized thesaurus algorithm, then it is not required
that you set up the TERMS, SYNONYMS, AND STOPWORDS panels.

4. Create specialized items within the panels:

a. TERMS:

Coding setup 81



— An item to store the code. You can create up to three items if the code
contains multiple parts.

— An item to store the term that is language-specific. You must create an
item to store the English term. The name of the item must contain the
string ENGLISH. You must create one item for each language that you
want to support, with the language string included in the item name.

b. SYNONYMS:

— An item to store the code. You can create more than one item if the code
contains multiple parts. The number of items, as well as the size and type
of the items, must correspond to the associated items and their sizes and
types in the TERMS panel.

— An item to store the synonym that is language-specific. You must create
an item to store the English synonym. The name of the item must contain
the string ENGLISH. You must create one item for each language that
you want to support, with the language string included in the item name.

c. STOPWORDS:

— An item to store the stopword that is language-specific. You must create
an item to store the English stopword. The name of the item must contain
the string ENGLISH. You must create one item for each language that
you want to support, with the language string included in the item name.

5. Create thesaurus languages for each national language that you want the
thesaurus to support.

6. Install the panels.
Create a thesaurus view for each panel:
a. TERMS
b. SYNONYMS
c. STOPWORDS

8. Optionally create a customized thesaurus algorithm.

For more information on setting up thesaurus protocols, see the Design section in
Admin and Design.

Setting up the clinical data protocol
To set up the clinical data protocol, you must perform the following steps in
Design:
1. Create the clinical data protocol.
2. Create panels and items.

3. Create three coding-related items of type TEXT for each item to be coded:
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c.
4. Optionally create an item for:
a.
b.
c.

d.

c.

f.

Set the thesaurus attribute on the code item defined in Step 3.

An item to store the verbatim text that will be coded.

An item to store the code that is sufficiently large enough to store the
largest expected code.

An item to store the workflow value.

The name of the user.

The date the item was coded.

The confidence level of coding.

The number of matches found by automatic coding.
The multiple parts of a code.

Normalized text.

6. Set up a coding target to associate items in the thesaurus protocol with the
coding-related items in the clinical data protocol.

a.

Indicate the thesaurus algorithm that you want to use, if you are not using
the default algorithm.

7. Install the panels.

For more information on setting up clinical data protocols, see the Design
section in Admin and Design.

Batch loading and preparing thesaurus data

When you have completed the necessary thesaurus protocol and clinical data
protocol setup, you can batch load and prepare your thesaurus data.

Oracle does not provide thesaurus data. You must obtain the raw thesaurus data
files from a regulatory authority or third-party vendor. You then batch load the
thesaurus data into the thesaurus protocol using Manage. You can also create
your own site-specific thesaurus data through interactive data entry using Enter.

Other coding setup checks

Additionally, you must ensure that the following conditions have been met for
automatic and interactive coding to function properly:

1. The thesaurus data must be in uppercase letters, unless you are using a
custom thesaurus algorithm without the Comprehensive Normalization
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option checked. In this case, interactive coding will be more difficult to
perform.

2. The thesaurus data must be screened, validated, and merged from the update
table to the data table. Only data in the DATA table is searched during
coding.

3. The verbatim text item field length in the clinical data protocol should be no
longer than the term item field length in the thesaurus protocol.

4. When the number of coded items does not match in the clinical data protocol
and the thesaurus protocol, the length of the field receiving the concatenated
data must be as long as the sum of the corresponding fields in the thesaurus
protocol.

5. The thesaurus attribute must be set on the codel item, and not the verbatim
text item.

For more information on batch loading, see Chapter 3.

Performing automatic coding

Automatic coding is the process by which the Clintrial software automatically
assigns codes to verbatim text.

When you run automatic coding, the Clintrial software tries to match the
verbatim text to terms (or synonyms) in the coding thesaurus:

* Ifone match is found, then the Clintrial software assigns the associated code.

+ If there are no matching terms (or synonyms), then no code is
assigned.
e If'there are multiple matching terms (or synonyms), then no code is

assigned because the Clintrial software does not know which code is the
most appropriate.

For records for which no matches or multiple matches are found, you may want
to perform interactive coding, or you may want to review the data, create an
appropriate synonym, and then run automatic coding again.

How the thesaurus algorithm works

During automatic coding, the Clintrial software uses a thesaurus algorithm to
determine the most appropriate code for the verbatim text. The Clintrial software
supplies a default thesaurus algorithm, as described in the Design section in
Admin and Design. You can also define a custom thesaurus algorithm to use.
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Before beginning to process data using the default thesaurus algorithm, the
Clintrial software converts the verbatim text to uppercase, discards extra spaces
between words, and discards punctuation (as identified for each language by the
designer). The seven steps of the default thesaurus algorithm are as follows:

Step Step
Number:  Description:

1 The Clintrial software looks in the TERMS panel for a term that is an
exact match to the verbatim text:

* If exactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and records the
confidence level as “1”. The algorithm ends.

* If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1" or the actual
number of matches, depending on the setting of the system
parameter AUTO_FULL CNT. The algorithm ends.

* If no match is found, then the Clintrial software goes to Step 2.

2 The Clintrial software looks in the SYNONYMS panel for a synonym
that is an exact match to the verbatim text:

* Ifexactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and returns the
confidence level as “2”. The algorithm ends.

» If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1” or the actual
number of matches, depending on the setting of the system
parameter AUTO_FULL CNT. The algorithm ends.

» Ifno match is found, then the Clintrial software goes to Step 3.

3 [The Clintrial software removes any word that is an exact match to a
stopword defined in the STOPWORDS panel from verbatim text,
creating a filtered text string. The Clintrial software also breaks up the
verbatim filtered text string into an array of words. The Clintrial software
goes to Step 4.
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Step Step
Number:  Description:

4 [The Clintrial software looks in the TERMS panel for a term that is an
lexact match to the filtered text string:

* If exactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and returns the
confidence level as “4”. The algorithm ends.

* If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1" or the actual
number of matches, depending on the setting of the system
parameter AUTO_FULL_CNT. The algorithm ends.

* Ifno match is found, then the Clintrial software goes to Step 5.

5 [The Clintrial software looks in the SYNONYMS panel for a synonym
that is an exact match to the filtered text string:

* Ifexactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and returns the
confidence level as “5”. The algorithm ends.

*  If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1" or the actual
number of matches, depending on the setting of the system
parameter AUTO_FULL CNT. The algorithm ends.

* If no match is found, then the Clintrial software goes to Step 6.

6 [The Clintrial software looks in the TERMS panel for a term that contains

leach word of the array in any order:

* If exactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and returns the
confidence level as “6”. The algorithm ends.

* If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1" or the actual
number of matches, depending on the setting of the system
parameter AUTO_FULL _CNT. The algorithm ends.

* Ifno matches are found, then the Clintrial software goes to Step 7.

INote: The term may contain additional words. However, the term must
contain all words in the verbatim text array.
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Step Step
Description:

Number:

7 [The Clintrial software looks in the SYNONYMS panel for a synonym
that contains every word in the array in any order:

If exactly one match is found, then the Clintrial software returns the
code, records the number of matches as “1”, and returns the
confidence level as “7”.

If multiple matches are found, then the Clintrial software returns no
code and records the number of matches as “>1" or the actual
number of matches, depending on the setting of the system

parameter AUTO_FULL_CNT.
If no matches are found, then the Clintrial software returns no code,
records the number of matches as “0”, and records the confidence

level as “8”.

What is recoding?

When an item has been successfully coded, its associated workflow item
contains the value AUTO or INT. You can recode the items for which the

workflow item is not Null. Recoding the item replaces the current code with a
different code. For example, suppose that an item was coded interactively to
have the code 568.01. If the item is recoded using automatic coding, then the

automatic coding process will assign a different code to the item if changes have
been made to data in the thesaurus. You could also recode the item using

interactive coding.

The following table shows whether an item is recoded during automatic coding,
based on a combination of the setting of the system parameter
AUTOCODE RECODE ALL and the setting of the Override Coding attribute
set up in Design for the protocol:

AUTOCODE_RECODE AUTOCODE_RECODE
_ALL=YES _ALL=NO
Workflow item Override Override Override Override
Coding=Y Coding=N Coding=Y Coding=N
AUTO Recode Recode Do not recode Do not recode
FAIL Recode Recode Do not recode Do not recode
INT Recode Do not recode Do not recode Do not recode
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How to begin

From the Manage menu, select Code >> Automatic. The Coding Selector
window opens:

[} Coding Selector H=]
Panels SOL Restriction
ADVERSE i
Language
Table(s] v Submit Batch
4
F zz[T):TE Submit at:  [1/5/33 120451
Submit every: [10 [ [Morths  [+]

You can perform automatic coding on a specific coding target in a panel, or on
all coding targets in a panel.

To perform coding on a specific coding target in a panel, select Selected Coded
Item for a Panel. You must then select a panel and coded item on which to
perform automatic coding. You can only select one coded item.

To perform automatic coding on all coding targets on a panel, select Panel. You
must then select the panels for which you want to automatically code data. Only
panels containing items set up for coding are available in the list. All items that
are set up for coding in each selected panel will be automatically coded.

Note: If a panel’s coding procedure in the clinical data protocol or any of the
necessary views for a panel in the thesaurus protocol is invalid, then the panel is
unavailable for selection in the window. This ensures that you do not attempt to
code items in a panel with an invalid coding setup.

Select the types of database tables for which you want to automatically code.
You can select the update table, the data table, or both.

How to restrict records

To restrict records based on a SQL restriction, click the SQL Restriction box. For
more information on restricting records, see the Reference Guide.
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How to select a language

If more than one language is available, then select the language in which you
want to code. When the Clintrial software searches the coding thesaurus,
matching terms are retrieved in the selected language.

How to specify the job type

You can perform automatic coding either interactively or as a batch job. If you
perform a task interactively, then you will not be able to use Manage for other
tasks until the current task is completed. For information about batch jobs, see
the Manage Help.

Automatic Coding Log

The Automatic Coding Log is a cumulative report that provides general
information about the number of records that were coded during automatic

coding.

From the Reports menu, select Coding Log >> View. The following table
describes the information in the Automatic Coding Log:

Report column:

Description:

Panel

Status

Remarks

Matches

Failures

Batch Id

Name of the panel in which records were automatically
coded.

NORMAL if automatic coding completed successfully;
ERROR if automatic coding did not complete
successfully.

COMPLETED if status is NORMAL; an error message if
status is ERROR.

Number of records in which items were coded.
Number of records for which matches were not found.

Oracle batch job queue ID, if the automatic coding was run
as a batch job.
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Report column: Description:

User Id User account that submitted or ran the automatic  coding.
Start Date and time that automatic coding began.

End Date and time that automatic coding completed.
Restriction SQL WHERE clause used to select records that was

built automatically from the specified selection criteria.

Table Type of database table (UPDATE or DATA) in which
automatic coding occurred.

The following example shows a portion of the Automatic Coding Log:

Panel Status Remarks Matches | Failures |Batch 1d| User Id Start End *|
A0V MORMaL 1 KIT 03/05/1993 04:15:34 PRO305./1993 04
A0 MORMAL 26 74 KIT 02/24/1333 01:01:37 PRO2/24,/1933 01
COMMED MORMAL KIT 02/25/1999 04:15:17 PRO2/25/19399 04
COMMED MORMaL & KIT 02/25/1993 04:14:20 PF02/25,/1933 04—
FRYMED MORMAL KIT 02/25/1393 04:15:21 PRO2/26./1933 04
PRVMED MORMAL 44 KIT 02/25/1999 04:14: 36 PRO2/25/19399 04
FRYMED MORMaL 44 KIT 02/25/1999 02:45:45 PR02/25/1993 02
T4l | »

How to work with the Automatic Coding Log

You can view the Automatic Coding Log, purge all entries from it, or purge
selected entries from it based on the following criteria:

* Panel name

* User account

* Type of database table (UPDATE or DATA)

» Status (NORMAL or ERROR)

* Range for the date and time that the automatic coding started

* Range for the date and time that the automatic coding completed

You can use the View menu to filter or sort a displayed Automatic ~ Coding
Log, and the File menu to save or print the log.
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Performing interactive coding

Interactive coding provides a means to search the coding thesaurus manually,
and then select an appropriate code for the verbatim text. You can use interactive
coding to:

* Assign codes to items that failed automatic coding.
* Change or clear codes that were previously assigned.

Note: Changing or clearing codes is dependent upon the protocol attribute
Override Coding. For more information on this attribute, see the Design
section in Admin and Design.

» Assign codes to items that have not yet been coded.

How to begin

From the Manage menu, select Code >> Interactive. The Coded Item Selector
dialog box opens:

# Coded Item Selector
S0OL Restriction
COMMED DRGCODE ’
COMMED INDCODET
MEDHIST CODE1_ART
PRYMED DRGCODE Language
FRENCH J

Table

@« UPDATE

" DATA

ok | camcel | soL.. | Heip |

Select the panel and item for which you want to code interactively. Only panels
containing items set up for coding are available in the list.

Note: If a panel’s coding procedure in the clinical data protocol or any of the
necessary views in the thesaurus protocol for a panel is invalid, then the panel is
unavailable for selection in the window. This ensures that you do not attempt to
code items in a panel with an invalid coding setup.

Select the type of database table for which you want to code interactively. You
can select either the update table or the data table.
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How to restrict records

To restrict records based on a SQL restriction, click the SQL Restriction box.
Your restriction will replace the restriction normally placed on the data selected

for interactive coding. For more information on restricting records, see the
Reference Guide.

If you do not use a restriction, only records that have failed the automatic coding
process will be displayed. That is, records with a NOT NULL workflow value
will be displayed.

How to select a language

If more than one language is available, then select the language in which you
want to code. When the Clintrial software searches the coding thesaurus,
matching terms are retrieved in the selected language.

How to continue

When you click OK in the Coded Item Selector dialog box, the Interactive
Coding window opens:

[#] Interactive Coding. MEDIKA_CLINICAL ADV_UPDATE [_[O]x
Filter: |I shulllady_update codel_art] or adv_update codel_art=" 1=
Adv Update | Adv Update Adv Update Adv Update All English Terms —
Subject Yisno Event Codel Art Term
MANTO EC) Abdomen swollen
HEL101 99 Abdomen swallen
ANATO 93 Abdomen swallen
ANATO 93 abnarmal
HEL101 93 abnarmal
4
Starts With LContains | Auto
Details... |
Accept |
< _>| Propagate LI

How to filter records

The Clintrial software automatically retrieves all records with a workflow value

from the database. You can view a subset of the selected records by using the
Filter field.
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In the Interactive Coding window, click the text in the Filter field. The Specify
Filter dialog box opens, where you can change or remove the default filter, or
add your own.

For more information on entering filters, see the Reference Guide.

How to select a record to code

The list of records includes all records for which the workflow item is AUTO,
FAIL, or INT. If the workflow item is Null, then the record is not included in the
list by default. To code items for which the workflow item is Null, you must
remove the default SQL restriction and implement your own filter.

When you select the record that you want to code, the verbatim text displays in
the search text field below the list. This is the text that the Clintrial software will
attempt to match.

How to select a matching method

There are three methods by which you can search the coding thesaurus. The
results of the search are listed below the search text field.

Button: Search method:

Starts With List terms and synonyms that begin with the search text.
Contains Lists terms and synonyms that contain the search text.

Auto Lists terms that would be found by the thesaurus algorithm that is

used for automatic coding. This search method is useful if more than
one match was found during automatic coding and you need to select
one appropriate term.

Note: 1f you are using a user-defined thesaurus, then the thesaurus data must be
in uppercase letters. If the data is in lowercase letters, then no matches will be
found when using the search methods.

When you click Starts With or Contains and you are using a customized
thesaurus algorithm, the preferred TERMS view is used to search the thesaurus.
You specify the preferred TERMS view in Design when you create a customized
thesaurus algorithm. You can set the preferred view to the TERMS or to the
SYNONYMS panel.
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If you are using the default algorithm, then the TERMS view is used to search
the thesaurus.

How to assign a code

Select a code and term from the list, then do one of the following:
* Click Details to get additional information on the code.

* Click Accept to accept the selected code. The associated code is assigned to
the verbatim text.

* Click Propagate to assign the selected code to all records that have the same
verbatim text as the selected record.

The list of records in the window is updated to reflect the selected code. When
you are satisfied with the code, from the File menu, select Save.

Using the Edit menu

The Edit menu becomes available when the Interactive Coding window opens.
The following table describes the Edit menu commands:

Command: Description:

Propose Code Enables you to propose a known code for verbatim text instead of
searching for a match on the term.

Clear Clears the coding target fields in the selected record.

Note: Changing or clearing codes is dependent upon the protocol
attribute Override Coding. For more information on this attribute, see
the Design section in Admin and Design.

Propagate Clear  Clears the coding target fields in all records that have the same
verbatim text as the selected record.
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Using the Propose Code command

Select one or more
search views. This field
provides a list of views
that are referenced in
the thesaurus
algorithm.

Enter a proposed code,
then click Search.

Select a code, then
click OK. The code
“ALOPECIA” is now
associated with the
verbatim text

“HAIR LOSS”.

The Propose Code dialog box allows you to propose a known code for the
verbatim text in the selected record. For example, to associate a specific code
with the verbatim text “hair loss”, from the Edit menu, select Propose Code.
The Propose Code for Item to be Coded dialog box opens:

m Propose Code for Item to be Coded [ %]
Th - BYREXEL_THES | Search View(s):
Algorithm:  [CTS$DEFAULT ] SYNOMYMS
L : [EMGLISH ]

Verbatim Term:  |has hair loss

Proposed Code: lALDF'E Cla

ALOPECIA HAIR LOSS

< | I

0K | Cancel | Help |

If you select more than one search view, then the time required to search for
possible matches will significantly increase. It is also possible that too many
matches will be found.

You can use multiple wildcards in the Proposed Code field to refine your search.
For example, if you enter ALOPECY%, the Clintrial software will find fewer
matches.

Note: 1f more than sixty matches are found, you are prompted to further refine
your search.

The code that you propose will only apply to the selected record in the
Interactive Coding window. Once the association is made, you can propagate the
change to other records by clicking Propagate in the Interactive Coding
window.
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Coding with MedDRA

The Clintrial software provides a means to use the Medical Dictionary for Drug
Regulatory Activities (MedDRA) during automatic and interactive coding.
MedDRA is a mixed-case, hierarchical thesaurus that contains terminology
applicable to all phases of drug development, and to the health effects of devices.
The MedDRA terminology categories include:

*  Symptoms
* Signs

* Diseases

* Diagnoses

* Therapeutic indications

* Investigations
» Surgical or medical procedures

* Medical, social, or family history characteristics

You perform automatic and interactive coding with MedDRA as you would
perform coding with any other thesaurus. Using Manage, you can perform
coding against the Preferred Terms (PT), or against the Lowest Level Terms
(LLT). You set up a thesaurus protocol and a clinical data protocol using the
steps on page 81 as you would for other industry-standard thesauruses.

What are the Preferred Terms?

The Preferred Terms (PT) are distinct descriptors for the MedDRA terminology
categories. PTs are hierarchically located above LLTs, and are used to group
together equivalent LLTs.

If you perform coding against the PT panel, then the Clintrial software searches
the PT panel, and then optionally the LLT panel for a matching term.

What are the Lowest Level Terms?

The Lowest Level Terms (LLT) are the lowest hierarchical level of terms in the
MedDRA dictionary. Each LLT is linked to only one PT that is its preferred
descriptor in the terminology.

If you perform coding against the LLT panel, then the Clintrial software searches
the LLT panel for a matching term.
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Other Hierarchy Levels

The following table describes the other MedDRA hierarchy levels:

Name: Full Name: Description:

HLT High Level Terms Used solely for data retrieval purposes.

HLGT  High Level Group Terms Used to group together HLTs, and for data
retrieval purposes.

SOC System Organ Class The highest level of the MedDRA hierarchy that
provides the broadest concept for data retrieval.

CT _MEDDRA protocol

The CT_MEDDRA protocol is a sample thesaurus protocol provided with the
Clintrial software that is specifically structured for the MedDRA dictionary.
CT_MEDDRA includes the following predefined objects:

* Panels

* Items

* Page sections

» Page templates

* Thesaurus views

* Thesaurus algorithms
* Derivations

* Translation functions
The protocol contains one panel for each MedDRA table.

CT_MEDDRA is intended as an example to assist you in setting up a thesaurus
protocol for MedDRA. CT _MEDDRA is set up to perform coding on panels in
the MEDIKA CLINICAL Sample Study. However, you can also use
CT_MEDDRA to perform coding on your own clinical data protocol.

Caution: If you choose to use CT_MEDDRA with your own clinical data
protocol, do not modify or delete panels or items. If you modify or delete panels
or items, the predefined Retrieve queries provided with the Clintrial software
will not function properly.
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To use CT_MEDDRA, you must first import the protocol, and ensure that you
name the protocol CT_MEDDRA. You then batch load the MedDRA dictionary
into the CT_MEDDRA protocol.

After you import CT_MEDDRA, you must execute scripts that create MedDRA
translation functions and indexes on CT _MEDDRA panels. For more
information on executing the scripts, see Getting Started.

For more information on importing the CT_MEDDRA protocol, see the Sample
Study section in Getting Started.

Note: Oracle does not supply the MedDRA dictionary. You must purchase the
most recent version of the MedDRA dictionary from a regulatory authority or
third-party vendor.

Batch loading MedDRA

Sample control files are provided with the Clintrial software to help you batch
load the MedDRA dictionary into CT_MEDDRA. You can also modify the
control files as necessary to batch load the MedDRA dictionary into your own
thesaurus protocol.

For more information on batch loading data, see Chapter 3.

MEDIKA CLINICAL protocol

You use the CT_MEDDRA protocol in conjunction with the
MEDIKA_CLINICAL Sample Study. You perform coding against the
ADV_LLT and ADV_PT panels in MEDIKA CLINICAL.

MEDIKA_ CLINICAL also includes several predefined queries to use with Ad
Hoc Query in Retrieve. By default, the PT and LLT terms are returned during
coding. The queries provide a means to derive additional terminology from the
other levels in the MedDRA dictionary without any additional setup or recoding.
The queries capture terms from the following hierarchical levels, as associated
with the PT and LLT returned during coding:

« HLT
« HLGT
+ SOC

For more information on the Retrieve queries, see the Retrieve section in Enter,
Resolve, and Retrieve.
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Coded Item Report

The Coded Item Report is a cumulative report that provides detailed information
about each item that was coded.

From the Reports menu, select Coded Items. Select the panel for which you
want to view coded items.

Select the type of database table for which you want to view coded items. You
can select the update table, the data table, or both.

If more than one language is available, then select the language in which you
want to view the report.

The following table describes the information in the Coded Item Report:

Report column:

Description:

Panel Name

Item Name

Subject Item

Block Item

Block Repeat Item

Page Item

Page Repeat Item

Encoded Item

Term Used

Confidence

Name of the panel containing the item.

Name of the item that contains the code (or the first part of a
multipart code); the value of this item is the Codel Item for
each entry.

Subject identifier of the record containing the item.
Block key value of the record containing the item.

Block repeat key value of the record containing the item.
Page key value of the record containing the item.

Page repeat key value of the record containing the item.
Verbatim text.

Search text; that is, the term that was used to search the
coding thesaurus. For automatic coding, this is the same as
the verbatim text. For interactive coding, this may or may
not be the same as the verbatim text.

In automatic coding, the step number of the thesaurus
algorithm that resulted in a code being assigned.

Coded Item Report 99



Report column: Description:

Codel Item Code for the first part of a multipart code.

Code2 Item Code for the second part of a multipart code. This is
optional.

Code3 Item Code for the third part of a multipart code. This is optional.

Workflow AUTO for automatic coding; INT for interactive  coding.

Coder Id User account that coded the item. This is optional.

Coding Date Date and time that coding was run. This is optional.

Note: The designer determines if the Code2, Code3, Coder Id, and Coding Date
items will have values on the report.

How to work with the Coded Item Report

You can review the Coded Item Report, print the report, and save the report to a
file.

The following example shows a Coded Item Report for records that have been
interactively coded in the ADV panel:

#: Coded Item Report M= B3

PANEL NAME: ADY ITEM NAME: CODE1_ART

Subject ltem:  ANAT01 Confidence:

Block Item: 9 Block Repeat Item: 2
Page Item: 27 Page Repeat Item:
Encoded Item: anoemia

Term Used:

Codel Item: AMNEMIA WorkFlow: INT
Code2 Item: 1 Coder Id: KIT

Code3 Item: Coding Date: 03/05/1933

=

You can use the View menu to filter or sort a displayed Coded Item Report, and
the File menu to save or print the report.
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Overview

Coding is the process of assigning a standard code from a coding dictionary to a
value that has been entered for an item as verbatim text. For example, a drug
could be assigned a standard code from the WHO-DD dictionary. If the verbatim
text entry for the drug a subject took to treat a headache during the study was
entered as “Tylenol”, then from the WHODD dictionary, it could be coded as
“002144.01.008”, with the Trade Name “Tylenol aches and strains medication”
and the Preferred Name “Parafon”.

Coding provides the following benefits to clinical data management:

» It standardizes the use of terminology describing information, such as
adverse events data, that is collected during clinical studies.

* It reduces the time and effort that is required to manually look up and select
terms in a coding dictionary.

The decision as to which coding utility will be used is made in the Admin and
Design modules, either as a system-wide parameter for all protocols, or on an
individual protocol basis using a protocol parameter.

The protocol designer determines which items will be coded. This is done in the
Clintrial Design module. Typical items to be coded are clinical events, drugs, or
diseases.

What is a coding dictionary?

A coding dictionary is a dictionary thesaurus that contains standard codes for a
particular type of clinical data. There are two types of dictionaries: industry-
standard and user-defined.

Contact Oracle for a list of supported dictionary versions.
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What is verbatim text?

The text entered by the user is referred to as verbatim text. The verbatim text is
the entered text for which you want to assign a standard code from a coding
dictionary. For example, the following verbatim text might be entered for
clinical events:

Clinical Event Onset Date End Date
Verbatim text | Pain in eye 3/1/09 3/6/09
Patient had rash 3/12/09 4/28/09

Why use coding dictionaries?

You use coding dictionaries to:

* Provide standardization for statistical analysis.

* Summarize terms by grouping verbatim terms into standardized terms.

» Create a standard language that is comparable across all therapeutic teams.

* Reduce the time needed to reach a final format, which leads to faster
regulatory approval.

Which coding utility should I use?

In order to match clinical data (verbatim text) against standard dictionary codes,
you may either:

* Use Clintrial Manage module, and optionally, the Clintrial Classify extended
module, or

* Use the Oracle Central Coding application.

The decision to use either approach may be made on a protocol basis. For
example, existing protocols may continue to use the Manage and the Classify
modules for coding, while new protocols may use the Central Coding
application. Of course, existing protocols may be updated to use the Central
Coding application if you want to use it as a standard within your organization.

The Central Coding application is a web-based application that integrates with
both the Oracle InForm application and the Oracle Clintrial application to
provide centralized coding for studies within an organization.
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Because the Central Coding software works independently from the Clintrial and
InForm software, you can have parallel work paths for the clinical study teams.
As a result, coding can happen earlier in the study cycle, providing valuable data
visibility for study managers who review and assess study safety concerns.

When you use the Central Coding software for coding, you are not limited to
three-part coding as you are with the Clintrial software.

Note: The instructions contained in this chapter for setting up the Clintrial
application to send coding requests to Central Coding assume that all Central
Coding tasks have been performed to support Clintrial, and that the Clintrial
Design module has been setup to identify which protocols, panels and target
items should be coded using the Central Coding application.

For information on Central Coding setup, see the Central Coding User Guide.
For more information on setting up Clintrial’s Design module to use the Oracle
Central Coding application, see the Clintrial Admin and Design guide.

Types of dictionaries

You can obtain the raw dictionary data files for the Central Coding application
from a regulatory authority or third-party vendor. The Clintrial software provides
a means to use industry-standard dictionaries, such as:

»  World Health Organization Drug Dictionary (WHO-DD)

*  World Health Organization Drug Dictionary C Format (WHO-DD C) (which
may be used to autocode a Preferred Term or Trade Name)

* Coding Symbols for a Thesaurus of Adverse Reaction Terminology

(COSTART)

* Medical Dictionary for Drug Regulatory Activities (MedDRA and
MedDRAJ)

» Data File for Ethical Drugs (Coding Table) from Iyaku-Joho-Kenkyujo, Inc.
(JDrug)

The Central Coding software also provides a means to use custom dictionaries.

How automatic coding relates to interactive coding

At data entry, the data-entry operator enters the verbatim text for the item to be
coded. Central Coding provides two methods of determining the correct code for
an entered item that has been set up as a coded item:
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* Automatic coding

If a single match is found on the verbatim text using the specified coding
algorithm, the Central Coding software selects a code for the verbatim text
item to be coded. The Central Coding software supplies a default coding
algorithm, or you can create your own customized coding algorithms.

* Interactive coding

In Central Coding, the data manager selects a code from a scrolling list of
similar matching terms, each of which has an associated code.

The Clintrial data manager sets up which panel items will be coded by specific
Central Coding dictionaries in the Design module, and actually sends them to
Central Coding using the Manage module. The requests may be batch loaded or
sent immediately to be coded in Central Coding. Depending on how the Central
Coding application is setup, the items will be designated for Automatic Coding
first if possible. The uncoded verbatims are then reviewed and coded via
interactive coding, also in Central Coding.

For more information on automatic and interactive coding, see
the Central Coding Users Guide.

Performing coding in Central Coding

Automatic coding is the process by which the Oracle Central Coding software
automatically assigns codes to verbatim text. All actual coding is performed in
the Central Coding application.

When you run automatic coding, the Central Coding software tries to match the
verbatim text to terms (or synonyms) in the coding dictionary:

» If one match is found, then the Central Coding software assigns the
associated code.

» If there are no matching terms (or synonyms), then no code is assigned.

+ Ifthere are multiple matching terms (or synonyms), then no code is assigned
because the Central Coding software does not know which code is the most
appropriate.

For records for which no matches or multiple matches are found, you may want
to perform interactive coding in the Central Coding software, or you may want to
review the data, create an appropriate synonym, and then run automatic coding
again.

For more information on automatic coding as performed by the Central Coding
application, see the Central Coding User Guide.
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Using Clintrial Manage to send Coding requests to Central

Coding

Steps in setting up Clintrial to work with Central Coding

To set up the Clintrial software to use a Central Coding dictionary, you must do
the following:

1.

10.

Ensure network or Internet access to the Central Coding Server. (See the
Clintrial Getting Started guide for more information.)

Configure the CC_HOST parameter with the HTTP address of the Central
Coding interface. This may be set in Admin as a System or Protocol
parameter. (See "Design system parameters" in Chapter 5 of the Clintrial
Admin & Design manual.)

Set the parameter USE_ CENTRAL CODING to Yes for the target protocol.
This may be set in Admin as a System or protocol parameter.

Create a dictionary definition. (See “Setting up a dictionary in Clintrial for
use with Central Coding” in Chapter 5 of the Clintrial Admin & Design
manual.)

Define labels for the dictionary definition. (See "Setting up Label Types and
Label Names in Clintrial Central Coding Dictionaries" in Chapter 5 of the
Clintrial Admin & Design manual.)

Select a dictionary definition for an item in a panel. See "Select a dictionary
definition for an item in a panel" in Chapter 5 of the Clintrial Admin &
Design manual.)

Create a Central Coding encoding target. See "How to create a Central
Coding Encoding Target" in Chapter 5 of the Clintrial Admin & Design
manual.)

Map the target items with the defined labels. (See "Mapping a defined label
with a Coding target" in Chapter 5 of the Clintrial Admin & Design manual.)

Use the Manage module to send coding requests to Central Coding. (This
chapter.)

Check the Automatic Coding Log to see the status of the Coding requests
sent to Central Coding. (This chapter.)
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Using Manage to send Coding requests to Central Coding

When setup is complete in the Central Coding application, and you have
completed the necessary dictionary and encoding target setup in the Design
module, you can either send the requests for coding to the Central Coding
application immediately, or batch load the coding requests.

Either way, the actual coding is performed in the Central Coding application, and
the Clintrial application simply sends the requests, asks the Central Coding
application for requests that have been coded, and receives the data back after
the coding is performed. If you send the coding requests immediately, the
Manage module will not perform other functions until all the requests are sent.

The items that need to be coded are sent to Central Coding using the Manage
Coding Selector dialog box.

Central Coding performs the coding requests, then loads the dictionary data into
its own database. The data is sent back to Manage when Clintrial sends a
request to Central Coding to send back coded verbatims. Replies with coding
information are saved in Clintrial’s protocol database.

Verbatims to be coded in the Central Coding application are contained within
requests; one verbatim per request. When the Central Coding application
receives a coding request from the Clintrial Manage module, the assignment
rules determine whether the request is to be automatically or interactively coded,
and which coding dictionary to use.

Note: All communication between the Clintrial application and the Central
Coding application is initiated from the Clintrial application.

To autocode the request, the Central Coding application attempts to find an
unambiguous response using a predefined set of steps in a coding algorithm. If
autocoding succeeds, the Central Coding application stores the information in
the Central Coding database. When a new coding request is received from the
Clintrial application, Central Coding returns the coded information to the
Clintrial application. If autocoding fails, a coder must interactively code the
request, and nothing is sent to Clintrial until interactive coding is successful.

An administrator can configure the Central Coding application so that
successfully autocoded requests can be automatically approved, or so that all
requests require manual approval by an approver. An administrator can also
configure the application so that autocoding results require review by a coder.

When interactive coding is successful, the application stores the configured
elements from the dictionary. An administrator can configure the Central Coding
application so that, like autocoded requests, interactively coded requests can be
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automatically approved or so that they require manual approval by an approver.
Approvers may approve or disapprove a coding request, or indicate that more
information is required to code the request.

As coding requests move through the steps in the Central Coding workflow, their
status is tracked and automatically updated to reflect their state of completion.

After a coding request is successfully coded and approved, it is available for
delivery to the Clintrial application. The Central Coding job queue forwards it to
Clintrial when Clintrial asks for requests that are ready for delivery. This
happens when the Receive Responses checkbox is checked on the Coding
Selector window.

When a response is received from Central Coding, the Clintrial data is updated
with the information sent. When responses are received, the following special
cases apply:

+ If the verbatim text has changed or the values of any associated items have
changed since the request was made, the response is ignored and a new
request with the new text is sent the next time requests are sent, if necessary.

» Ifthe Clintrial record was deleted, a request is sent to Central Coding to
delete the corresponding coding request.

» If a second response for the same record is received, the new values
overwrite the previous ones.

» Ifyou are using Multisite Replication, and the ownership of the record has
changed since the request was sent, the request cannot be processed.

*  When using Global Delete, if requests have been sent to Central Coding, but
responses have not yet been received, requests are sent to Central Coding to
delete the corresponding coding request.

Note: When problems arise at the Central Coding server (for example, running
out of tablespace in the database), the Automatic Coding log in Clintrial may
return a non-specific message for the failure. If unexpected errors occur while
the Central Coding jobs are running, you should check the Central Coding server
Event Viewer for application-specific problems, or consult the Database Analyst
(DBA) responsible for the Central Coding server.
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How to begin

From the Manage menu, select Code > Automatic. The Coding Selector
window opens:

{#: Coding Selector

Select targets from a

" selected Coded Item for a Panel

Panel SOL Restriction

[V Submit Batch

Table(s) T
¥ UPDATE Submitat:  [/5/2009 15:43:17
[ pata Submit every: fi0 = [Marths -

[ Receive Responses

How to select coding targets

You may designate a specific coding target in a panel, or all coding targets in a
panel for coding by Central Coding. The coding targets displayed will only be
those defined in Design for Central Coding.

To designate a specific coding target in a panel, choose Selected Coded Item
for a Panel. You must then select a panel and an item for coding. You can only
select one coded item and it must have been set up for Central Coding in Design.

To designate all coding targets on a panel, select Panel. You must then select the
panels for which you want to have Central Coding code data. Only panels
containing items set up for Central Coding in Design are available in the list. All
items that are set up for coding in each selected panel will be sent to Central
Coding for coding.

Note: 1f a panel’s coding procedure in the clinical data protocol is invalid, then
the panel is unavailable for selection in the window. This ensures that you do not
attempt to code items in a panel with an invalid coding setup.
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How to specify the types of database tables to update

Select the types of database tables for which you want to send requests. You can
select the UPDATE table, the DATA table, or both.

How to receive responses from Central Coding after
targets are coded

Select the Receive Responses checkbox to receive coding responses. The
responses may update the UPDATE table, the DATA table, or both.

How to restrict records

To restrict records based on a SQL restriction, click the SQL Restriction box.
Your restriction will replace the restriction normally placed on the data. For more
information on restricting records, see the Reference Guide.

If you do not use a restriction, then coding requests will be sent for all records
with a value for the verbatim text, but which have not yet been coded (Workflow
value is null).

Note: The restriction applies only to new requests. Any available responses will
be processed.

For more information on restricting records, see the Clintrial Reference Guide.

Note: When you export then import a protocol where requests have been sent to
Central Coding, but not yet received back (workflow item values are SENT) the
verbatims will not be coded in the imported protocol. To send requests for the
imported protocol, set the protocol parameter AUTOCODE RECODE_ALL to
YES. To avoid recoding items that were coded previously in the exported
protocol set the coding SQL restriction to <workflow_item>='SENT".

How to specify the job type

The coding requests may be batch loaded or sent immediately to be coded in
Central Coding. Check the box Submit Batch to have the coding requests sent to
Central coding as a batch job. If you send the coding requests immediately, the
Manage module will not perform other functions until all the requests are sent.

For more information about batch jobs, see the Manage Help.
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Automatic Coding Log

The Automatic Coding Log is a cumulative report that provides general
information about the number of records that were sent to Central Coding to be

coded.

From the Reports menu, select Coding Log > View. The following table
describes the information in the Automatic Coding Log:

Report column:

Description:

Panel

Status

Remarks

Received

Sent

Batch Id

User Id

Start

End

Restriction

Table

Name of the panel in which records were automatically
coded.

NORMAL if automatic coding completed successfully;
ERROR if automatic coding did not complete
successfully.

COMPLETED if status is NORMAL; an error message if
status is ERROR.

Number of responses delivered from Central Coding.
Number of new requests sent to Central Coding.

Oracle batch job queue ID, if the automatic coding was run
as a batch job.

User account that submitted or ran the automatic coding.
Date and Time the batch job began.
Date and Time the batch job ended.

SQL WHERE clause used to select records that was built
automatically from the specified selection criteria.

Type of database table (UPDATE or DATA) for which
requests were sent. This column may also show RECYV,
which indicates that responses have been received from
Central Coding.
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The following example shows a portion of the Automatic Coding Log:

.

Panel Status Remarks Received Sent BatchId UserId Start End
ADY_LLT MORMAL 3 o 81CTSYS 10/02/2008 03:44 PM 10/02/2008 03:44 PM
ADY_LLT MORMAL 1] 5 TRCTSYS 10022008 03:33 PM  10/02/2005 03:35 PM
DRGCODE_ALL MORMAL 3 o S0CTSYS 10/02/2008 03:44 PM - 10/02/2008 03:44 PM
DRGCODE_ALL MORMAL 0 3 TTCTEYS 10022008 03:33 PM  10/02/2008 03:35 PM
DRGDATA MORMAL o o TACTENS 10/02/2008 03:44 PM 10/02/2008 03:44 PM
DRGDATA MORMAL 1] 0 TECTSYS 10022008 03:33 PM  10/02/2005 03:35 PM
| Kl

How to work with the Automatic Coding Log

You can view the Automatic Coding Log, purge all entries from it, or purge
selected entries from it based on the following criteria:

¢ Panel name
¢ User account

* Type of database table (UPDATE or DATA) or RECYV, indicating responses
received from Central Coding.

» Status (NORMAL or ERROR)
* Range for the date and time that records were sent to Central Coding.

* Range for the date and time that records were received from Central Coding.

You can use the View menu to filter or sort a displayed Automatic Coding Log,
and the File menu to save or print the log.

Note: Regardless of which table you chose in the Coding Selector window (the
Update table, the Data table, or both), the Coding Log will list which table was
actually updated with the coded forms.

Note: When problems arise at the Central Coding server (for example, running
out of tablespace in the database), the Automatic Coding log in Clintrial may
return a non-speciifc message for the failure. If unexpected errors occur while
the Central Coding jobs are running, you should check the Central Coding server
Event Viewer for application-specific problems, or consult the Database Analyst
(DBA) resposible for the Central Coding server.
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What is recoding?

When an item has been successfully coded, its associated workflow item
contains the value CODED. You can recode the items for which the workflow
item is not Null. Recoding the item replaces the current code with a different
code. For example, suppose that an item was coded interactively to have the
code 568.01. If the item is recoded using automatic coding, then the automatic
coding process will assign a different code to the item if changes have been made
to data in the thesaurus. You could also recode the item using interactive coding.

The following table shows whether an item is recoded during automatic coding,
based on a combination of the setting of the system parameter

AUTOCODE RECODE_ALL and the setting of the Override Coding attribute
set up in Design for the protocol:

AUTOCODE_RECODE AUTOCODE_RECODE
_ALL=YES _ALL=NO
Workflow item Override Override Override Override
Coding=Y Coding=N Coding=Y Coding=N
SENT Recode Recode Do not recode Do not recode
CODED Recode Recode Do not recode Do not recode

Note: Oracle recommends that if you are planning to use Central Coding on
existing protocols which were formerly setup to use Clintrial coding, before you
export a protocol for import after upgrading, you set the protocol parameter
AUTOCODE _RECODE_ALL to No.

The original reason for allowing AUTOCODE RECODE ALL was to allow
you to recode everything if the coding dictionary underwent updates or changes.
With Central Coding, that is no longer necessary, because if the Dictionary used
by Central Coding changes, it will detect which requests need to be recoded, and
perform the work on only those requests. To see the impact of an update to a
dictionary, you may choose run an Impact Analysis in Central Coding.

For more information about importing protocols into Clintrial when
AUTOCODE_RECODE_ALL is set to Yes, see the Clintrial Getting Started
guide.
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Overview

Validation is a process that performs the following:
* Calculates any derived items set up by the designer.

* Cleans clinical data by applying the logic and consistency rules that were set
up by the designer.

You can validate records in the update table or in the data table. You must
validate records in the update table before you can merge them from the update
table to the data table.

You can validate records in more than one panel at a time.
Note: Depending on the setting of the system parameter ALLOW-

_MERGE_TO_VALIDATE, you may validate records as part of the merge
process, which is described in Chapter 8.

What is a validation procedure?

During validation, the Clintrial software applies to data the validation procedure
attached to the panel. A validation procedure is a PL/SQL procedure that is built
automatically from derivations and rules associated with a panel. There is one
validation procedure for each panel.

What is a derivation?

A

A derivation is a PL/SQL statement or series of statements that calculates the
value of an item or a temporary variable during validation. For example, a
derivation might calculate the AGE item from the BIRTH DATE and
CONSENT _ DATE items.

Caution: Data-entry checks (for example, checks against upper and lower
bounds) are not applied to derived values.

When a derived value is stored in the database, the change may be reflected in
the Audit Report, depending on the setting of the audit start point.
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What is a rule?

A rule is part of a PL/SQL statement that evaluates to True or False. For
example, a rule might be “DOSAGE is not Null and DRUGNAME is not Null.”
If the DOSAGE item is not Null, and DRUGNAME item is not Null, then the
rule evaluates to True.

Each rule has an associated rule action:

» If a rule with the rule action REPORT evaluates to False, then the record is
considered to have passed the rule, and the record passes validation.
However, the evaluation of the rule to False generates an entry in the Error
Log. The use of rules with the rule action REPORT is intended for rules that
are significant, but that are not crucial to data cleaning.

e If arule with the rule action REJECT evaluates to False, then the record is
considered to have failed the rule. The failed rule generates an entry in the
Error Log, and the record fails validation.

Passing or failing validation

A record can pass or fail validation:
* A record passes validation only if it passes all rules attached to the panel.

* A record fails validation if it fails one or more rules attached to the panel.

Note: Records that fail a rule with the rule action REPORT are considered to
have passed the rule.

How flags and rules work

If a flag is attached to a rule, then the following occurs during validation
(regardless of whether the rule action is REPORT or REJECT, and regardless of
whether the record is released for merge):

‘When one or more
rules evaluate to: Result:

TRUE The flag associated with the rule is removed, if it was already
attached to the record.

FALSE The flag associated with the rule is automatically attached to the
record. The text in the rule message (in Design) is used as the
flag comment.
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Validating data

The eligibility of update table records for validation depends on whether
verification (reentry of data) is required for the panel:

+ Ifa panel has been set up to require verification, then only records with the
status Verified (1), Validated (0), or Validation Error (-1) are available for
validation.

« Ifa panel does not require verification, then records with the status
Unverified (2), Verified (1), Validated (0), or Validation Error (-1) are
available for validation.

Note: 1f you do not release records for merge, then you can also validate records
with the status Verification Error (-2). For more information, see "How to release
records for merge" on page 123.

All data table records are available for validation, since all data table records
have the status Validated (0).

Note: You can validate records as many times as necessary. For example, if you
have validated records and then the designer changes the rules and derivations
attached to a panel, then you must validate the records again.

Effect on the record status

When an update table record is validated and released for merge:
» If the record passes validation, then its status becomes Validated (0).

» If'the record fails validation, then its status becomes Validation Error (-1).

If a record in the update table passes or fails validation but has not been released
for merge, then its status does not change.

If a record in the data table passes or fails validation, then its status remains
Validated (0).
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The following figure shows changes in record status as a result of
validation of records in the update table:

Update Table

Verified (1) or
Unverified (2)*

Record Record Fails Vdidation
Fasses
Vdiddion

Validated (0) Validation Error (-1)

* An Unverified record can be validated only if the panel is not set up in Design
to require verification.

The following figure shows how the record status does not change as a result of
validation of records in the data table:

Data Table
or Fals
Validation
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How to begin

From the Manage menu, select Validate. The Validation window opens:

Panels eem— | REstrict Data |
A0V : ) B
COMMED Date and Time Range Flags
DM From:- l— CDR DOWNLDAD ﬂ
g:gém : COR UNSPECIFIED
EMROLL To: | CLASSIFY REQUEST
ERXCLUS Notes
INCLUS Status
INVESTIGATORS INVESTIGATOR UNSPECIFIED
INTASM  Enor SPONSOR DATA_ENTRY
INTSUM SPONSOR UNSPECIFIED
L&E " Walid
L&E_NORMS : i
MEDHIST  Verified SQL Restriction
NELIROL &
PLYESM All of the above
PRVYMED
SIGNATURE
TERMIMATION
VITAL Table(s)

¥ UPDATE ¥ Release for Merge [¥ Submit Batch

DATA
L Submit at: |03!1 241933142810

Submit every: IUD E
=]

The system parameter and user preference SELECT _BY PAGE determines
whether records are selected by panel or by page for validation. The default
setting of the parameter is No, where records are selected by panel. To change
the user preference, from the File menu, select Preferences. Set the preference
to either Yes or No.

If the user preference SELECT BY PAGE is set to No, then the Validation
window lists all panels in the current protocol. Select the panels for which you
want to validate data. To select all panels, from the Edit menu, select Select
Panels >> All The order in which data in the selected panels is validated is
determined by the designer in Design.

Caution: Do not validate the Resolve panels:
*  VCT_ERRORSTATUS UPDATE
* VCT_ERRORITEM UPDATE

Resolve only uses the update tables. Validating and merging these panels will
make Resolve discrepancies unavailable.

Select the types of database tables for which you want to validate data. You can
select the update table, the data table, or both types of database tables.
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Note: You can validate the records in an observation either individually or as a
group. However, all records in an observation are merged at the same time. If the
merge fails for one record in the observation, then the merge fails for all records
in the observation. Thus, all records in an observation must pass validation
before you can merge the records in the observation.

Validation by study page

If the SELECT BY PAGE user preference is set to Yes, then the Validation

window lists all study pages in the selected page list for the current study book,
as shown in the following example:

(. Validation |_[Of =
Page List . Restrict Data —
ALL | [
I 1] Date and Time Range Flags
& All pages
" Selected pages From: l COR DOWHLOAD il

CDR UMSPECIFIED
- To: | CLASSIFY REQUEST
Notes
Status INVESTIGATOR: LNSPECIFIED
 Emor SPOMSOR DATA_ENTRY
 Valid SPOMSOR UMSPECIFIED
 Verified 50L Restriction
@ All of the above

Tablels)
¥ UPDATE ¥ Release for Merge ¥ Submit Batch

DATA
i Submit at: 0312999 14:31.37

You can then:

» Click All pages to validate records on all pages that appear in the list.

* Click Selected pages and select specific pages with records to be validated.

Note: The Validation window only specifies which records are selected for
validation, and does not guarantee that all records on a page are validated as a
group.

Using Page Lists

If the SELECT BY_ PAGE user preference is set to Yes, then the List menu
commands become available. You can use the List menu commands to create,

edit, or delete a page list. You can then select a page list from the Page List drop-
down list.
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Page lists are used in Manage and Enter. Therefore, any changes that you make
to a page list in Manage also affect Enter.

Note: In Manage, you cannot work with subject lists, as you can in Enter. You
can only work with page lists.

For more information on page lists, see the Manage Help.

How to restrict records

You can optionally restrict records based on:
* Date and time.
+ Flags and notes.

e A SQL restriction. Click the SQL Restriction box, or, from the Edit menu,
select SQL Restriction.

¢ Record status.

Note: You can clear the restrictions you set. From the Edit menu, select Clear
Restrictions.

For information on restricting records based on date and time, flags and notes, or
a SQL restriction, see the Reference Guide or the Manage Help.

To restrict records based on record status, click one of the following:

If you click: The validation includes:

Error Records with the status Validation Error (-1).

Valid Records with the status Validated (0).

Verified Records with the status Verified (1); if verification is not
required, also records with the status Unverified (2).

Failed verify Records with the status Verification Error (-2).

This command is only available if you do not check
Release for Merge.

All of the above Records with the status -1, 0, 1, and 2. If you do not check
Release for Merge, then this option also includes records
with the status Verification Error

(-2).
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How to release records for merge

The Release for Merge check box applies to records in the update table.

If you check Release for Merge, the status of records that pass validation
changes to Validated (0), and the records are eligible for merging.

If you clear Release for Merge, the status of records that pass validation does not
change, and the records are not eligible for merging. Before releasing records for
merge, you can ensure that all the records will pass validation. To do so:

Clear Release for Merge and validate the records.
Review the Error Log to determine which records failed validation.
Edit the records that failed validation.

Validate records again, with Release for Merge still cleared.

A

When all records pass validation, check Release for Merge and  validate the
records.

The Release for Merge option enables you to review the results of validation
before you release the records for merge.

How to specify the job type

You can perform validation either interactively or as a batch job. If you perform
validation as a batch job, you may not be able to use your computer for other
tasks until the batch job is completed. For more information on batch jobs, see
the Manage Help.

How to begin

To begin validation by panel or by page, from the File menu, select Run.

How errors appear in the Error Log

When a rule with the rule action REPORT evaluates to False during validation, it
is recorded as an entry in the Error Log with the error type VALIDATE and the
Error Action REPORT.
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When a rule with the rule action REJECT evaluates to False during validation, it
is recorded as an entry in the Error Log with the error type VALIDATE and the
Error Action REJECT.

For information about the Error Log, see Chapter 9.

Summary of statuses and derived values

The following table summarizes how record statuses and derived values behave
during validation:

If the record is: and it passes validation: or it fails validation:

(that is, passes all rules) (that is, fails one or more rules)
In the update table, not *  The record status does not +  The record status does not change.
released for merge change. * Derived values are stored.

e Derived values are stored.

In the update table, *  The record status becomes *  The record status becomes Validation Error
released for merge Validated (0). (-1).
* Derived values are stored. * Derived values are stored.
In the data table *  The record status does not +  The record status does not change.
change. * Derived values are not stored.

e Derived values are stored.

Validation Log

The Validation Log is a camulative log of validation results. There is one
Validation Log for each protocol.

From the Reports menu, select Validation Log >> View. The following table
describes the information in the Validation Log:

Report column: Description:
Panel Name of the panel in which records were validated.
Table Type of database table (UPDATE or DATA) in which

records were validated.
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Report column:

Description:

Status

Remarks

Selected

Reported

Rejected

Batch Id

User Id

Start

End

Restriction

NORMAL if the validation completed successfully;
ERROR if the validation did not complete successfully.

COMPLETED if the validation completed successfully; an
error message if the validation did not complete
successfully.

Number of records for which validation was attempted.

Number of rules with the rule action REPORT that
evaluated to False.

Number of rules with the rule action REJECT that evaluated
to False.

Oracle batch job queue ID, if the validation was submitted
as a batch job.

User account that validated records.
Date and time that the validation began.
Date and time that the validation completed.

SQL WHERE clause used to select records.
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The following example shows a portion of a Validation Log:

\#: Yahidation Log M [=] E3
Panel Table | Status Remarks Selected | Reported | Rejected Batch Id| User Id 1=
COMMED UPDATE |NORMAL 1 KIT 0341
DMG UPDATE |NORMAL 2 681|kIT 0340
INCLUS UPDATE |NORMAL 1 kIT 03../[_
DG UPDATE |NORMAL 1 1 KIT 030
DG UPDATE |NORMAL 1 KIT 030
DMG UPDATE |NORMAL KIT 030
DMG UPDATE [NORMAL 1 KIT 0370
DMG UPDATE [NORMAL 1 KIT 0370
DG UPDATE [ERROR  |DRA-0B508: PLASOL: could not find kIT 03/C
program unit being called
ADY UPDATE |NORMAL 7 BE1|KIT 030
ADY UPDATE [ERROR  |DRA-0B508: PLASOL: could not find KIT 030
program unit being called
ADY UPDATE [ERROR  |DRA-OB508: PLASEL: could not find KIT 030
program unit being called
DMG UPDATE [ERROR  |0RA-OB508: PLASEAL: could not find KIT 0340
program unit being called =
{7 IO TE FARAR B0 AR, O A et n n n o mﬂ_l

How to work with the Validation Log

You can view the Validation Log, purge all entries from it, or purge selected
entries from it based on the following criteria:

* Panel name

» User account

* Type of database table (UPDATE or DATA)

« Status (NORMAL or ERROR)

* Range for the date and time that the validation began

* Range for the date and time that the validation completed

You can use the View menu to filter or sort a displayed Validation Log, and the
File menu to save or print the log.

Automatic revalidation

When a record that previously underwent the validation process is changed, the
Clintrial software automatically revalidates the record. A record has previously
undergone the validation process if it has the status Validated (0) or Validation
Error (-1). As with the initial validation, a record can pass or fail automatic
revalidation.
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If a record in the update table fails revalidation, then you can save the changes.
As with the initial validation, the evaluation of a rule to False during revalidation
generates an entry in the Error Log. If a record in the data table fails revalidation,
then you cannot save the changes.

As with the initial validation, the Clintrial software may calculate and store
derived values as a result of revalidation, and the Clintrial software may attach
flags to data or remove flags from data.

How revalidation works

The following table describes how revalidation works. Derived values are stored
as a result of revalidation except for data table records that fail revalidation.

If the record is in And the status is:  During automatic revalidation:
the:
Update table Validated (0) If the record passes revalidation, then

the change is saved and the record
status remains 0.

If the record fails revalidation, then the
change is saved, and the record status
changes to -1.

Update table Validation error (-  If the record passes revalidation, then
1) the change is saved and the record
status changes to 0.

If the record fails revalidation, then the
change is saved and the record status
remains -1.

Data table Validated (0) If the record passes validation, then
the change is saved and the record
status remains 0.

If the record fails revalidation, then the
change is not saved, and the record
status remains 0.
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Overview

Global change is the process of changing the value of one or more items in
multiple records. Once you have specified a global change, you can preview the
changes to records before modifying the records.

What is global deletion?

Global deletion is the process of deleting multiple records. Once you have
specified a global deletion, you can preview the effects of the deletions before
actually deleting the records.

& Caution: You can delete all of a subject’s records, including those in the
enrollment panel, through global deletion.

Enrollment data

The only way to change or to delete data in the data table for the enrollment
panel is to perform a global change or global deletion.

& Caution: The changes that you make to enrollment data can affect records in
multiple panels. For example, if you change the subject item, then records in all
panels will be changed to have the new subject item value.

Globally changing or deleting data

All records, regardless of status, are available for global change or  deletion.

Effect on the record status

The record status does not change as a result of global change or deletion, except
as a result of revalidation as described in "Revalidation" on page 136.
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How to begin

From the Manage menu, select Global Change or Global Delete. The Select
dialog box opens:

. Select [x]

Panel
4DV »1 Record per Patient Visit 4
COWNMED »1 Record per Patient Vigit
DMG 1 Record per Patient
DRGADM »1 Record per Patient izt
DRGCMP 1 Record per Patient Wisit
ENROLL Subiject Enrollment j
Table(s])

[ UPDATE

" DATA

1] & I Cancel | Help |

Select the panels in which to make the global change or deletion.

Global change restrictions

If you are making a global change, then you must consider the following
restrictions:

* To change Type 0 panel data, you must select only the Type 0 panel.

* To change any subject-type context items, with the exception of the subject
item, you must select only the enrollment panel.

» To change the subject item value you can either select the enrollment panel
(then the change propagates to every Type 1-4 panel) or you can select Type
1-4 panel.

Note: If possible, the subject item value should be changed in the enrollment
panel to preserve the audit history. If subject item is changed for Type 1-4
panel, the software deletes the record and inserts a new one with a different
ct recid. As a result the audit trail of the newly created record does not
contain the audit history of the original record.

» To change other context item values, select all panels that you want to
change, excluding the enrollment panel and any Type 0 panels.

* To change Type 1-4 panel data, you can select the panels individually or in
groups. If you select the panels individually, then all nonsystem items in the
panel will be listed, with the exception of subject-related context items. If

you select the panels in groups, then all non-subject type context items will
be listed.

Note: You cannot directly change any derived item values.
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Global deletion restrictions

If you are making a global deletion, then you must consider the following
restrictions:

* To delete Type 0 panel data, you must select only the Type 0 panel.

* To delete Type 1-4 panel data, you must select all panels for which you want
to delete data, excluding the enrollment panel and any
Type 0 panels.

» Ifyou select only the enrollment panel, then all data for each subject selected
will be deleted from Type 1-5 panels in the protocol. The subject’s
enrollment panel record will also be deleted.

* To delete Type 1-4 panel data, you can select the panels individually or in
groups. If you select multiple panels, then you can delete some or all of the
records from the panels. The subject’s enrollment panel record will not be
deleted. Therefore, the subject will still be enrolled.

Select the type of database table in which you want to make the global change or
deletion. You can select the update table, the data table, or both types of database
tables.
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When you click OK in the Select dialog box, the Global Change window or the

Global Delete window opens:

#. Global Change M= ES

SUBJECT

Restrict Data

-

Flags
CDR DOWNLDAD il
CDR LINSPECIFIED
CLASSIFY REQUEST j
Notes
INVESTIGATOR UNSPECIFIED
SPONSOR DATA_ENTRY
SPONSOR LUNSPECIFIED
_— " Owvermde Checks
50QL Restiiction
[ Submit Batch
Submit at: 0341271993 14:56:23
5 Submit every: [00 @ [Morths [+
Items to Change
Item Mame DB Format Change to... il
DAYMO WARCHARZ(3]
FIRSTNAME WARCHARZ(20) =
4l B r‘ -
Al 3
\#: Global Delete [_ O]
SURJECT Restrict Data =
Flags
CDR DOWNLOAD il
CDR LNSPECIFIED
CLASSIFY REQUEST j
Notes
INVESTIGATOR UMSPECIFIED
SPONSOR DATA_ENTRY
SPONSOR LNSPECIFIED

50QL Restiction

[+ Submit Batch

Submit at: 03412/1999 15:00:46

Subnit every: [ @ [Fort: [~

How to select subjects

In the Global Change window or the Global Delete window:

If you click All Subjects, the change or deletion that you specify will be
made for all subjects’ records in the selected panels.

If you click Selected Subjects, and then select subjects from the list, then the

change or deletion that you specify will be made for only the selected
subjects’ records in the selected panels.
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How to specify the job type

You can perform global change or global deletion either interactively or as a
batch job. If you perform this task interactively, then you will not be able to use
Manage for other tasks until the current task is completed. For more information
on batch jobs, see the Manage Help.

How to restrict records

You can optionally restrict records based on:

e A SQL restriction. Click the SQL Restriction box, or, from the Edit menu,
select SQL Restriction.

* Flags and notes.

For more information on restricting records, see the Reference Guide or the
Manage Help.

How to specify a change

In the Global Change window, select each item that you want to change.

In the Change to... field, enter the value to which you want to change the item:
* The new value must match the DB Format (database format) of the item.

* For the TEXT data type, you must enclose the new value in single quotation
marks.

» For any data type, the new value can be a constant or a calculated value,
which can refer to other items in the panel.

* To specify a calculated value, specify a SQL expression that is a valid
UPDATE statement. The SQL expression can contain any valid Oracle
function or operator.

Note: If the item selected for change is a context key or a grouping item, the
modified record is deleted and a new record with a different ct_recid is created.
As a result the audit trail of the newly created record does not contain the audit
history of the original (deleted) record. The change to the context item and all
changes prior remain in the audit trail of the deleted record.
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The following examples show the ways in which you can specify new values:

Item name: Database format: New value:

AGE NUMBER(2) 25

VISIT VARCHAR2(5) 'BASELINE'

VISIT DATE DATE ‘01-feb-1999° or TO_DATE (‘01-feb-

1999°,DD-MON-YYYY’)

Note: Use the date format that has been
set up for your Oracle

database, or use the TO_DATE()
function to override it.

BPDIA NUMBER(2) BPDIA+10

TOTAL NUMBER(2) ITEM 1+ ITEM 2

How to override data-entry checks

When you make a global change, the Clintrial software applies the same checks
that are applied during interactive data entry. These checks are:

» Confirming that subjects are enrolled.
» Confirming that subject, block, and page keys are defined.

* Confirming that block repeat and page repeat keys are defined, if they will be
used.

» Confirming that subset keys (if used) are defined.
» Confirming that a master record exists for a detail record.
» Confirming that the master key is unique.

» Confirming that grouping items have values, if grouping items are defined
for Type 0 panels. Confirms that default grouping items have values for Type
2 and Type 4 panels.

* Confirming that values are provided for mandatory items.

* Confirming that a code for an item with an attached codelist exists in the
codelist.

* Applying the range checks (upper and lower limits) that are defined for
items.

* Confirming that a value exists in the checklist for an item with an attached
checklist.
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If you check Override Checks in the Global Change window, you can override
the following checks for items:

* For an item with an attached checklist, the value must exist in the checklist.

e The value must be within any upper or lower bounds that have been defined
for the item.

Revalidation

When you change and try to save a record with the status Validated (0) or
Validation Error (-1), the Clintrial software automatically attempts to revalidate
the record.

If a record in the update table fails revalidation, then you can save the changes.
As with the initial validation, the evaluation of a rule to False during revalidation
generates an entry in the Error Log.

If a record in the data table fails revalidation, then you cannot save the changes.

For more information about revalidation, see "Automatic revalidation" on page
126.

Coding

If the protocol parameter ENCODE CLEAR ITEMS is set to Yes, then coding-
related items are cleared when verbatim text is changed. However, during global
change, if you explicitly specify a coding-related item, the item receives the
explicitly assigned value.
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How to preview

Before you globally change or delete records, it is recommended that you
preview the records that will be affected. To preview a global change or deletion,
from the View menu, select Preview. The Global Change Preview window or
the Global Delete Preview window opens, listing records that meet the selection

criteria:
# Global Change Preview for Panel: INVESTIGATORS Table: UPDATE =] E3
Merge Datetime Status Entiy Id Entiy Datetime Ct Recid Db Id Subject I1d -

03/01/1933 10:50:10 L 03/01/1933 10:60:10 |2 KIT.OC?KIP2.001 2 4380002

02/26/1939 15:48:44 L 02/26/1959 15:45:44 |2 KIT.OBXPH2.001 2 4310002

02/28/1999 11:06:03 AKIT 02/28/1939 11:06:03 |2 KIT.OBZLGY2.001 2 3460002 —

02/26/1933 16:05:35 L 02/26/1933 16:05:35 |2 KIT.0BXQ/B2.001 2 3440002

| | r
#. Global Delete Preview for Panel: INVESTIGATORS Table: UPDATE [ [=] E3

Merge Datetime Status Entry Id Entry Datetime Ct Recid Dbld | Subject Id -
02/26/1999 15:48:44 AKIT 02/26/1999 15:48:44 |2 KIT_OBXPH2.001 2 4310002
03/05/1933 14:46:20 2KIT (03/05/1993 14:46:20 |2 KIT.0OCCO[j2.001 2 4200002
03/05/1933 11:51:11 2KIT (0340541933 11:51:11 |2KIT.0CCLzd2.001 2 470002 T
02/26/1933 16:05:35 2KIT 02/26/1933 16:05:35 |2KIT.0BXQIB2.001 2 2440002
4| | H o

The Global Change Preview window and the Global Delete Preview window
display the records in one panel and one type of database table at a time. The
window title indicates the panel and the table with which you are currently

working. If you are working with more than one panel or table type, you can
view and select all available records by using:

* The View menu’s First Table, Prior Table, Next Table, and Last Table
commands.

e The arrow buttons on the Task toolbar.

If you are globally deleting records, then when you have confirmed that the
appropriate records will be deleted, you must return to the Global Delete
window. To run the global deletion, from the File menu, select Run. All records
listed in the Global Delete Preview window are deleted.
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If you are globally changing records, then in the Global Change Preview
window, select the records for which you want to preview the global change.
Then, from the View menu, select Preview Change. The Mock Global Change
Preview dialog box opens:

#. Mock Global Change Preview B
Current Record
| Merge Datetime | Status ‘ Entry Id | Enbry Datetime ‘ Ct Recid ‘
|03/011999 10.50:10 | KT |02/01/138910.60.10 2K T.OC7KP2.001 |
Modified Record
Merge Datetime | Status | Entry Id | Entry Datetime | Ct Recid
03/01/1999 10:50:10 | KT 0320111989 10:50:10 [2KIT.0C3KP2.001
4] | »
&) [ 1]
~Results
Column Entered Value Changed Yalue Action
I\NVNUM |24 I NOT MODIFIED
Ermract | Remarks i’
REJECT |Item INYNUM value 24 does not appear in codelist M_INVESTIGATORS. =
4| | Ll_l
ok | Help |

The Current Record is the current record in the database. The Modified Record is
the way the record will look in the database if you make the global change.

You can use the arrow buttons to scroll through the list of records, if multiple
records were selected.

In the Results section of the window:
* The Column field is the name of the item being changed.

* The Entered Value field is the value you entered in the Change to field of the
Global Change dialog box.

* The Changed Value field shows the value that the item will have if you make
the global change.

» If'the change passes data-entry checks and revalidation, then the Action field
is MODIFIED; otherwise, the Action field is NOT
MODIFIED.

If the change is to the subject item in the enrollment panel, only the enrollment
panel record will be previewed. Records in panels to be changed are not
previewed.

After previewing the records, return to the Global Change window. To run the
actual global change, from the File menu, select Run. All records listed in the
Global Change Preview window are modified, even if you did not preview the
changes for all of them.

138  Chapter 7: Globally Changing or Deleting Data



Reason for change

If auditing is in effect for any records that you globally changed or deleted, then
the Reason for Change dialog box opens. If the AUDIT REASON REQD
system parameter is set to Yes, then you must specify a reason for the change or
deletion. The same reason applies to all records that are included in the global
change or deletion.

The Clintrial software stores the reason for change in the CTSSREASON system
item of each record.

How errors appear in the Error Log

If a record fails a data-entry check during global change (and the check is not
overridden) then an entry is made in the Error Log with the error action REJECT
and one of the following error types:

*  GLOBCH if the error was during running of the actual global change.
*  MGLOBCH if the error was during previewing of the global change.

If an error occurs during global deletion, then an entry is made in the Error Log
with the error action REJECT and the error type GLOBAL DEL.

For more information about the Error Log, see Chapter 9.

Global Change Log

The Global Change Log is a cumulative report that contains the results of global
changes. There is one Global Change Log for each protocol.

From the Reports menu, select Global Change Log >> View. The following
table describes the information in the Global Change Log:

Report column: Description:
Panel Name of the panel in which the global change was made.
Table Type of database table (UPDATE, DATA, or BOTH) in

which the global change was made.
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Report column: Description:

Status NORMAL if the global change completed successfully;
ERROR if the global change did not complete
successfully.

Remarks COMPLETED if status is NORMAL,; an error message if
status is ERROR.

Selected Number of records for which the global change was
attempted.

Modified Number of records in which values were changed. If you

change enrollment data, the log shows only one record as
modified for each subject selected even though records in
other panels are changed.

Reported Number of items that failed data checks, but passed because
the checks were overridden.

Rejected Number of records that failed the global change.

Batch Id Oracle batch job queue ID, if the global change was
submitted as a batch job.

User Id User account that made the global change.

Start Date and time that the global change began.
End Date and time that the global change completed.
Restriction SQL WHERE clause used to select records.

Note: Each panel and table combination is listed in the Global Change Log as a
separate process.

The following example shows a portion of a Global Change Log:

Panel Table | Status Remarks Modified Reported | Rejected |Batch Id| User Id
DRUGAD UPDATE |NORMAL [COMPLETED g a CTEYS |0
DEMOG UPDATE [NORMAL |COMPLETED 47 34 4ACTSYS 0
DEMOG UPDATE |NORMAL [COMPLETED 0 a1 MCTEYS |0
[ K| | i
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How to work with the Global Change Log

You can view the Global Change Log, purge all entries from it, or purge selected
entries from it based on the following criteria:

You can use the View menu to filter or sort a displayed Global Change Log, and
the File menu to save or print the log.

Panel name

User account

Type of database table (UPDATE or DATA)

Status (NORMAL or ERROR)

Range for the date and time that the global change started
Range for the date and time that the global change completed

Global Delete Log

The Global Delete Log is a cumulative log of the results of global deletions.
There is one Global Delete Log for each protocol.

Note: Each panel and table combination is listed in the Global Delete Log as a
separate process.

From the Reports menu, select Global Delete Log >> View. The following
table describes the information in the Global Delete Log:

Report column: Description:
Panel Name of the panel for which the global deletion was made.
Table Type of database tables (UPDATE or DATA) in which the

global deletion was made.

Status NORMAL if the global deletion completed successfully;

ERROR if the global deletion did not complete successfully.

Remarks COMPLETED if status is NORMAL; an error message if
status is ERROR.

Selected Number of records for which the global deletion was
attempted.
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Report column: Description:

Deleted Number of records deleted.

Batch Id Oracle batch job queue ID, if the global deletion was
submitted as a batch job.

User Id User account that made the global deletion.
Start Date and time that the global deletion started.
End Date and time that the global deletion ended.
Restriction SQL WHERE clause used to select records.

The following example shows a portion of a Global Delete Log:

Panel Table | Status Remarks Selected | Deleted [Batch Id| User Id Start = |
DRGCMP UPDATE |NORMAL (COMPLETED 0 KT 03/04/1933 021531 PHO3/041
DRGCMP UPDATE [NORMAL |COMPLETED 1684 184 KIT 03/04/1993 01:53:47 PEO3/0441
DRGADM UPDATE |NORMAL (COMPLETED 18 181 KIT 03/04/1933 01:53:12 PH03/04.1
COMMED UPDATE |NORMAL (COMPLETED 95 95 KT 03/04/1933 01:52:50 P03/04.1
ADV UPDATE |NORMAL [COMPLETED 215 315 KIT 03/04/1933 01:51:58 PH03/04.1
L&E UPDATE |NORMAL (COMPLETED 2403 240 KIT 03/04/1933 01:23:.41 PHO3/041
WITaAL UPDATE [NORMAL |COMPLETED 227 229 KIT 03/04/1993 01:10:47 PEO3/0441
JNTSUM UPDATE |NORMAL (COMPLETED 2 KIT 03/04/1933 01:10:39 PH03/04.1
JNTASM UPDATE [NORMAL |COMPLETED 1050 1.05 KIT 03/04/1939 01:07:46 PFO3/041
JNTASH UPDATE NORMAL COMPLETED 1020 1.020 KT 03/01 /1933 0: 40:25 Pt 03/01 ﬂlll
14l | »

How to work with the Global Delete Log

You can view the Global Delete Log, purge all entries from it, or purge selected
entries from it based on the following criteria:

* Panel name

» User account

* Type of database table (UPDATE or DATA)

» Status (NORMAL or ERROR)

* Range for the date and time that the global deletion began

* Range for the date and time that the global deletion completed

You can use the View menu to filter or sort a displayed Global Delete Log, and
the File menu to save or print the log.
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Overview

Merging is the process of moving validated data from the update table to the data
table. You can only merge data that has passed validation.

Note: Depending on the setting of the system parameter ALLOW-
_MERGE TO VALIDATE, you may be able to validate records as part of the
merge process.

Duplicate records

A duplicate record is a record for which a record already exists for the same
subject or subject visit, and the same panel. When you merge records, the
Clintrial software checks for duplicate records.

Merging data

Only records that are in the update table and have the status Validated (0) are
available for merging.

All records must be validated before you can merge them, even if the panel has
no attached derivations or rules.

Effect on the record status

If the merge succeeds, then the Clintrial software moves the record from the
update table to the data table. The status of the record remains Validated (0).

If the merge fails, then the record remains in the update table. The record status
becomes Validation Error (-1).

The following figure shows changes in record status as a result of
merging:
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Update Table

Validated (0) Validation Error (-1)

Merge Fails
Data Table Merge Sucoeeds

Validated (0)

About panel keys

It is recommended that you set up panel keys for the Type 0, Type 2, and Type 4
panels into which you will merge data. The items referenced by the panel key
definition must be defined as required items.

How to begin

From the Manage menu, select Merge. The Merge window opens:

Panels ~Restrict Data |
ADY - =
CONMED Date and Time Range ELE
OMG CDR DOWMLOAD il
gggéag From: | COR 1MSPECIFIED
ENROLL Tee [ |cuessey REQUEST o
ECLUS ——
IMCLUS g
INVESTIGATORS fus INVESTIGATOR UNSFECIFIED
jm?am € Enmor SPONSOR DATA_ENTRY
LAB  vaiid SPOMSOR 1MSPECIFIED
L4E_NORMS $0L Restricti
MEDHIET  Verified 0L Restriction
g:gg?r: " All of the above
FRVMED
SIGNATURE
TERMIMATION
HITAL ™ Validate First F# Submit Batch
Submit at:  [03/12/1333 14,4511
Submit every: [00 B
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The system parameter and user preference SELECT _BY PAGE determines
whether records are selected by panel or by page for merge. The default setting
of the parameter is No. To change the user preference, from the File menu, select
Preferences. Set the preference to either Yes or No.

If the user preference SELECT BY PAGE is set to No, then the Merge window
lists all panels in the current protocol.

Caution: Do not merge the Resolve panels:
*  VCT_ERRORSTATUS UPDATE
* VCT_ERRORITEM UPDATE

Resolve only uses the update tables. Merging these panels will make Resolve
discrepancies unavailable.

Select the panels for which you want to merge data. To select all panels, from the
Edit menu, select Select Panels >> All.

Panels with invalid validation procedures are unavailable for selection in the
Merge window. If you need to merge records in a panel that is listed but is
unavailable, check with the designer to determine whether the panel’s validation
procedure has been compiled properly.

Note: All records that are part of an observation are merged at the same time. If
the merge fails for one record that is part of the observation, then the merge fails
for all records that are part of the observation.
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Merge by study page

If the SELECT BY_PAGE user preference is set to Yes, the Merge window lists
all study pages in the selected page list for the current study book, as shown in
the following example:

B Merge =
Page List i~ Restrict Data =
[ =
! & Al =i Date and Time Range [
pages COR DONLOAD i’
" Selected pages From: I— DR UNSPEOFED
! i To: " |cLassiee REDUEST |
Notes
Status INVESTIGATOR LUNSPECIFIED
" Error SPONSOR DATA_ENTRY
& valid SPOMSOR LINSPECIFIED
£ Verified 50QL Restiiction
" All of the above
™ Validate First ¥ Submit Batch
Submit at: 0371241993 14:47:08
Submt every: 78 o]

You can then:
» Click All pages to merge records in all pages that appear in the list.
* Click Selected pages and select specific pages with records to be merged.

Note: The Merge window only specifies which records are selected for merge,
and does not guarantee that all records on a page are merged as a group.

Using Page Lists

If the SELECT BY_ PAGE user preference is set to Yes, then the List menu
commands become available. You can use the List menu commands to create,

edit, or delete a page list. You can then select a page list from the Page List drop-
down listbox.

Page lists are used in Manage and Enter. Therefore, any changes that you make
to a page list in Manage also affect Enter.

Note: In Manage, you cannot work with subject lists, as you can in Enter. You
can only work with page lists.

For more information on page lists, see the Enter Help.
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How to restrict records

You can optionally restrict records based on:
* Date and time
» Flags and notes

* A SQL restriction. Click the SQL Restriction box, or, from the Edit menu,
select SQL Restriction.

For more information on restricting records, see the Reference Guide or the
Manage Help.

If you are validating records as part of the merge, you can also restrict records on
the basis of status. Only records of the specified status will be validated.

For more information about status restrictions during validation, see "How to
restrict records" on page 122.

How to validate first

If the Validate First check box is available, you can check it to validate the
records as part of the merge. If a record fails validation, then an entry is made in
the Error Log and the record is not merged.

If the Validate First check box is unavailable, or if you do not check the Validate
First check box, then you must have previously validated the records.

How to specify the job type

You can perform merging either interactively or as a batch job. If you perform a
task interactively, you may not be able to use Manage for other tasks until the
current task is completed. For information about batch jobs, see the Manage
Help.

How to begin

To run the merge process, from the File menu, select Run.
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How errors appear in the Error Log

If an error occurs during merging, it is recorded as an entry in the Error Log with
the error type MERGE. For information about the Error Log, see Chapter 9.

Merge Log

The Merge Log is a cumulative log that contains general information about the
number of records added to the data table during merging. There is one Merge
Log for each protocol.

From the Reports menu, select Merge Log >> View. The following table
describes the information in the Merge Log:

Report column: Description:
Panel Name of the panel in which records were merged.
Status NORMAL if the merge completed successfully; ERROR if

the merge did not complete successfully.

Remarks COMPLETED if status is NORMAL; an error message if
status is ERROR.

Added Number of records added (merged) to the data table.

Errors Number of errors that occurred during merging.

Batch Id Oracle batch job queue ID, if the merge was submitted as a
batch job.

User Id User account that submitted or ran the merge.

Start Date and time that merging started.

End Date and time that merging ended.

Restriction SQL WHERE clause used to select records.
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The following example shows a portion of a Merge Log:

@) Merge Log [_[Olx
Panel Status Remarks Added | Errors |Batch Id| User Id Start End =]
CONMED NORMAL (COMPLETED kIT 03/12/1939 01:04:00 PAO3/12/1933 01
CONMED NORMAL [COMPLETED KIT 03/12/1933 12:57:33 P403/12/1999 12
CONMED ERROR  |0RA-06508: PL/SOL: could not KIT 03/12/1999 12:53:32 PR03/12/1939 12
find program unit being called
DMG NORMAL (COMPLETED 1 KIT 03/08/1933 01:24:15 PH03/06,/1933 01
DMG NORMAL (COMPLETED kIT 03/08/1939 01:22:60 P03/06/1933 01
DMG NORMAL [COMPLETED 1 KIT 03/06/1933 09:41:41 4§03/06,/1993 09
DMG ERROR  |0RA-06508: PL/SOL: could not KIT 03/06/1939 03:38:10 A403/06/1939 09_|
find program unit being called
DMG ERROR  |ORA-06508: PLASOL: could not kIT 03/06/1933 09:26:11 4§03/06/1933 09
find program unit being called
DY NORMAL [COMPLETED KIT 03/05/1933 04:33:11 PY03/05/1993 04
DMG NORMAL (COMPLETED 3 KIT 03/05,/1939 01:36:07 PH03/05/1933 01
DMG ERROR  [ORA-00911: invalid character KIT 03/05/1933 01:15:56 P03/05/1933 01
DMG ERROR  [ORA-00911: invalid character B42KIT 03/05/1933 12:52:41 PY03/05/1999 12
DMG NORMAL COMPLETED 4 il KIT 03/05/1933 12:43:19 Pt03/05/1999 12
{ R} 1 L

How to work with the Merge Log

You can view the Merge Log, purge all entries from it, or purge selected entries
from it based on the following criteria:

* Panel name

» User account

* Type of database table (UPDATE or DATA)

« Status (NORMAL or ERROR)

* Range for the date and time that the merge started
* Range for the date and time that the merge ended

You can use the View menu to filter or sort a displayed Merge Log, and the File
menu to save or print the log.
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Viewing the Error Log

The Error Log is a cumulative log of errors that occurred during screening,
validation, merge, global change, and global deletion in Manage. The Error Log
is also a cumulative log of errors that occurred during screening, validation, and
transfer in Lab Loader. You use the Error Log to view and correct records that
failed these processes. There is one Error Log for each protocol.

How to begin

To view the Error Log for all panels in a protocol, from the Reports menu, select
Error Log >> View All

To view the Error Log for selected panels, from the Reports menu, select Error
Log >> View by Panel.

The View Selected Error Log Records dialog box opens:

#, Yiew Selected Enmor Log Records
Panels Emor Types
COMMED
onG LCancel
LAE
Resel
Help
Table[s]) Insertion Datetime
v UPDATE From: l—
v DATA

To: l—

Select the panels for which to view the Error Log. Then, select the error types for
which you want records to be displayed on the Error Log. If you do not select an
error type, then records containing all error types will display on the log.

Select the type of database table for which you want to display the Error Log.
You can select the update table, the data table, or both types of database tables.

You can further restrict the records that appear in the log by entering arange
of dates and times that the records were generated.
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The following example shows the Error Log:

i, Error Log for All Panels [_ O] %]
Filter: | |
Panel SUBJECT YISND PAGEND Table Error Type Action Datetime 3
[subject_item] [block_item) [page_item) bl [ ] [emract) [errdt)

CONMED PAT101 93 26 UFDATE [VALIDATE REFDRT  |03/12/1933 01:03.5
DMG tANT13 i] 3 UPDATE [VALIDATE REFORT  |03/06/1959 04:19:41
DG HEL102 0 3 UFDATE [VALIDATE REPORT  |03/05/1999 12460
DMG HEL102 i] 3 UPDATE [VALIDATE REFORT  |03/05/19399 12:42:4!
DMG HEL102 0 3 UFDATE  [VALIDATE REPORT  |03/05/1999 12082
CONMED PAT101 99 26 UPDATE [VALIDATE REFORT  |03/05/1959 10:58:0;
CONMED ANATOT 93 26 UFDATE  [VALIDATE REPORT  |03/05/1933 035711
L&B ANATO1 2 16 LUPDATE |SCREEN REFORT  |03/04/1999 02:45:2
Lag ANATOT 3 22 UPDATE |SCHEEN REPORT  |03/04/1999 02:45:2

i — - 5 e d;I

If you are working with more than one page of records, you can view records by
page using:

» The View menu’s First Page, Prior Page, Next Page, and Last Page
commands.

* The arrow buttons on the Task toolbar.

You can view the Error Log, purge all entries from it, or purge selected entries
from it based on the following criteria:

* Panel

* Error type

* Type of database table (UPDATE or DATA)

* Date and time the entries were added to the log
* SQL Restriction

You can use the View menu to filter or sort a displayed Error Log, and the File
menu to save or print the log.

Error Log contents

The following table describes the information in the Error Log:

Report
column: Description:
Panel If you selected the View All submenu command, name of the panel

containing the record with the error.
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Report
column:

Description:

Error

Subject item

Block key
item

Block repeat
key item

Page key item

Page repeat
key item

Table

Error Type

The name of the error.

For Type 1 through Type 5 panels. The column heading is the subject
item. The value in the column is the value of the record’s subject
item.

For Type 1 through Type 4 panels. The column heading is the block
item. The value in the column is the value of the record’s block item.

For Type 1 through Type 4 panels. The value of the block repeat key
item (if the context panel for the protocol has a block repeat key
item).

For Type 1 through Type 4 panels. The column heading is the page
item. The value in the column is the value of the record’s page item.

For Type 1 through Type 4 panels. The value of the page repeat key
item (if the context panel for the protocol has a page repeat key
item).

Type of database table (UPDATE or DATA) containing the record.

The Clintrial task during which the error occurred:
*  GLOBCH —Global change

*  MGLOBCH — Previewing of a global change (a temporary
entry that appears only during the preview)

*  GLOBDEL — Global deletion
*  MERGE — Merge

* SCREEN — Screening

*  VALIDATE — Validation

For error type TRANSFER, see the Lab Loader section in Manage,
Classify, and Lab Loader.
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Report

column: Description:

Action For error types GLOBCH, MGLOBCH, or SCREEN:

*  REPORT — The record did not pass data-entry checks, but the
checks were overridden.

*  REJECT — The record did not pass data-entry checks, and the
checks were not overridden.

For error type VALIDATE:

*  REPORT — A rule with the error action REPORT evaluated to
FALSE.

* REJECT —A rule with the error action REJECT evaluated to
FALSE.

For error type SCREEN:

*  REPORT — There is an error with the study book. For example,
a page is not defined for a visit. Or, the record did not pass data-
entry checks.

* REJECT — There is an error with the data. For example, the
subject is not enrolled. Or, the record did not pass data-entry
checks.

For error type MERGE:

*  REJECT — There is a duplicate record.

For more information on screen checks, see "Screening batch-loaded

data" on page 61.

Datetime Date and time that the error occurred.

Remarks Description of the error, as determined by the error type.

Rule Name For error type VALIDATE, name of the rule that evaluated to False.
For error types SCREEN, GLOBCH, or MGLOBCH, the name of
the item that failed a screen check. For example, if the error is that
there was no subject identifier for a record you tried to screen, this
value is SUBJECT ID.

Ct Recid Value of the CT_RECID system item for the record.
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Additional item

With the user preference ERRLOG DISPLAY ITEM, you can specify an
additional item to appear in the Error Log for Type 0 panels. The item only
displays on the Error Log when you use the View By Panel submenu command.

Editing records from the Error Log

When a record fails a process in Manage, you may need to edit the record and
repeat the process. For example, if a record fails validation, you may need to edit
the record and validate it again. You can edit records directly from the Error Log
if you have to correct Enter access rights. You do not need to use Enter to edit the
records.

You can use the Error Log to edit records that have an error reported against
them if you have the required access rights and if your designer has defined a
study page and study book for the panel that contains the record that you want to
edit.

When you select a record in the Error Log, a study page opens in which you can
edit the records and save the new values to the database.

You can also:
*  Supply a reason for change.
» Attach flags and notes to records.

*  Work with discrepancies.

Note: You must set the study book to use when editing from the Error Log.
From the File menu, select Set Study Book. A dialog box opens in which you
can select the study book.
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How to edit from the Error Log

To select a record in the Error Log for editing, double-click the record. The
Clintrial software opens the study page that contains the record. The following
example shows a portion of the study page that opens for a record from the LAB
panel of the MEDIKA CLINICAL protocol that was selected in the Error Log:

. Error Log for All Panels |_ (O] x|
Filter: | |
Panel SUBJECT YISND PAGEND Table Ermror Type Action Datetime ﬂ
[subject_item] [block_item) [page_item) I [ ] [emact] [endt)
CONMED PATI0 59 E UPDATE |VALIDATE REPORT  [03/12/1333 01:035
DG MAM113 0 3 UPDATE |WVALIDATE REPORT  [03/06/1333 041941
DKG HEL102 0 3 UPDATE  |MALIDATE REPORT  [03/06/1333 12:46:0:
DMG HEL102 0 3 UPDATE  |WALIDATE REPORT  [03/05/1999 12424
DG HEL102 0 3 UPDATE |WVALIDATE REPORT  [03/05/19331208.2
CONMED PATI0 59 E UPDATE |VALIDATE REPORT  [03/05/1333 10:58:00
CONMED ANATOT 99 26 UPDATE  |WALIDATE REPORT  (03/05/1939 095711
ANATD 2 18 UPDATE |SCREEN REPORT
K] 27 |IPNATE ISCRFFMN RFPORT  IN3./M4/1999 N7 45 2

| AR AMATM
mANlﬂ 01.Days 30, 60, unsched.1.Laboratory Exams [UPDATE] |_ (O] x|

Medika Clinical - Rheumatoid Arthritis - Phase Il

Protocol Page Humber [Page Repeat]
Bs ] ;
[ Subject C 1
SHATE ¥isit Number [Visit Repeat]
Subject Initials
Day Humber -
A
I 1
JLABORATORY TESTS |
Lab Name: [Afied Health Lab LabMumber: [
-

You edit the record in the same way that you enter or edit records in a study page
in Enter. However, you can perform only some of the editing and navigation
functions available in Enter. For example:

*  You can edit only one study page at a time; you cannot navigate to other
study pages in the study book.

*  You cannot add or insert repeating items.

*  You cannot delete any records.
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Using the Error Log with discrepancies

If the protocol is set up for Resolve, then you can also use the Error Log to show,
create, and delete discrepancies. A discrepancy is either an actual or a potential
data problem, such as missing values or variations from an expected range, or
inconsistencies among data values entered over time for different panels.
Discrepancies are created automatically in Manage when the protocol is set up
for Resolve and:

* Arecord fails merging.
* Arule evaluated to FALSE during validation.

For example, if during merging two records have the same subject, page, and
block key values, then both records generate a REJECT error on the Error Log,
and both records generate discrepancies.

For more information about editing records or discrepancies from the Error Log,
see the Manage Help.

For more information on resolving discrepancies, see the Resolve section in
Enter, Resolve, and Retrieve.

Revalidation

When you change and attempt to save a record with the status Validated (0) or
Validation Error (-1), the Clintrial software automatically attempts to revalidate
the record.

If a record in the update table fails revalidation, you can save the changes. As
with the initial validation, the evaluation of a rule to False during revalidation
generates an entry in the Error Log.

If a record in the data table fails revalidation, you cannot save the changes.

For more information, see "Automatic revalidation" on page 126.
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Reason for change

If auditing is in effect for the record that you edited, then the Reason for Change
dialog box opens. If the AUDIT REASON_ REQD system parameter is set to
Yes, then you must specify a reason for the change. Otherwise, specifying a
reason for change is optional.

The Clintrial software stores the reason for change in the CTSSREASON system
item.
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Overview

Auditing is the process of tracking changes made to clinical data, and of tracking
notes associated with clinical data. The designer determines which Clintrial
software panels and tasks are audited, and whether notes are audited.

What is the audit table?

When a record is changed or deleted, a copy of the record as it was before the
change or deletion is stored in the audit table for the panel. There is one audit
table for each installed panel.

The following figure shows how, as the value for AGE is changed twice in the
DEMOG_UPDATE table, a copy of the record before the change is stored in the
DEMOG_AUDIT table if auditing is in effect:

DEMOG_UPDATE Table
Subid | Sex | Age

200 | F | 34

Record is
Modified DEMOG_AUDIT Table
Subid | Sex | Age

DEMOG_UPDATE Table

Subid | Sex | Age 200 | F | 34
200 | F | 30 » 200 | F | 30
Record is
Modiified

DEMOG_UPDATE Table
Subid | Sex | Age

200 | F | 36

What is the audit tags table?

If auditing of notes has been set up for a protocol and auditing is in effect, then a
copy of a note that is attached to a record that is eligible for auditing is stored in
the audit table when it is changed. The audit table stores a copy of the note
before it was changed.
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What is the audit start point?

The audit start point is the data management activity after which auditing
begins. Depending on where auditing is set to begin, auditing can track changes
to records or notes in the update table, data table, or both.

The designer determines when auditing begins. There is a default audit start
point for the database, and there may be protocol-specific or panel-specific audit

start points.

The following table summarizes possible audit start points:

Audit start point: Database table:

Description:

ENTRY Update table

VERIFICATION  Update table

VALIDATION Update table

VALIDITY Update table

MERGE Data table

Auditing begins after the record is entered
interactively.

If a record is entered interactively, auditing
begins after the record has been verified.

If a record is entered by batch loading, auditing
begins after the record has passed screening.
Records with the status 3 (Unscreened) or -3
(Screening Error) are not eligible for auditing.

Auditing begins after the record has been
validated, regardless of whether it passed or
failed validation.

Auditing begins after the record has passed
validation.

Auditing begins after the record is merged
successfully.

Audit report

The audit report shows differences between the record before and after it was
modified. It also shows records that have been deleted from the update table or

data table.
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If auditing is in effect when values are changed in any way for the items
(including system items) that make up a record, then an entry for the record is
made in the audit report.

Note: 1f a derived value changes as a result of validation, an entry is made in the
audit report. If the status of the record changes because the record was
processed, then an entry is made in the audit report. For example, if a record is
validated, then an entry is generated for the report.

How to begin
From the Reports menu, select Audit Records. The Select dialog box opens:

. Select | x|

Table(s] Records
[~ UPDATE * Active,
¥ DATA " Deleted

(114 I Cancel | Help |

Select the panel for which you want to display the audit report.

Select the type of database table for which you want to display the audit report.
You can select the update table, data table, or both types of database tables.

To work with only records that are currently in the update table or data table,
click Active. To work with only records that have been deleted from the update
table or data table, click Deleted.

Note: If Global Change has been used to modify a context key of panel record,
only changes that took place after modification of the context key will be
included into the Active Records report. The modification to the context key and
all changes prior to key modification will be included into Deleted Records
report.
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Example 1. If you modify a record three times, and then change the value of a context
key, the Clintrial software deletes the modified record and inserts the record into the
panel that is being modified. All four changes are now stored in the audit trail of the
deleted record under the old context key. If you run a report for the active record, you
will not see the details for the changes you made. You may or may not see the audit trail
of the new record; it depends on a Audit Start parameter. These details are included in
the Deleted Record report.

Example 2. If you change a record three times, and then change the value of a context
key, the Clintrial software deletes the modified record and inserts the record into the
panel that is being modified. If two more changes to non-context items are made, these
two changes are stored in the audit trail of the NEW record with the new ct_recid. If you
run a report for active records, the last two changes that took place after the context item
was modified appear in the Active Records report. The Deleted Records report shows
modifications to the context item and all modifications prior the context key change.

How to select records

When you click OK in the Select dialog box, the Select for Audit window opens,
listing records that meet the selection criteria.

You can use the View menu to filter or sort the list of records.

How to run the audit report

To run the audit report, select one or more records from the Select for Audit
window, and from the File menu, select Run.
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The Clintrial software creates an audit report that includes any existing audit
records for the records that you specified. The following example shows an entry
in the audit report for a record in the ENROLL panel:

[ MEDIKA CUNICAL - ENROLL -Actve Reconds eI
SUBJECT: ANATOT =
VISNO: VISRPT:

PAGEND: PAGERPT:
CT_RECID: 2. 50LL0AD.OEXOHw.001
Timestamp: 02/26/1933 021717 PM Status before change: ‘alidated in _UPDATE
User ID: KIT
ITEM OLD VALUE NEW VALUE
STATUS -20 -0
Reason for Change: Merged
Changed: 1 —
Timestamp: 02/26/19393 021716 PM Status before change: ‘erified
User ID: KT
ITEM OLD VALUE NEW VALUE
STATUS -40 -20
Reason for Change: <Mone Specified>
Changed: 1

-l

You can use the View menu’s First Page, Prior Page, Next Page, and Last
Page commands to view different pages of the audit report, and the File menu to

save or print the report.

Audit Report contents

The following table describes the information in the Audit Report for each

modified record:

Report column:

Description:

Subject item

Block key item

Block repeat key item

For Type 1 through Type 5 panels. The field name is the
subject item. The value in the field is the value of the
record’s subject item.

For Type 1 through Type 4 panels. The field name is the
block item. The value in the field is the value of the
record’s block item.

For Type 1 through Type 4 panels. The value of the
block repeat key item (if the context panel for the
protocol has a block repeat key item).
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Report column:

Description:

Page key item

Page repeat key item

CT_RECID
Timestamp

Status before change
User ID

ITEM

OLD VALUE
NEW VALUE

Reason for Change

Changed

For Type 1 through Type 4 panels. The field name is the
page item. The value in the field is the value of the
record’s page item.

For Type 1 through Type 4 panels. The value of the page
repeat key item (if the context panel for the protocol has
a page repeat key item).

Value of the CT_RECID system item.

Date and time the record was modified or deleted.
Status of the record before the record was modified.
User account that modified or deleted the record.

Name of the item for which a value was modified.

Note: The Status item may appear in this column. This is
a system item for internal Clintrial software purposes
only.

Value of the item before the modification.
Value of the item after the modification.

The reason that the user specified for the change or
deletion.

The number of items that were changed in the record.

Additional context item

With the user preference AUDIT ITEM_LIST, you can specify one additional
context item to appear in the audit report.
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Audit Notes Report

The Audit Notes Report shows notes that have been modified or added. The
designer determines whether investigator notes, sponsor notes, or both are
audited for a protocol. Additionally, to audit notes, auditing must be in effect for
the record that the note refers to, as determined by the audit start point.

If auditing is in effect for notes, then modifications of notes attached to an
observation, record, or item generate an entry in the Audit Notes Report. The
Audit Notes Report does not show deletions of notes attached to clinical data.

How to run the Audit Notes Report

From the Reports menu, select Audit Notes. Select the panel for which you
want to display the report.

The following table describes the information in the Audit Notes Report:

Report column: Description:

Subject Subject identifier of the record to which the note is
attached.

Record The CT_RECID of the record to which the note is

attached. (For an observation-level note, this is the first
record in the observation.)

Database Table Update table or data table, depending on the type of
database table to which the note is attached.

Entry Date Value of the system item ENTRY DATETIME for the
record to which the note is attached.

Item note Item note, record note, or observation note, depending
on the level of data to which the note is attached.

Entry Id User account that modified the note.

You can use the View menu to filter or sort a displayed Audit Notes Report, and
the File menu to save or print the report.
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Audit History Report

The Audit History Report shows the audit start point of panels, and any changes
that are made to the audit start point for the panels in a protocol. You can view
and print the Audit History Report.

How to run the Audit History Report

From the Reports menu, select Audit History. The Audit Commencement

History report opens:

. Audit Commencement History H[=] E3
Panel Effective Date Audit Start Point =
A0V

02/26/133312:4216 FM ENTRY
CONMED
02/26/193312:42:40 FM ENTRY
DMG
02/26/1933 11:48:11 AM ENTRY |
DRGADM
02/26/1999 12:42:58 PM ENTRY
DRGCMP
02/26/133312:42:03 M ENTRY
ENROLL
02/26/193312:43: 20 PM ENTRY
EXCLUS
02/26/193912:43.27 FM ENTRY
INCLUS
02/26/1999 12:43:40 PM ENTRY
INVESTIGATORS
02/26/1333 11:43:12 AW ENTRY _I

You can use the View menu’s First Page, Prior Page, Next Page, and Last
Page commands to view different pages of the Audit History Report, and the
File menu to save or print the report.

The following table describes the information in the Audit Commencement

History report:

Report column:

Description:

Panel

Effective Date

Audit Start Point

Name of the panel to which the audit start point applies.

Date on which the audit start point was set or changed.

Processing event at which the audit start point is set to
begin; for possible values, see "What is the audit start
point?" on page 163.
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Subject Audit Report

The Subject Audit Report shows any changes that are made to the subjects in a
protocol, including data for all panels/pages. You can view and print the report.
The Subject Audit Report is available under the Reports menu in Manage.

In order to obtain this report, you must

1. Generate a data set for the report.
* Choose subjects for which data should be gathered.

» Data is saved as of the time the report data is generated. If the report
generation is submitted as a batch job, then the data is saved as of the
time the job runs.

* To generate and purge report data, you must have an access level of Full
for the Access Right of Other in the Manage module.

2. Use the generated data to create a report.
* The report may contain a subset of the subjects and pages/panels.

* To create and print report data, you must have an access level of Read for
the Access Right of Other in the Manage module.

How to generate data for the Subject Audit Report

From the Reports menu, select Audit Subjects. You can then choose between
Generate Data... or Create Report.... The initial step is to generate data. When
you choose this option, the Generate Report Data screen opens:

[# Generate Report Data x|

Records
¥ Active
" Deleted

= Al Bubjeti
" Selected Subjects

SUBJECT

SQL Restriction
CEMNTER = "AMA'

[+ Submit Batch

Submit at: 572007 14:26:53
Submit every: l@lm

cncer | ow_|
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Select the All Subjects or the Selected Subjects for which you want to display
the audit report. If Selected Subjects is chosen, one or more subjects in the list
may be selected. If All Subjects is chosen, then you will be warned about the
performance impact after hitting the OK button.

To work with subjects that are currently enrolled, click Active. To work with
subjects that have been deleted, click Deleted. Both may be selected.

You can create a SQL Restriction in the clause builder to further specify the
data reported. The subject list does not change, but the restriction is passed to the
batch job.

Submit Batch is selected by default. If Submit Batch is deselected, you will be
warned that the operation may be time consuming. If you wish to continue
anyway, the report data will be generated, and you will be taken directly to the
Create Report window.

If the Submit Batch is selected, you may make this a recurring batch job by
specifying how often the job should be run. When you hit the OK button, you
will be informed that the job has been submitted, and to see the menu item
Reports\Audit Subjects\Create Report... for the job status.

Batch jobs may be managed via the existing Tools\Batch Job Queue menu
items, just as for other jobs. Modify, Delete and Run options are available as for
other batch jobs.

To access the data generated, go to Reports\Audit Subjects\Create Report... A
browser window appears with summary information for each data set that has
been generated.

&, Create Report =10}
Restriction Status Success Failure Remarks Batch Id User Id Start End
(CENTER - 'ANA) NORMAL 6 0 106CTSYS  5/7/2007 14:45:30 5/7/2007 14:45:31

MNORMAL g 0 106CTSYE
SUBJECT_ID IM (80002.50002.20002.10002.70002.60 30002.40002) [NORMAL 8l I 104CTSYS 5/7/2007 10:49 107 10:49:36
SUBJECT_ID IN (40002) MNORMAL 1 o 103CTSYS 572007 10:48:20 5/7/2007 10:48:20
SUBJECT_ID IN (B0002) MNORMAL 1 0 102CTSYE 5/7/2007 09:46:06 &/7/2007 09:46:07

To delete all generated data for a dataset, select a row in the browser and use
Edit\Delete.

How to create and view the Subject Audit Report

The actual report is created by selecting a row in the browser and using
File\Run.
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A dialog box appears which allows you to further limit the contents of the report.

x|
Subject Page List
s [aLL 4|
JANAT 04
202 & All pages
IANAZ12 " Selected pages

PANAAE
ANAZE
HEL202
AN103

oK | Cancel Help |

The Subject list includes only those subjects actually included in the data set.

The Page List or Panel List varies depending on your preference setting for
SELECT_BY_PAGE. If Yes, a list of pages is shown, allowing either all pages
or one or more selected pages. If No, a list of panels is shown, allowing either all
or one or more selected panels. Protected panels for which you do not have
access do not appear. The Page or Panel lists otherwise includes all available in
the protocol, and not just those for which data was actually included in the
dataset.

Clicking OK causes the actual Subject Audit Report to appear.

m. Subject Audit Report -0 ﬂ
Protocol: MEDIKA_CLINICAL SUBJECT: ANA1 8000z
VISNO: 0 VISRPT:
PAGENO: 3 PAGERPT:
Panel Ct Recid Modified By Reason For Change
DMG 2 ENTERERWDKEYE3.001 4/13/2007 0456:41  ENTERER Werify
ltem Previous Value New Value
STATUS 60 <50
Panel Ct Recid Modified By Reason For Change
INVESTIGATORS 2 ENTERERWDKEYE2.001 4/13/2007 0456:41  ENTERER Weify
ltem Previous Value New Value
STATUS -60 -40
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Data in Protected Panels, for which you do not have access is excluded from the

created report.

You can use the View menu’s First Page, Prior Page, Next Page, and Last
Page commands to view different pages of the Subject Audit Report, and the
File menu to save or print the report. Standard printing options are available.

The following table describes the information in the Subject Audit Report:

Report column: Description:

Panel Name of the panel.

Ct Recid Value of the CT_RECID system item.

Modified Date on which the modification was made.

By User account that modified or deleted the record.

Reason For Change

Item

Previous Value

New Value

The reason the item was modified.

Name of the item for which a value was modified.

Value of the item before the modification.

Value of the item after the modification.
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Panel reports

There are two panel reports in Manage:
* Rules

¢ Derivations

The panel reports provide information on rules and derivations in the current
protocol. You can print the reports, and then file the reports in archives when a
study is complete, or you can use the reports for reference when you perform
validation.

Rule Report

The Rule Report contains information on the rules associated with each panel in
the current protocol. The Rule Report also optionally contains information on
unimplemented rules. Unimplemented rules are rules that have been modified
within a panel that is marked for revision. The rules are unimplemented if the
revisions to the panel have not yet been implemented.

From the Reports menu, select Panels >> Rules. The Report Options dialog box
opens:

4 Report Options

[~ Include Unimplemented Rules

ADV A
ADV_LLT

ADV_PT

CONMED

CONTEXT

DM@

DRGADM

DRGCMP

ENROLL

EXCLUS

INCLUS

INVESTIGATORS

INTASM

INTSUM =
LB

LAB_NORMS

MEDHIST

NEUROL

PHYEXM =l

OK || Cancel || Selectan || el |

If you check Include Unimplemented Rules, then revisions to rules that have
been modified within a panel marked for revision are included, instead of the
original version of the rule.
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If you clear Include Unimplemented Rules, then only the original versions of the
rules are included in the report.

Select the panels for which you want to display rules, and then click OK. You
can select more than one panel, or you can select all panels by clicking Select
All

The information that appears in the Rule Report is based on the rules in the
panels that you select. For more information on the rule fields, see the Design

section in Admin and Design.

The following example shows a Rule Report:

for Protocol MEDIKA_CLINICAL =

Panel: DMG
Fube Hame Uses Home Hoddied Flag to Set Flag Cateqory Initiol Stotus  Priorty Action
AGE_CHECK CISvS /TN 24858 REFORT

Othes Rule Altiibutes

[E] Mull Pazves Rule [ Copy with Panel [E] Mxg Devived [ Compied

Description —

Message Text
—Rude Teat

AGE_CHECK $meg = rud

Derivation Report

The Derivation Report contains information on the derivations associated with
each panel in the current protocol. The Derivation Report also optionally
contains information on unimplemented derivations. Unimplemented derivations
are derivations that have been modified within a panel that is marked for
revision. The derivations are unimplemented if the revisions to the panel have
not yet been implemented.

From the Reports menu, select Panels >> Derivations. The Report Options
dialog box opens:
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M. Report Options | %]

[ Include Unimplemented Derivations

ADV

ADV_LLT
ADV_PT
CONMED
CONTEXT

DMG

DRGADM
DRGCMP
ENROLL
EXCLUS

INCLUS
INVESTIGATORS
JNTASM
JNTSUM b
LAB

LAB_NORMS

MEDHIST

NEUROL

PHYEXM =l

ITI [:mll Sdecl&ll Help |

If you check Include Unimplemented Derivations, then revisions to derivations
that have been modified within a panel marked for revision are included, instead
of the original version of the derivation.

If you clear Include Unimplemented Derivations, then only the original versions
of the derivations are included in the report.

Select the panels for which you want to display derivations, and then click OK.
You can select more than one panel, or you can select all panels by clicking
Select AlL

The information that appears in the Derivation Report is based on the derivations
in the panels that you select. For more information on the derivation fields, see

the Design section in Admin and Design.

The following example shows a Derivation Report:
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. Derivation Repoit

for Protocol MEDIKA_CLINICAL

JH[=] E3

Panel: DMG

Derivalion Name Compiled Modified By Modified Date

AGE_CHECK (4] CTSYS 11/7/200012.48:58
-Descrption

Showes detrved message, ule lgic in detivation, used with AGE_CHECK rule

— Derivation Text
etv_cote setup_enoitem{AGE_CHECK, cl:§panel, COMSDATE . this ct_recsd, thiz.consdate, rul).
civ_core setup_sttonitemlAGE_CHECK ctsdpanel, BIRTHDATE', this.ct_recid, thes brthaate, rudl):

If this age <18 then
AGE_CHECKS§msg := 'Age is less than 187,
else AGE_CHE CK$meg = null;

end i,
Derivalion Name Compiled Modified By Modified Date
AGE_DRV ) CTSYS 11/7/2000 12.48:57
Description
Dedive subsect’s 3ge
— Derivation Text

this.age = cl_sample cale_age(this.consdate this. bihdate).

4

Display Object reports

There are two display object reports in Manage:

* Page Template Summary
+ Study Books

The display object reports provide information on page templates and study
books in the current protocol. You can print the reports, and then file the reports
in archives when a study is complete, or you can use the reports for reference

during Manage activities.

Page Template Summary Report

The Page Template Summary Report contains information on the page sections

that appear on each page template.
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From the Reports menu, select Display Objects >> Page Template Summary.
The Report Options dialog box opens:

M Report Options

Available Page Templates

ADV

BOTOISP
BOTRET
BOTRET_FINAL
COMMED
CONMED_AE_YN
DMG

DRGADM
ENROLL
EXCLUS
HISTORY
INCLUS
INCLUSRADIO
JNT

LABLNG
LABSHT
LAB_NORMS
PHYERM
SUBJECT_LOCK
TERMINATION
VITAL

[0k ] _cancel | setectan | Hew |

Select the panels for which you want to display page template information, and
then click OK. You can select more than one panel, or you can select all panels

by clicking Select All.

The following table describes the information in the Page Template Summary

Report:

Report Column:

Description:

Order

Usage #

Page Section

X

Subset Value

Order of the page section on the page template, from the
top of the page template to the bottom.

Number that uniquely identifies each page section in the
page template.

Name of the page section on the page template.

Horizontal (X) coordinate of the page section on the
page template.

Vertical (Y) coordinate of the page section on the page
template.

If the page section is a subset page section, then the
subset key value.
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Selection Criteria If all panels are selected, then value is All Page
Templates were selected.

If specific panels are selected, then value is A partial list
of Page Templates was selected.

The following example shows a Page Template Summary Report:

#: Page Template Summary Report

=
for Protocol MEDIKA_CLINICAL

Page Template: ADVY I
Order Usage # Page Section X Y  Subset Value

1 1 COMTEXT 1] 1]

2 2 ADY 0 948

3 3 ADVCOMM o 1908
Page Template: DMG I
Order Usage#t Page Section X hd Subset Value

1 1 COMTEXT 1] 1]

2 3 INWESTIGATOR 0 888

3 4 DMG 0 1624
Page Template: VITAL I
Order Usage#t Page Section X hd Subset Value

1 1 COMTEXT 0 0

2 2 VITAL 0 a90

3 3 MEUROL o 21z

Selection Criteria was: & partial list of Page Templates was selected

Study Book Report

The Study Book Report contains information on study books within the current
protocol, and optionally, contains information on the blocks and study pages
within the study book. You can choose to print the report in three levels of
varying detail.

From the Reports menu, select Display Objects >> Study Books. The Report
Options dialog box opens:
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. Report Options [ %]

Level of Detail

* Summary
" Basic
" Detail

Available Study Books

EMROLL
MEDIKA
SUBJECT_LOCK

OK | Cancel | Selectan || Hep |

You can select one of three levels of detail in which the report will print:
* Summary — Prints only the study book attributes.
» Basic — Prints study book attributes and block attributes.

» Detail — Prints study book attributes, block attributes, and study page
attributes.

Select the study books for which you want to display study book information,
and then click OK. You can select more than one study book, or you can select
all study books by clicking Select All.

The information that appears in the Study Book Report is based on the study
books that you select. For more information on the fields that appear on the
report, see the Design section in Admin and Design.

The following example shows a Study Book Report, in Summary format:

4, Study Book Report [_ o] <]
for Protocol MEDIKA_CLINICAL

Modifiable
Study Book Status Status Study Book Class  Date Modified User Name Description
ENROLL Valid Modifiable Subject Enroliment 11/7/2000 12:48:57  CTSYS
MEDIKA Valid Modifiable Hormal 11/7/2000 124857 CTSYS

Selection Criteria was: & partial list of Studpbooks was selected and level of detail chosen was Summary
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Overview

This chapter describes how Manage works differently in a Multisite
environment, and contains the following sections:

* General information
» Batch loading records in a replication environment

* Coding clinical data in a replication environment

General information

This section contains the following information about Manage in a Multisite
environment:

* Error Log entries in a replication environment

* Auditing data in a replication environment

Error Log entries
in a replication environment

Entries in an Error Log are local to each site. These entries do not replicate to
other sites in the replication environment.

You can only use the Error Log to edit records that are owned by the current site.

Editing data
in a replication environment

You can only edit records that are owned by the current site. Therefore, if you
use Global Change or Global Delete on a set of records that includes records that
are owned by another site, the change or deletion affects only those records that
are owned by the current site.

Validating and merging records

You can only validate and merge records that are owned by the current site.

184  Chapter 12: Manage and Multisite



Auditing data in

a replication environment

In a replication environment, auditing occurs at the audit start point when the
modification to the data is:

* Made at the current site.

* Received, through replication, at the current site.

Records in audit tables are not replicated, and are specific to each site in a
replication environment. Therefore, audit reports may contain different
information and different sites for a single protocol. Trusted data is stored at the
Replication Master site; therefore, the Replication Master site’s audit
information is the most comprehensive.

The following figure shows how auditing occurs in a replication environment. (It
is assumed that the audit start point for the protocol is ENTRY.)

While uploading,
records added to
audit table for
Subject A

While uploading,
records added to
audit table for
Subject B

Replication
Master

While downloading,
records added to

While downloading,

C Owner of Owner of recorgls added to
audit t_able for Subject A Subject B audit tgble for
Subject B Subject A
Edit data in Edit data in
update table for update table for
Subject A Subject B

Records added to
audit table for
Subject B

Records added to
audit table for
Subject A

Auditing in a replication environment
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Batch loading records in a replication environment

This section contains the following information about batch loading records in a
replication environment:

+ Batch loading data into Type 1 to Type 4 panels
* Batch loading data into Type 5 panels
« Batch loading data into Type 0 panels

Batch loading data into Type 1 to Type 4 panels

You can batch load data into Type 1 to Type 4 panels only for subjects that are
owned by the batch-loading site. All the batch-loaded data is owned by the
batch-loading site.

If a record is batch loaded for a subject that is not owned by the batch-loading
site, the record fails the screening process. Then, you must transfer ownership of
the subject to the batch-loading site before you can screen the batch-loaded data.

Batch loading data into Type 5 panels

When you batch load data into Type 5 panels, or enrollment panels, the batch-
loaded data is owned by the current site. The screening process does not transfer
ownership of the data to different sites because the subjects, defined in the Type
5 panel, are enrolled in the protocol at the current site.

Batch loading data into Type 0 panels

When you batch load data into Type 0 panels, the batch-loaded data is initially
owned by the current site. However, the observations for the batch-loaded data
may be owned by different sites in the replication environment.

When you group batch-loaded data, Manage automatically transfers the
ownership of the record to the site that owns the observation.
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Coding clinical data in a replication environment

In a replication environment, you can interactively or automatically code clinical
data for a subject only at the site that owns that subject. You can manage the
coding of clinical data by:

* Coding clinical data interactively or automatically at each site in the
replication environment.

* Coding all clinical data in the protocol interactively or automatically at a
central site in the replication environment.

* Use Oracle Central Coding.

This section contains information about the first two ways of coding clinical data
in a replication environment.

Coding in a replication environment

You can only code clinical data for subjects owned by the current site. To ensure
that clinical data for subjects owned by different sites is coded consistently, you
must create a replication environment for the coding thesaurus protocol that
overlaps the replication environment for the clinical data protocol. Creating an
overlapping replication environment for the coding thesaurus protocol — that is, a
replication environment that includes the same sites as the clinical data protocol
replication environment — ensures that if you modify coding thesaurus data at
one site, those modifications are available when coding at another site.

To ensure consistent coding for a protocol in replication, and to improve the
success of automatic coding, you can add synonyms to the coding thesaurus
protocol. These synonyms then replicate to all the sites where coding occurs, and
therefore improve the performance of automatic coding throughout the
replication environment.

New and modified coding thesaurus data replicates throughout the replication
environment as does all the clinical data for that subject, according to the
replication restrictions that you set.

The following figure shows an example of two overlapping replication
environments: a clinical data protocol replication environment and a coding
thesaurus protocol replication environment. In this example, you code clinical
data at the site where each subject is owned, either Site 1, Site 2, or Site 3. You
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Clinical Data

Protocol (CD):

Replication
Subordinate

Coding
Thesaurus
Protocol (T):
Replication
Subordinate

can add synonyms to the coding thesaurus protocol at any of the four sites, and
these synonyms are made available to the other sites through the replication of
the coding thesaurus protocol.

Clinical Data Protocol (CD): Replication Master

Coding Thesaurus Protocol (T): Replication Subordinate

Clinical Data

Protocol (CD):
Replication
Subordinate

Coding
= = Thesaurus
1 — Protocol (T):
F— S ————— ]
E=————- Replication

Subordinate

O @

I_I_I_l
c I

Coding Thesaurus Protocol (T): Replication Master

Coding throughout a replication environment

Coding at a central coding center

When a central coding center is responsible for coding clinical data in a protocol
that is in a replication environment, you must transfer ownership of a subject to
the central coding center site before clinical data for that subject can be coded.

After clinical data is coded, you can transfer ownership of the subject from the
central coding center site back to the site that originally owned the subject.

The following figure shows an example of a replication environment for a
clinical data protocol (A) with a central coding center. In this example, subjects
are enrolled and clinical data is entered at Site 1, Site 2, and

Site 3. Subjects are transferred to the Coding Site for clinical data coding, then
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transferred back to the original owning site. In this example, there is no need for
the coding thesaurus protocol to be in replication, because it is used only at the

Coding Site.

Protocol A: Replication Master

Transfer Transfer
Ownership to Ownership
Coding Site Back to
L Site 1
A
— ——————————— == =y
oL .. ==
Coding
Transfer Site Transfer
Ownership to Ownership to
Coding Site Coding Site
© =
Transfer f Transfer
Ownership Ownership
Back to Site 2 Code Data Back to Site 3

Replication environment with a central coding center
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Overview

This chapter provides an overview of the Classify’s features and functions. It
introduces terms and concepts used throughout this guide, and suggests how you
might incorporate this module into your work.

This chapter also provides information on preparing to use Classify. It includes
descriptions of the access right and access level assignments that users need to
work in Classify, and recommended system parameter

settings.

For step-by-step instructions on any tasks described in this chapter, see the Help.

Classify in the Clintrial software workflow

What does Classify do?

The Clintrial software Classify module is a Clintrial software extended module
that helps coding experts and dictionary managers:

* Track, review, and find solutions for values that fail automatic coding.

» Examine the contents of a coding thesaurus protocol, and compare different
coding thesaurus protocols.

* Build and test effective thesaurus algorithms.

These specialists can use different Classify features before and after automatic
coding runs in Manage, and before and after creating or modifying coding
thesaurus protocols and thesaurus algorithms in Design.
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The following figure shows Classify’s role in the Clintrial software workflow for
coding:

Manage

Automatic Coding

i

Build and Test Classify Track and Resolve
Thesaurus Algorithms Coding Failures

N

Analyze and Enhance
m Coding Thesauruses

When Classify is installed with the core Clintrial software modules, coding
specialists can improve the accuracy, consistency, and efficiency of automatic
coding.

Ajisse[)

Classify’s objects

In Classify, you can work with three different objects: omission, thesaurus, and
algorithm. Each Classify object corresponds to a branch of automatic coding, as
follows:

* Omission — Helps you track, review, and find solutions for records that fail
automatic coding.

* Thesaurus — Helps you examine and compare the contents of coding
thesaurus protocols.

* Algorithm — Helps you build and test thesaurus algorithms.

Each of these Classify objects is introduced in this chapter.
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Classify and coding omissions

After you create coding thesaurus protocols in Design, you prepare for automatic
coding by batch loading codes and terms into the thesaurus’s views in Manage.
You can enter additional codes and terms for a coding thesaurus protocol in
Enter, which is also the module used to enter clinical data, including values in
verbatim text item fields.

When automatic coding runs in Manage, the Clintrial software attempts to match
the values in verbatim text item fields to the terms and synonyms in thesaurus
views. If the value matches a single term or synonym, a corresponding code is
assigned to the verbatim text automatically.

However, automatic coding can result in two other situations:
* A value does not match any terms.

¢ A value matches several different terms.

In these situations, the values fail to code automatically. In Classify, an omission
record is created for each value that fails automatic coding. The following figure
shows this process:

<

© p—(

7]

% Enter: Manage:

e Clinical Data Entered; Codes and Terms

© Thesaurus Views Loaded into
Maintained Thesaurus Views

Manage:

Automatic Coding Runs

" . Classify:
anagg. Omission Records
Codes Assigned Created

For more information on omissions and omission records, see
Chapter 14.
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Usage scenario

After automatic coding runs in Manage, omission records are created for future
review by a coding expert. As omission records undergo review, a coding expert
may propose solutions for them.

For example, suppose that an omission record is created for an adverse event
field with a value of PHERENGYTIS. To solve this coding problem, any one of
the following solutions could be proposed:

» Change the value of the verbatim text to PHARYNGITIS to correct its
spelling.

* Request more information from the data-entry operator or investigational
site.

* Add PHERENGYTIS to the appropriate thesaurus view as a synonym for
PHARYNGITIS.

After you propose the solution for an omission record, the solution is reviewed
and then accepted. Before it is accepted, a solution can be edited or, if necessary,
cleared completely and replaced with a different type of solution.

When you accept a solution, you initiate one of the following processes:

* Create a new synonym record in a thesaurus view.

Ajisse[)

» Change the verbatim text in a clinical data record.

* Request information by flagging an item or creating a discrepancy record for
it in Resolve.

You can apply both proposed and accepted solutions to other omission records,
as appropriate. The ability to reuse an existing solution minimizes redundancy,
and speeds the coding omission management workflow.

Classify and coding thesaurus protocols

In Design, you set up coding thesaurus protocols and thesaurus views, designate
coding targets in clinical data protocols, and perform other tasks required for
automatic coding. You then use Manage to batch load codes and their
corresponding terms into the thesaurus’s views.

Classify enhances automatic coding by helping you examine the codes and terms
in a coding thesaurus protocol. It allows you to:
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e Search for any code or text in a coding thesaurus protocol.

* Produce a report of terms that are included in a coding thesaurus protocol
more than once; that is, the same term is present with different codes or is
included in different views.

* Produce a report that compares the terms in two different coding thesaurus
protocols, and also displays either terms that are found in both thesauruses or
that are found in only one of them.

Before a coding thesaurus protocol is used for automatic coding, Classify allows
you to identify terms or codes that may result in coding problems, and then make
any necessary modifications in Enter. The following figure shows this process:

Design:
Thesaurus Set Up

1

Manage:
Code/Term Pairs
Batch Loaded

Classify:
Thesaurus Examined
and Problems
Identified

Enter:
Coding Thesaurus
Protocol Modified

Classify and thesaurus algorithms

In Design, you create thesaurus algorithms by selecting a series of
transformations, which make a specific change to a verbatim value, and lookup
steps, which attempt matches to a term in a thesaurus view. Thesaurus
algorithms are used during automatic coding to increase the likelihood of a
match between the value entered by a user in Enter and a term that exists in the
coding thesaurus protocol.
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To enhance the effectiveness of your thesaurus algorithms, Classify provides 16
additional transformations. When you set up a thesaurus algorithm in Design,
you can choose any of the Classify transformations, in addition to the standard
Clintrial software transformation and lookup steps.

Some of Classify’s transformations require a list of support elements. For
example, if you use the Replace Words transformation in a thesaurus algorithm,
you also need to define the words that you want to replace and their
replacements. You maintain these transformation support elements in Classify.

After you create a thesaurus algorithm, you can use Classify to test it.

The following figure shows this process:

Classify:
Transformations
Added

1

Design:
Thesaurus Algorithm
Created/Modified

{

Classify:
Support Elements
Maintained

1

Classify:
Thesaurus Algorithm
Tested
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Required access rights and access levels for Classify

What are access rights and access levels?

An access right is a predefined set of Clintrial software activities that can be
associated with a usergroup or a user. An access level determines what type of
access the user has to the activities defined by an access right. Classify is
installed with a complete set of access rights and access levels.

What are the Classify access rights?

Your system administrator can assign Classify access rights to the coding experts
and dictionary managers who perform activities supported by this module. The
Classify access rights are as follows:

* Propose is a non-protocol access right that gives users access to Classify’s
omission records, and allows users to propose solutions for them.

» Accept is a non-protocol access right that gives users access to Classify’s
omission records, and allows users to accept solutions for them.

* Thesaurus is a protocol access right that gives users access to specific coding
thesaurus protocols and their thesaurus algorithms in Classify.
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» Enter/Merged is a protocol access right that, when applied to a thesaurus
protocol, allows users to modify or delete synonyms.

In addition, Design’s System non-protocol access right is required to give users
access to Classify’s thesaurus and algorithm objects.

System administrators make access assignments in Admin.

Types of Classify access rights and access levels

Users who are assigned an access level of Full or Read for a Classify access right
can perform specific tasks in Classify. The following table lists the privileges
corresponding to each Classify access right and access level:
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Access right:  Access level: User can:

Propose Full * Review omission records.
* Propose solutions.
» Edit proposed solutions.
*  Clear proposed solutions.
* Reuse solutions.

Read Review omission records.
Accept Full * Review omission records.
*  Accept proposed solutions.

»  Purge solved and obsolete omission records.

NoDel * Review omission records.
*  Accept proposed solutions.

Read Review omission records.
Thesaurus Full » Search for terms or codes in a coding thesaurus
protocol.

* Run thesaurus reports.

Ajisse[)

*  Test thesaurus algorithms.
» Edit support elements for transformations.
* Use Configuration menu commands.

Read »  Search for terms or codes in a coding thesaurus
protocol.

*  Run thesaurus reports.
+  Test thesaurus algorithms.

Enter/Merged  Full *  Modify synonyms.
* Delete synonyms.
*  Create thesaurus synonym solutions.
*  Propose synonym solutions.
* Accept synonym solutions.

NoDel *  Propose synonym solutions.
*  Accept synonym solutions.

Read *  Propose synonym solutions.
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To prevent access to Classify’s functions, your system administrator can assign
users an access level of “-” or null for all Classify access rights. This is the
default access level for all Classify access rights.

Assigning an additional access right in Design

Before a user can access Classify’s thesaurus and algorithm objects, Design’s
non-protocol System access right must be assigned with an access level of Read
or Full. Only users with this access right can review coding thesaurus protocols
and thesaurus algorithms in Classify.

To perform any additional processing in Classify for a coding thesaurus protocol
or its thesaurus algorithms, Classify’s Thesaurus access right must also be
assigned with the Full or Read access level. This access right is protocol-
specific.

For more information on access rights and access levels, see the Admin section
of Admin and Design.

Parameters for automatic coding

How the Classify parameters work

Three Classify-specific system parameters, which system administrators set in
Admin, how you work in Classify, as follows:

« CTG_ALLOW_CHANGEVERB determines whether the Propose Solution
>> Change Verbatim menu item is enabled. The default is Yes. If you reset
it to No, this command will be suppressed, and coding experts will be unable
to propose Verbatim solutions.

* CTG_AUTOACCEPT determines whether the system automatically accepts
proposals defined by any user whose access level is Full for the Propose
access right, and either Full or No Delete for the Accept access right. The
default is No. If you reset it to Yes, you will speed the omission resolution
process, but forfeit the chance to review proposals before you finalize them.

* CTG_EDIT_SYNTEXT determines whether coding experts can edit
normalized text strings before saving them as synonyms. The default is No.
If you reset it to Yes, some Synonym solution omission records may fail to
code successfully.
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How the Classify user preferences work

The following eight user preferences can be set by the user:

CTG_PANEL RESTRICT restricts the omissions displayed in the Omission
Browser to those from a specified list of panels. The list of panels is entered
into the preferences field and panel names must be separated by commas.
The resulting SQL clause restricting the panels appears in the Server
Restriction field in the Omission Browser.

CTG_PROT RESTRICT restricts the omissions displayed in the Omission
Browser to those from a specified list of protocols. The list of protocols is
entered into the preferences field and protocol names must be separated by
commas. The resulting SQL clause restricting the protocols appears in the
Server Restriction field in the Omission Browser.

CTG_THES RESTRICT restricts the omissions displayed in the Omission
Browser to those from a specified list of thesauruses. The list of thesauruses
is entered into the preferences field and thesaurus names must be separated
by commas. The resulting SQL clause restricting the thesauruses appears in
the Server Restriction field in the Thesaurus Browser.

CTG_GENERAL RESTRICT restricts the omissions displayed in the
Omission Browser to those that are returned by a SQL restriction clause. The
SQL restriction clause is entered into the preferences field and it appears in
the Server Restriction field in the Omission Browser. Use of this preference
requires knowledge of table and column names and SQL syntax, and should
only be used when the CTG_ PANEL- RESTICT, CTG_PROT RESTICT or
CTG_THES- RESTICT preferences are insufficient.

CTG_QUICK PROPOSE determines if the Proposed Solution dialog box is
closed automatically after changes are saved. The default is Yes. If set to No,
the dialog box remains displayed after performing a Save operation.

CTG_REPORT LIMIT restricts the number of results included in a report
search. The default is 100. If the number of results exceeds the default value,
the system displays a message that some results are not shown.

CTG_SEARCH_LIMIT restricts the number of results returned in a
thesaurus search. The default is 100. If the number of results exceeds the
default value, the system displays a message that some results are not shown.

CTG_SEARCH_WARNING determines if a dialog box is displayed before
performing a text search with a wildcard as the leading character, warning
that the search may tie up the computer for a significant amount of time. The
default is Yes.

Parameters for automatic coding 203
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How the Manage parameters work

Two other parameters regulate the automatic coding process in Manage. The
settings that you choose for these parameters affect Classify’s omission
management functionality, as follows:

* AUTOCODE SET FAIL is a system parameter. If No, automatic coding
sets the workflow item value to AUTO for every record that is processed,
regardless of the outcome of automatic coding. If Yes, the workflow item
value is set to AUTO for records that code successfully and to FAIL for those
that do not.

« AUTOCODE RECODE ALL is a protocol parameter. If No, automatic
coding attempts to assign codes only to records that have never been
processed (that is, with a workflow item value of null). If Yes, automatic
coding is attempted on all records, including those that previously coded
successfully or that failed to code (that is, the workflow item value is AUTO,
INT, FAIL, or null), subject to the setting for that protocol’s Override Coding
attribute.

For more information on these parameters, see the Admin section of Admin and
Design.

How the Override Coding attribute works
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Your study designer sets the Override Coding attribute in Design for each
clinical data protocol. For protocols with the AUTOCODE- RECODE ALL
parameter set to Yes, this attribute controls whether records that have been
interactively coded (workflow item value is INT) are included when automatic
coding runs.

*  When the Override Coding check box is checked, interactively coded records
are included in automatic coding. This setting can help ensure standardized
coding after you make changes to your coding thesaurus protocols and
thesaurus algorithms.

*  When the Override Coding check box is cleared, interactively coded records
are not included in automatic coding. This setting prevents interactively
assigned codes from being overridden automatically, and can improve
system performance during automatic coding.

For more information on the Override Coding attribute, see the Admin section of
Admin and Design.
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Manage parameters and Classify

The settings that you select for the AUTOCODE _SET FAIL and
AUTOCODE_RECODE_ALL parameters affect both the omission records that
are created, and the results of applying solutions to omission records in Classify.

When you install Classify, the following settings are recommended for these

parameters:
Parameter: Recommended setting:
AUTOCODE_SET FAIL Yes

AUTOCODE RECODE ALL  Yes

If the AUTOCODE RECODE ALL parameter is set to No, automatic coding
cannot complete processing for omission records when you accept proposed
solutions.

The recommended setting for AUTOCODE _RECODE_ALL is Yes; therefore,
records that previously coded successfully are included when automatic coding
runs. To eliminate processing redundancy and improve performance, you can
include a SQL clause in the SQL Restriction field when you initiate automatic
coding. This option is described in the following section.
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How a SQL restriction works with Classify

In addition to setting the two Manage parameters as described in the previous
section, you can include a SQL clause to select a subset of records when you
initiate automatic coding in Manage.

When Classify is installed and the AUTOCODE_RECODE_ALL protocol
parameter is set to Yes, a SQL clause that limits records processed by automatic
coding to those that have not been processed before (workflow item value of
null) and those that failed automatic coding (workflow item value of FAIL) is
recommended. For example, include the following clause in the SQL Restriction
field:

NVL(workflow_item, 'FAIL") = ‘FAIL’

While not required, you can improve the efficiency of automatic coding by
including this or a similar SQL clause.
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Note: To run automatic coding for all records in a protocol, check the Override
Coding check box and do not include a SQL restriction clause. For example, you
could process all records in this way after you add new terms or synonyms to a
coding thesaurus protocol, or modify a coding thesaurus algorithm.

For more information on using a SQL restriction clause in automatic coding, see
Chapter 13.
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Omissions and omission records

What is an omission?

When automatic coding runs in Manage, coding is attempted for every verbatim
text item field in a coding target (subject to the parameter settings described in
Chapter 13). An omission is a term or phrase that does not successfully match a
single term in a coding thesaurus protocol during automatic coding.

What is an omission record?

Each instance in which automatic coding fails results in a uniquely identified
omission record. You use omission records to track, review, and find solutions
for values that fail automatic coding.

How are omission records created?

Omission records are created when automatic coding runs in Manage and the
following occurs:
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» Text in the verbatim text item field of the coding target does not match any
terms in the coding thesaurus protocol.

* There are multiple matches for the text in the verbatim text item field.
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In either of these situations, Manage cannot assign a code automatically and an
omission record is created:

Automatic Coding
Runs

Automatic Coding Omission Record
Fails Created

Only One
Match?

Yes

Automatic Coding
Succeeds
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Note: Automatic coding does not create an omission record if the verbatim text
item field has a null value. Automatic coding does create an omission record if
the verbatim text does not have a null value, but the text normalizes to null.

Managing omission records

How managing omission records works

Once automatic coding creates omission records, you use Classify to track,
review, and solve them.
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The following figure shows the Classify workflow for omission records:

Review Omission
Record

!

Propose Solution

{

Create Omission Review Proposed
Record Solution

{

Accept Solution

{

Automatic Coding
Runs

Edit or Clear Solution
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Coding

End
Succeeds?

What are omission statuses?

To help you track the progress of an omission record through this workflow and
find a solution efficiently, Classify assigns a series of omission statuses to each
omission record.
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In the following figure, the shaded elements indicate the omission statuses that
correspond to different points in your omission record management workflow:

Review Omission
Record  [T°7°°7° a

l Obsolete
Needs

Proposal i
Propose Solution |feeeo--t

Solution l
Proposed |~~~ T

Review Proposed
Solution

Create Omission
Record l

Accept Solution

Solution l
Applied |~ 7T

Automatic Coding
Runs
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Coding
Succeeds?

End

Note: The Solution Pending omission status, which is not shown in this figure,
can also be assigned in certain circumstances.

Omission statuses are assigned automatically based on your actions in Classify
and the results of coding in Manage.
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Classify’s omission statuses

The following table describes Classify’s omission statuses:

Status:

Description:

Needs
Proposal

Solution
Proposed

Solution
Pending

Solution
Applied

Solved

Obsolete

Error

Indicates an omission record at the beginning of the Classify workflow.
Automatic coding generally creates omission records with this status.
Also assigned when you clear a proposed solution in Classify.

Indicates that your review of an omission record resulted in a possible
solution. Assigned when you propose a solution in Classify.

For more information on proposing solutions, see Chapter 15.

Indicates that the proposed solution has been only partially implemented
because this is a Multisite environment, and automatic coding has not yet
been run at the autocoding site.

Indicates that the proposed solution for an omission record is valid.
Assigned when you accept a proposed solution in Classify.

For more information on accepting proposed solutions, see Chapter 16.

Assigned by automatic coding to omission records with a Solution
Applied status. Indicates that automatic coding now succeeds for a
verbatim text item that previously resulted in an omission record, or that
the omission record is no longer valid.

For additional details on how this omission status closes omission
records, see Chapter 16.

Assigned to Needs Proposal or Solution Proposed omission records that
are no longer valid.

For additional details on how this omission status closes omission
records, see Chapter 16.

Assigned if processing was interrupted by an unexpected event, such as a
system failure, so the change to the verbatim text, creation of a
discrepancy record, or application of a flag did not occur. This status is
relevant only to Multisite users who are processing records at
noncolocated sites. Otherwise, Classify simply displays an error message
if an anticipated change cannot be implemented.
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For more information

For more information on how to review omission records and their proposed
solutions, see the following section.

For more information on proposing and changing solutions, see
Chapter 15.

For more information on accepting proposed solutions, see Chapter 16.

For step-by-step instructions on any tasks described in this chapter, see the Help.

Reviewing omission records

In Classify, you can review omission records in two ways:

» The Omission Browser summarizes omission records as rows on a window
display.

» The Details for Omission window shows data for a single omission record.
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How to open the Omission Browser

To open the Omission Browser, from the Objects menu, select Omission, or
click the Omission button on the toolbar. The Omission Browser opens,
displaying omission records for the entire database instance:

# Omission Browser - All (1B866)

Filter: | |
Server Restriction: | |
Omission Id Verbatim Text Stalus Solution Type |Solution Text Thesaurus Algorithm Protocol Panel ﬂ
19230003 Robitussin Meeds Proposal  None DORUG_THESAURUS CTS$DEFAULT MEDIKA_CLINICAL PRYMED
19240003 asprin Meeds Proposal  Mone DRUG_THESAURUS CTS$DEFAULTMEDIKA_CLINICAL PRYMED |
1 | 2y

The following table describes the information provided in the Omission

Browser:
Column: Description:
Omission Id The unique identifying number for the omission record.
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Column: Description:

Verbatim Text The literal value stored in the clinical data record’s verbatim text
item field.

Status An omission status that helps you track your progress in finding a
solution. Contains one of the following automatically assigned
statuses:

* Needs Proposal

*  Solution Proposed
* Solution Pending
*  Solution Applied

e Solved
e Obsolete
e Error

For more information, see "Classify’s omission statuses" on page
212.

Solution Type For omission records with a Needs Proposal status, None displays.
Otherwise, displays one of the following solution types:

* Synonym
*  Verbatim
* Request
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For information on proposing solutions, see Chapter 15.

Solution Text Blank for omission records with a Needs Proposal status. Otherwise,
displays information about the omission record's solution as follows:

« Ifthe Solution Type is Request, its Message value
displays.

« Ifthe Solution Type is Synonym, its Synonym Text value
displays.

« Ifthe Solution Type is Verbatim, its Verbatim Text value
displays.

For information on proposing solutions, see Chapter 15.

Thesaurus The name of the coding thesaurus protocol used to code the verbatim
item during automatic coding.

Algorithm The name of the thesaurus algorithm used to normalize the verbatim
item during automatic coding.

Protocol The name of the clinical data record’s protocol.
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Column:

Description:

Panel

Verbatim Item
Creation Date
Modification
Date

Modified By

Subject

Block

Own

The name of the clinical data record’s panel.

The name of the field in the clinical data record that contains the
value that did not code automatically.

The date and time the omission record was created.

The date and time of the last change to the omission record; that is,
when its solution was proposed, edited, cleared, or accepted.

User name of the user who performed the last modification on this
omission record.

The subject context item of the clinical data record whose verbatim
text did not code automatically. For records on
Type 0 panels, this item is null.

The block context item of the clinical data record whose verbatim
text did not code automatically. For records on
Type 0 panels, this item is null.

Note: This column displays the values stored in the Details for
Omission window’s Visit field.

Whether the omission record is owned by the current site. Blank
indicates no; the record is accessible only in Read mode.

Note: Omission records for the entire database instance display in the Omission
Browser. Classify does not require you to select a specific protocol.

How to select an Omission Browser view

By default, only records that need a proposed solution (those with the Needs
Proposal omission status) display when you open the Omission Browser.
However, to review omission records more efficiently, you can limit the display

to:

» Omission records with a particular status.

» Sets of omission records restricted by panel, protocol or thesaurus, or with a
general SQL statement, by using one of the Classify user preferences.
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Note: Restricting the number of displayed omission records is useful when the
total number of records is so large that an inordinate amount of time is required
to retrieve and display them all.

To review different subsets of omission records based on their corresponding
omission statuses, you can select one of the following View menu commands:

* Needs Proposal

* Solution Proposed
* Solution Pending
e Solution Applied
* Solved

* Obsolete

You can also select the View menu’s All command to display all omission
records, regardless of their omission status.

Subsets of omission records can be created with the CTG_PANEL- RESTICT,
CTG_PROT RESTICT and CTG_THES RESTICT user preferences. These
preferences restrict the source panels, source protocols, or source thesauruses
from which the omission records are selected. A general SQL statement can also
be supplied using the CTG_ GENERAL RESTRICT preference to limit the
number of displayed records. The resulting SQL restriction clause generated by
any or all of these preference values appears in the Server Restriction field of the
Omission Browser. For more information on the Classify user preferences see
Chapter 13.
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Note: If a Filter restriction is also used, the intersection of the Filter and the
Server Restriction clause applies.

Once you select the initial set of records for the Omission Browser, you can:
* Rearrange the records by modifying the sort specifications.

* Change the order and width of the Omission Browser’s columns.

Your column layout, sort criteria, and filter string are automatically saved and
reused the next time you open the Omission Browser.

For information about views, filtering, sorting, and the layout revision options,
see the Help.
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How to open the Details for Omission window

The Details for Omission window provides additional information about one
omission record. To open the Details for Omission window for a particular
record, use one of these methods:

* In the Omission Browser, select a row. From the Omission menu, select
Show Details.

* In the Omission Browser, select a row, then click the Shows Details icon on
the Omission Browser toolbar.

* In the Omission Browser, double-click a row.

The following example shows the Details for Omission window:

& Details for Omission 12880003
~Coding Information
Thesaurus: [ART_THESAURUS | Algorithm: [CTS$DEFAULT |
Languag ENGLEH |
Protocol: [MEDIKA43_KIT | Panel: [MEDHIST |
Subject JANAT 07 | Visit: ] |
Verbatim ltem:  [CONDITION | Codel item: [CODE1_ART | Q
Verbatim Text  |head pain | %
Normalized Text. [HEAD PAIN | .
CT_ReclD: [2.50LLOAD.OBXS;02.002 | Own | ‘?
rSolution Information
Status: [Needs Proposal | Solution Type:  [None |
1 | 2

This window consists of two sections. The top section displays the omission
record’s coding information, and the bottom section displays the omission
record’s solution information. The fields in the coding information section do not
vary, however, the fields in the solution information section vary depending on
the type and status of the omission.

List of coding information fields

The following table lists the fields in the Coding Information section of the
Details for Omission window:

Field: Description:

Thesaurus The coding thesaurus protocol used to code the verbatim text.
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Field:

Description:

Algorithm

Language

Protocol

Panel

Subject

Visit

Verbatim Item

Codel Item

Verbatim Text

Normalized Text

CT ReclD

The thesaurus algorithm used to normalize the verbatim text
during automatic coding.

The designated thesaurus language.

The protocol of the clinical data record that has a verbatim text
item value that did not code automatically.

The panel for the clinical data record that has a verbatim text
item value that did not code automatically.

Subject context item of the clinical data record that has a
verbatim text item value that did not code automatically. For
records on Type 0 panels, this item is null.

Visit number of the clinical data record that has a verbatim text
item value that did not code automatically. For records on Type 0
panels, this item is null.

The clinical data record field, identified as the verbatim text item
of a coding target, that has a value that did not code
automatically.

The name of the coding target item that stores the code when
assigned.

The literal phrase or term that did not match a single term or
synonym in the coding thesaurus protocol, and therefore could
not be coded during automatic coding.

The phrase or term that resulted from applying the Codel item’s
selected thesaurus algorithm to the verbatim text.

The unique ID number of the clinical data record that has a
verbatim text item value that did not code automatically.
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List of solution information fields

The following table lists the fields in the Solution Information section of the
Details for Omission window:

Field:

Description:

Status

Solution Type

The following omission statuses help you track your progress in
finding a solution for an omission record:

* Needs Proposal

*  Solution Proposed
* Solution Applied
* Solution Pending

* Solved
* Obsolete
*  Error

For more information, see "Classify’s omission statuses" on page
212.

The solution for an omission record can be:
*  Synonym

*  Verbatim

*  Request

*  None

The solution type None displays when the omission record has a
Needs Proposal status.

Depending on the solution type you select for an omission record, additional
fields may display in the Solution Information section.

For more information on proposing solutions, see Chapter 15.

How to print omission record information

You can print the data that displays in the Omission Browser or Details for
Omission window. To send information displayed in the active window to a
printer, from the File menu, select Print.

» For the Omission Browser, selecting Print produces the list of omission
records that display in the browser.

* For the Details for Omission window, selecting Print produces a detailed
report of the information on file for that omission record.
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Proposing solutions for omission records

Types of solutions

After you review an omission record, you can propose one of the following types
of solutions for it:

* Synonym — Create a new synonym
* Verbatim — Change the verbatim text

*  Request — Request more information

The sections in this chapter describe the activities you perform in Classify to
propose each of these types of solutions for your omission records. For step-by-
step instructions on specific tasks, see the Help.

By default, when you propose a solution, only the omission record is updated.
Changes to clinical data records (and thesaurus protocols, in the case of
Synonym solutions) are delayed until after the proposal is accepted. For more
information on accepting proposed solutions, see Chapter 16.

Note: You can use Classify’s procedure for proposing and accepting solutions
instead of, or in addition to, interactive coding in Manage.

Ajisse[)

Support for one-step processing

If you reset Classify’s CTG_AUTOACCEPT parameter to Yes, then every
solution you propose will be simultaneously accepted. This option is available
only if you have the Full access level for the Propose access right, and either the
Full or No Delete access level for the Accept access right (the same access rights
and access levels are required to perform both tasks individually, as explained in
Chapter 13).

Note: Because it is difficult to undo changes once they are propagated to the
underlying data records, it is generally best to retain the default setting (No).
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Creating synonyms

What is a synonym?

A synonym is a record in one of a coding thesaurus protocol’s synonym views. In
the Clintrial software, synonyms consist of a code and a description. In each
coding thesaurus protocol, a terms view stores the standard, industry-accepted
terms and their corresponding codes, while approved variations of the terms for
each code are stored in one or more synonym views.

An entry in a synonym view consists of a code from a terms view and a synonym
for that code’s term. The following table lists the term and synonyms that
correspond to a specific example code:

View: Description: Code:
Terms ERYTHEMATOSQUAMOS DERMATOSIS 690
> Synonym SEBORRHEIC ECZEMA 690
o
‘@
% Synonym DANDRUFF 690
@)
Synonym SEBORRHEIC DERMATITIS 690

In this example, code 690 has a single official definition, the term
ERYTHEMATOSQUAMOS DERMATOSIS. However, three additional,
equivalent descriptions of this medical condition are on file as synonyms,
corresponding to the same code.

Why create a synonym?

When automatic coding runs in Manage, the likelihood that a matching code will
be found for the value in a verbatim text item field improves when synonyms are
on file in the coding thesaurus protocol.

Using the previous example, if the coding target contains SEBORRHEIC
ECZEMA, DANDRUFF, or one of the other descriptions, when automatic
coding runs, it succeeds and code 690 is assigned. If no synonyms are on file for
code 690, automatic coding fails for clinical data records with a value of
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SEBORRHEIC ECZEMA, DANDRUFF, or SEBORRHEIC DERMATITIS, and
succeeds only for records with a value of ERYTHEMATOSQUAMOS
DERMATOSIS.

In Classify, an omission record may indicate that a valid variation of a
synonymous term has not yet been identified as a synonym and filed in one of
the coding thesaurus protocol’s synonym views. If you create a new synonym,
you solve:

* The current omission record

e All other omission records with the same verbatim text

This solution type also ensures that automatic coding will succeed whenever the
same synonymous term is encountered in the future.

Note: When you accept a proposed new synonym in Classify, automated coding
runs on affected clinical data records. However, if you add new synonyms in
Enter, automatic coding does not run until you initiate it manually. For more
information about accepting synonym solutions, see Chapter 16.

A synonym can also be added to an omission record that already has another
solution type associated with it, or to a record that needs a solution proposal,
without changing the record’s solution status. For more information, see
"Adding a synonym" on page 245.
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How to create a synonym

To propose a solution with the Synonym solution type:

1. Inthe Omission Browser, select an omission record with a Needs Proposal
status, or open the Details for Omission window for that particular omission
record.

2. From the Omission menu, select Propose Solution >> Create
Synonym, or click the corresponding toolbar icon.
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The Create Synonym Solution for Omission dialog box opens:

M Create Synonym Solution for Omission 12880003 H[=] 3
Verbatim Text: head pain |
Normalized Text: HEAD PAIN |

—Search Criteria
Text to be Matched: head?% |
C Autocode ¢+ Search Thesaurus

Autocode Criteria————————————— Search Thesaurus Criteria
’7 ’75. by Taxt ‘ Search |

Algorithm: ICTS$DEFAULT L] ¢ by Code v Advanced Search

Matching Terms and Synonyms

Code View Dictionary Term Search Info
C HEADACHE ¥ not found

sE} —Solution Information

A New Synonym Text |HEAD PAIN |
&

— 4 -

O New Synonym View: [SYNONYMS ~|

Comments: | |

Note: Autocoding is attempted before this dialog box opens. If matches are
found, they display in the Matching Terms and Synonyms list.

For step-by-step instructions on how to use this dialog box to propose a new
synonym, see the Help.
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Synonym attributes

After you select Create Synonym and propose a new synonym as the solution
for an omission record, the Details for Omission window

opens:

& Details for Omission 12880003

-Coding Information
Thesaurus: [ART_THESAURUS | Algorithm: [cTssDEFAULT |
Languag [ENGLISH ]
Protocol: |MEDIKA43_KIT | Panel: MEDHIST |
Subject: [ANAT07 | Visit: o |
Verbatim ltem: |[CONDITION | Codel Hem: |CODE1_ART |
Verbatim Text: head pai |
Normalized Text [HEAD PAIN |
CT_ReclID: [2.SQLLOAD.OBXSi002.002 | Own ]

rSolution Informati
Status: [Solution Proposed ] Solution Type:  [Synonym |
Synonym Text:  [HEAD PAIN | O
Synonym View: [SYNONYMS | Code: |[HEADACHE.1.BODY. | =
Source Text: [HEADACHE | A
Source View: [TERMS | =
Dictionary Term: [HEADACHE | <
Comment: | |

4 I 2|

The following table describes the fields in the Details for Omission window’s
Solution Information section for omission records with a proposed Synonym
solution type:

Field: Description:

Status Solution Proposed. For more information on omission statuses,
see Chapter 14.

Solution Type Synonym.
Synonym Text The description that you propose for the new synonym.
Synonym View The thesaurus view to which your new synonym will be added.

Limited to synonym views.
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Field: Description:

Code The code of an existing term that you want to associate with your
proposed synonym text.

Source Text The term that is currently on file for the selected code.

Source View The thesaurus view in which the selected code was found; this
view can be a terms or synonym view.

Dictionary Term The description in the coding thesaurus protocol’s terms view
that corresponds to the selected code.

Comment User-defined text describing your reason for creating this new
synonym.

Synonym Details
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Viewing synonym details

Autocoding or performing a thesaurus search in the Create Synonym Solution
for Omission dialog box often produces more than one result in the Matching
Terms and Synonyms list. To assist in selecting which of the listed synonyms to
propose as a solution, additional details about a highlighted result can be viewed
by selecting Details from the Synonym menu before proposing the result as a
synonym solution.

The Synonym Details window includes large fields capable of displaying the full
text of the synonym’s attributes, including the Synonym Code, Dictionary Term,
and Synonym Text.

The content of the window will vary depending on whether the thesaurus is
extended. For example, if the MedDRA extended thesaurus protocol is used, the
window includes the Preferred Term (PT), High Level Term (HLT), High Level
Group Term (HLGT), and System Organ Class (SOC) fields.
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The following shows a Synonym Details window for a synonym from a
nonextended thesaurus protocol:

Thesaurus: P\RT_WESAURUS | View: I'I'ERMS |
Creation Date: |11-NOV-1 995 14:52 | Creator- FTSYS |
Code: FEADACHE,LBODY |
Term: HEADACHE

Dictionary Term: [HEADACHE

The following table describes the fields in the Synonym Details window for a
synonym from a nonextended thesaurus protocol:

Field: Description:
a
Thesaurus The thesaurus protocol containing the selected synonym. ()
2,
View The thesaurus view in which the selected synonym was found,; Q”

this view can be a terms or synonym view.

Creation Date The date when the creator entered the selected synonym into the
coding thesaurus.

Creator The user who created the selected synonym.

Code The code of an existing term that is associated with the selected
synonym text.

Term The term that is currently on file for the selected code.

Dictionary Term The description in the coding thesaurus protocol’s terms view
that corresponds to the selected code.
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Decodes:

WHO drug dictionary synonym details

If the selected synonym is contained in the WHO drug dictionary extended
thesaurus protocol (GCT _WHODD), a Synonym Details window displays the
WHO drug dictionary information:

Thesaurus: PCT_WHODD | View: FJRMTERMS_‘I PARTCODE |
Creation Date: FZ—JUN-ZDOB 10:45 | Creator: FTSYS |
Code: PDGU3TU1 003 |
Term: MODUSTATINE

Dictionary Term: |[MODUSTATINE

Desig: T Non-Proprietary Name: FOMATOSTA“N

Manufac: PLlN'MlDY |
Added: |:| Source Year:

Source Decoded: France |
ATC Codes and HO1CB:ANTIGROWTH HORMONE

The following table describes the fields in the Synonym Details window for a
synonym from the GTC_WHODD extended thesaurus protocol. The following
fields are in addition to those fields displayed in the non-extended Synonym

Details window:

Field:

Description:

Desig

Non-Proprietary
Name

Manufac

A code indicating if the synonym is a trade name or a multiple-
ingredient drug.

The non-proprietary name of the drug.

The manufacturer of the drug.
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Field:

Added

Source Year

Source Decoded

ATC Codes and
Decodes

Description:

The year and quarter that the drug was added to the dictionary.
The source year of the drug.
The decoded source text.

A list of ATC codes and the decoded source text.

MedDRA thesaurus synonym details

& Synonym Details (MedDRA) [ [=] 3 @)

—

Thesaurus: |GCT_MEDDRA | View: |LLT_NORMAL | %
@

Creation Date: |1 8-AUG-200013:22 | Creator: |CTPROC | &

Code: |1 0019211 |

Term: HEADACHE

Dictionary Term:  [Headache

Preferred Term:  [Headache NOS

High Level Term: [Headaches NEC

High Level Group
Term:

Primary System
Organ Class:

Number of SOCs:

If the selected synonym is contained in the MedDRA extended thesaurus
protocol (GCT_MEDDRA), a Synonym Details window displays the MedDRA-
specific information:

Headaches (all forms)

[Nervous system disorders

[ 1
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The following table describes the fields in the Synonym Details window for a
synonym from the GCT _MEDDRA extended thesaurus protocol. The following
fields are in addition to those fields displayed in the non-extended Synonym
Details window:

Field: Description:

Preferred Term The Preferred Term (PT) for the synonym.

High Level Term The High Level Term (HLT) for the synonym.

High Level Group  The High Level Group Term (HLGT) for the synonym.
Term

Primary System The Primary System Organ Class (SOC) for the synonym.
Organ Class

Number of SOCs The number of potential SOCs for the PT.

For more information on extended thesaurus protocols, see "What is an extended
thesaurus protocol?" on page 258.
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MedDRA Hierarchy Browser

If a selected synonym in the Matching Terms and Synonyms box

of the Create Synonym Solution for Omission dialog box is from the
CTG_MEDDRA extended thesaurus protocol, the MedDRA Hierarchy Browser
can be viewed. This browser is only available for synonyms

in the CTG_MEDDRA extended thesaurus protocols, and it works only for
algorithms based on GCT _MEDDRA views with CODE1 = LLT CODE.
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To open the MedDRA Hierarchy Browser, from the Synonym menu, select
MedDRA Browser:

#: MedDRA Hierarchy Browser

Low Level Cephalalgia ar cephalgia

Terms: Farehead headache
Fullness head
Headache discomfon

Headache fullness
Headache occuning
Mocturnal headache

Pounding in head L'
High Level narme for 100159233
Terms:
High Level sadaches (all forms)
Group Terms
System Organ tern disorders
Class Terms:

Ajisse[)

The following table describes the fields in the MedDRA Hierarchy Browser:

Field: Description:

Low Level Terms A list of Low Level Terms (LLT) for the Preferred Term (PT).

High Level Terms A list of High Level Terms (HLT) related to the selected LLT.
Selecting different LLTs produces different lists of associated
HLTs.

High Level Group A list of High Level Group Terms (HLGT) related to the selected

Terms HLT. Selecting different HLTs produces different lists of
associated HLGTs.

System Organ A list of System Organ Class (SOC) Terms related to the selected

Class Terms HLGT. This field usually contains only one SOC term.

For more information on extended thesaurus protocols and the GCT _MEDDRA
and GCT_WHODD extended thesaurus protocols, see "What is an extended
thesaurus protocol?" on page 258.
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Changing verbatim text

What is verbatim text?

Verbatim text is the value entered by the user in a clinical data record’s verbatim
text item field. This value is recorded in every omission record.

Why change verbatim text?

When you review an omission record, you may find a straightforward

explanation for why it did not code automatically: a misspelling, abbreviation, or
typographical error may be evident when you examine the omission record. For
example, if a record fails automatic coding and the resulting omission record has
the verbatim text GLUACOMA, you may decide to change it to GLAUCOMA.

Note: When you propose a change to verbatim text in Classify, you can reuse
the same solution for other omission records. However, if you edit the clinical
data record in Enter, this feature is not available. For more information about
reusing verbatim solutions, see "Reusing and propagating solutions" on page
239.
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How to change verbatim text

To propose a solution with the Verbatim solution type:

1. In the Omission Browser, select an omission record with a Needs Proposal
status, or open the Details for Omission window for that particular omission
record.

2. From the Omission menu, select Propose Solution >> Change
Verbatim, or click the corresponding toolbar icon.
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The Change Verbatim for Omission dialog box opens:

4 Change Yerbatim for Omission 12870003 HE
Verbatim Text Eaj’akg
Normalized Text: lEARAKE

—Search Criteria
Text to be Matched: |ear ache |

& Autocode

" Search Thesaurus

Algorithm:  [CTS$DEFAULT |

& by Text
by Code ¥ Advanced Search

’7Autocode Criteria

’—Search Thesaurus Criteria

Matching Terms and Synonyms

Code Term
EAR ACHE

2|

View Dictionary Term Search Info
notfound in TERMK I not found

Replacement Text:

EARACHE |

—Reason for Change
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erbatim text not spelled carrectly.

Note: Autocoding is attempted before this dialog box opens. If matches are
found, they display in the Matching Terms and Synonyms box.

For step-by-step instructions on how to use this dialog box to propose a change
to the verbatim text, see the Help.
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Verbatim attributes

After you select Change Verbatim and propose a different verbatim text value
as the solution for an omission record, the Details for Omission window opens:

& Details for Omission 12870003
~Coding Information
Thesaurus: [ART_THESAURUS | Algorithm: [CTS$DEFAULT |
Language: [ENGLISH |
Protocol: [MEDIKA43_KIT | Panel [MEDHIST |
Subject: JARA107 | Visit: 0 |
Verbatim tem:  |[CONDITION | Codel item: [CODE1_ART |
Verbatim Text:  [garake |
Normalized Text: [EARAKE |
CT_ReclD: [2.SALLOAD.OBXS]f002.001 | Own ¥
rSolution Information
Status: [Eclution Proposed | Solution Type: 'srbatim |
Verbatim Text:  [EARACHE ]
Reason: Nerb atim text not spelled comectly. |
4 I 2

The following table describes the fields in the Details for Omission window’s
Solution Information section for omission records with a proposed Verbatim
solution type:
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Field: Description:
Status Solution Proposed. For more information on omission statuses, see
Chapter 14.

Solution Type Verbatim.

Verbatim Text The new value that will replace the current verbatim text, as shown
in the Coding Information section of this window, when this
proposed solution is accepted. This value may or may not
correspond to an existing term or synonym.

Reason The reason for changing the verbatim text, such as a misspelling.
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Requesting more information

What is a request?

A request is a method of seeking clarification or additional detail about verbatim
text that cannot be coded automatically, and that results in an omission record.

Why request more information?

When you review an omission record in Classify, you may discover

that its verbatim text is too vague or complex to be coded. To solve the coding
omission, help is needed from an expert coder or from

the investigative site that originated the data.

For example, if a record fails automatic coding and the resulting omission record
has the verbatim text ULCER, you may decide that more information, such as a
specific body site, is required.

In the Clintrial software, requests can be recorded by creating either:

Ajisse[)

» A discrepancy record in Resolve (if that extended module is installed)

* Anitem flag on the verbatim text item in the clinical data record

How to request more information

To propose a solution with the Request solution type:

1. Inthe Omission Browser, select an omission record, or open the Details for
Omission window for that particular omission record.

2. From the Omission menu, select Propose Solution >> Request More Info,
or click the corresponding toolbar icon.
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The Request More Info for Omission dialog box opens:

Message

& Request More Info for Omission 50003 | [=] B3
Yerbatim Text: Joint problem

Normalized Text: JOINT PROBLEM

Predefined Messages: |Medical event requires more information for coding. j

Medical event requires more information for coding. Need more specific information.

Spell Check... |

In this dialog box, you can enter your own message describing the problem and
the clarification needed, or select a predefined message from the drop-down list,
and add additional text if needed. The list messages are contained in the
CTS_CTG_DSC _TXT codelist that is installed with Classify. The codelist
contains three predefined messages. Your system administrator maintains this
list, and can add additional messages in Design.

Note: Alternatively, you can use Enter to add a flag to the verbatim text item, or
you can use Resolve to create a discrepancy record manually. In both cases, you
will not be able to reuse this solution in Classify to solve other coding omissions.

For step-by-step instructions on how to use this dialog box to propose a request
for more information, see the Help.
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Request attributes

After you select Request More Info and propose a request for more
information, the Details for Omission window opens:

-Coding Information
Thesaurus: [CT_MEDDRA | Algorithm: PT_ALG |
Language: [ENGLISH |
Protocol: [MEDIKA_CLINICAL | Panel: jaDyv |
Subject: [BRNATI0 | Visit: 5B |
Verbatim ltem:  [EVENT | Codel ltem: [CODE1_ART |
Verbatim Text:  [Jointproblem |
Normalized Text [JOINT PROBLEM |
CT_ReclD: |2.SQLLOAD.OCEPLN02.003 | Own 1
rSolution Information
Status: [Eolution Proposed | Solution Type:  |[Reguest |
Message: |Medical eventreguires more information for coding. Need more specific information. |

<

2

The following table describes the fields in the Details for Omission window’s
Solution Information section for omission records with a proposed Request

solution type:

Field:

Description:

Status

Solution Type

Message

Solution Proposed. For more information on omission statuses, see
Chapter 14.

Request.

Comments on this omission record and its verbatim text.

Reusing and propagating solutions

Once you propose a solution for an omission record in Classify, you can use it
for other omission records as needed.

Reusing and propagating solutions 239

Ajisse[)



If an omission record has a Synonym solution type, Classify identifies

all other omission records with the same values in the Verbatim Text, Thesaurus,
Algorithm, and Language fields and automatically proposes the same solution
for those omission records.

If the proposed solution is a Verbatim or Request type, you can either reuse or
propagate that solution, as follows:

» To reuse a solution, you select a single omission record with a Needs
Proposal status, then specify the Verbatim or Request solution of any other
omission record to propose for that record.

» To propagate a solution, you select an omission record that has a Verbatim or
Request solution, and Classify proposes that solution for every other
omission record that has the same values in the Verbatim Text, Thesaurus,
Algorithm, and Language fields automatically.

How reusing Synonym solutions works

Whenever you propose a Synonym solution type for an omission record,
Classify automatically searches for other omission records with a Needs
Proposal status that have the same values in the Verbatim Text, Thesaurus, and
Language fields. If matching records are found:

* The same solution is proposed for each of those omission records.
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* The omission status is changed to Solution Proposed.

* The solution information is updated.

Until you accept the proposed synonym solution, any newly created omission
records with the same verbatim text are created with a status of Solution
Proposed (rather than Needs Proposal) and the same proposed solution.

How to reuse Verbatim or Request solutions

To reuse a Verbatim or Request solution type for another omission record:

1. In the Omission Browser, select an omission record with a Needs Proposal
status, or open the Details for Omission window for that particular omission
record.

2. From the Omission menu, select Propose Solution >> Reuse Solution.
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The Reuse Solution for Omission dialog box opens:

#: Reuse Solution for Omission 12970003 M [=] B3
Verbatim Text: learach |
Normalized Text: [EARACH |
Text to be Matched: |EARAKE |

Search

Select Solution

Verbatim Text

Details |
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In this dialog box, you select the existing solution of another omission record to
propose for your selected omission record. All Verbatim and Request solutions
for omission records that have the same values in the Verbatim Text, Thesaurus,
and Language fields as your selected omission record display in this dialog box
automatically. To search for additional solutions, enter a term or phrase in the
Text to be Matched field, then click Search.

Note: Classify does not use the value in the Algorithm field to determine
potential matches for reusable solutions.
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To review information about other omission records that were previously
assigned a particular solution, in the Reuse Solution for Omission dialog box,
select that solution, and then click Details. The Solution Details dialog box
opens:

#: Solution Details | x|

Verbatim Text:  |earake |
Solution Type: l\‘e'bﬁlim ‘
New Verbatim: ‘EAR ACHE ‘
Thesaurus: ‘ART_THESAURUS ‘
Language: ‘ENGUSH ‘

—Related Omissions

Omission Id Status Protocol Panel Subject Block Page Verbatim ltem Codel ltem CtReq
12870003 Solved |MEDIKA43_KIT MEDHIST ANAT07 0 4 CONDITION CODE1_ART 2.30LL
4 I Ll

| (0] 4 I Help

In this dialog box, you can review the other omission records that were assigned
the same reusable solution. To return to the Reuse Solution for Omission dialog
box, click OK. Then select a solution for your omission record. When you click
OK:

* The solution is proposed for the omission record.
* The omission status of the omission record changes to Solution Proposed.

* The solution information for the omission record is updated.

For step-by-step instructions on using these dialog boxes, see the Help.
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How to propagate Verbatim or Request solutions

To propagate a Verbatim or Request solution type to all other omission records
that have the same values in the Verbatim Text, Algorithm, Thesaurus, and
Language fields:

1. In the Omission Browser, select an omission record with a Verbatim or
Request solution type, or open the Details for Omission window for that
particular omission record.

2. From the Omission menu, select Propagate Solution. Classify searches for
those omission records that have a Needs Proposal status and identical values
for verbatim text, algorithm, thesaurus, and language. For each omission
record found, Classify automatically:

* Proposes the same solution
» Changes the omission status to Solution Proposed
» Updates the solution information

3. A confirmation message displays. This message includes the number of
omission records that now have the same proposed solution as the omission
record you selected in Step 1.
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Changing proposed solutions

After you propose solutions for omission records, you can edit or clear the
solution of any omission records that have a Solution Proposed omission status,
as follows:

» Editing lets you alter the proposed solution.

* Clearing deletes the proposed solution from the omission record and its
omission status reverts to Needs Proposal.

Note: If you propose a solution of one type, then determine that another solution
type is more appropriate, you must clear the current solution before proposing
the new one. For information on clearing solutions, see "How to clear a solution”
on page 244.
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How to edit a solution

To edit a proposed solution:

1. In the Omission Browser, select an omission record with the Solution
Proposed omission status, or open the Details for Omission window for that
omission record.

2. From the Omission menu, select Edit Solution.

A dialog box opens that is similar to the Propose Solution dialog box specific to
the solution type for the omission record. In other words, if the selected record
has a Request solution type proposed, editing this proposed solution will display
a dialog box similar to the Request More Info for Omissions dialog box.

In the dialog box you can change the message for a Verbatim or Request
solution, or change any of the attributes for a Synonym solution.

How to clear a solution

To clear, or delete, a proposed solution:

1. In the Omission Browser, select one or more omission records with the
Solution Proposed omission status, or open the Details for Omission window
for a single omission record.
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2. From the Omission menu, select Clear Solution.

A confirmation message displays. To clear the proposed solution, click OK. To
exit without clearing the proposed solution, click Cancel.

Note: The omission record must be reselected before a new solution can be
proposed.

Results of changing a proposed solution

When you edit or clear a solution, keep in mind that:

* For Synonym solution types, the changes you make to a solution for one
omission record affect every other omission record that uses it.

* For Verbatim or Request solution types, other omission records with the
same solution are unaffected by the change. You must modify each omission
record as needed.
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Adding a synonym

What is adding a synonym?

You can add a synonym to an omission record with a Needs Proposal status, or to
arecord that already has a Verbatim or Request solution type. The new synonym
is created in addition to any existing solution type the record may have. When
you add a synonym, the omission

status of the record is not changed.

Note: A record that already has a Synonym solution type cannot have a
synonym added.

Adding a synonym differs from a Create Synonym solution in that added
synonyms are accepted immediately, without the need to Propose and Accept the
synonym.

Why add a synonym?

Adding a synonym can be useful if:
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* A change to the verbatim text is required, resulting in a Verbatim solution,
but a synonym for the changed verbatim text is needed for successful coding.

* A Request solution type results in a response indicating that a new synonym
is required.

How to add a synonym

To add a synonym:

1. In the Omission Browser, select an omission record, or open the Details for
Omission window for that particular omission record.

2. From the Omission menu, select Thesaurus Solution.

The Thesaurus Solution for Omission dialog box opens. A synonym can be
selected from the Matching Terms and Synonyms box. For information on
creating a synonym, see "How to create a synonym" on page 225.

Note: Coding does not automatically follow the addition of a synonym, and the
record’s omission status is not changed.
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Accepting Proposed
Solutions

Proposed solution processing 248

How to accept a proposed solution 248

Accepted solution processing 248
How accepting a Synonym solution type works 249
How accepting a Verbatim solution type works 251

How accepting a Request solution type works 252

Accepting proposed solutions and access rights 254

Closing omission records 254

Purging omission records 255
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Proposed solution processing

How to accept a proposed solution

To accept a proposed solution:

1. In the Omission Browser, select one or more omission records with a status
of Solution Proposed, or open the Details for Omission window for a
particular omission record.

2. From the Omission menu, select Accept Solution.

Note: To accept proposed solutions, you must be assigned Classify’s Accept
access right. For more information, see "Accepting proposed solutions and
access rights" on page 254.

This process changes the omission status of the selected omission record to
Solution Applied or Solved. Additional processing, specific to each solution
type, then occurs, as described in the following sections.

Note: If the status of your omission records is updated to Solution Pending, the
AUTOCODE RECODE ALL parameter may be set to No for the protocol. For
more information on setting this parameter, see Chapter 13.
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For step-by-step instructions on tasks described in this chapter, see the Help.

Accepted solution processing

This section describes the processing that occurs when you accept a solution of
one of the following solution types:

e Synonym — Assigned when you select the Omission menu’s Create
Synonym command.

*  Verbatim — Assigned when you either select the Omission menu’s Change
Verbatim command, or reuse a Verbatim solution.

* Request — Assigned when you either select the Omission menu’s Request
More Info command, or reuse a Request solution.
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How accepting a Synonym solution type works

When you accept a Synonym solution type, you specify the thesaurus view to
which the new synonym will be added. Classify checks the coding thesaurus
protocol to ensure that it is not locked. If it is locked, an error message displays
and no processing occurs. If it is not locked, the following processing is initiated:

1. A new synonym is created and inserted into the specified thesaurus view.

2. Automatic coding executes on every clinical data record associated with the
omission records that use this solution. This process runs automatically in
Manage whenever you accept a Synonym solution type.

3. The omission status of each omission record is set to Solved, regardless of
whether automatic coding completes successfully.

If automatic coding fails, a new omission record is created to track
the new coding problem. This may occur, for example, if the newly created
synonym does not result in successful coding for that verbatim text.

Note: Classify does not prevent the creation of duplicate synonyms. You can
review the contents of a coding thesaurus protocol for duplicates by using the
Classify’s Duplicates within Thesaurus report. For more information, see
Chapter 18.

Note: In a Multisite installation, automatic coding at the omission processing
site does not affect records at other sites.
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The following figure illustrates the process that is initiated when you accept a
Synonym solution type:

Accept Synonym
Solution Type

{

Omission Status Set
to Solution Applied

{

Synonym Created

{

Automatic Coding
Runs

{

Omission Status Set
to Solved
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Coding End

Succeeds?

New Omission
Record Created

Note: Coding thesauruses can be implemented as external Oracle tables. If a
table’s columns do not match those of a thesaurus view, then values for Clintrial
software system items (such as DB_ID and ENTRY DATETIME) will be
omitted when records representing newly created synonyms are created. To
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populate the empty fields, your database administrator can specify DEFAULT
values, or use an INSERT TRIGGER on the table when Classify inserts
synonym records. If the columns have the NOT NULL attribute, they must be
populated using one of these methods.

How accepting a Verbatim solution type works

When you accept a Verbatim solution type, the following processing occurs:

1. The value in the Verbatim Text item is changed in the clinical data record.

2. Automatic coding executes on the omission record. This process runs
automatically in Manage whenever you accept a Verbatim solution type.

3. The omission status of the omission record is set to Solved, regardless of
whether automatic coding completes successfully.

If automatic coding fails, a new omission record is created to track
the new coding problem. This may occur, for example, if automatic coding

does not find a single exact match for the new value in the verbatim text item
field.

Note: In a Multisite installation, automatic coding at the omission processing
site does not affect records at other sites.
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The following figure illustrates the process that is initiated when you accept a
Verbatim solution type:

Accept Verbatim
Solution Type

1

Omission Status Set
to Solution Applied

1

Automatic Coding
Runs

1

Omission Status Set
to Solved
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Coding End

Succeeds?

New Omission
Record Created

Note: In a Multisite installation, after the omission is replicated from the
omission processing site to the automatic coding site, reselection of the record
for automatic coding will apply the Change Verbatim solution.

How accepting a Request solution type works

When you accept a Request solution type, the processing that occurs depends on
the Clintrial software modules installed at your site:
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» IfResolve is installed and the clinical data protocol containing the verbatim
text that failed to code has been set up for use with Resolve, a discrepancy
record is created.

» If Resolve is not installed, or the protocol has not been set up for use with
that module, an item flag is added to the Verbatim Text item of the clinical
data record.

The following figure illustrates how the process that is initiated when you accept
a Request solution type differs based on whether Resolve is installed:

Accept Request
Solution Type

{

Omission Status Set
to Solution Applied

Create New
Discrepancy Record

Resolve
Installed?
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Flag Verbatim Text
Item Field

Unlike the processing initiated for other Classify solution types, when you
accept a Request solution type, coding does not run automatically. Instead, the
omission record remains in Solution Applied status until the next time you
initiate automatic coding in Manage. Even then, the omission status is not
changed to Solved until automatic coding succeeds; that is, until after the
verbatim text has been changed in response to your request for more
information. No new omission record is created when automatic coding runs
again.

If Resolve is installed and the protocol has been properly set up, a discrepancy
record is created with the following characteristics:

* Discrepancy status is New.
» Error type is CLASSIFY.
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» Discrepancy message is the text of your omission record’s message.

e The Item Value in the Item Values for Discrepancy section of Resolve’s
Detailed window is the verbatim text.

Omission records and discrepancy records are managed separately, in Classify
and Resolve respectively. Solving one does not necessarily solve the other.

If Resolve is not installed, or the protocol has not been set up for use with
Resolve, an item flag is created with the following characteristics:

* Flag category is CLASSIFY.
* Flag name is REQUEST.

*  Comment for the flag is your omission record’s message.

The CLASSIFY flag category and REQUEST flag name are installed with
Classify.

Note: In a Multisite installation, automatic coding at the omission processing
site does not affect records at other sites. After the omission is replicated from
the omission processing site to the automatic coding site, reselection of the
record for automatic coding will apply the Request solution.
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Accepting proposed solutions and access rights

To accept a proposed solution of any solution type, you must have an access
level of either Full or No Delete for the Classify non-protocol access right
Accept, and for the protocol access right Enter/Merged for the coding thesaurus
protocol being used.

For more information about Classify’s access rights and levels, see Chapter 13.

Closing omission records

Omission records with an omission status of Solved or Obsolete are considered
closed. One of these omission statuses is assigned automatically in each of the
following situations:

* The verbatim text item is interactively coded in Manage.
* The verbatim text item’s record, panel, or protocol is deleted.

* The verbatim text item is changed.
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* Automatic coding successfully codes a verbatim text item that previously
failed automatic coding.

* Automatic coding detects a change in the thesaurus language for
a clinical data record that was processed previously by automatic coding.

If one of these situations occurs, the current omission status of the corresponding
omission record changes to either Obsolete or Solved, as follows:

Current omission status: Automatic coding assigns:
Needs Proposal Obsolete

Solution Proposed Obsolete

Solution Applied Solved

You can reuse or propagate the Verbatim or Request solution of a closed
omission record until it is purged. For more information on purging omission
records, see the following section.
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Purging omission records

You can purge omission records that have one of the following omission

statuses:
*  Solved
*  Obsolete

You may want to purge omission records to reclaim space on the server, or to
prevent the outdated solution of an omission record from appearing as a valid,
reusable solution for other omission records.

To purge an omission record:

1. Inthe Omission Browser, select one or more omission records with either the
Solved or Obsolete omission status, or open the Details for Omission
window for a single omission record.

2. From the Omission menu, select Purge Solved or Purge Obsolete.
A message displays to confirm this action before the omission record is purged.

Before you purge an omission record, keep in mind that:
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* Verbatim and Request solutions for purged omission records are not available
for use in solving other omission records.

+ If the omission record's solution type is Verbatim or Request, only the
selected omission record is purged.

« If'the omission record's solution type is Synonym, all omission records
sharing that solution are purged.
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Using coding thesauruses in the Clintrial software

In the Clintrial software, you set up coding thesaurus protocols and coding
targets so that clinical data can be grouped and standardized. This process, which
is performed by automatic coding in Manage, allows clinical data to undergo
statistical analysis and to be shared by a multilingual team.

This section includes a brief overview of the activities you perform in Design to
prepare for automatic coding.

For more information on how you work with coding thesauruses in Classify, see
"Using Classify to improve coding thesaurus protocols" on page 261.

What is a coding thesaurus?

A coding thesaurus is a dictionary that contains standard codes for a particular
type of clinical data. There are two types of thesauruses: industry-standard and
user-defined. For example, the industry-standard COSTART thesaurus contains
the standard codes for clinical events such as HYPERACUSIS, which is the code
that corresponds to the term PAINFUL SENSITIVENESS TO SOUND.

What is a coding thesaurus protocol?

In the Clintrial software, you use Design to set up coding thesaurus protocols.
Coding thesaurus protocols contain the database tables, which store a coding
thesaurus’s terms and codes. After you create and install the required panels and
items in the coding thesaurus protocol, you either batch load data into them using
the batch-loading capability provided by Manage, or enter data in the panel’s
study book in Enter.

Note: To prevent the creation of duplicate synonyms, set up unique indexes on
all thesaurus tables.

What is an extended thesaurus protocol?

A coding thesaurus protocol can be set up as an extended thesaurus protocol. If a
thesaurus is set up as extended, Classify recognizes information specific to the
type of extended thesaurus.
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Currently, two types of extended thesaurus protocols are recognized by Classify,
one for MedDRA data, and the other for WHO drug dictionary data. A thesaurus
protocol is set to one of these two extended types with the protocol parameter
CTG_THES TYPE. There can be more than one of each extended thesaurus
type in a database instance. For more information on setting up thesaurus
protocols, see the Design section of Admin and Design.

When you view synonym details from an extended thesaurus, MedDR A-specific
or WHO drug dictionary-specific information displays in the Synonym Details
window, and you can use the MedDRA Hierarchy Browser to view MedDRA
data. For more information, see "Synonym Details" on page 228.

Two extended thesaurus protocols are provided, one designed to hold MedDRA
data (the GCT_MEDDRA protocol), and the other to hold WHO drug dictionary
data (the GCT_WHODD protocol). Each protocol contains all of the panels,
panel keys, views and sample algorithms necessary to perform coding. For more
information on importing and setting up the GCT_MEDDRA and
GCT_WHODD extended thesaurus protocols, see Getting Started.

For more information about MedDRA and coding with MedDRA, see Chapter
17.
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What is a coding target?

A coding target is a Clintrial software object that identifies a set of items in a
panel of a clinical data protocol; these items are used with a coding thesaurus
protocol during coding. Among these items are the verbatim text item whose text
you want to code, the Codel item with the code, and optionally one item
containing each part of a multipart code.
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How to prepare for automatic coding

Before you run automatic coding, you must set up coding thesaurus protocols
and coding targets in Design. The following figure summarizes these activities:
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Coding Thesaurus Protocol

Create Coding
Thesaurus Protocol

l

Create Thesaurus
Languages

l

Create Required
Panels and ltems

1

Set Up Required
Views and Attributes

1

Load Thesaurus Data

Clinical D ata Protocol

Add Coding-Related
Iltems to Clinical Data
Panel

!

Define Thesaurus
Attribute for Code1
ltem

{

Specify Coding
Target's Thesaurus
Algorithm

How automatic coding works

Once coding thesaurus protocol setup is complete and coding targets are
identified, automatic coding can run. Automatic coding, which is initiated in
Manage for a clinical data protocol, examines the value for each coding target’s
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verbatim text item, searches the views in the coding thesaurus protocol for a
single term that matches it, and then assigns the code for that term to the coding
target. The following figure describes this process:

Set Up Coding Identify Coding Automatic Coding

Thesaurus Protocol Target Runs Codes Assigned

For more information

For more information on setting up coding thesaurus protocols and coding
targets, see the Design section of Admin and Design.

For more information on batch loading data and automatic coding, see Chapter
19.

For more information on thesaurus algorithms, see Chapter 19.

Using Classify to improve coding thesaurus protocols
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Classify enhances automatic coding by allowing you to examine, evaluate, and
compare the coding thesaurus protocols that you set up in Design. To help you
improve coding thesaurus protocols, Classify provides:

* A Thesaurus Browser that allows you to review all coding thesaurus
protocols in a database instance.

» Search capabilities that check for the presence of specified terms or codes in
a coding thesaurus protocol.

* Reports that find duplicate codes in the views of a single coding thesaurus
protocol, or that compare coding thesaurus protocols and views.

Once you evaluate the terms and codes in a coding thesaurus protocol, you can
decide whether to modify its contents.

For more information

For more information on the Thesaurus Browser, see the following section,
“Reviewing a coding thesaurus protocol.”
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For more information on Classify’s search capabilities, see "Searching a coding
thesaurus protocol" on page 264.

For more information on coding thesaurus protocol reports, see
Chapter 18.

Reviewing a coding thesaurus protocol

In Classify, you use the Thesaurus Browser to review coding thesaurus protocols
as rows on a window display.

How to open the Thesaurus Browser

To open the Thesaurus Browser, from the Objects menu select Thesaurus, or
click the Thesaurus icon on the toolbar. The Thesaurus Browser opens,
displaying coding thesaurus protocols for the current database instance:

Z
- & Thesaurus Browser E[=] B
72} -
7] Filter: | |
=
U Thesaurus Locked Status Creation Date Description
EART_THESAURUS Mo MNORMAL 11/7/0013:22:32 Sample thesaurus - ART codes :
CT_MEDDRFA MNa NORMAL 1177700 12:46:36 MedDRA 3.1
CTL_REFERENCE MNa NORMAL 1/9/01 121252
DRUG_THESAURUS Mo MNORMAL 11/7/0013:24:239 Sample thesaurus - drug codes
GCT_MEDDRA MNa NORMAL 117/15/0015:26:45 Classify Meddra Protocol
GCT_WHODD MNa NORMAL 11/15/0015:24:56 Classify ¥wHO Drug Dictionary

The following table describes the information provided in the Thesaurus

Browser:

Column: Description:

Thesaurus The name of a coding thesaurus protocol.

Locked Indicates whether the coding thesaurus protocol is currently

locked. Locked protocols must be unlocked before changes can be
made in Enter or Design, and before Synonym solution types can
be accepted for omission records.
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Column: Description:

Status Indicates the current status of the coding thesaurus protocol.
Creation Date The date and time that the coding thesaurus protocol was created.
Description The description for the coding thesaurus protocol, if ~ available.

Two commands in the Synonym menu are available when a record in the
Thesaurus Browser is selected:

*  Delete — Allows you to delete a synonym from a thesaurus view.

*  Modify — Allows you to modify a synonym in a thesaurus view.

Note: To use these commands, you must have Full Thesaurus access rights and
Full Enter/Merged protocol access rights for the selected thesaurus protocol.

If you select either of these commands, a dialog box opens that allows you to
select the synonym to modify or delete.

Note: Classify does not automatically recode existing data that may reference
the modified or deleted synonym.
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Once you display the initial set of records in the Thesaurus Browser, you can
select either of the following View menu commands:

» Filter
e Sort

You can also change the order and width of the Thesaurus Browser’s columns.

For more information on filtering, sorting, and the layout revision options, see
the Help.

How to print thesaurus information

You can print the data that displays in the Thesaurus Browser. To send
information displayed in the active window to a printer, from the File menu,
select Print. This produces a list of the coding thesaurus protocols currently
listed in the Thesaurus Browser.
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Searching a coding thesaurus protocol

For any coding thesaurus protocol in the Thesaurus Browser, you can search for:
* All code and term pairs that match a specified text string

e A particular code (or part of a code) within a coding thesaurus protocol

These search capabilities can help you to test a new coding thesaurus protocol
before it is used, or to review an existing coding thesaurus protocol after new
code and term pairs have been added.

Note: To search for text or codes in a coding thesaurus protocol, you must have
the Read or Full access level for Classify’s Thesaurus access right for that
protocol. In addition, you must have the Read or Full access level for Design’s
non-protocol System access right.

How to search for text

You search for text in a coding thesaurus protocol as follows:

1. Select a coding thesaurus protocol in the Thesaurus Browser.

2. From the Thesaurus menu, select Text Search, or double-click the row.
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The Text Search Thesaurus dialog box opens:

& Text Search - Thesaurus ART_THESAURUS E
Language: |ENGLISH j
Views: SYNONYMS

Textto be Matched: [ ENINGIOMA

Search Results

Code Term View

| Search | Close | Help |

Ajisse[)

In this dialog box, you enter a text value in the Text to be Matched field. Then,
select a Language (ENGLISH is the default) and use Ctrl+Click or Shift+Click
to select one or more thesaurus views. When you click Search, the selected
thesaurus views are searched for all code and term pairs that match your text.
Matches display in the Search Results section.

You can use the Oracle wildcard characters (% and ) to search for partial values.
Use the percent sign (%) to replace any number of characters, or the underscore
() to replace a single character. For example, if you search for MAN% in a
coding thesaurus protocol that contains drug data, the resulting list may include
the drug names MANDELAMINE, MANDOL, and MANNITOL. Alternatively,
if you search for MAN _, the resulting list will be limited to drug names that
begin with MAN and are precisely four characters long.
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How to search for a code

You search for a code in a coding thesaurus protocol as follows:

1. Select a row in the Thesaurus Browser.

2. From the Thesaurus menu, select Code Search.

The Code Search Thesaurus dialog box opens:

# Code Search - Thesaurus ART_THESAURUS E
Language: |ENGLISH j
Views: SYNONYMS

Code to be Matched:

Search Results

Code Term View
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| Search | Close Help

You use this dialog box to determine whether a specified code exists in a coding
thesaurus protocol. You enter a code in the Code to be Matched field, select one
or more views in the Views to Search list, and click Search. The resulting
match(es) displays in the Search Results section.

If the coding thesaurus protocol contains multipart codes, you can use a wildcard
character to search for a subset of a code. For example, if you search for 472. ,
the resulting list may include all of the following codes: 472.0, 472.1, and 472.2.
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For more information

For step-by-step instructions on searching coding thesaurus protocols, see the
Help.
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Overview

In Classify, you can produce reports that find:
* Terms that are duplicated within a single coding thesaurus protocol

* Code and term pairs that are different in two different coding thesaurus
protocols

* Code and term pairs that are identical in two different coding thesaurus
protocols

You can use Classify’s thesaurus reports when you prepare for or implement
changes to your organization’s coding thesaurus protocols, such as upgrading to
a new version of an industry-standard coding thesaurus, or developing a new
project-specific coding thesaurus.

Types of reports

You can produce these reports in Classify:
* Duplicates within Thesaurus
* Thesaurus Comparisons

* Thesaurus View Comparisons
The following sections describe these reports in more detail.

For step-by-step instructions on printing reports, see the Help.

Duplicates within Thesaurus report

The Duplicates within Thesaurus report finds terms that are on file more than
once in the same coding thesaurus protocol. This can occur if the same term is:

* Assigned two different codes

¢ Included in two different thesaurus views

This report lists the duplicated terms, their corresponding codes, and the
thesaurus view in which they occur.
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To display the Duplicates within Thesaurus report, in the Thesaurus Browser,
select a single coding thesaurus protocol. Then, from the Reports menu, select
Duplicates within Thesaurus. The following dialog box opens:

@) Specify Report Parameters - Duplicates within Thesaurus

Thesaurus: |ART_THESAURUS |
Language: |ENGLISH Ll oK
. = =
Cancel
Help
After you select the language to report on and the thesaurus views to include,
click OK. The following example shows a sample of this report: ®)
3
i Report - Duplicates within Thesaurus ART_THESAURUS =] EY <8
Thesaurus Protocol: ART_THESAURUS = Q?
Thesaurus Language: EMNGLISH
Thesaurus ¥Yiews: SYNONYMS, TERMS |
Term View Caode
ALBUMINURIA
TERMS ALBUMINURIA 1 MAN
TERMS ALBUMINURIA 1 UG
ANTICHOLINERGIC SYHNDROME
TERMS ANTICHOLINERG S¥MD.1.BODY
TERMS ANTICHOLINERG SYMND.1.NER
ANXIETY
TERMS ANKIETY.1.NER
ARTERIOSPASM
TERMS ARTERIOSPASKMI OV
TERMS ARTERIOSPASHM.1 NER
B12 DEFICIENCY ANEMIA
TERMS ANEMIA B12 DEFIC T.HAL
TERMS ANEMIA B12 DEFIC.T.MAN Sl
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Thesaurus Comparisons reports

A Thesaurus Comparisons report compares data in two different coding
thesaurus protocols and reports on either the differences between them or their
similarities.

To produce these reports, in the Thesaurus Browser you must select two coding
thesaurus protocols. Then, from the Reports menu, select Thesaurus
Comparisons. The following dialog box opens:

M Specity Report Parameters - Thesaurus Comparisons

Repont Type

¢ Differences in Thesauruses
¢ Intersection of Thesauruses

Thesaurus 1: |DRUG_THESAURUS I Thesaurus 2:  IDRUG_THESAURUS2 I

Language: [ENGUSH EI Language:

Views: Views:

| OK I Cancel Help

In this dialog box, you select the Report Type:
« Differences in Thesauruses

¢ Intersection of Thesauruses

You also select the specific language and thesaurus view(s) that you want to
compare.

Differences in Thesauruses

If you select Differences in Thesauruses, the resulting report lists each code
and term pair that is present in only one of the two coding thesaurus protocols.
Code and term pairs that are present in both coding thesaurus protocols but in
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differently named views (for example, in the terms view of one coding thesaurus
protocol and a synonyms view of the other) are considered the same, and
therefore are not included on this report.

The following example shows a sample of this report:

. Report - Thesaurus Differences DRUG_THESAURUS / DRUG_THE SAURLUS?Z
Thesaurus1 Protocol: DRUG_THESAURUS

Thesaurus1 Language: ENGLISH

Thesaurus1 Views: DRUG_TERMS_MEDIKA SYNONYMS, TERMS

Thesaurus2 Protocol: DRUG_THESAURUS2
Thesaurus2 Language: ENGLISH

Thesaurus2 Views: DRUG_TERMS_MEDIKA SYNONYMS, TERMS

Code Term Thesaurus
8001126534 BIGZIMAX DRUG_THESAURUS2
8001328454 BITTYMIN DRUG_THESAURUS?2
8001343345 MIDINAC DRUG_THESAURUS2

Intersection of Thesauruses

Ajisse[)

If you select Intersection of Thesauruses, the resulting report lists the code and
term pairs that are present in both of the selected coding thesaurus protocols,
regardless of the view in which they occur.
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The following example shows a sample of this report:

A. Report - Thesaurus Intersection DRUG_THESAURUS | DRUG_THESAURLS?Z

Thesaurus1 Protocol: DRUG_THESAURUS =
Thesaurus1 Language: ENGLISH | |
Thesaurus1 Views: DRUG_TERMS_MEDIKA SYNONYMS, TERMS

Thesaurus2 Protocol: DRUG_THESAURUS2

Thesaurus2 Language: ENGLISH

Thesaurus2 Views: DRUG_TERMS_MEDIKA SYNONYMS, TERMS

Code Term

0000050000 FORMALDEHYDE SOLUTION

0000050011 GUANIDINE HYDROCHLORIDE

0000050022 DEXAMETHASONE

0000050033 HYDROCORTISONE ACETATE

0000050044 CORTISONE ACETATE

0000050066 PHENOBARBITAL

0000050077 MITOMYCIN -

Thesaurus View Comparisons reports

Thesaurus View Comparisons reports are similar to the Thesaurus Comparisons
reports; however, the thesaurus view in which each code and term pair is found
is considered as well.
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For these reports, in the Thesaurus Browser you must select two coding
thesaurus protocols. Then, from the Reports menu, select Thesaurus View
Comparisons. The following dialog box opens:

. Specity Beport Parameters - Thesaurus View Compansons | X
Report Type Thesaurus 1: PRUG_THESAURUS |
& Differences in Thesaurus Views Thesaurus 2: |DRUG_T|-|ESAURU82 I
C Intersection of Thesaurus Views Language: [ENGLISH ~|

Views:

| OK I Cancel Help

In this dialog box, you select the Report Type:

» Differences in Thesaurus Views
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» Intersection of Thesaurus Views

You also select the language and the view(s) to include for each coding thesaurus
protocol. Only languages and views that have the same name in both coding
thesaurus protocols appear.

Differences in Thesaurus Views

If you select Differences in Thesaurus Views, the report lists each code and
term pair that is present in only one of the selected coding thesaurus protocols,
and code and term pairs that exist in both coding thesaurus protocols, but in
differently named views.
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The following example shows a sample of this report:

n. Report - Thesaurus View Differences DRUG_THESAURUS / DRUG_THESAURUS?2

Thesaurus1 Protocol: DRUG_THESAURUS

Thesaurus2 Protocol: DRUG_THESAURUS2

Thesaurus Language: ENGLISH

Thesaurus Yiews: DRUG_TERMS_MEDIKASYNONYMS, TERMS

Cod T Ti Vi
8001126534 BIGZIMAX DRUG_THESAURUS?2 TERMS
8001328454 BITTYMIN DRUG_THESAURUS?2 TERMS
8001343345 MIDINAC DRUG_THESAURUS?2 TERMS

Note: By default, this report is not formatted for printing on 8 1/2 x 11 (portrait
mode) paper. Like the previous example, you can adjust the column widths of
this report so it prints in portrait mode. To do so, from the File menu, select
Print Preview, then click the column dividers and drag to resize the report’s
columns.

Intersection of Thesaurus Views
If you select Intersection of Thesaurus Views, the report lists the code and term
pairs that are present in both of the selected coding thesaurus protocols in views
that have the same name, such as TERMS.

The following example shows a sample of this report:

#. Report - Thesaurus View Intersection DRUG_THESAURUS / DRUG_THESAURUS?2 M [=] B3
Thesaurus1 Protocol: DRUG_THESAURUS =
Thesaurus?2 Protocol: DRUG_THESAURUS?2

Thesaurus Language: ENGLISH

Thesaurus Views: DRUG_TERMS_MEDIKASYNONYMS, TERMS

Code Term View
0000050000 FORMALDEHYDE SOLUTION TERMS
0000050011 GUANIDINE HYDROCHLORIDE TERMS
0000050022 DEXAMETHASONE TERMS
0000050033 HYDROCORTISONE ACETATE TERMS
0000050044 CORTISONE ACETATE TERMS
0000050066 PHENOBARBITAL TERMS
0000050077 MITOMYCIN TERMS
0000050099 HEXOBARBITAL SODIUM TERMS
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Thesaurus algorithms

What is a thesaurus algorithm?

Automatic coding matches to the standardized terms in a coding thesaurus
protocol the verbatim text (that is, text entered by the user) such as the names of
diseases or drugs. A thesaurus algorithm is a sequence of steps that determines
the most appropriate code match for the verbatim text. The Clintrial software
supplies a default thesaurus algorithm, and you can create customized thesaurus
algorithms. When automatic coding runs in Manage, thesaurus algorithms are
applied to increase the likelihood of finding a matching term in a coding
thesaurus protocol.

Example: thesaurus algorithm

For example, suppose that a record contains the following verbatim text for a
medical history event:

History of bleeding small intestinal ulcers
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When automatic coding runs, a thesaurus algorithm might automatically
transform it as follows:

Thesaurus algorithm step: Resulting text:

Step 1. Change text to uppercase. HISTORY OF BLEEDING SMALL
INTESTINAL ULCERS

Step 2. Remove words: BLEEDING SMALL INTESTINAL ULCERS
HISTORY OF

Step 3. Change plural words to BLEEDING SMALL INTESTINAL ULCER
singular.

Step 4. Replace words: HEMORRHAGE DUODENAL ULCER

BLEEDING with HEMMORRHAGE,
and

SMALL INTESTINAL with
DUODENAL
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Thesaurus algorithm step: Resulting text:

Step 5. Alphabetize words. DUODENAL HEMORRHAGE ULCER

Step 6. Attempt an exact match inthe  Exact match found, code ULCER DUODEN
terms view. HEM assigned.

A thesaurus algorithm’s steps either transform the verbatim text in some manner,
or attempt to find a matching code by looking up a term in a thesaurus view. You
use Design to create thesaurus algorithms and associate them with your coding
targets. You use Manage to initiate automatic coding.

What is the Algorithm Browser?

The Algorithm Browser summarizes all of the thesaurus algorithms in a single
window display. To open the Algorithm Browser, from the Objects menu select
Algorithm, or click the Algorithm icon on the toolbar. The Algorithm Browser

opens:
@l Algorithm Browser ==
Filter: | |
Protocol Algorithm [Modification Date [Modified By il
ART_THESAURUS ALGTEST 11/14/00 13:48:07 CT3Y3
.ART_THESAURUS SAMPLE1 11/14/0013:47:15 CTSYS
=
The following table describes the information provided in the Algorithm
Browser:
Column: Description:
Protocol The name of a coding thesaurus protocol.
Algorithm The name of a thesaurus algorithm.
Modification Date The date and time when this thesaurus algorithm was last
modified.
Modified By The name of the user who last modified this thesaurus
algorithm.

Thesaurus algorithms 279
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Once you display the initial set of algorithms in the Algorithm Browser, you can
select either of these View menu commands:

e Filter
e Sort

You can also change the order and width of the Algorithm Browser’s columns.

For more information on filtering, sorting, and the layout revision options, see
the Help.

How to print algorithm information

You can print the data that displays in the Algorithm Browser. To send
information displayed in the active window to a printer, from the File menu,
select Print. This produces a list of the thesaurus algorithms currently listed in
the Algorithm Browser.

For more information

For more information on thesaurus algorithms, see the Design section of Admin
and Design.
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For more information on automatic coding, see Chapter 19.

Thesaurus algorithm step types

What are step types?

Step types are the different transformations and lookup steps that you can
combine to create a thesaurus algorithm.
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What is a transformation?

A transformation is a change made to verbatim text that converts it into a
semantically equivalent construction. Examples of different types of
transformations include changing all letters to uppercase, or making all plural
words singular. In the example starting on page 278, Steps 1 through 5 are all
transformations.

You can include as few or as many transformations in a thesaurus algorithm as
you need for effective coding.

What is a lookup step?

A lookup step is a thesaurus algorithm step that attempts to match a text string to
an official term in a thesaurus. You can add a lookup step as one of the first steps
in a thesaurus algorithm. After you apply one or more transformations to the
verbatim text, you can add another lookup step. In the example starting on page
278, Step 6 is a lookup step.

Design’s step types

You use Design to create and modify thesaurus algorithms, which usually consist
of a combination of both transformations and lookup steps. If Classify is not

installed, you can include only the following step types in a thesaurus algorithm:

» Filter is a transformation that removes words previously filed in a stopwords
view of a coding thesaurus protocol.

» Contains is a lookup step that attempts to match the verbatim text to a
thesaurus term. The words in the verbatim text can be in any order.

* Exact is a lookup step that attempts to match the exact verbatim text to a
thesaurus term.

Another way to include transformations in a thesaurus algorithm is by checking
the Comprehensive Normalization check box in the Create or Modify Algorithm
window. When this check box is checked, the thesaurus algorithm performs a
series of transformations on the text before applying the other steps.

After you install Classify, additional transformations are available for use in your
thesaurus algorithms. When you create or modify a thesaurus algorithm, you can
include any of Classify’s transformations in addition to the step types supplied in
Design. The transformations supplied with Classify are described in the
following section.
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For more information

For more information on using Design step types and the Comprehensive
Normalization check box in thesaurus algorithms,
see the Design section of Admin and Design.

Transformations added by Classify

What do Classify transformations do?

Each Classify transformation makes a specific change to the verbatim text, such
as changing all characters to uppercase or making all plural words singular.
Then, each transformation also makes the following changes:

* Removes nonprinting control characters, including line feed indicators
(carriage returns).

* Replaces multiple spaces with a single space.

* Removes extra spaces before and after the verbatim text.

List of Classify transformations

Classify’s transformations are described in the following table. For examples of
each transformation and tips on usage, see Chapter 20.

Transformation: Description:

Alphabetize Alphabetizes words to remove dependence on word order.
Iterative Replace Replaces previously defined words or phrases with previously
Words defined replacements; then, after all replacements are made to

the original text, reruns the process to replace any newly created
phrases as needed.

Note: For information on replacing words, see "Support elements
for transformations" on page 284.

Lower Case Converts all uppercase letters to lowercase. Non-alphabetic
characters are not transformed.
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Transformation:

Description:

Plural to Singular

Protected Stemming

Remove Bracketed

Text

Remove Chars

Remove Dates

Remove Dups

Remove Numbers

Remove Quotes

Remove Words

Replace Words

Reset

Converts all lowercase letters to uppercase, then removes the
final character(s) S, IES, or ES from words.

Converts all lowercase letters to uppercase, then:

1. Replaces previously defined words or phrases with
previously defined replacements.

2. Removes suffixes from words that were not replaced, leaving
the word root followed by *.

Removes all text found within a pair of brackets [ ] or
parentheses ( ), including the brackets or parentheses themselves.

Replaces specific, previously defined characters, such as
punctuation marks, with a space.

Removes any string of numbers that includes periods (.), hyphens
(-), or slashes (/).

Removes the second (and all subsequent) occurrence of a word.
The first occurrence is preserved.

Removes strings composed of numbers. Also removes plus signs
(+), minus signs (-), asterisks (*), slashes (/), periods (.), and
commas (,) when these symbols are found in the string of
numbers.

Removes all apostrophes (') and single (‘) and double (*)
quotation marks.

Removes previously defined words and phrases.

Replaces previously defined words or phrases with previously
defined replacements. Removes words or phrases if the defined
replacements are null.

Note: For information on replacing words, see "Support elements
for transformations" on page 284.

Resets the verbatim text back to its original form, that is, back to
the value entered in the Verbatim Text field, before any
transformations were performed.
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Transformation: Description:

Stemming Converts all lowercase letters to uppercase, then removes
suffixes from words, leaving the word root followed by *.
(Prefixes are not removed.)

Upper Case Converts all lowercase letters to uppercase. Non-alphabetic
characters are not transformed.

Support elements for transformations

What are support elements?

Support elements are the characters, words, and phrases that you define in
advance so that Classify transformations can operate correctly. For example,
when you include Remove Words as a step in a thesaurus algorithm, you must
separately define the words (and phrases) that the transformation should remove,
such as AND, THE, and A.
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Not all Classify transformations require support elements. For example, Remove
Dups removes words that are repeated within a text string without requiring any
specific definition to be made as a support element.

Which transformations require support elements?

The following Classify transformations require user-defined support

elements:

Transformation: You define:

Iterative Replace Words Each word or phrase to replace and its corresponding
replacement.
Note: The same support elements are used for
both this transformation and the Replace Words
transformation.

Protected Stemming Each word or phrase to replace and its corresponding
replacement.

284  Chapter 19: Classify and Thesaurus Algorithms



Transformation: You define:

Remove Chars The characters to remove.

Note: If you do not define support elements for this
transformation, the characters (if any) listed in the
Punctuation item of the Thesaurus Language are
removed instead.

Remove Words Each word or phrase to remove.
Replace Words Each word or phrase to replace and its corresponding
replacement.

Note: The same support elements are used for
both this transformation and the Iterative Replace Words
transformation.

How to edit support elements

You use Classify to add, change, and delete support elements for the
transformations that require them.

Ajisse[)

After you select a thesaurus algorithm in the Algorithm Browser, from the
Algorithm menu, select Edit Support Elements. The Edit Support Elements
window opens:

A, Edit Support Elements - Algonthm ALGTEST in Thesaurus ART_THESAURUS
Filter: |
Language Transformation Element Replacement
v |Remove Words - |BUT
ENGLISH ~|Remove Words ~|CAUSING
ENGLISH » |Remove Words ~|MINOR
ENGLISH » |Remove Words »|MY
ENGLSH » |Remove Words = |SERIOUS
ENGUSH v |Remove Words »|SEVERE
ENGLSH v |Remove Words »|THIS

Note: To edit support elements for a thesaurus algorithm, you must be assigned
the following access rights and access levels:

* The Full access level for Classify's Thesaurus access right for that
algorithm’s coding thesaurus protocol.
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* The Read or Full access level for Design's non-protocol System access right.

When the Edit Support Elements window is active, you use the Edit menu’s
commands to insert new rows or to delete existing rows. In each row, you
specify:

» Language — The specific language view to which the entered element
applies. You can establish different support elements for each language view.

*  Transformation — Select Protected Stemming, Remove Chars, Remove
Words, or Replace Words.

* Element — A single word or phrase to remove or replace. For Remove
Chars, you can specify multiple characters in a single row; you do not need to
add a separate row for each one.

* Replacement — For Replace Words and Protected Stemming, you can
specify a replacement word or phrase for each element. If blank, the element
will be replaced by null.

Once you enter the necessary support elements in Classify, you can use all of the
Classify transformations in the thesaurus algorithms you create and maintain in
Design.

For more information
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For more information on maintaining transformation support elements, see the
Help.

Comparing Design’s transformation and algorithm attribute to
Classify’s transformations

When you use Design to create thesaurus algorithms, you can use a
transformation and an algorithm attribute to transform verbatim text in ways that
are also performed by Classify transformations, as follows:

* The Filter transformation, which removes words from the verbatim text.

* The Comprehensive Normalization check box, an algorithm attribute that, if
checked, removes extra spaces and changes text to uppercase, as well as
making other changes.

For more information on this transformation and attribute, see the Design section
of Admin and Design.
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When Classify is installed, if you want your thesaurus algorithm to remove
words, you can include either Design’s Filter transformation or Classify’s
Remove Words transformation, or both. If you want your thesaurus algorithm to
change letters to uppercase and remove extra spaces, you can check Design’s
Comprehensive Normalization check box or include specific Classify
transformations. These options are compared in the following sections.

How to remove words

In Design, a stopwords panel is a required component of each coding thesaurus
protocol. This panel (and its corresponding view) stores the words that are
extracted from verbatim text when Filter is one of the steps in a thesaurus
algorithm.

Because Filter is included in the default algorithm supplied with the Clintrial
software, you should continue to maintain the stopwords panel if any of your
coding targets use the default algorithm during automatic coding.

Note: The Clintrial software uses the default algorithm for any coding targets
that have an undefined Algorithm attribute.

When Classify is installed, you can use a Remove Words step in your thesaurus
algorithms instead of, or in addition to, a Filter step. If you include the Remove
Words transformation in a thesaurus algorithm, you must also maintain a list of
support elements, consisting of a list of words to be extracted. You must
maintain this list of support elements in Classify instead of, or in addition to,
maintaining the stopwords panel in Design.

Ajisse[)

How to normalize verbatim text

In Design, the Create and Modify Algorithm windows include the
Comprehensive Normalization checkbox. If you check this check box, the
verbatim text is transformed in all of the following ways:

« Removes characters defined in the Punctuation item of the Thesaurus
Language.

* Changes text to uppercase.
* Replaces end-of-line sequences (carriage returns) with a space.
* Replaces multiple spaces with a single space.

* Removes spaces before and after the text.

Automatic coding makes all of these preliminary changes to the verbatim text
before performing the other steps in the thesaurus algorithm.
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When Classify is installed, you can use the Remove Chars and Upper Case
transformations to perform the first two of these changes; in addition, the Plural
to Singular, Stemming, and Protected Stemming transformations all convert text
to uppercase. Every Classify transformation performs all of the remaining three
normalization activities listed above.

As a result, if you clear the Comprehensive Normalization check box, you
should consider including Remove Chars, Upper Case, or other Classify
transformations in your thesaurus algorithm.

Note: To determine the characters to remove, the Remove Chars transformation
first references a list of support elements in Classify. Only if this list is empty
does it refer to the Punctuation item of the Thesaurus Language.
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Designing thesaurus algorithms

The Clintrial software supplies a thesaurus algorithm which every coding target
uses by default. To create and modify your own customized thesaurus
algorithms, you use Design. By designing your own thesaurus algorithms, you
can:

* Increase the number of values that code successfully during automatic
coding

» Adapt thesaurus algorithms to specific coding thesaurus protocols

* Make project-specific thesaurus algorithms

When Classify is installed, you can include any of Classify’s transformations, as
well as Design’s Filter transformation and Contains and Exact lookup steps, in
your thesaurus algorithms.

After you create a thesaurus algorithm, you can assign it to any coding target to
use during coding. You do this in the coding target’s Algorithm attribute.

For more information on creating and modifying thesaurus algorithms and
coding targets, see the Design section of Admin and Design.
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How to use transformations

When you design a thesaurus algorithm, you choose the different types of
transformations to include as its steps, and decide on their order, including when
to attempt matches with the Contains and Exact lookup steps.

The following table provides usage notes for each of the Classify
transformations to assist you in your thesaurus algorithm design. For a
description of each transformation, see Chapter 19.

Transformation: Usage:

Alphabetize Sorts words using ASCII sort order: words beginning with special
characters are placed first, followed by those beginning with
numbers, uppercase letters, and lowercase letters. For example,
changes SEVERE HEAD ACHE to ACHE HEAD SEVERE.

Normally used after either Replace Words or Iterative Replace
Words.

Note: This transformation is suited for use only with coding
thesaurus protocols that store terms in alphabetized form.
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Transformation: Usage:

Iterative Replace Case sensitive. Rather than using both Remove Words and

Words Replace Words transformations, you can use Iterative Replace
Words for cases in which changing or removing a word in the
middle of a phrase will allow the phrase to be matched.

For example, if the word BELLY is to be replaced by STOMACH,
and STOMACH PAIN is to be replaced by STOMACH ACHE,
then this transformation will change BELLY PAIN to STOMACH
PAIN first, then change that to STOMACH ACHE. (The Replace
Words transformation would transform this text to STOMACH
PAIN only.)

This transformation removes a word or phrase if the defined
replacement is left null.

Lower Case Used if other transformations rely on lowercase entries. For
example, if all of your support elements for Replace Words are
lowercase, this transformation is needed first. Also used if the
terms in your coding thesaurus protocols are lowercase.

Plural to Singular This transformation changes Pains to PAIN and ABSCESSES to
ABSCESS. Special consideration is made for words that end in SS
or in an S preceded by a vowel other than E; as a result, PUS,
ABSCESS, and PERTUSSIS are not changed to singular form.
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Note: The words HURTS and SORES are not changed by this
transformation.

The location of this transformation in relation to other
transformations in a thesaurus algorithm is critical. If this
transformation precedes Replace Words or Remove Words in the
algorithm, all corresponding support elements must be singular.

Note: Because this transformation results in words in singular
form only, it is suited for use only with coding thesaurus protocols
that use the same convention for its terms.
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Transformation: Usage:

Protected Stemming Suited for use with English words only.

Use instead of Stemming, so that you can define exceptions to
words that are transformed to their root form. For example, the
Stemming transformation would transform both PATIENT
SUICIDAL and PATIENT SUICIDE to PATIENT SUICID*.

To prevent SUICIDAL and SUICIDE from being stemmed, use
Protected Stemming instead, and define each word as its own
replacement: replace SUICIDAL with SUICIDAL and SUICIDE
with SUICIDE. Protected Stemming would then transform
PATIENT SUICIDAL to PATIENT SUICIDAL, and PATIENT
SUICIDE to PATIENT SUICIDE.

Normally used after Replace Words or Iterative Replace Words.

Note: Because this transformation results in word roots that end in
an asterisk (*), it is suited for use only with coding thesaurus
protocols that use the same convention for its terms. As a result, it
should come after Remove Chars if asterisks are removed.

Remove Bracketed = Text is removed only if enclosed within one pair of brackets or

Text parentheses; a series of nested parenthetical statements is not
removed. For example, transforms HYOSCINE
[SCOPOLAMINE] to HYOSCINE.
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Remove Bracketed Text requires that all brackets within a given
string be of the same type. For example, this transformation would
remove the bracketed text from (HAS) HEADACHE
(FREQUENT), but not from (HAS) HEADACHE [FREQUENT].

Include before a Remove Chars transformation if either brackets [
] or parentheses () are defined as characters to remove.

Remove Chars You define characters for this transformation to remove in
Classify. Characters defined in the Punctuation item of the
Thesaurus Language are removed only if you do not define any
characters in Classify.

This step replaces each removed character with a space (extra
spaces are then eliminated). For example, transforms KAPOSI’S
SARCOMA to KAPOSI S SARCOMA (including the extra
space). To prevent these results, use a Remove Quotes step before
this transformation.

Remove Dates Removes 10/10/87 and 123-45-6789; however, does not remove
04-MAY-1995.

Normally used before Remove Numbers.
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Transformation:

Usage:

Remove Dups

Remove Numbers

Remove Quotes

Remove Words

Normally used after Replace Words or Iterative Replace Words.

You do not need an Alphabetize step before this step.

For example, transforms ULCER: STOMACH ULCER to
ULCER: STOMACH.

Removes any strings that are made up of numbers. Also removes

the following symbols if they are part of a numeric string: + - *

If the string contains one or more letters, it is not removed. As
result, TEMPERATURE OF 99. DEGREES is transformed to
TEMPERATURE OF DEGREES, but PATIENT201 is not
changed.

For example, transforms STEIN’S SYNDROME to STEINS
SYNDROME.

Generally used instead of or before Remove Chars.

/.,

a

Usually, only words that do not add meaning to the verbatim text,
and that also do not change the meaning when they are removed,

should be defined as support elements.

Removes the longest defined phrase first. For example, if you

specify both the word COMPLAINED and the phrase PATIENT

COMPLAINED OF for removal, changes PATIENT
COMPLAINED OF BAD DREAMS to BAD DREAMS (not
PATIENT OF BAD DREAMS).

Case sensitive. Use either before or after Replace Words, based on

the support elements defined for each transformation. If your

sequence uses Remove Words first, followed by Replace Words,

your replacement phrases should not contain words that would
otherwise be removed. If both processes are needed, consider

using Iterative Replace Words, which may be more efficient and

produce better results.

Note: You define words and phrases for this transformation to
remove as support elements in Classify. Words defined in a

stopwords view are not removed by this transformation; use the

Filter transformation to remove stopwords.

Designing thesaurus algorithms
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Transformation: Usage:

Replace Words Replaces the longest defined phrase first. For example, if you
specify that BELLY is to be replaced by STOMACH, and BELLY
PAIN is to be replaced by STOMACH ACHE, changes MILD
BELLY PAIN to MILD STOMACH ACHE (not MILD
STOMACH PAIN).

Case sensitive. If Remove Words is also used, you should consider
the support elements defined for each transformation. Typically,
Remove Words will be used first, followed by Replace Words,
which therefore should not contain words that are defined to be
removed.

Reset Can be included in a thesaurus algorithm after other
transformations and lookup steps, so that a different set of
transformations and lookup steps can be performed to find a
unique match.

Note: If you check the Comprehensive Normalization check box
for the thesaurus algorithm, its effects are not reset by this
transformation.

Stemming Suited for use with English words only.

For example, transforms INCREASE, INCREASED, and
INCREASING to INCREAS*.
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Because this transformation results in word roots that end in an
asterisk (*), it is suited for use only with coding thesaurus
protocols that use the same convention for its terms. Also, it
should come after Remove Chars if asterisks are removed.

Generally used after Replace Words or Iterative Replace Words.

Upper Case Used if other transformations rely on uppercase entries. For
example, if all of your support elements for Remove Words are in
uppercase, this transformation is needed before Remove Words.
Also used if the terms in your coding thesaurus protocols are
uppercase.

Note: Other transformations, including Plural to Singular and
Protected Stemming, also convert characters to uppercase.
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Example thesaurus algorithms

This section contains example thesaurus algorithms that consist of Classify and
Design step types.

Thesaurus algorithm: first example

The following table shows the thesaurus algorithm design created by a coding
group to improve the success rate of automatic coding. The approved changes to
the verbatim text, and the points at which a match should be attempted, are
listed, along with the step types that perform these functions.

Change needed:

Step type:

1.

10.

Capitalize verbatim text.

Attempt a direct match of the transformed text
to the terms view.

Attempt a direct match of the transformed text
with a synonym view.

Remove items in parentheses, including the
parentheses ( ).

Remove characters in the Punctuation item for
the Thesaurus Language.

Remove words in the stopwords view.

Perform word substitutions contained in the
replace word table.

Remove more than one space between the
words and any spaces at the beginning of the
text.

Attempt a direct match of the transformed text
with the terms view.

Attempt a direct match of the transformed text
with a synonym view.

Upper Case

Exact, step view is the
terms view

Exact, step view is a
synonym view

Remove Bracketed Text

Remove Chars (which, in this
case, has no support elements,

as explained in the Note below)

Filter

Replace Words

(Done by Steps 1, 4, 5, and 7)

Exact, step view is the
terms view

Exact, step view is a
synonym view

Example thesaurus algorithms
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Note: By default, Remove Chars removes the characters defined as its support
elements. It removes the characters defined in the Punctuation item of the
Thesaurus Language only if its support elements are null. You can achieve the
same effect by checking the Comprehensive Normalization check box and
omitting this step from the thesaurus algorithm.

The following example shows how this sample thesaurus algorithm appears in
Design:

&. Create Algorithm
Protocol:  |ART_THESAURUS |

Algorithm:  [SAMPLET [ LRtk
Preferred
Terms View: ITERMS ‘ﬂ

Description: |Samp|e algorithm (1)

Order Step Type Step View

3? 1 Upper case = |

2 2 Exact =] [TERMS =l

= 3 Exact =] [SYNONYMS =l
@)

4 Remove bracketed text 3 3

5 Remove characters 3 3

6 Filter =] [sTOPWORDS =]

7 Replace words 3 3

8 Exact v| | TERMS =

- B srons £

After you save this thesaurus algorithm in Design, you edit the support elements
for its Replace Words transformation in Classify:

& BEdit Support Elements - Algonthm SAMPLET in Thesaurus ART_THESAURUS

Filter: I
Language Transformation Element Replacement

ENGLISH ~ |Replace Words :lFOETAL FETAL

ENGLISH ~[Replace Words »|PATIENT COMPLAINS OF

ENGLISH v |Replace Words :lDISCOMFORT PAIN
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You can test this thesaurus algorithm before you begin using it for automatic
coding. For more information, see "How to test a thesaurus algorithm" on page
299.

Thesaurus algorithm: second example

The following table shows another example of a thesaurus algorithm design and
its corresponding step types:

Change needed: Step type:

1. Remove any date-formatted numbers. Remove Dates

2. Remove characters defined as support elements. Remove Chars

3. Make all plural words singular. Plural to Singular

4. Perform word substitutions iteratively, as defined in Iterative Replace Words
this transformation’s support elements.

5. Remove all words defined as support elements. Remove Words

6. Attempt a direct match of the transformed text with a Exact, step view is a
synonym view. synonym view

7. Attempt a direct match of the transformed text with the ~ Exact, step view is the
terms view. terms view

8. Reorder words in alphabetical order. Alphabetize Words

9. Attempt a direct match of the transformed text with a Exact, step view is

different synonym view.

a different synonym
view

Example thesaurus algorithms

297
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The following example shows how this sample thesaurus algorithm appears

when you create it in Design:

J. Modify Algorithm — SAMPLE?2

Protocol: |ART_THESA.URUS

Algorithm:  [SAMPLE2

Comprehensive
Normalization

Preferred
Terms View: ITERMS

Description: |Second sample thesaurus algorithm

Order Step Type Step View
1 Remove dates = |
2 Remove characters 3 3
3 Plural to singular 3 Z
4 lterative replace words il =
5 Remove words - =
3 Exact =] [SYNONYMS =]
7 Exact | [TERMS =]
8 Alphabetize v v

In Classify, you define the support elements for this thesaurus algorithm’s
Remove Chars, Iterative Replace Words, and Remove Words transformations.
The following example shows the Edit Support Elements window for this
thesaurus algorithm:

a. Edit Support Elements - Algorithm SAMPLE?Z in Thesaurus ART_THESAURUS

Filter: |
Language Transformation Element Replacement

ENGLISH » | Remove Chars " 1710

ENGLISH ~ | Remove Words ~|THE

ENGLISH » | Remove Words vl|A

ENGLISH v | Replace Words +|DISTRESS PAIN

ENGLISH » | Remove Words »|IN

ENGLISH v | Remove Words » |SYMPTOMS INDICATE
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When support elements are entered for this thesaurus algorithm, all words and
phrases entered are uppercase and singular. Because the third step in the
thesaurus algorithm, Plural to Singular, makes all characters uppercase and
changes all words to the singular form, this convention reflects the format that
words and phrases will have when the thesaurus algorithm performs the Iterative
Replace Words and Remove Words transformations, which are its fourth and
fifth steps.

Testing a thesaurus algorithm in Classify

After you complete your design for a thesaurus algorithm and then create it in
Design, you can use Classify to test its performance before it is used during
automatic coding.

How to test a thesaurus algorithm

You test a thesaurus algorithm as follows:

1. In Classify’s Algorithm Browser, select a thesaurus algorithm.

2. From the Algorithm menu, select Test, or double-click the row. The Test
Algorithm dialog box opens.

3. Select a language view. The default is ENGLISH.
4. Enter a word or phrase in the Text to be Matched field.

Ajisse[)

5. Click Test or press Enter.

The thesaurus algorithm’s transformations and lookup steps are applied to your
entered text value to simulate automatic coding. All of the terms in the coding
thesaurus protocol that match the transformed text display.

Note: To test a thesaurus algorithm, you must be assigned the following access
rights and access levels:

* The Read or Full access level for Classify's Thesaurus access right for that
algorithm’s coding thesaurus protocol.

* The Read or Full access level for Design's non-protocol System access right.

How to test the first example

The verbatim text
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Patient complains of  hepatic neoplasia (chronic)

is transformed by the thesaurus algorithm created for the first example on page
295 by the following steps:

* The transformations in this thesaurus algorithm will capitalize all characters,
and remove extra spaces and bracketed text.

*  Support elements must be defined for the transformations that require them.
When you test a thesaurus algorithm, you also test its support elements.

* The lookup steps attempt matches against the terms and synonyms views of
the ART THESAURUS coding thesaurus protocol, which is a version of the
COSTART coding thesaurus.

The following example shows the results of this test in Classify:

& Test - Algorithm SAMPLET1 in Thesaurus ART_THESAURUS E
Language: [ENGUISH ~]

Text to be Matched: |Paiient Complaing of hepatic neoplasia (chronic) |

Search Results

>

f': Code Term View
72}

g CARCINOMA LIVER. HEFATIC NEOPLASIA TERMS

5 NEOPL LWER.1.DIG HEPATIC NEOPLASIA TERMS

T Test | Close Help

By testing this thesaurus algorithm before you assign it to a coding target, you
can determine if automatic coding will succeed or fail for any given text string.
In this example, when the value

Patient complains of  hepatic neoplasia (chronic)

is encountered during automatic coding, it will fail, because there are two
different potential matches after the algorithm is applied. As a result, you may
want to modify your thesaurus algorithm’s step types or edit their defined
support elements, or review the contents of the coding thesaurus protocol by
using one of Classify’s thesaurus reports.

For more information on Classify’s thesaurus reports, see Chapter 18.
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How to test the second example
The following example displays the results of testing the verbatim text:
10/31/2000 conjunctivitis

against the thesaurus algorithm created for the second example, on page 297.
Like the first example, the lookup steps in this thesaurus algorithm attempt
matches to terms and synonyms views in a COSTART coding thesaurus

protocol.
& Test - Algorithm SAMPLE? in Thesaurus ART_THESAURUS | x|
Language: [ENGUISH ~|

Text to be Matched: |1EI;'31}2EIIJIJ conjunciviis |

Search Results

Code Term View
CONJUNCTIMITIS.1.8S CONJUNCTIVITIS TERMS

T Test | Close Help

When automatic coding encounters the value

10/31/2000 conjunctivitis

and this thesaurus algorithm is used, coding succeeds at Step 7.

Testing a thesaurus algorithm in Classify 301
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Overview

This chapter describes how Classify works differently in a Multisite
environment, and contains the following sections:

*  Working with Classify objects in a replication environment
e C(lassify sites
« Examples of Classify replication environments

* Codelists used by Classify

Working with Classify objects in a replication environment

Three types of Classify objects are replicated in a replication environment as part
of the CTCLASSIFY account:

¢ Omission records
*  Synonym solutions

* Support elements

This section contains information about:
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* Creating Classify objects
*  Modifying support elements

* Deleting support elements

Creating Classify objects

If a Classify object is created at the Replication Master site for the
CTCLASSIFY account, the object downloads to all the Replication Subordinate
sites for the CTCLASSIFY account.

If a Classify object is created at a Replication Subordinate site for the
CTCLASSIFY account, the object uploads to the Replication Master site. After
uploading to the Replication Master site, the new Classify object downloads to
other Replication Subordinate sites.

& Caution: If a Replication Subordinate site is invited into the replication
environment for the CTCLASSIFY account as “Read Only”, the site cannot
create Classify objects.
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The following figure shows the uploading and downloading of an omission
record in an account replication environment for the CTCLASSIFY account.

CTCLASSIFY Account Replication Environment

- [ - PE—

e == = °c [ 14
CTCLASSIFY Account: CTCLASSIFY Account: CTCLASSIFY Account:
Replication Subordinate Replication Master Replication Subordinate

. The new omission The new omission
A new omission ) .
. record is uploaded record is
record is created .
. to the Replication downloaded to
at Site 2. . )
Master site. Site 3.
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Modifying support elements

You can only modify a support element in a replication environment at the site
that owns the support element. You cannot modify support elements at any other
site unless you first transfer ownership.

When you modify a support element, the modifications upload and download
throughout the replication environment.

Deleting support elements

You can only delete a support element in a replication environment from the site
that owns the support element. You cannot delete a support element at any other
site unless you first transfer ownership.

Classify sites

The two types of sites related to the tasks that you perform in Classify are the:
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e Autocoding site, and the

* Omission handling site

The autocoding site and the omission handling site may be different sites in the
replication environment. These sites may also be the same site, in which case the
sites are referred to as colocated.

What is an autocoding site?

An autocoding site is the site at which users perform autocoding using Manage.
Every record whose normalized term matches a term in the thesaurus is coded.
Every coding failure results in the creation of an omission record.

For information about coding in a replication environment, see Multisite.

What is an omission handling site?

An omission handling site processes omissions and ultimately purges them using
Classify.

The omission type is determined by three attributes:
* The autocoding site that produced it
* The clinical data protocol

* The coding thesaurus protocol

If your replication environment includes multiple omission handling sites, you
must specify which omission handling site handles which omissions, as
explained in the next section.

Multiple omission handling sites

AN

If there are multiple omission handling sites in the replication environment that
are accepting synonym solutions in the same coding thesaurus, there are two
potential problems, which are described in this section.

Caution: If there are multiple omission handling sites in the replication
environment that are accepting synonym solutions in the same coding thesaurus,
all synonym tables must have a unique index on the TEXT column, and
duplicate errors should be resolved, as described in Multisite, to correct coding
discrepancies.
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Identical synonym solutions

If synonyms with the same text and code are created at different sites:

+ If the synonym at one site has replicated, you cannot accept the synonym at
the second site.

+ If neither synonym has replicated before both synonyms are accepted:

— Ifthere is a unique index on the TEXT column, the second synonym to
replicate causes a replication error.

— If there is not a unique index on the TEXT column, a duplicate synonym
exists after both synonyms have replicated.

Synonym solutions with identical text but different codes

If synonyms with the same text and different codes are created at different sites:

» Ifthe synonym at one site has replicated, then you cannot accept the
synonym at the second site.

» If neither synonym has replicated before both synonyms are accepted:

— If'there is a unique index on the TEXT column, the second synonym to
replicate causes a replication error. If the site where the second synonym
was entered is also an autocoding site, there are clinical data records that
were coded with the synonym which has been deleted from the coding
thesaurus protocol in replication.
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— Ifthere is not a unique index on the TEXT column, after replication, each
site has two synonyms with the same text and different codes. If both
sites are also autocoding sites, records may be coded differently at each
site. Furthermore, future autocoding is compromised because it is unclear
which of the two codes should be used.

How to identify sites

To identify sites:

1. Start Classify and log in to the Replication Master site for the CTCLASSIFY
account.

2. From the Configuration menu, select Autocoding Sites or Omission
Handling Sites. A dialog box opens, displaying all previously specified
sites.

Note: The Configuration menu is enabled only if your access level is Full
for both Accept (in Classify) and Replication (in Multisite).

3. If you want to add a new site, allocate space by selecting Insert Row from
the Edit menu. The Select Site dialog box opens.
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4. Select a site from the drop-down list, and click OK.

& Caution: Before you can identify sites in Classify, you must register the site for
replication in Multisite, as described in Multisite.

What is a site pairing?

A site pairing is an association between one omission handling site and every
autocoding site, clinical protocol, and coding thesaurus protocol grouping. Your
site pairing specifications determine where each type of omission record is
directed for processing.

Example

For example, suppose that one autocoding site is processing one study’s records,
and that it is coding both adverse events and drug names. Because there is one
site and one protocol but two coding thesauruses, there are two autocoding
site/protocol/thesaurus groups, each of which must be assigned an omission
handling site. If your company processes all omissions at one site, you would
assign the same omission handling site to both groups; if your company
maintains topic-specific sites for use by specialized coding experts, you would
assign a different omission handling site to each group.
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A single site

Whether the autocoding and omission handling sites that process a particular
type of omission reside in the same database instance determines what happens
when an omission handling user accepts a solution. When the autocoding site
and the omission handling site are the same site, or colocated, autocoding is
automatically applied to every record for which a Verbatim or Synonym solution
has been accepted, those omissions are automatically labeled Solved.

Multiple sites

If the autocoding site and the omission handling site are different sites, an
autocoding site user must invoke autocoding after the processed omissions (and
thesauruses, in the case of synonym solutions) replicate back to that site. Until
then, the omissions are labeled Solution Pending.
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The following table provides details about how both site-location models
process the acceptance of all three solution types assuming that the
AUTOCODE RECODE_ALL parameter for the clinical data protocol is set to
YES, which is required for Classify.

Sites: Change Verbatim: Create Synonym: Request More Information:
Colocated Status changes to Solved. Status changes to Solved for ~ Status changes to Solution
Sites that omission and any Applied once a flag is added to

matching ones. the source record or a

. discrepancy record is created.

Note: Synonym solutions are paney

autoproposed if the

verbatim, thesaurus,

algorithm, and omission

handling sites are identical.
Non- Status changes to Solved if ~ Status changes to Solution Status changes to Solution
colocated the verbatim change was Pending for that omission Pending, and the omission
Sites autocoded. and any matching ones, and replicates back to the

Otherwise, the status
changes to Solution
Pending, and the omission
replicates back to the
autocoding site. Once
autocoding runs, the
omission’s status changes
to Solution Applied. After
autocoding runs again, it
changes to Solved.

Note: This solution type
requires two invocations
of the autocoder.

both the omission and
thesaurus replicate back to
the autocoding site. Once
autocoding runs, the
omission’s status changes to
Solved. See the previous
Note in this table for
information about
autoproposed solutions.

autocoding site. Once
autocoding runs, a flag is added
to the source record or a
discrepancy record is created,
and the omission’s status
changes to Solution Applied.
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Note: A new Error omission status, which is relevant only to Multisite users,
indicates that the change to the verbatim text, creation of a discrepancy record,
or application of a flag did not occur due to a validation or resource depletion
error. If you are not using Multisite, Classify displays an error message if an
anticipated change cannot be implemented.
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How to specify a site pairing

To specify a site pairing:
1. Start Classify and log in to the Replication Master site for the CTCLASSIFY
account.

2. From the Configuration menu, select Mapping. The Mappings dialog box
opens, listing all previously specified groups and their associated omission
handling sites.

3. To define a new site pairing, from the Edit menu, select Insert Row. The
Specify Mapping dialog box opens.

4. Make selections from the drop-down lists of autocoding sites, protocols, and
thesauruses, and then click OK.

5. Once the group’s attributes display in a single row, complete the associated
Omission Handling Site field.

Note: Do not use an asterisk (*) as a wildcard character in the Omission
Handling Site field.

Examples of Classify replication environments
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This section contains three examples of replication environments that you could
set up to use with Classify.
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Example A

The following figure shows two coding thesaurus protocol replication
environments. The CTCLASSIFY account is not in replication.

Thesaurus

H_' ors ] H_'
Thesaurus T1: j C E Thesaurus T1:

Replication Subordinate Rgr:ﬁ:saat‘ilcj)r:?\/l-;;ier Replication Subordinate
Thesaurus T2: Trl)qesaurus T2: Location of Protocol B
Replication Subordinate Replication M t
Location of Protocol A cplcation Vaster

In this figure:

* The Thesaurus T1 replicates between the Thesaurus Site and Site 1, and
between the Thesaurus Site and Site 2.
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* The Thesaurus T2 replicates between the Thesaurus Site and Site 1.
* Protocol A and Protocol B are not in replication.

» Protocol A uses both Thesaurus T1 and Thesaurus T2.

* Protocol B uses only Thesaurus T1.

* All Manage and Classify activities happen for Protocol A at Site 1.

» All Manage and Classify activities happen for Protocol B at Site 2.

» IfSite 1 or Site 2 adds synonyms to T1 or T2, these synonyms upload to the
Thesaurus Site and download to other Replication Subordinate sites.

Example B

The following figure shows a Classify replication environment with two levels:
*  One level for centralized omission management.

* One level for centralized dictionary management.

In this figure:
* Clear lines represent clinical data protocol replication.

* Shaded lines represent coding thesaurus protocol replication.
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* Black lines represent CTCLASSIFY account replication.

Protocol A: Replication Master
Thesaurus T1: Replication Subordinate
Thesaurus T2: Replication Subordinate

CTCLASSIFY (CL): Replication Subordinate

Protocol B: Protocol A:
Replication Replication
Master > Subordinate
Thesaurus T1: Protocol B:
Replication Replication

Subordinate Subordinate

—_— @)

Thesaurus T2: Thesaurus T1:
Replication @ Replication
Subordinate Master

B
I
=l

Protocol A: Replication Subordinate

CTCLASSIFY (CL):
Replication Master

CTCLASSIFY (CL):
Replication
Subordinate
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Protocol B: Replication Subordinate
Thesaurus T2: Replication Master

CTCLASSIFY (CL): Replication Subordinate

The following tables lists and describes the objects in this figure:

Object: Description:
Thesaurus T1 Replicates between Site 3 and Site 1, and between Site 3
and Site 2.

Synonyms added at Site 1, Site 2, or Site 3 replicate to
the other two sites.
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Object: Description:

Thesaurus T2 Replicates between Site 4 and Site 1, and between Site 4
and Site 2.

Synonyms added at Site 1, Site 2, or Site 4 replicate to
the other two sites.

Protocol A Replicates between Site 1 and Site 3, and between Site 1
and Site 4.

Uses both Thesaurus T1 and Thesaurus T2.

Coding in Manage is done at the site where clinical data
was entered.

Omission records are generated at Site 1.

For coding targets that use Thesaurus T1, omission
records are handled at Site 3.

For coding targets that use Thesaurus T2, omission
records are handled at Site 4.

Protocol B Replicates between Site 2 and Site 3, and between Site 2
and Site 4.

Uses both Thesaurus T1 and Thesaurus T2.
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Coding in Manage is done at the site where clinical data
was entered.

Omission records are generated at Site 2.

For coding targets that use Thesaurus T1, omission
records are handled at Site 3.

For coding targets that use Thesaurus T2, omission
records are handled at Site 4.

CTCLASSIFY account Solutions generated at Site 3 or Site 4 are replicated as
part of the CTCLASSIFY account to all other sites.

Example C

The following figure shows a Classify replication environment with three levels

*  One level for centralized omission management.

*  One level for centralized dictionary management.
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¢ One level for data entry and coding in Manage.

In this figure:
* Clear lines represent clinical data protocol replication.
* Shaded lines represent coding thesaurus protocol replication.

* Black lines represent CTCLASSIFY account replication.

Thesaurus T: Replication Master

CTCLASSIFY (CL): Replication Subordinate

Thesaurus T:
Replication
Subordinate

Thesaurus T:
Replication
Subordinate

CTCLASSIFY
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CTCLASSIFY
(CL): Replication (CL): Replication
Master Subordinate
I ==
Protocol A: Protocol B:
Replication Replication

Subordinate

P S EEEPE
e < o< << <<

Subordinate

e*

Thesaurus T:
Replication Subordinate

CTCLASSIFY (CL):
Replication Subordinate

Protocol A:
Replication Master

Thesaurus T:
Replication Subordinate

CTCLASSIFY (CL):
Replication Subordinate

Protocol A:
Replication Subordinate

Protocol B:
Replication Subordinate

Thesaurus T:
Replication Subordinate

CTCLASSIFY (CL):
Replication Subordinate

Protocol B:
Replication Master
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The following tables lists and describes the objects in this figure:

Object: Description:

Thesaurus T Replicates between Site 1 and each site in the Multisite
environment. For Site 4, Site 5, and Site 6, Thesaurus T
replicates as read-only data.

If Site 1, Site 2, or Site 3 adds synonyms, these
synonyms are replicated to each site in the Multisite
environment.

Protocol A Replicates between Site 4 and Site 2, and between Site 4
and Site 5.

Coding in Manage is done at the site where clinical data
was entered.

Omission records are generated at Site 4 and Site 5.

Omission records are handled at Site 2.

Protocol B Replicates between Site 6 and Site 3, and between Site 6
and Site 5.

Coding in Manage is done at the site where clinical data
was entered.
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Omission records are generated at Site 5 and Site 6.

Omission records are handled at Site 3.

CTCLASSIFY account Solutions generated at Site 2 or Site 3 are replicated as
part of the CTCLASSIFY account to all other sites.

Codelists used by Classify

Classify uses two codelists that are created during the Classify server installation
for which there are requirements when Classify is used in a replication
environment:

. CTS$THESA ALGO STEP
« CTS_CTG DSC TXT
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CTSSTHESA ALGO_STEP codelist

The CTSSTHESA ALGO_STEP codelist must be maintained separately at each
site in the CTCLASSIFY account replication environment.

& Caution: You must not distribute the CTSSTHESA ALGO_STEP codelist in
the CTCLASSIFY account replication environment.

CTS_CTG_DSC_TXT codelist

The CTS_CTG_DSC_TXT codelist, which stores text fragments for the
Predefined Message field in the Request More Info dialog box, may be
distributed to sites in the CTCLASSIFY account replication environment. The
Replication Master site of the CTCLASSIFY account should be the Distribution
Master site for this codelist.
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Manage, Classify, and Lab Loader

Lab Loader

Chapter 21: Introduction to Lab Loader
Chapter 22: Batch Loading Lab Data
Chapter 23: Preparing Data for Transfer
Chapter 24: Transferring Records
Chapter 25: The Error Log

Chapter 26: Lab Loader Setup

Chapter 27: Lab Loader System Administration

Chapter 28: Lab Normals

JI9peoT qe|

Chapter 29: Control Files

Chapter 30: Transfer Maps
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Chapter 31: Lab Loader and Multisite
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Introduction to Lab Loader

Overview 321
Why use Lab Loader? 322

What are source and destination
protocols? 322

Who uses Lab Loader? 322

Batch loading data 322
What is an input file? 323
What is a control file? 323

Preparing data for transfer 323
About screening records 324
About validating records 324

Transferring data 325
What is a transfer map? 325
How data is transferred 325
After transferring data 325

Lab Loader workflow 326
Lab Loader setup workflow 327

Example 328

Destination panel structure 328

Source panel structure 328
Input file 329
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Control file 329

Batch Load Log 330

Records after batch loading 331
Records after screening 332
Records after validation 332
Transfer map 333

Records after transfer 333
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Overview

The Clintrial software Lab Loader module is a Clintrial software extended
module that you use to:

» Batch load lab data into a source protocol
* Process the data

» Transfer the data into a clinical data destination protocol
The following figure shows how to set up the Clintrial software system and

manage Clintrial software data. The figure indicates where Lab Loader fits in
this system:

Set Up and Manage Clintrial System

. Set Up and Set Up and Set Up Lab
Admin Maintain Users Maintain Security H Loader Security
S Design the Create Clintrial Create Lab
esign Database Objects Loader Objects

Enter and Manage Clintrial Data

. . Batch Load and

Ent

nter Verify Data Enter and Edit Data Process Lab Data

Validate and Advanced Edit

M

e Merge Data and Batch Load Transfer Lab Data

. Review Query .

Retrieve Results ﬁ Create Queries
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Why use Lab Loader?

Lab Loader extends the batch-loading capabilities that are provided in Manage.

Using Lab Loader, you first batch load data into a source protocol. You can then
prepare the data through editing, screening, and validation to ensure that it is in
the form that you want before transferring the data into the destination protocol.

What are source and destination protocols?

When you use Lab Loader to batch load laboratory data, you use two different
types of protocols:

* A source protocol is a Lab Loader protocol (Type 4) into which you batch
load lab data. You work with the lab data in this protocol to prepare it for
transfer to the destination protocol.

* A destination protocol is a clinical data protocol (Type 1) that contains the
clinical data for a study. You transfer the lab data into this protocol after
preparing it in the source protocol.

Who uses Lab Loader?

Lab Loader users are generally data managers who are responsible for receiving
lab data from central laboratories, and then preparing the lab data to be placed in
the destination protocol for a study.

This module is also used by designers, who may be responsible for creating
control files and transfer maps.

Batch loading data

Using Lab Loader, you can place lab data into the update tables of a source
protocol. Batch loading is the process of taking data that is stored in an ASCII
file and placing that data directly into a Clintrial software database table.
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Lab Loader uses Oracle SQL*Loader to perform the initial step in the batch-
loading process.
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What is an input file?

An input file is an ASCII file that contains lab data to be batch loaded into the
Clintrial software. Each line in the input file is a record composed of delimited
fields. Each field in a record contains data that will be batch loaded into an item
in the source protocol.

For each input file, you create a control file to describe how data from the input
file will be batch loaded into the source protocol.

What is a control file?

A control file is a file that describes how data from an input file will be batch
loaded into the source protocol. The control file:

+ Interprets the organization and format of data in the input file for
SQL*Loader.

* Provides instructions on how SQL*Loader loads data from the input file into
the database table.

Preparing data for transfer

The structure of the data in the input file may differ from the structure of the data
in the destination protocol. For example, one item in the destination protocol
may be the result of a calculation between two different items in the input file.
Or, the data type of an item in the input file may be different from the data type
of the same item in the destination protocol.

You can manipulate the data in the source protocol using editing, screening, and
validation procedures to prepare the data for transfer. You must prepare the data
to ensure that it corresponds to the structure of the data in the destination
protocol.

After you batch load data, you must perform the following tasks to prepare the
data for transfer:

e Screen the data.
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» Validate the records.
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Optionally, you can perform the following additional tasks:
» Edit the records.

¢ Delete unscreened records.

About screening records

Screening is a combination of several processes performed from one menu
command. You screen records after data is batch loaded into the source protocol.
When you screen records, Lab Loader performs the following:

* Updates the system items. The system items in records that were
successfully batch loaded into the database table are given values. The values
assigned are equivalent to those assigned when you interactively enter
records through Enter. A system item is an internal item used by the Clintrial
software to uniquely identify records. System items are automatically
attached to each record.

* Groups the records into observations, if grouping items are indicated in
Design. Grouping the records organizes batch-loaded records into
observations. An observation is a group of records in a page section that
contains repeating items, or a group of records in a non-subject study book
that has been configured for grouping. For example, you might group
multiple blood tests that were taken on one sample into a single observation.

* Applies data checks to batch-loaded data. When data checks are applied to
batch-loaded data, the same checks that are applied to interactively entered
data are applied.

About validating records

Validation is the process of running a validation procedure on clinical data to
ensure that the data meets the requirements of the clinical trial for logical and
consistent data. Validation also applies any derivations that are defined. Data can
either pass or fail validation.

Each panel has one validation procedure. A validation procedure is a PL/SQL
procedure that is built automatically from the derivations and rules associated
with the panel:

* Derivations calculate values of items or temporary variables that the designer
has set up as Derived based on constants or on the values of other items.
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* Rules are PL/SQL statements that evaluate to either true or false.
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Because the panels in the source protocol can differ from the panels in the
destination protocol, you may need to use the validation procedure to help
prepare the data for transfer.

Transferring data

Data transfer is the process of moving data from a source protocol to a
destination protocol. The transfer is directed by criteria specified in a transfer
map.

You can only transfer data from a Type 4 - Lab Loader protocol into a Type 1 -
Clinical Data protocol. That is, the source protocol must be a Lab Loader type
protocol, and the destination protocol must be a Clinical Data type protocol.

What is a transfer map?

A transfer map indicates the data to be transferred from a source protocol to a
destination protocol by establishing a direct connection from the source items to
the destination items. The transfer map indicates which data will be transferred,
and indicates the location for the transferred data to be stored.

How data is transferred

When you transfer data, you set the current protocol to the destination protocol
into which you want to transfer data. You then select the transfer map that you
want to use to transfer data, and then start the transfer.

After transferring data

After you transfer the data into the destination protocol, you can use the
following reports to check the status of the data transfer and the records:

* Duplicates Report

JI9peoT qe|

* Error Log
* Transfer Log
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If errors occur during the transfer, entries appear in the source protocol’s Error
Log for records that did not transfer. Entries appear in the destination protocol’s
Error Log for records that transferred, but that encountered an error, such as a
screening error, during the transfer process.

If the data transferred successfully, you can work with the data in the destination
protocol as you would with any interactively entered data, or with data that was
batch loaded through Manage.

Lab Loader workflow

The following figure shows the workflow that you should follow to batch load
and transfer lab data using Lab Loader. These tasks are described in Part I:

Batch Load Lab Data

1

Screen Records

1

Edit Records

l

Validate Records ﬁ Transfer Data to

Destination Protocol
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Lab Loader setup workflow

The following figure shows the workflow you should use to set up Lab Loader.
These tasks are described in Part II:

Design the Clinical Desian the Source
Design Data Destination gProtocoI
Protocol

Admin

Lab Loader
Source Protocol

Lab Loader
Source Protocol

Design

Lab Loader
Source Protocol

Lab Loader
Source Protocol

Lab Loader
Destination Protocol

Set Up Security

1

Create Control Files

1

Test the Control Files
by Batch Loading
Sample Data

1

Create Derivations
and Rules for Lab
Loader Protocols

l

Test Derivations
and Rules

1

Create Transfer
Maps
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1

Test the Transfer
Maps by Transferring
Sample Data
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Example

The following example demonstrates the batch loading, screening, validation,
and transferring processes.

Destination panel structure
The following CONTEXT panel and LAB panel were set up for the XYREXEL

protocol to be used as the destination panels:

Ellem Browser S [=1
Filter: [protocal = "YREXEL' AND panel ='CONTEXT' |

Rev o
State DB Format Description

Protocol Panel Ite:
COMTEXT MWES MUMBER(5] Iy tor |0

HYREXEL COMTEXT PAGE IN MUMBER[E) Page number
FREXEL COMTEXT PAGEREPEAT IN_ MUMBER(E] Page repeat key item
HrREXEL COMTEXT SUBJECT IN_ MUMEBER[E] Subject ID
HrREXEL COMTEXT WISIT IN_ MUMEBER[E] Wigit number
XYREREL COMTEXT WISITREPEAT IN MUMEBER[S] Visit repeat key item
Ellem Browser [_[O] %]

Filter: [protocol = }YREXEL' &ND panel = LAB' |

Rev

Protocol Panel Item State DB Format

; LAE

XYREREL LB TEMPERATURE IN_ MUMEBER[E.Z]

XYREREL LB TEST IN_ MARCHARZ(20)  Test name
HYREREL LB WISITDATE IN  DATE Visit date

Source panel structure

The following LAB panel was set up for the XYREXEL LAB SRC protocol to
be used as the source panel:

Ellem Browser [_[O] =]

Filter: ‘pmtocol =WYREXEL_LAB_SOURCE' AND panel = LAR |
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WARCHA N

VARCHARZ(20)  Laboratory name
HYREXEL_LAB_SOURCE  LAR PAGE IN_ MUMBER(E] Page rumber
HYREXEL_LAB_SOURCE  LAR SUBJECT IN_ MUMBER(E] Subject ID
sorREXEL_LAB_SOURCE  LAR TEMPERATURE IN_ MUMBER[E.2]  Temperature
XYREXEL_LAB_SOURCE  LAR TEST IN_ MARCHARZ(20)  Test name
XYREXEL_LAB_SOURCE  LAR WISITDATE IN_ DATE Wisit date
*YHEXEL_LAB_SOLURCE  LA&B WISITND IN MUMBER[S) Wisit number

328 Chapter 22: Introduction to Lab Loader



Input file

The following input file, named SOURCE.TXT, contains six records that
provide results of two specific lab tests (XGT and XGX) for six patients:

001,NATIONAL LABS,XGT,012,1,1,12/11/1998,98.1
002,NATIONAL LABS,XGX,013,1,1,12/11/1998,98.5
003,NATIONAL LABS,XGX,012,1,1,12/11/1998,98.5
004,NATIONAL LABS,XGX,012,1,1,12/11/1998,99.6
005,NATIONAL LABS,XGT,013,1,1,12/11/1998,100.0
006,NATIONAL LABS,XGT,013,1,1,12/11/1998,100.2

Control file

The lab data from the SOURCE.TXT input file was loaded into the LAB panel
of the XYREXEL LAB SRC protocol using the following control file named
LAB.CTL:

Control file for loading data
into:

XYREXEL LAB_SRC.LAB_UPDATE
LOAD DATA

REPLACE
INTO TABLE XYREXEL_LAB_SRC.LAB_UPDATE

-- Note: Change @ to your file's separator character and adjust the 'ENCLOSED BY'
clause

FIELDS TERMINATED BY ', OPTIONALLY ENCLOSED BY "

TRAILING NULLCOLS

(STATUS constant 3,

CT_RECID sequence  (count),

SUBJECT ID constant 0,

SUBJECT "RTRIM(LTRIM(:SUBJECT))",

LAB "RTRIM(LTRIM(:LAB))", g
TEST "RTRIM(LTRIM(:TEST))", (=n
INVESTIGATOR NULLIF INVESTIGATOR=BLANKS, g
PAGE NULLIF PAGE=BLANKS, g-
VISITNO NULLIF VISITNO=BLANKS, 2
VISITDATE DATE "MM/DD/YYYY",

TEMPERATURE NULLIF TEMPERATURE=BLANKS)

Example 329



Batch Load Log

The batch load completed successfully, as indicated in the following Batch Load
Log:

SQL*Loader: Release 11.2.0.1.0 - Production on Mon Mar 19 14:45:02 2012
Copyright (c) 1982, 2009, Oracle and/or its affiliates. All rights reserved.
(Allow all discards)

Number to load: ALL

Number to skip: 0

Errors allowed: 50

Bind array: 64 rows, maximum of 256000 bytes
Continuation: none specified

Path used: = Conventional

Table XYREXEL LAB SRC.LAB UPDATE, loaded from every logical record.
Insert option in effect for this table: APPEND
TRAILING NULLCOLS option in effect

Column Name Position Len Term Encl Datatype
STATUS CONSTANT Value is '3'
CT_RECID SEQUENCE (COUNT, 1)
SUBJECT ID CONSTANT Value is '0'
SUBJECT FIRST * , O(") CHARACTER
SQL string for column : "RTRIM(LTRIM(:SUBJECT))"
LAB NEXT * , O(") CHARACTER
SQL string for column : "RTRIM(LTRIM(:LAB))"
TEST NEXT * , O(") CHARACTER
3 SQL string for column : "RTRIM(LTRIM(:TEST))"
-g INVESTIGATOR NEXT * , O(") CHARACTER
S NULL if INVESTIGATOR = BLANKS
£ PAGE NEXT * , O(") CHARACTER
3 NULL if PAGE = BLANKS
VISITNO NEXT * , O(") CHARACTER
NULL if VISITNO = BLANKS
VISITDATE NEXT * , O(") DATE MM/DD/YYYY
TEMPERATURE NEXT * , O(") CHARACTER
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NULL if TEMPERATURE = BLANKS

Table XYREXEL _LAB SRC.LAB_UPDATE:

6 Rows successfully loaded.

0 Rows not loaded due to data errors.

0 Rows not loaded because all WHEN clauses were failed.

0 Rows not loaded because all fields were null.

Space allocated for bind array:
Read buffer bytes: 1048576

Total logical records skipped: 0
Total logical records read: 6
Total logical records rejected: 0
Total logical records discarded: 0

Run began on Mon Mar 19 14:45:02 2012
Run ended on Mon Mar 19 14:45:04 2012

Elapsed time was:  00:00:01.31
CPU time was: 00:00:00.07

Records after batch loading

133824 bytes(64 rows)

The following example shows the records as they initially appear in the

LAB_UPDATE table after batch loading, but before any of the data preparation

tasks have occurred. Note the values for the system items ENTRY ID and

CT_RECID:
& Loaded Records _ O] x!

Status Entiy |d Entiy Datetime CtRecid | Dbld | SubjectId | Investigator Lab FPage | Subject| Temperature] b
CTS$L0A0_<vREXEL_LAB [03/17/193914:0956 |1 2 mz MNATIOMAL LABS 1 1 9BHGT
CTS$L0A0_<vREXEL_LAB (03/17/193914:0956 |2 2 o3 MNATIOMAL LABS 1 24 98.5=Gx g
CTS$L0AD_<vYREXEL_LAE (03/17/1939 140356 |3 2 mz MNATIOMAL LABS 1 98.5=Gx
CTS$L0AD_WYREXEL_L&E |03/17/193314:0956 |4 2 oz MATIOMAL L4ES 1 4 93 ERGR r
CTS$L0AD WYREXEL_L&E |03/17/1933 140956 |5 2 o3 MATIOMAL L4ES 1 g 100RGT =
CTE$LO0AD_XYREXEL_LAR |03/17/193314:0856 |E 2 L] MNATIOMAL LABS 1 K 100.2=GT g-

141 | I 2
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Records after screening

The following example shows the records as they appear in the LAB_ UPDATE
table after screening. Note the new value for the system item STATUS:

. Query Results
SELECT status. entry_id. entry_datetime. ct_recid. db_id. subject_id. investigator. lab. page. subject. temperature. test FROM XYREXEL_LA

[H[=] E3

Status | EntryId Entry Datetime Ct Recid Dbld | Subject Id | Investigator Lab Fage | Subject [Temperat
WYCTSYS (03171999 140956 |2.50LL0AD 0000w, 00 2 gmz NATIOMAL LABS 1 1 ]
ACTSYS (034771933 140556 |2 50LL0AD OCODWANDT 001 2 aoa MATIONAL LABS 1 2 9
1CTSYS (0341771939 140356 |250LL0AD OCODWAND2 001 2 aomz MATIONAL LABS 1 9
JCTSYS  |03/17/1999 14:0%:56 |250LL0AD OCOOWE.O01 2 aomz MATIONAL LABS 1 4 9
CTSYS (03171999 140956 |2.50L0L0AD 0CO0WEDDT.0M i ooms HATIOMNAL LAES 1 g 1
CTSYS (03171999 140956 |2.50LL0AD 0CO0WEDDZ.001 i ooms HATIOMNAL LAES 1 K 10

1 3

Records after validation

The following example shows the records as they appear in the LAB_ UPDATE
table after successful validation. Note the new value for the system item
STATUS:

. Query Results Hi= B

SELECT status. entry_id. entry_datetime. ct_recid. db_id. subject_id. investigator. lab. page. subject. temperature. test FROM XYREXEL_LA

Status | Entrpld Entiy Datetime Ct Recid Dbld | Subjectld | Investigstor Lab Page | Subject |Temperaturs
CTSYS  |03/A1741939 7140956 |250LL0AD.OCO0WA. 001 2 oz MNATIONAL LABS 1 1 381

CTSYS 0371741993 140356 |2 SULLOAD OCOOWADDT 001 2 ma MNATIONAL LABS 1 2 98.5;

CTSYS 0371741993 140356 |2 SULLOAD OCOOWADDZ 001 2 mz MNATIONAL LABS 1 98.5;

CTSYS  |03/17/193914:09%.56 |2,S0LLOAD.OCOOWE.001 2 mz MNATIONAL LABS 1 4 99.5;

CTSYS  |03A17/199314:0356 |250LL0AD.OCO0WEOM .00 2 o3 NATIONAL LABS 1 g 100;

CTSYS  |03A17/199314:0356 |250LL0AD.OCO0WEO02.001 2 o3 NATIONAL LABS 1 K 100.2;

14l | 3
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Transfer map

The following transfer map transfers the records from the LAB panel of the
XYREXEL LAB SRC source protocol to the CONTEXT and LAB panels of
the XYREXEL destination protocol:

[l Transfer Map - XYREXEL
Destination Protocol:  XYREXEL

Destination Panel.ltem

Source Protocol: XYREXEL_LAB_SRC

Destination Panels: _ Source Panel:  LAB

Source ltem

[Cestination Pratocol]

[ [=]

CONTEXT.SUBJECT [SUBJECT [~
CONTEXT.PAGE [PaGE [~
CONTEXT MISITHO [wISITHO [~
CONTEXT.INVESTIGATOR [INVESTIGATOR [~
LB WISITDATE [VISITDATE [~
LAB LAB [LaB [~
LAB.TEST

LAB TEMPERATURE

Destination Type: HUMBER(6.2]

Map Description

Source Type: NHUMBER([G.2)]

< prexel tranzfer map

Records after transfer

- [0] %]

The following example shows the records as they appear in the LAB_ UPDATE

table in the XYREXEL protocol after they have been transferred. Note the new
values for the system items CT_RECID and SUBJECT ID:

# Query Results

SELECT status, entry_id, entry_datetime, ct_recid, db_id, subject_id, lab, temperature, test FROM XYREXEL.LAB_ UPDATE

Status

I« |

Entry Id Entry D atetime Ct Recid Dbld | Subjectld
1CTSYS 0371939 14:42:42 | 2XFER. OCOO0KKOM. 0O
1CTSYS 034171939 14:42:42 | 2XFER OCO0KKOD2.001
1CTSYS 034171939 14:42:42 | 2XFER OCO0KKOD3.001
CTSYS (0341741999 14:42:42 | 2XFER OCOOkkO0D4 001
WCTSYS (0341741993 14:42:42 | 2XFER OCODkkOD5.007
NCTSYS  |03/17/1999 14:42:42 |2XFER.OCOOkKK. 001

rafraf el ral ral pa

Lab
ONATIOMAL LABS
ONATIOMAL LARS
ONATIOMAL LARS
ONATIONAL LABS
ONATIONAL LABS
OMATIONAL LABS

Temperature Test
585G
58 BXGH
iR
100%GT
100.2%G6T
98.1=GT
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Overview

Lab data for a clinical study typically comes from a central laboratory as raw
data in an ASCII file. Using Lab Loader, you batch load this data into a source
protocol, and then perform the following tasks:

e Edit the raw data.
¢ Validate the data.

* Transfer the prepared data into a destination protocol.

You cannot batch load data directly into a clinical data protocol. You perform
batch loading in the source protocol. You must first set the current protocol to the
source protocol to batch load data.

If you are using master-detail panels, you must batch load the master panel data
before you batch load the detail panel data.

What is batch loading?

Batch loading is the process of taking data that is stored in an ASCII file and
placing the data directly into a Clintrial software database table.

When you batch load data, you need two files:
* An input file. An input file is an ASCII file that contains lab data.

* A control file. A control file is a file that describes how data from an input
file will be batch loaded into the source protocol

What is an input file?

An input file is an ASCII file that contains lab data. Each line in the file is a
record composed of fields. Each field contains data that will be batch loaded into
a Clintrial software item.

There can be data for one specific protocol or for multiple protocols in the same
input file. The input file can be in either fixed format or variable format.
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The following example shows records in a variable format input file. Each line
corresponds to a single record, with fields separated by
commas:

325,M89,0,022,3/9,5/15/1995 00:00:00,0,ASH,,4/13/1994 00:00:00,5/15/1995 00:00:00,1
325,M89,0,023,3/9,4/5/1995 00:00:00,1,L-W,,6/7/1980 00:00:00,4/5/1995 00:00:00,14,1
325,M42,0,007,3/9,7/9/1976 00:00:00,1,MDS,,1/1/1961 00:00:00,1/1/1976 00:00:00,,1,2
325,99,0,998,3/9,1/1/1911 00:00:00,1,MEH,,2/2/1922 00:00:00,1/1/1911 00:00:00,,1,1,

Note: You must edit the control file to match the structure and order of the data
you will be batch loading.

What is a control file?

A control file is a file that describes how data from an input file will be batch
loaded into the source protocol. It functions as the interface between the input
file and the Clintrial software database tables, and specifies the location where
the Clintrial software should store the data. In Lab Loader, this initial storage
location is a panel in a source protocol.

You do not need to batch load all of the information in the input file to the source
protocol. You can selectively eliminate information that should not be batch
loaded by removing the associated item from the control file.
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The following figure shows the interaction between the input file, the control
file, and the Clintrial software database:

325, M89, 5/5/1999, ASH...
325, M89, 5/19/1999, ASH...
325, M42, 5/6/1999, MDS...

...Control File
Data from the Load Dat
input fileis A?)ien da a
interpreted by Into Table Labdata_Update
the control Fields Terminated by ',
file..
Protid,
Subid,
Visdate "MM/DD/YYYY",
Patinit,
LABSDATA_UPDATE table
' then the batch Protid | Subid Visdate | Patinit
loaded in the 325 | M89 |5/06/1999 | ASH
dalabase table.
325 M89 | 5/19/1999 | ASH
325 M42 | 5/06/1999 | MDS

Using Lab Loader, you can create new control files or edit existing control files.
These control files can be stored in the database control file library, and are then
available to any user with the correct privileges. You can also save control files
to a file on your client.

Note: You must save the control file to a file on your client before you can use it
to batch load data.
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The following example shows a sample control file for batch loading data into
the LAB panel of the XYREXEL LAB_SRC protocol:

Control file for loading data

into:
XYREXEL LAB SRC.LAB _UPDATE
LOAD DATA

REPLACE
INTO TABLE XYREXEL LAB SRC.LAB UPDATE

-- Note: Change @ to your file's separator character and adjust the 'ENCLOSED BY'

clause

FIELDS TERMINATED BY ', OPTIONALLY ENCLOSED BY "
TRAILING NULLCOLS

(STATUS constant 3,

CT_RECID sequence  (count),

SUBJECT _ID constant 0,

SUBJECT "RTRIM(LTRIM(:SUBJECT))",

LAB "RTRIM(LTRIM(:LAB))",

TEST "RTRIM(LTRIM(:TEST))",

INVESTIGATOR NULLIF INVESTIGATOR=BLANKS,
PAGE NULLIF PAGE=BLANKS,

VISITNO NULLIF VISITNO=BLANKS,

VISITDATE DATE "MM/DD/YYYY",
TEMPERATURE NULLIF TEMPERATURE=BLANKS)

Additional information

For more information on creating, editing, and saving control files, see Chapter
30.

Using the control file library
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During the course of a clinical study, you may receive multiple input files from
different labs. You can create standard control files to batch load the data, and
then store the control files in the database control file library.
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After the control files are saved to the library, they can be accessed by any user
who has the correct privileges, and can then be used multiple times. You and
other users do not have to recreate the control files each time you receive data
from the labs.

Batch loading data

When you batch load data, the input file and the control file that you want to use
must be saved as files on your client or on a network in an accessible location.
You cannot use a control file for batch loading data while it is stored in the
control file library. If either the input file or the control file is missing, the
Clintrial software cannot batch load the data.

The Clintrial software uses Oracle SQL Loader to batch load data. For more
information on batch loading, see your Oracle SQL Loader documentation.

Note: To batch load data, you must have the Oracle SQL Loader
Utilities included with Oracle8 installed on your client, and you must connect to
the Clintrial software using an Oracle Net8 alias.

How to batch load data

To batch load data, from the Load menu, select Load Data. The Batch SQL
Loader dialog box opens:

[l Batch SOL Loader
|
Control File: | Browse. .
Cancel |
Advanced. .. |

Browse._ .. | Help |

@dog

Database:

Discard:
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In this dialog box, you specify the control file and the input file that you want to
use for the batch load. The Clintrial software saves the files in this dialog box as
default values for the next session. You can change these default values.

340 Chapter 23: Batch Loading Lab Data



The Clintrial software also creates default names for three additional files. You
can change the default names of the files. The following table describes the files:

File: Description:

Log The Log file is a SQL Loader file that records information about the
batch load. For example, the Log file specifies any errors that occur
with a record during the batch load. You can use this file to
determine if the batch load was successful.

The default name for the Log file is the name of the control file with
the three-character extension .LOG. For example, if the control file
name is loaddata.ctl, then the default Log file name is
loaddata.LOG. This file is stored by default in the same directory as
the control file. You can change this default.

For information on viewing this file, see page 343.

Bad The Bad file contains records that could not be successfully batch
loaded. For example, if a value exceeds its maximum length, then
the record is copied into this file.

After the batch load completes, you can edit the records in the Bad
file, and then use the Bad file as the new input file.

The default name for the Bad file is the name of the input file with
the three-character extension .BAD. For example, if the name of the
input file is labdata.dat, then the default Bad file name is
labdata.BAD. This file is stored by default in the same directory as
the input file. You can change this default.

Discard The Discard file contains records that do not meet the batch load
criteria. You can edit the records in this Discard file, and then use
this file as the new input file.

The default name for the Discard file is the name of the input file
with the three-character extension .DIS. For example, if the name if
the input file is labdata.dat, then the default Discard file name is
labdata.DIS. This file is stored by default in the same directory as
the input file.You can change this default.

For information on specifying batch load criteria, see your Oracle
SQL Loader documentation.
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Note: Although the Clintrial software creates default names for the Bad file and
the Discard file, these files are optional. The files will not be generated if you
delete the default names from the dialog box.
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About advanced Batch Loader options

You can set advanced SQL Loader options by clicking Advanced to open the
Advanced Batch Loader dialog box.

The following table describes the options you can set in the Advanced Batch

Loader dialog box:
SQL
Loader
Option: Description: parameter:
Records to Skip The number of logical records from the SKIP
beginning of the file that should not be
loaded. Use this option to continue batch
loads that have been interrupted.
Records to Load The number of logical records to load after LOAD
skipping the number of records specified in
Records to Skip.
Rows per Commit The number of rows in the bind array. ROWS
Maximum Errors The number of insert errors allowed before ERRORS
SQL Loader terminates with an error.
Maximum The number of discards allowed before SQL DISCARDM
Discards Loader terminates with an error. AX
Maximum Bind The maximum size in bytes of the bind array. ~ BINDSIZE
Array

How to begin batch loading

Once you have indicated the control file and the input file to use and have
optionally set advanced SQL Loader options, you can begin the batch load.

To begin the batch load in the Batch SQL Loader dialog box, click Load. The
batch load begins.

-
2]
=
s
=
—
=
«
—

342 Chapter 23: Batch Loading Lab Data



About the record status and system items

The system items STATUS, CT_RECID, and SUBJECT _ID are included in the
default control file. When you batch load records into Lab Loader, values for the
system items are defined automatically. The following table lists the system
items and the values to which they are set:

System item: Default value:
STATUS Unscreened (3)
CT_RECID An increasing integer that is one number higher than the

largest current value

SUBJECT_ID 0

Note: New values for these system items are created when you screen the items.

For more information on screening items, see page 347.

About the Batch Load Log

The Batch Load Log (also called the Log file) is a SQL Loader file that records
information about the batch load as it occurs. You can use this report to help
determine if the batch load completed successfully.

To display the Batch Load Log from within the Clintrial software, from the
Reports menu, select Batch Load Log. The Open dialog box displays.

Select the Batch Load Log that you want to view. The file is stored in the same
directory as the control file that you used to load the data. The Batch Load Log
displays.

You can also view this file using any text editor.

Note: The name for the Batch Load Log file is the name that you specified for
the Log file in the Batch SQL Loader dialog box.
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How to view batch-loaded records

It is recommended that you verify that the records that you batch loaded were
loaded correctly. To view the records, from the Load menu, select Show Raw
Loaded Records.

After you select a panel and table for which you want to edit unscreened records,
the Loaded Records window opens:

M|
Status Enty Id Entiy Datetime CtRecid | Dbld | SubjectId | Investigator Fage | Subject [Temperature
CTS$LO0AD_¥vREXEL_LAB |03/17/1399 15:06:46 |1 2 oz MNATIOMAL LABS 1 1 98.1[=GT
CTS$LO0AD_¥vREXEL_LAB |03/17/1399 15:06:46 |2 2 o3 MNATIOMAL LABS 1 24 985G
CTS$LOAD_¥vREXEL_LAB |03/17/1999 15:06:46 |2 2 mz MNATIOMAL LABS 1 985G
CTS$L0AD_=vREXEL_LAB |03A17/1999 15:06:46 |4 i 012 MATIOMAL L4ES 1 4 93BG
CTS$L0AD _=vREXEL_LAB |03A17/199315:06:46 |5 i 013 MATIOMAL L4ES 1 g 100GT
CTS$L0AD =vREXEL_LAB |03A17/1999 15:06:46 |6 i 013 MNATIOMAL LABS 1 K 100.2=GT
14 | »

Note: The Loaded Records window displays only those records that have not
yet been screened. When you have successfully screened the items, the items no
longer display in the window, and you must use interactive SQL to view the
records.

If there is more than one page of records, then you can use the View menu
commands to navigate through the records. From the View menu, select:

» First Page to display the first page of records

* Prior Page to display the previous page of records

* Next Page to display the subsequent page of records
* Last Page to display the last page of records

You can also use the arrow buttons on the Task toolbar to navigate the pages of
records.
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Overview

After you have batch loaded the lab data into the source protocol, you can
prepare the data for transfer into the destination protocol.

Note: Data preparation tasks are performed in the source protocol. You must set
the current protocol to the source protocol to perform these tasks.

To prepare data for transfer, you must perform the following tasks:
» Screen the records.
* Validate the records.

You can also perform the following optional tasks:
» Edit the records.

¢ Delete unscreened records.

Data preparation workflow

The following workflow shows how the data preparation tasks relate to each
other:

Screen Records

1

Edit Records

l

Validate Records
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Screening records

Screening is a combination of several processes performed as one single task.
You screen records after data is batch loaded into the source protocol. When you
screen records, Lab Loader performs the following tasks:

* Updates the system items. The system items in records that were
successfully batch loaded into the database table are given values. The values
assigned are equivalent to those assigned when you interactively enter
records through Enter. A system item is an internal item used by the Clintrial
software to uniquely identify records. System items are automatically
attached to each record.

* Groups the records into observations, if grouping items are indicated in
Design. Grouping the records organizes batch-loaded records into
observations. An observation is a group of records in a page section that
contains repeating items, or a group of records in a non-subject study book
that has been configured for grouping. For example, you might group
multiple blood tests that were taken on one sample into a single observation.
Observations will succeed or fail the transfer as a group. Records grouped
into a single observation are displayed as a repeating group in a study page in
Enter, and exist collectively in the update and data tables.

Note: 1t is not recommended that you group items in a Lab Loader protocol
unless absolutely necessary. System performance will be negatively effected.

* Applies data checks to batch-loaded data. When data checks are applied to
batch-loaded data, the same checks that are applied to interactively entered
data are applied. The data checks are:

— Confirming that subjects are enrolled.

— Confirming that subject keys, block keys, and page keys are defined.
— Confirming that subset keys (if used) are defined.

— Confirming that a master record exists for a set of detail records.

— Confirming that the master key is unique.

— Confirming that grouping items have values, if grouping items are
defined.

— Confirming that values are provided for mandatory items.

— Confirming that a code or value for an item with an attached codelist
exists in the codelist.

— Applying the range checks (upper and lower limits) that are defined for
items.

JI9peoT qe|

— Confirming that a value exists in the checklist for an item with an
attached checklist.
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For more information on specifying grouping items, see the Design section in
Admin and Design.

System item values

When you screen records in a source protocol, the Clintrial software assigns the
following values to the system items:

* Sets CT_RECID to a unique system number for each record.

This CT_RECID is used only in the source protocol. The Clintrial software
assigns a new CT_RECID automatically during data transfer.

* Sets ENTRY DATETIME to the system date at the time of the screening.
* Sets ENTRY ID to the user account that screened the records.

* Sets DB _ID to the correct database instance.

* Assigns a value of “0” to SUBJECT _ID.

All panels in Lab Loader are Type 0 panels. Therefore, in the source
protocol, the SUBJECT ID item is merely a placeholder. It is not referenced
in Lab Loader. The Clintrial software assigns a valid SUBJECT ID
automatically during data transfer, using data from the destination protocol’s
enrollment panel.

How screening affects the record status

When you batch load records, the Clintrial software assigns the status
Unscreened (3) to all records that are successfully loaded into the update table.

During screening, if you release records for validation and the records pass
screening, then the Clintrial software changes the records’ status from
Unscreened (3) to Verified (1). You can then validate and transfer the records.

If a record fails screening, the record status changes to Failed
Screening (-3). An entry is also made in the Error Log. You must edit the failed
record and screen the record again.

If you do not release records for validation, then the record status does not
change. However, Error Log entries are created for records that fail screening.
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For more information on the Error Log, see Chapter 27.
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How to start screening

Select the panel
or panels that you
want to screen.

From the Load menu, select Screen. The Screen dialog box opens, in which you
specify the criteria for screening:

m Screen E
— Panels S0L Restriction
LARS

Optionally,
specify a SOL

restriction.

Check or clear
Submit Batch.

Check or clear
Release for
Validation.

Check or clear
Override Checks.

B

|  ——— ¥ Submit Batch

Submit at: |1D£24£‘I 997 15:17:38
Submit Every: IUD E ﬂ

" Release for Validation
[~ Ovenmide Checks

o Close soL.. | Help |

To select records for screening, select the panel or panels that store the batch-
loaded records. You can also specify a SQL restriction to restrict the records
within the selected panels.

If you want to release the records for validation, check Release for Validation. If
you check this option, the record status changes to Verified (1) when the records
are screened successfully.

Note: You can prescreen records by clearing this check box. However, if you do
not release the records for validation, you must screen the records again before
you can validate them.

If you do not want to check the records against checklists or upper and lower
bounds, check Override Checks. Records that normally would not pass these
checks will be screened successfully.

Note: The screening process always checks values against codelists, and checks
to see if a value is required.

To screen the records, click OK.
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For more information on specifying SQL restrictions, see the Common
Information section in the Reference Guide.
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About the Screen Log

The Screen Log is a cumulative report that describes the screening results for
screened panels.

You can view the Screen Log, purge all entries from it, or purge selected entries
from it based on the following criteria:

¢ Panel

»  User
» Status (NORMAL or ERROR)
» Type of database table (UPDATE or DATA)
o Start date
* End date

To view the Screen Log, from the Reports menu, select Screen Log >> View.
The Screen Log opens:

@soeontoa ——  ———— — —  —— EEE
Panel | Table | Status Remarks Selected Modified Reported Rejected |Batch Id| User Id Start End =
LAB UPDATE [MORMAL |COMPLETED g & 0 CTSYS 12/16/98 10:28:06 &AM 12716798 10:28:07 &AM
LABS UPDATE [MORMAL |COMPLETED 2 2 0 CTSYS 11/24/3812:57.13PM [11/24/98 12:5715 PM
LABS UPDATE [MORMAL |COMPLETED 2 2 0 CTSYS 11/23/98 10:01:24 &M 11723798 10:01:25 AM
LABS UPDATE [MORMAL |COMPLETED 1 1 0 CTSYS 11/23/98 09:52.17 &M [11/23/98 09:5217 &M
LABS UPDATE [MORMAL |COMPLETED g & 0 CTSYS 11/23/98 09:02:33 M |11/23/98 09:02:34 AM | _
LABS UPDATE [MORMAL |COMPLETED 1 1 0 CTSYS 11/20/9812:5313PM (11720798 12:5313 PM
LABS UPDATE [MORMAL |COMPLETED 1 1 0 CTSYS 11/20/98 12:4312 PM (11720798 12:4312 PM
LABS UPDATE [MORMAL |COMPLETED 1 1 a CTSYS 11/20/98 10:47:48 &AM (11720798 10:47:48 AM
LABS UPDATE [MORMAL |COMPLETED 1 1 a CTSYS 11/20/98 09:01:31 &AM (11720498 09:01:32 AM
| K| | LI_I

You can use the View menu commands to filter or sort a displayed Screen Log,
and the File menu to save or print the log.

The following table describes the information in the Screen Log:

Report

column: Description:

Panel Source panel for which batch-loaded records were screened.
Table Oracle table in which batch-loaded records were screened.
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Report

column: Description:
Status Indication of whether screening completed successfully.
+  NORMAL indicates screening completed
successfully.
* ERROR indicates that an error occurred during
screening, although some records may have been successfully
screened before the failure.
Remarks Information about the status of the screening.
» If'the screening was successful, this column displays
COMPLETED.
» If'the screening was unsuccessful, this column displays an
error message.
Selected Number of records for which screening was attempted.
Modified Number of item checks that were successful.
Reported If you are overriding data checks during screening, the number of
items that failed checks, but passed screening because checks
were overridden.
Rejected Number of item checks that failed screening.
Batch Id Oracle batch job queue ID of a process submitted to the batch job
queue.
This column displays information only if the screening was
submitted as a batch job.
User Id User ID of the user who submitted or ran the screening.
Start Date and time the screening began.
9
End Date and time the screening completed. =
g
Restriction SQL restriction used to select records for screening. g
=
(]
-
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Editing records

If you have the appropriate access rights and the designer has defined a study
page for the source protocol, then you can use Enter and the default study book
to edit the data in a source protocol. However, you cannot use navigator-style
editing to edit data; source protocols do not support enrollment panels.

You can also edit data in Lab Loader. There are two ways to edit records in Lab
Loader:

* You can edit records with the status Unscreened (3) or Failed Screen
(-3) in the Edit Unscreened Records window.

+ Ifthe designer has defined a study page for the panel, you can edit records for
which an Error Log entry was generated using Error Log editing. The records
must have enough context information to be identifiable to Enter.

How to edit unscreened records

You can edit any unscreened records from within Lab Loader. To edit unscreened
records, from the Load menu, select Unscreened Records >> Edit.

After you select a panel and table for which you want to edit unscreened records,
the Edit Unscreened Records window opens, in which you can edit clinical data
values:

Entiy Datetime |Ct Recid Db Id | Subject Idlﬁjhiecl Page | Yizitno Yizitdate Investigator Lab 4
12/14/9810:03:33 1 3 1 1[12/11,/95 00:00:00 12MNATIONAL LABS i
12/14/98 10:08:33 |2 3 ojooz2 1 112411498 00:00:00 TAMNATIONAL LABS
12/14/9810:08:33 |3 3 ojoo3 1 112411498 00:00:00 T2NATIONAL LABS
12/14/98 10:09:33 |4 3 Ojoo4 1 112411498 00:00:00 1ZMNATIONAL LABS | |
12/14/9810:02:33 |5 3 Ojo0s 1 1[12411,/98 00:00:00 TANATIONAL LABS
12/14/9810:0:33 |6 3 Oj00e 1 112411498 00:00:00 TANATIONAL LABS

il

When you edit unscreened records in Lab Loader, you are editing the raw
database records. The editor does not provide editing features such as range
checking or codelist support. To use these features, you must edit the records
using Enter.

Note: You cannot edit the system items in the unscreened records.

352  Chapter 24: Preparing Data for Transfer



About Error Log editing

You can use the Error Log to edit records that have an error reported against
them if you have the required access rights and if your designer has defined a
study page and study book for the panel that contains the record that you want to
edit. The records must contain valid context information for them to be
identifiable in Enter.

For more information on Error Log editing, see Chapter 27.

Deleting unscreened records

Select the panel

Sor which vo L R—

want to delete
unscreened records.

The results of the
deletion appear
in this box.

You can delete records for a panel that have the status Unscreened (3) or Failed
Screen (-3). For example, you may want to delete the records that you have batch
loaded incorrectly, and then batch load the records again using a different control
file.

To delete unscreened records, from the Load menu, select Unscreened Records
>> Delete. The Delete Unscreened Records dialog box opens:

#. Delete Unscreened Records

SQL Restiction

Optionally, specify a
SQOL restriction.

[~ Include Failed Screen Check Include Failed
~Results Screen if you want to
Panel Dot delete records with the
| status -3.

Clear this check box if
you do not want to delete

[ petete | Gose | How | those records.

Note: In the Delete Unscreened Records dialog box, you select the panel for
which you want to delete unscreened records. Optionally, you can specify a SQL
restriction to restrict the records that will be deleted. If you do not specify a SQL
restriction, all unscreened records for the selected panel will be deleted.
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Click Delete to delete all unscreened records for the selected panel.
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Validating records

Validation is the process of running a validation procedure on clinical data to
ensure that the data meets the requirements of the clinical trial for logical and
consistent data.

Using Lab Loader, you can only validate records in a source protocol. If your
current protocol is not set to a Lab Loader protocol, then the menu command for
validation will not be available.

What is a validation procedure?

Each panel has one validation procedure associated with it. A validation
procedure is a PL/SQL procedure that is built automatically in Design from the
derivations and rules associated with the panel:

* Derivations calculate values of items or temporary variables that the designer
has set up based on constants or on the values of other items.

*  Rules are part of PL/SQL statements that evaluate to True or False. Rules can
automatically flag data that fails validation.

For more information on the order in which derivations and rules are processed
at validation, see the Design section of Admin and Design.

Results of validation

Records either pass or fail validation. After a record passes validation, it can be
transferred to the destination protocol.

Records that fail validation cannot be transferred to the destination protocol. The
records remain in the source protocol until they are edited and pass validation at

a later time. Validation errors are recorded in the Error Log.

Note: You must validate records before you can transfer the data to the
destination protocol.

For more information on the Error Log, see Chapter 27.
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How validation works with observations

You can validate the records in an observation individually or as a group.
However, you can only transfer records in an observation if all records in the
observation validate successfully. You cannot transfer any records in an
observation if one or more records fails validation or has not been validated.

About the record status

When a record passes validation, the Clintrial software changes its status to
Validated (0). You can only transfer records with the status Validated.

When a record fails validation, the Clintrial software assigns the status
Validation Error (-1).

How to validate records

To start validation, from the Manage menu, select Validate. The Validation
window opens, in which you can select records for validation:

[H] validation M=l E3

Select the panel
or panels that
you want to
validate.

Optionally,

Panels

~ Restnict Data
Flags
CDR
CDR
GEMERAL

Date and Time Range

From: I—
To: I—

DOWNLOAD i’
UNSPECIFIED
UNSPECIFIED |

Notes
Status

restrict the records
to validate.

Check or clear
Submit Batch.

INVESTIGATOR
SPONSOR

UNSPECIFIED
UNSPECIFIED

" Emror

£ Valid

£ Verified SQL Restiction

1 All of the above

¥ Release for Transfer ¥ Submit Batch

Check or clear

Release for
Transfer.

Submit at: 12/14/98 16:41:28
Submit every: [0 B [Fons 5]

You select the records for validation by selecting one or more panels, and
optionally specifying various restrictions.
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You can specify the following types of restrictions:
+ SQL

* Flags and notes

» Date and time range

e Status

You can restrict the records to validate by record status. You can select one or
more statuses. The following table describes the statuses on which you can
place a restriction:

Status: Status code:  Description:

Error -1 The record failed validation.

Valid 0 The record passed validation.

Verified 1 The record passed screening (for batch-

loaded data) or verification (for
interactively entered data).

All of the above -1,0,1 All relevant records.

Note: Also includes record status -2 if you
check Release for Transfer.

For more information on SQL and flag and note restrictions, see the Common
Information section in the Reference Guide.

About releasing records for transfer

When you run validation, you can specify that you want to:
* Run the validation and release the records for transfer.
¢ Or, run the validation, but not release the records for transfer.

This option allows you to generate derived values and review the results of
validation without changing the status of the records. You must run the
validation again, and check Release for Transfer to transfer the records to the
destination protocol.
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The following table summarizes how Release for Transfer works:

When you: If validation succeeds: If validation fails:
Validate records Record status changes to Record status changes to Validation Error (-
and release them Validated (0). 1).
for transf L Sy .
or transter Derived items are updated. Validation errors are recorded in the Error
Log.

Validate records and
do not release them
for transfer

You can transfer the records to a
destination protocol. Flags that are attached automatically during
validation are added to records.

Record status does not change. Record status does not change.

Derived items are updated. Validation errors are recorded in the Error

Log.
You cannot transfer the records to £

a destination protocol. Flags that are attached automatically during
validation are added to records.

Note: The record can change when you are testing validation. Therefore,
records may be audited, depending on where the audit start point is set. For
example, if the validation procedure calculates a derivation, and the audit start
point is set to data entry, then records in the update table are audited when you
test validation.

To begin the validation procedure, from the File menu, select Run.

About the Validation Log

The Validation Log is a cumulative report that describes the results of the
validation process.

You can view the Validation Log, purge all entries from it, or purge selected

entries from it based on the following criteria:
* Panel
* User

+ Status (NORMAL or ERROR)

* Type of database table (UPDATE or DATA)
+ Start date

* End date
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To view the Validation Log, from the Reports menu, select Validation Log >>
View.

The Validation Log opens:

=
Panel Table | Status Remarks Selected | Rep d | Rej d |Batch Id| User Id Stait End )=
L&B LIFDATE [NORMAL = CTSYE 12/16/38 10:30:05 AM |12/16/98 10:30:05 AM |
LaBS_TEST LIPDATE [NORMAL 1 3.2024CTSYS 12/15/98 09.55:22 AM (12115738 03:55:22 AM |/
LaBS_TEST LIPDATE [NORMAL 1 1.234CTPROC |12/15/93 09.0%23 AM [12/15/38 09:03:23 AM |/
LaBS_TEST LIPDATE [NORMAL 1 1234CTPROC |12/15/98 03:02:48 &M [12/15/38 09.02:48 &M |
LA&BS_TEST LIFDATE [NORMAL 1 1.2340PS$YERS12/15/98 0%:01:23 AWM [12/15/38 03:07:23 4M |
L&BS_TEST LIFDATE [NORMAL 1 1.2340PSHYERS12/15/98 02:56:42 AM |12/16/98 DB:66:42 AM |/
L&BS_TEST LIFDATE [NORMAL 1 CTSYE 12/15/98 03:46:24 AM |12/15/98 08:46:24 AM |
LaBS_TEST LIPDATE [NORMAL 1 3.20CTSYS 12/15/98 03:45:21 AM [12/15/98 05:45:21 AM |!
1« | LI_I

You can use the View menu commands to filter or sort a displayed Validation
Log, and the File menu to save or print the log.

The following table describes the information in the Validation Log:

Report
column: Description:
Panel Name of the panel for which records were validated.
Table Type of database table for which records were validated. In a
source protocol, this column is always UPDATE.
Status Indication of whether validation completed successfully.
*  NORMAL indicates a successful validation.
* ERROR indicates an unsuccessful validation.
Remarks Information about the status of the validation.
s » Ifavalidation completed successfully, then this column
= displays COMPLETED.
g » Ifavalidation was unsuccessful, this column displays an error
] message.
G
. Selected Number of records selected for validation.
Reported Number of items in the records with the rule action REPORT.
Rejected Number of items in the records with the rule action REJECT.
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Report

column: Description:

Batch Id Oracle batch job queue ID of a process submitted to the batch job
queue.
This column displays information only if the validation was
submitted as a batch job.

User Id User account that submitted or ran the validation.

Start Date and time the validation began.

End Date and time the validation completed.

Restriction SQL restriction used to select records for validation.
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Overview

After you have batch loaded lab data into a source protocol and prepared the data
for transfer, you can transfer the data to the destination
protocol.

Note: You cannot transfer data into Enrollment (Type 5) panels.

What is data transfer?

Data transfer moves data from a source protocol to a destination protocol. The
transfer is directed by criteria specified in a transfer map.

You can only transfer data from a Type 4 - Lab Loader protocol into a Type 1 -
Clinical Data protocol. That is, the source protocol must be a Lab Loader type
protocol, and the destination protocol must be a Clinical Data type protocol.

What is a transfer map?

A transfer map indicates data to be transferred from a source protocol to a
destination protocol by establishing a direct connection from the source items to
the destination items. The transfer map specifies which data will be transferred,
and indicates the location where you want the data to be stored.

Transfer maps are owned by the source protocol, and must be created before the
transfer is performed. Each transfer map can be used for many transfers. Any
pair of source panels and destination panels typically has only one transfer map
that is used for all transfers between the panels. You can also specify multiple
maps for each source-destination pair of panels for greater flexibility.

Transfer maps are uniquely identified by five values:
* The map name

* The source protocol

e The source panel

* The destination protocol

* The destination panel

For example, you can create the following unique transfer maps:

* A map named MAPA that maps items from the STUDY 1 panel in the
LAB_SRC source protocol to items in the MEDIKA CLINICAL protocol.
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* A map named MAPB that maps items from the STUDY 1 panel in the
LAB_SRC source protocol to items in the MEDIKA CLINICAL protocol.

* A map named MAPA that maps items from the STUDY 1 panel in the
LAB_SRC source protocol to items in the KALURIL protocol.

Transferring records

To transfer records, the current protocol must be set to the destination protocol.
For example, if you are transferring data from the LAB_SRC source protocol to
the MEDIKA CLINICAL destination protocol, you would set the current
protocol to MEDIKA CLINICAL before transferring data.

About enrollment

To transfer a record to a Subject type panel (Type 1-4), the subject associated
with the record must be enrolled. You may want to add rules to the source
protocol’s validation procedure to check for enrollment before transferring the
records.

Note: You cannot transfer data from a source protocol to an enrollment panel in
the destination protocol.

About panel keys

You must have set up panel keys for the panels into which you will transfer data.
The items referenced by the panel key definition must be defined as required
items. If you do not set up panel keys, you will be unable to transfer repeat
records for a specific visit. Lab Loader will transfer one record per visit and treat
the other records as duplicates.
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How to transfer data

To begin the transfer, from the Transfer menu, select Start Data Transfer. The
Start Data Transfer dialog box opens:

[} Start Data Transfer

Map Hame Source Protocol Source Panel Status

Map Description

[<yrexel ransfer map

[¥ Check Duplicates in Update Table I” Dvenide Scieening Checks
I” Check Duplicates in Data Table ¥ Delete After Transfer
SAL Restiiction ¥ Submit Batch

Submit at: |1 2M4/9812:23.56
Submit every: [0 @ [Mois o]

ok | Cancel | sa. | Help |

In this dialog box, you select the transfer map that will control the data transfer.
Only valid maps can be used in the transfer process. You also select several
transfer options, which are described in the following table:

Option: Description:
Check Duplicates in Check this option to check for duplicates in the update
Update Table table.

Clear this option if the Clintrial software should not
check for duplicates in the update table.

Check Duplicates in Data ~ Check this option to check for duplicates in the data
Table table.

Clear this option if the Clintrial software should not
check for duplicates in the data table.

-
2]
=
s
S
—
=
«
—

364 Chapter 25: Transferring Records



Option: Description:

Override Screening You can choose whether the automatic screening that the

Checks Clintrial software performs during data transfer
overrides certain screening checks. The screening
checks the Clintrial software applies during data transfer
are the screening checks defined for the destination
panel.

If you check Override Screening Checks, then the
Clintrial software does not check that the value for an
item is within the defined upper or lower bounds and
does not check values against checklists attached to
items.

Delete after Transfer You can choose whether to delete the records from the
source panel after transferring them to the destination
panel.

*  Check Delete After Transfer to delete the records
from the source panel after transferring them to the
destination panel.

*  Clear Delete After Transfer to keep the records in the
source panel after the transfer is complete.

Note: This option appears only if you set the system
parameter and user preference CTL_TEST MODE to
Yes. If the system parameter or user preference is set to
No, then the records are always deleted.

SQL Restriction Allows you to specify a SQL restriction to restrict the
records that are selected for transfer to the destination
protocol.

The transfer process

During the data transfer, the Clintrial software performs the following actions for
each record:

1. Checks the record in the source protocol against the SQL restriction to see
whether it should be transferred.
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2. Checks the record for necessary destination protocol key items and
mandatory items.

3. Updates the CT _RECID.

The transfer process 365



4. Updates the SUBJECT ID using information from the destination
protocol’s enrollment panel.

5. Screens the record using the screening checks defined for the
destination panel.

6. If duplicate detection is specified, checks for duplicates in the
destination protocol.

If the Clintrial software: Then the Clintrial software:

Finds a duplicate in the a. Updates the record in the destination
update table protocol.
b. Automatically validates the record if the
original record had a status of 0 or -1.

Finds a duplicate in the a. Inserts the record into the update table of the desti-
data table nation protocol.
b. Adds a flag to either the record in the update table
or the record in the data table.

Does not find a duplicate Inserts the record into the update table of the
destination protocol.

7. If duplicate detection is not specified, inserts the record into the update table
of the destination protocol.

8. Regroups the records, using the subject item, block key item, block repeat
key item (if defined), page key item, and page repeat key item (if defined) as
the grouping items, if they are in a Type 2 or Type 4 panel. If they are in a
Type 0 panel, the Clintrial software groups the records using the predefined
grouping items and subset key item.

9. Deletes the records that transferred successfully from the source panel, if
appropriate.

If any of the preceding actions results in a REJECT error, then a copy of the
record is added to the Error Log in the source protocol, and the record is not
transferred.

Note: If a REPORT error occurs during screening, then the record is still
transferred to the destination protocol, and the error is reported in the Error Log
of the destination protocol.
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About the transfer map status

When you begin the transfer, Lab Loader checks that the source protocol and
destination protocol referenced in the selected transfer map exist, and that the
source panel and destination panels exist and are installed. If any of these checks
fails, the transfer map status becomes Invalid, and the transfer does not occur.

Lab Loader then checks that the last modification date of the map is later than
the last modification date of the source panel and the destination panels. If the
source panel and the destination panels were modified and the transfer map was
not updated, then the map is marked Old, and the transfer is rejected.

The following table summarizes the possible statuses for transfer maps:

Status: Description:
Valid (0) The map was valid the last time it was edited or used for transfer.
Invalid (1) The map is invalid. This status can occur when the destination

protocol, destination panel, source protocol, or source panel has
been deleted after the map was created, or if the data types for
mapped items no longer match.

0Old (2) One of the source or destination protocols or panels has been
edited more recently than the map.

Incomplete (3) The map was saved before all required items were mapped. For
example, the map was saved, but not all key items were mapped.

To change the status of a transfer map, you open the transfer map, make any
necessary modifications, and save the map. You can also compile the map, which
changes the map status of Old to a status of Valid if the map is still valid.

Note: You must set the protocol to the source protocol to edit the transfer map.

About compiling the transfer map
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You can compile a transfer map to ensure the map is valid. Compiling the map
checks that the source and destination panels are still installed, and that source
and destination items still exist. In this manner, you can easily see if something
has changed.
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To compile a transfer map, from the Transfer menu, select Map >> Check. The
Select Map to Check dialog box opens:

i Select Map to Check [ x|
Map Hame Destination Protocol Source Panel Status

Map Description

FLR -yrexel_Lab_Src to Xyrexel transfer map

Dismiss | LCompile | Help |

Select a map name and click Compile. To close the dialog box, click Dismiss.

About duplicate records

When you transfer data from the source panel, you may be transferring a record
that already exists in the destination panel. For example, a lab may send you data
that is identical to data it sent you in a previous dataset, or data that is an update
of previous data.
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Lab Loader can check for duplicate records during data transfer. A duplicate
record is a record for which the following keys are identical:

* Subject item

* Block key item

* Block repeat key item
* Page key item

» Page repeat key item
* Subset key item

* Panel key items

* User-defined panel keys

For example, look at the following three records:

Subject Visit No. Page No. Test

1D Visit No. (block (page Name
Record (subject (block repeat Page No. repeat (panel Test
number key) key) key) (page key) key) key) Result
1 004 1 2 7 al HCT 45.7
2 004 1 2 7 al HCT 44.1
3 004 1 2 7 al HGB 15.5

Records 1 and 2 are duplicate records. That is, all the key item values match.
Record 3 is not a duplicate record because the panel key item (Test Name) values
are different.

When you transfer data, you determine the extent to which Lab Loader checks
for duplicate records in the destination protocol. You can:

» Check for duplicates in the update table.
*  Check for duplicates in the data table.
* Check for duplicates in both the update table and the data table.

» Disregard duplicate checking.

If Lab Loader detects a duplicate record in the update table, then Lab Loader
updates the record in the update table with the data in the record being
transferred. If multiple duplicate records exist in the update table, then Lab
Loader updates all of the records.
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If Lab Loader detects a duplicate record in the data table but not in the update
table, then Lab Loader inserts the new record in the update table, and flags either
the newly created record in the update table, or the duplicate record in the data
table. The location for the flag is determined by the system parameter

CTL DUPFLAG_LOC. For more information on this system parameter, see
page 403.

If there is a duplicate record in both the update table and the data table, Lab
Loader updates the record in the update table, but no flag is attached to the
record. Either a flag already exists for the duplicate record, or the record in the
update table was entered interactively and is outside the scope of Lab Loader
duplicate detection.

About transfer errors and the Error Log

When errors occur during data transfer, entries are added to the Error Log for the
record. However, the location of the Error Log entry depends on when the error
occurs:

» If the error prevents the record from being transferred, then the record
remains in the source protocol, and an entry is added to the source protocol’s
Error Log.

For example, a record for a subject who is not enrolled in the destination
protocol’s study book results in an error in the source protocol’s Error Log.

» Ifthe error occurs after the record is inserted into the update table, an entry is
added to the destination protocol’s Error Log.

For example, a screening error would generate an entry in the destination
protocol’s Error Log.

For errors that occur during data transfer in Lab Loader, the ERRTYPE column
in the Error Log has the following value:

TRANSFER — The error occurred during the transfer.

For more information on the Error Log, see Chapter 27.
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Transfer reports

The Transfer Log is a cumulative log that describes the results of the transfer
process.
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You can view the Transfer Log, purge all entries from it, or purge selected entries
from it based on the following criteria:

* Source panel, source protocol, and transfer map

*  User

» Status (NORMAL or ERROR)
» Start date

* End date

To view the Transfer Log, from the Reports menu, select Transfer Log >>

View.

Note: 1If the current protocol is not set to the destination protocol, then the
Transfer Log menu command is unavailable.

The Transfer Log opens:

. Transfer Log

=]

Job ID Source Map Status | Selected | Successes | Failures | Heport Errors

437 #YREXEL_LAB_SOURCE LAB HYREXEL MORMAL K g

41592 »rAEXEL_LAB_SOLURCE LAB SrREXEL HORMAL K 5

4183 »YREXEL_LAB_SOURCE LAB HYREXEL MORMAL K g

4143 #YREXEL_LAB_SOURCE LAB HYREXEL MORMAL 12 13 ||
3487 »rAEXEL_LAB_SOURCE LAB SrREXEL HORMAL = g

3484 »YREXEL_LAB_SOURCE LAB HYREXEL MORMAL 1 1

209 #rYREXEL_LAB_SOLRCE LAB HYREXEL MORMAL 5 5

Kl

-

ol

You can use the View menu commands to filter or sort a displayed Transfer Log,

and the File menu to save or print the log.

The following table describes the information in the Transfer Log:

Report column:

Description:

Job ID

Source

Map

The Clintrial software job number assigned to the transfer
process. You can use this number to match transfers between the
Transfer Log and the Duplicates Summary Report.

Name of the transfer map used to perform the transfer.

Name of the source protocol and source panel from which the
records were transferred.
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Report column:

Description:

Status Indication of whether the transfer completed successfully.
*+  NORMAL indicates that the transfer completed
successfully.
* ERROR indicates that an error occurred during the
transfer.
Selected Number of records for which the transfer was attempted.
Successes Number of records that transferred successfully.
Failures Number of records that failed the transfer.
Report Errors Number of destination protocol Error Log entries generated by
the transfer.
Remarks Information about the transfer.
Start Date and time the transfer started.
End Date and time the transfer completed.
Batch ID Oracle batch job queue ID of a process submitted to the batch
job queue.
This column only displays information if the transfer was
submitted as a batch job.
User ID User account that submitted or ran the transfer.
Restriction SQL restriction applied to records to determine if they should be

transferred.

Note: The Batch ID is an Oracle ID assigned to processes submitted as a batch
job. The Job ID is a Clintrial software ID assigned to all processes regardless of
whether they were submitted as a batch job.
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About the Duplicates Summary Report

The Duplicates Summary Report is a cumulative report that contains general
information about the number of duplicate records detected during the transfer
process.
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Note: A duplicate record in this situation is a record in the source protocol that
is a duplicate of a record in either the update table or the data table of the
destination protocol.

The following table describes the information in the Duplicates Summary
Report:

Report field: Description:
Map Name of the transfer map used to perform the transfer.
Job Number The Clintrial software job number assigned to the transfer

process. You can use this number to match transfers between
the Transfer Log and the Duplicates Summary Report.

User User account that submitted or ran the transfer.

Note: If you purge entries from the Transfer Log, the
corresponding entries in the Duplicates Summary Report do
not have a value for User.

Source protocol Name of the protocol from which records were
transferred.

Source panel Name of the panel from which records were
transferred.

Started Date and time the transfer began.

Note: 1f you purge entries from the Transfer Log, then the
corresponding entries in the Duplicates Summary Report do
not have a value for Started or Ended.

Ended Date and time the transfer completed.
Destination Panels Destination panel to which records were
transferred. -
1Y)
Update Table Number of duplicates detected in the update table for the <
panel. g
&
Data Table Number of duplicates detected in the data table for the panel. g

Note: 1If a source protocol record is the duplicate of both a record in the update
table and a record in the data table, then the record is included only in the count
of the number of duplicates detected in the update table.
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About the Detail Duplicates Report

The Detail Duplicates Report is a cumulative tabular report that provides
identification information for the duplicate records detected during the most
recent transfers.

The report includes the following columns:

e The table in which the duplicate record is located
* The job ID assigned to the transfer process

* The CT _RECID

* A column for keys associated with the destination panel (for example,
subject item and block key item)

If you transfer a duplicate of a record that is already recorded in the Detail
Duplicates Report, then another entry is made in the Duplicates Summary Report
and the Detail Duplicates Report.
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Overview

A protocol account (or protocol) is an Oracle account that consists of database
tables that hold the clinical data, flags, and notes associated with clinical data,
audit and error log information, and one or more views of the clinical data stored
in the protocol.

What are source and destination protocols?

When you use Lab Loader to load and transfer lab data, you work with two
different types of protocols:

* The source protocol is a Lab Loader protocol (Type 4) into which you batch
load lab data. You work with the lab data in this protocol to prepare it for
transfer to the destination protocol.

» The destination protocol is a clinical data protocol (Type 1) that contains the
clinical data for a study. You transfer data into this protocol after preparing it
in the source protocol. The destination protocol must not be a Lab Loader
protocol (Type 4).

You also work with an input file, which is an ASCII file that contains lab data to
be batch loaded into the Clintrial software. You receive the input file from the
lab analyzing the specimens or samples. Using Lab Loader, you batch load the
data from the input file into the source protocol, prepare the data, and then
transfer the data to the destination protocol.

-
2]
=
s
=
—
=
«
—

376 Chapter 26: Lab Loader Setup



The following figure shows the interaction between the input file, source
protocol, and destination protocol:

325, M89, 5/5/1999, ASH...
325, M89, 5/19/1999, ASH...
325, M42, 5/6/1999, MDS...

Source Protocol
LABS_UPDATE

Bdfch load
f‘kstaf;c n.the Protid | Subid Visdate | Patinit
input file into

the source 325 M89 | 5/06/1999 | ASH
protocol.

325 M89 | 5/19/1999 | ASH

325 M42 | 5/06/1999 | MDS

Destination Protocol
LABS_UPDATE

Trander data Protid | Subid | Visdate | Patinit
to the
dedination 325 M89 | 5/06/1999 | ASH

protocol. 325 | M89 |5/19/1999 | ASH

325 M42 | 5/06/1999 | MDS

JI9peoT qe|

Overview 377



Lab Loader setup workflow

The following figure shows the workflow you should use to set up Lab Loader:

Clintrial Module:

Protocol Type

Protocol

Design the Clinical .
Design Data Destination Design the Source
Protocol

Admin

Lab Loader
Source Protocol

Lab Loader
Source Protocol

Design

Lab Loader
Source Protocol

Lab Loader
Source Protocol
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Lab Loader
Destination Protocol

Set Up Security

!

Create Control Files

!

Test the Control Files
by Batch Loading
Sample Data

{

Create Derivations
and Rules for Lab
Loader Protocols

{

Test Derivations
and Rules

{

Create Transfer
Maps

{

Test the Transfer
Maps by Transferring
Sample Data
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Setting up the destination protocols

A destination protocol is a clinical data protocol (Type 1) that contains the
clinical data for a study. The destination protocols are the same clinical data
protocols that you use to perform all other Clintrial software data management
tasks. You set up these protocols as described in the Design section in Admin and
Design.

However, when you are designing the destination panels that will contain the
transferred data, you should consider the following:

* The way that you will map the transfer.
» The structure of the input files that you will batch load.

» The structure of the source protocol and source panels.

& Caution: You must also set up panel keys for the panels into which you will
transfer data. The items referenced by the panel key definition must be defined
as required items. If you do not set up panel keys, then you will be unable to
transfer repeat records for a specific visit. Lab Loader will transfer one record
per visit and treat the other records as duplicates.

Creating a source protocol

A source protocol is a Lab Loader protocol (Type 4) into which you batch load
lab data. You work with the lab data in this protocol to prepare it for transfer to
the destination protocol.

Source protocols contain the source panels from which you transfer lab data into
the clinical data panels.

Before you create a source protocol, you should determine how you want to
organize the data that will be batch loaded into Lab Loader, and what you need to
do to transfer the batch-loaded data into the destination protocol.

How to determine protocol hierarchy
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When you batch load data, you place it in the source protocol, which serves as a
holding and processing area before you transfer the data to the destination
protocol. The structure of this holding and processing area is determined by the
protocol hierarchy that you create.
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You can use one source protocol to contain all of the data that you batch load.
Alternatively, you can use multiple source protocols. For example, you may
want a separate source protocol for each lab that sends you data, or you may
want a separate source protocol for each study for which you are processing lab
data.

The following questions may help you decide how to structure your source
protocols:

* Do you want to create a data dictionary protocol to hold standardized items?

If you create a protocol with the Dictionary attribute to hold standardized
items, then the source protocols that you create must include this protocol in
their searchlist. The data dictionary protocol should be a Lab Loader protocol
(Type 4). Only Type 4 protocols can own control files and transfer maps.

* How many destination protocols will you transfer the data to? How are these
clinical data protocols structured?

The structure and items of the destination protocols determine which items
you need to create in your source protocol. If the destination protocols have
many differences, then you may want to create separate source protocols and
source panels to accommodate these differences. You may also want to
include the destination protocols in the search list for the source protocol.

* How many labs send you data? Is the structure of the input file the same for
each lab?

If the input files from different labs are different in structure, you may need
to use separate control files to batch load data, and you may need different
items to contain the data once it is batch loaded. Therefore, you may want to
use separate source protocols or source panels.

* How many studies will you be obtaining data for? Is the data for the studies
similar in structure and type, or does the structure change between studies?

If the data for the studies is different, you may need to create different items
in the source panels to contain the data.

* Will data for a single study come in as a separate input file, or will it be in the
same file as data for another study?

Suppose you receive data from three central labs for two separate studies. You
can structure your source protocol hierarchy in any one of the following ways:

» Create three source protocols, one for each lab. Each protocol has two panels,
one for each study:
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Lab A Lab B Lab C
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Create two source protocols, one for each study. Each protocol has three
panels, one for each lab:

Lab A Lab A

LabB LabB

Lab C Lab C

III FG

Create one source protocol with three panels, one for each lab. Each panel
contains data for both studies:

Source Aotocol

Lab A S$1,S2

Lab B S1,S2

Lab C $1,82

Create one source protocol with two panels, one for each study. Each panel
contains data from all three labs:

Source Rotocol

S1Labs AB,C

S2 Labs AB,C

Create one source protocol with six panels, one for each lab/study
combination:

Svurce Rotocol

| S1,Lab A || S1,LabB || S1,LabC | g

| S2,Lab A || S2,Lab B || S2,LabC | g
o
<
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Create one source protocol with one panel. All the data will be batch-loaded
into the same panel:

Surce Rotocol

S1 & S2
Labs A,B,C

Characteristics of the Lab Loader protocol type

Lab Loader protocols (Type 4) differ from other Clintrial software protocols in
the following ways:

A Lab Loader protocol can contain only Type 0 panels. It does not allow the
creation of enrollment panels, and does not use a context panel.

Records in a Lab Loader protocol stay in the update table. They cannot be
merged into the data table.

A Lab Loader protocol can never be used as a destination
protocol during data transfer.

Only a Lab Loader protocol can be used as a source protocol during data
transfer.

When you delete a Lab Loader protocol, any transfer maps and control files
owned by that protocol are also deleted, even if the destination protocols are
still active.

When you import a Lab Loader protocol, any transfer maps and control files
owned by that protocol are also imported.

When you export a Lab Loader protocol, any transfer maps and control files
owned by that protocol are also exported.

A Lab Loader protocol cannot be Resolve-enabled. That is, a Lab Loader
protocol cannot be used in conjunction with Resolve in working with
discrepancies.

How to create a source protocol

You create source protocols using Design. Source protocols must be Lab Loader
protocols (Type 4).
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The following table describes some of the protocol attributes that may affect the
setup of source protocols:

Attribute: Description:

Protocol The name of the protocol. You may want to create a naming
convention that immediately identifies a protocol as a source
protocol.

Type The protocol type. Source protocols must be Type 4 — Lab

Loader protocols. If the Lab Loader module is not installed, then
Type 4 will not be an option.

Dictionary Specifies whether the protocol is a data dictionary protocol. The
Clintrial software cannot create associated clinical data tables
for a protocol with the dictionary attribute.

Parent Protocol The protocol that defines the default searchlist for the current
protocol as the combination of the parent protocol and the parent
protocol’s searchlist. If you are using a data dictionary protocol
to contain standardized items, then you may want to use that
protocol as the parent protocol.

Modify Searchlist An indication of whether searchlist modification is allowed.

The searchlist for a protocol is defined by the parent protocol; if
you want to be able to copy panels and items from other
protocols, such as the destination protocol, then you should
check this option.

Audit Start The default point at which auditing begins in each panel created
in this protocol. In Lab Loader protocols (Type 4), the Audit
Start point is set to Merge by default. You can change this
attribute.

Error Log item An item optionally displayed for each record in the Error Log to
uniquely identify the record. This item must be a context item. It
cannot be used in Lab Loader protocols (Type 4) as Lab Loader
protocols do not have CONTEXT panels.

You can use the Manage system parameter or user preference
ERRLOG DISPLAY ITEM to generate the same behavior. For
more information on this parameter, see "Manage system
parameters" on page 403.
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For information on other protocol attributes, see the Design section of Admin
and Design or the Design Help.
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Creating source panels and items

After you have created a source protocol, you need to create the panels and items
for that protocol.

The panels and items you create depend on the protocol hierarchy you have set
up, the format and structure of the data you intend to batch load into the protocol,
and the format and structure of the panels into which you want to transfer the
data.

How to determine the source panel structure

The structure of the destination protocol helps to determine how you design the
panels in your source protocols. For example, when you transfer records, each
nonderived item in a destination panel that you want to populate at transfer time
must have a corresponding item in the source panel.

The design of the panels in the source protocol is also influenced by the format
and structure of the data in the input files.

The source protocol is similar in structure to both the destination protocol and
the input file. The source protocol design must take these structures into account
to facilitate both batch loading and data transfer.

For example, an item in the destination protocol may not have a corresponding
item in the input file, but may be a derivation resulting from two other items in
the input file. The source protocol could have three items: two items to store the
values batch loaded from the input file, and one item to hold the derived value,
which will then be transferred to the destination protocol:

Surce Rotocol Dedination Rotocol

Bdch Load

P A&B Item A ltem B

ltem C

ltem C (derived
from ltems A & B)
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Or, you may want to batch load all data from the input file as ASCII text, and
then use derivations in the source panel to convert certain item values to numeric
values before transferring them to the destination panel. The source panel could
have two items for each item in the input file and destination protocol: one item
to hold the character value, and one item to hold the derived numeric value.
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How to determine the needed source items

You determine the items you need to create in the source panels by looking at the
structure of the input file and the destination panels, and by anticipating the
mapping of the transfer records.

First, look at the format of the input file and assess the structure by asking the
following questions:

*  What fields can you batch load directly into the Clintrial software? These
fields need corresponding items in the source panel.

*  What fields must be converted? For example, you cannot use conversions
such as TO_ NUMBER() when transferring data in the Clintrial software.
These conversions must be handled during batch loading through the control
file. You can also use derivations to convert the data by setting up items to
hold the derived values.

Then, look at the format of the destination panel and assess the structure by
asking the following questions:

* What items have a corresponding field in the input file? These values can be
batch loaded into the source file, and then transferred directly to the
destination panel without any processing. The source panel can contain one
item to handle the value.

»  What are the subject, block, block repeat, page, page repeat, and subset keys?
Are other keys, such as panel keys, defined for the panel? All keys need a
corresponding item in the source panel to permit transfer into the destination
panel.

*  What are the required items for the destination panel?

Keep in mind the following requirements when you are defining the source panel
items:

» The underlying types of source and destination items must be the same. If the
data types are different, you can use derivations in the source panel to derive
an item of the correct type, and then transfer the derived item.

o Ifthe item sizes of the source and destination items do not match, then the
destination item length must be larger.

* A subject item, block key item, and page key item must be mapped for Type
1-4 destination panels. In addition, if defined, a block repeat key item, page
repeat key item, and subset key item must be mapped for Type 1-4
destination panels. Therefore, you need corresponding items in the source
panel.
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+ If additional keys are defined on the destination panel, then these keys must
have corresponding items in the source panel. For example, if you are
transferring data into a Type 4 panel, then the destination panel should have a
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panel key defined to help uniquely identify the records during duplicate
detection.

+ Ifakey item is a derived item in the destination panel, then all items that are
used for the derivation must have a corresponding item in the source panel.
Otherwise, the key item value will change during
validation.

* All required items in the destination panel must be mapped. They must have
corresponding items in the source panel.

» If data for more than one destination protocol is stored in a source panel, then
there must be a protocol destination item defined in the source panel to
differentiate the data.

About key items

When you transfer data from a source panel to a Type 1 - 4 panel, you must map
the subject item, block key item, and page key item. Therefore, you must ensure
that these items exist in the source panel.

If any other keys for the destination panel have been defined, then there must be
a corresponding key item in the source panel for them.

About derived items

Lab Loader does not support type conversions during record transfer. The
underlying types of source and destination items must be the same for the map to
be valid.

One method you can use to manage type conversions is to have an extra item in
the source panel, and then use derivations to populate the item with the type-
converted data.

You can also use derivations to create items in the source panel that exist in the
destination panel, but that do not have a corresponding field in the input file.

About the destination protocol item

When you transfer data, Lab Loader transfers all of the records from a source
panel into the panels of the destination protocol. However, if you are storing
records for multiple destination protocols in one source panel, then you should
transfer only the records for one specific destination protocol at a time.
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Lab Loader provides a transfer map item called [Destination Protocol] to
differentiate records belonging to different protocols. You can map the transfer
map item to a source item that contains the name of the destination protocol.

 If the destination protocol name exactly matches the source item value in a
record, then the record is transferred.

» If'the destination protocol name does not match the source item value, then
the record is not transferred.

» Ifyou do not map the [Destination Protocol] item, then all records in the
source panel are transferred.

Data integrity checks

One of the main functions of Lab Loader is to enable you to process the lab data
after batch loading before placing the data in the data tables. This ensures that
the data will be logical and consistent with the standards of your clinical trial.

You can create several data integrity checks to help you process and evaluate the
data before transferring it.

About validation procedures

A derivation is a PL/SQL statement that calculates the value of an item or
temporary variable. You can use derivations in the source protocol to convert
data types, supply item values, or change the format of data to match the
destination protocol.

A rule is a PL/SQL expression that checks the value of an item against certain
conditions, and evaluates to either TRUE or FALSE. For example, a rule could
check that the subject ID item for a record has a value.

The validation procedure is the combination of all the derivations and rules that
have been set up and attached to the panel. When records are validated, the
Clintrial software runs the validation procedure for the records. Each record can
either pass or fail validation. Whether a record passes validation depends on
whether the rules that make up the validation evaluate to TRUE for that record.
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Note: For arecord to transfer successfully, the record must be valid and the
subject associated with the record must be enrolled. You may want to add checks
to the validation procedure to check for enrollment before transferring the
records.
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About codelists and checklists

A codelist is a set of codes and a corresponding set of values. Codelists are
associated with items.

By associating a codelist with an item, you can limit valid data to the codes or
values that are in the codelist. The Clintrial software stores the entered code, or
encodes the entered value as the corresponding code. You can also allow for the
entry of more than one value for the same code.

Codelists are available to all protocols within the database instance. You can
attach the same codelist to both an item in the source protocol and an item in the
destination protocol.

A checklist is a type of codelist used to view suggested entries for a field. No
encoding is performed. That is, the codelist value is stored, rather than the
codelist code. Entered values are checked against the checklist to see if they are
valid.

For example, if you use standard names for all of the lab tests, then you may
want to place these names in a checklist to ensure that the batch-loaded data
corresponds to the correct tests. You can also use codelists or checklists to ensure
consistency in units of measure.

For more information on codelists and checklists, see the Design section in
Admin and Design.

About flags

Lab Loader uses flags to help identify records that do not meet certain data
integrity checks. For example, Lab Loader automatically attaches a flag to a
record in the destination protocol during transfer if a duplicate record is detected
during data transfer.

You also can associate a flag with rules created for use during validation. These
flags are attached automatically to records if the rule evaluates to FALSE.

When you transfer records, only item level flags are transferred to the
destination protocol. Record or observation level flags are not  transferred:

+ If there is a one-to-many mapping of an item from source to destination
panels, then the flag is duplicated and transferred to each relevant item in the
destination panel.

» If'the flag already exists for a record in the destination panel, then the text of
the newly transferred flag is appended to the text of the existing flag.
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In most places where a restriction clause can be used to access records (for
example, validation), a flag or note restriction can also be used. A flag or note
restriction enables the user to request only records to which specified flags or
notes are attached. For example, a user might want to edit or delete only records
with a duplicate detection flag attached.

For more information on flag and note restrictions, see the Enter section in Enter,
Resolve, and Retrieve.

Data navigation

If you define a study page that corresponds to the Lab Loader protocol (Type 4),
then you can use Enter and the default study book for the panel to edit the data.

About Error Log editing

If you plan to use Error Log editing, you must define a study page that
corresponds to the Lab Loader protocol (Type 4).

For more information

For information on creating study pages, see the Design section in Admin and
Design.

For information on editing data using the default study book, see the Enter
section in Enter, Resolve, and Retrieve.

For information on editing data using the Error Log, see Chapter 27.
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Overview

The Error Log is a cumulative log of errors that occurred during screening,
validation, and transfer operations in Lab Loader. It is also a cumulative log of
errors that occurred during screening, validation, merging, global change, and
global delete operations in Manage. You use the Error Log to view and correct
records that failed these processes. There is one Error Log for each protocol.

Where is the Error Log found?

When errors occur in Lab Loader during screening, validation, or transferring,
entries are added to the Error Log. However, the location of the Error Log entry
depends on when the error occurs:

» If'the error occurs during screening, then an entry is added to the source
protocol’s Error Log.

For example, if a mandatory item is missing a value, an error will be
generated and added to the source protocol’s Error Log.

» If'the error occurs during transfer and prevents the record from being
transferred, then the record remains in the source protocol, and an entry is
added to the source protocol’s Error Log. A flag is attached to the record in
the source protocol.

For example, if a record contains a subject who is not enrolled in the
destination protocol’s study book, an error will be generated and added to the
source protocol’s Error Log.

+ If the error occurs during transfer and occurs after the record is inserted into
the update table of the destination protocol, an entry is added to the
destination protocol’s Error Log.

For example, if a screening error occurs during the transfer process, then an
error will be generated and added to the destination protocol’s Error Log.

Viewing the Error Log
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View the Error Log for all panels

To view the Error Log for all panels in a protocol, from the Reports menu, select
Error Log >> View All
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The Error Log opens:

i@ Error Log for All Panels [_ (O] x]
Filter: | ‘
Panel SL]BJEI;T VISNVEI PAGEVNEI Table Emor Type Action i’
[subject_item] [block_item] (page_item]) [ ) (errtype] [erract)

WITAL ANATTT 2 13 UPDATE |VALIDATE REPORT  |;
DRGCMP ANATTT 1 12 UFPDATE |VALIDATE REJECT |
WITAL ANATTT 2 13 UPDATE |VALIDATE REFORT |1
VITAL ANATTZ 2 13 UFPDATE |VALIDATE REFORT |1
VITAL ANAT0E 2 13 UFDATE |VALIDATE REFORT |1
WITAL AMA105 1 k] UPDATE |VALIDATE REFORT |I
VITAL AMAT0E 2 13 UFPDATE |VALIDATE REFORT |1
WITAL ANA105 0 5 UPDATE |VALIDATE REPORT |1
JNTSUM ANA103 1 10 UPDATE |VALIDATE REFORT |1
JNTSUM ANAT03 1 10 UFPDATE |VALIDATE REFORT |1
JMTSUM AMAI03 1 il UPDATE |VALIDATE REFORT |1
DRGCMP ANATTD 1 12 UFPDATE |VALIDATE REJECT |I
ITfII:lMINAT\ﬂN AMATNY 3 | R IIPDATF WAL INDATF RFIFCT L';I

If you are working with more than one page of records, you can view records by

page by using:

* The View menu’s First Page, Prior Page, Next Page, Last Page

commands.

* The arrow buttons on the Task toolbar.

View the Error Log for selected panels

To view the Error Log for selected panels, from the Reports menu, select Error

Log >> View By Panel.

The View Selected Error Log Records dialog box opens:

m\fiew Selected Error Log Records [ ]
Panels Error Types

Table(s)
v UPDATE
v DATA

TRAMSFER_SCREEN

Insertion Datetime

From: l—

To: l—
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Select the panels for which you want to view the Error Log. Then, select the
error types for which you want records to be displayed on the Error Log. If you
do not select an error type, then records containing all error types will display on
the log.

Select the type of database table for which you want to display the Error Log.
You can select the update table, the data table, or both types of database tables.

You can further restrict the records that display in the log by entering a range of
dates and times that the records were generated on the Error Log.

The Error Log opens:
&, Eror Log for LAB [_ O] =]
Filter: | ‘
SI.]BJEI;T VISNVEI PAGEVND Table Emor Type Action Datetime i’
[subject_item) [block_item) [page_item) [errtype] [emract) [errdt)
ANATO 2 16 UPDATE |SCREEN REPORT  |03/04/1993 02:45:27 Ph
ANATO 2 16 UPDATE |SCREEN REPORT  |03/04/1993 02:45:27 PI\:
ANATO 2 16 UPDATE |SCREEN REFORT  |03/04/1399 02:45:27 P
ANATO 1 11 UPDATE |SCREEN REFORT  |03/04/15999 02:45:27 P
ANATO 2 16 UPDATE |SCREEN REFORT  |03/04/15999 02:45:27 P
ANATO 0 a8 UPDATE |SCREEN REFORT  |03/04/15999 02:45:27 P
ANATO 1 11 UPDATE |SCREEN REFORT  |03/04/15399 02:45:27 Ph
ANATO 1 11 UPDATE |SCREEN REFORT  |03/04/1999 02:45:27 Ph
IA:Jiﬂ o 1 11 | UPDATE SCREEN REPORT  03/04/1993 02:45:27 F:Iv ha

When you view the Error Log for a specific panel, the Error Log may display an
additional item, defined by the ERRLOG DISPLAY ITEM user parameter.
Your designer determines if this additional item is used.

If you are working with more than one page of records, then you can view
records by page by using:

* The View menu’s First Page, Prior Page, Next Page, Last Page
commands.

¢ The arrow buttons on the Task toolbar.

Error Log options

You can view the Error Log, purge all entries from it, or purge selected entries
from it based on the following criteria:

e Panel

* Error type
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» Type of database table (UPDATE or DATA)
* Date and time the entries were added to the log
*  SQL Restriction (Double-click the SQL Restriction box.)

You can use the View menu to filter or sort a displayed Error Log, and the File
menu to save or print the log.

Error Log contents

Information displays for each record in which an error occurs. The following
table describes the information in the Error Log:

Report column:

Description:

Panel

Subject Item

Block Item

Block Repeat Item

Page Item

Page Repeat Item

Table

If you select the View All command, name of the panel
containing the record with the error.

For Types 1 through 5 panels. The column heading is the
subject item. The value in the column is the value of the
record’s subject item.

Note: This column only displays in View By Panel mode.

For Types 1 through 4 panels. The column heading is the
block item name. The value in the column is the value of the
record’s block item.

For Types 1 through 4 panels. The value of the block repeat
key item if the context panel for the protocol has a block
repeat key item.

For Types 1 through 4 panels. The column heading is the
page item. The value in the column is the value of the
record’s page item.

For Types 1 through 4 panels. The value of the page repeat
key item if the context panel for the protocol has a page
repeat key item.
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Type of database table (UPDATE or DATA) containing the
record.
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Report column: Description:

Error Type *  SCREEN — The error occurred during screening.
*  VALIDATE — The error occurred during validation.
*  TRANSFER — The error occurred during data
transfer.

For error types GLOBCH, GLOBDEL, and MGLOBCH,
see the Manage section of this book.

Action For error type SCREEN:

REPORT — There is an error with the study book. For
example, a study page is not defined for the visit.

REJECT — There is an error with the data. For example, a
mandatory item is missing a value.

For error type VALIDATE:

REPORT — A rule with the error action REPORT
evaluated to FALSE.

REJECT — A rule with the error action REJECT
evaluated to FALSE.

For error type TRANSFER:

REPORT — There is an error with the study book. For
example, a page is not defined for the visit. Or, there is an
error with the screening checks on the destination items.

REJECT — There is an error with the data. For example, a
mandatory item is missing a value.

Datetime Date and time the error occurred.
Remarks Description of the error, as determined by the error type.
Rule Name For error type SCREEN, the name of the item that failed a

screen check. For example, if there was no subject identifier
for the record that you tried to screen, then this value is
SUBJECT ID.
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For error type VALIDATE, the name of the rule that
evaluated to FALSE.

For error type TRANSFER, the name of the item that failed
a screen check.
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Report column: Description:

Ct Recid Value of the CT_RECID system item for the record in the
protocol where the record exists.

Note: If an additional Error Log item is defined for the protocol, the error log
item will also display on the Error Log. The Error Log item is determined by the
designer and is defined by the ERRLOG_DISPLAY ITEM user parameter.
Error Log items are only displayed if you select Error Log >>View By Panel to
view the Error Log.

Editing records from the Error Log

When a record fails a process in Lab Loader, you may need to edit the record and
repeat the process. For example, if a record fails validation, you may need to edit
the record and validate the record again. You can edit records directly from the
Error Log. You do not need to use Enter to edit the records.

You can use the Error Log to edit records that have an error reported against
them if you have the required access rights and if your designer has defined a
study page and study book for the panel that contains the record that you want to
edit. There must also be enough context information in the record for the record
to be identifiable to Enter.

When you select a record in the Error Log, a study page opens in which you can
edit the records and save the new values to the database. You can also:

* Supply a reason for change.
» Attach flags and notes to records.

»  Work with discrepancies in the destination protocol.

Note: You must set the study book to use when editing from the Error Log.
From the File menu, select Set Study Book. A dialog box opens in which you
can select the study book.
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How to edit from the Error Log

To select a record in the Error Log for editing, double-click the record. The
Clintrial software opens the study page that contains the record. The following
example shows a portion of the study page that opens for a record from the LAB
panel of the MEDIKA CLINICAL protocol that was selected in the Error Log:

m]ANJM 01.Days 30, 60, unsched.2.Laboratory Exams [UPDATE]) H[=] E3
Medika Clinical - Rheumatoid Arthritis - Phase [ll ml
Protocol Page Mumber [Page Repeat)
S ]
¥isit Number [Visit Repeat)
Subject Initials
Day Number
A
JLABORATORY TESTS |
Lab Name: [1lizd Health Lab Lab Mumber: I—
BLOOD CHEMISTRY =

You edit the record in the same way that you edit records in a study page in
Enter. However, you can only perform a subset of the editing and the navigation
functions available in Enter:

* You can only edit one study page at a time; you cannot navigate to other
study pages or subjects in the study book.

*  You cannot add or insert repeating items.

¢ You cannot delete records.

After you make the corrections and save the record, you can perform the activity,
such as validation, that the record had previously failed.

For more information on access rights, see the Admin section of Admin and
Design.
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Overview

After you define your source protocol, you need to perform the following system
administration tasks:

*  Manage access to the Lab Loader protocol by defining access rights and
access levels.

* Define system parameters to customize Lab Loader behavior.
You perform system administration tasks in Admin.

For more information on system administration tasks, see Admin and Design.

Access rights and access levels

After you set up a source protocol, you assign access rights to the source
protocol in Admin. An access right is a predefined set of Clintrial software
activities that can be associated with a user or a usergroup.

Access levels determine what type of access users have to the activities defined
by an access right. By selecting an appropriate access level, you grant users or

usergroups the ability to perform certain activities.

For more information on access rights and access levels, see Admin and Design.

Design access rights

To set up source and destination protocols, users must be assigned access to the
appropriate Design protocol access rights.
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Lab Loader access rights

To perform setup and data-processing tasks within Lab Loader, such as creating
control files and transfer maps, batch loading data, processing the batch-loaded
data, and transferring records, users must be assigned the appropriate access

level to the following Lab Loader access rights:

Protocol
access right:

User can:

Access level:

Design

Transfer

Work on control files and transfer

maps.

Transfer records from a Lab
Loader protocol into the clinical
data protocol on which this right
will be set, and manage
duplicates.

Granting this option allows
the user to transfer data to any
panel.

Full — Can perform all actions
on control files and transfer
maps.

Read — Can view attributes of
control files and transfer maps.

None — Cannot access control
files or transfer maps.

Note: The Design access right
can be applied to only a Lab
Loader protocol.

Full — Can transfer records,
view and purge the Transfer
Log, and view maps and reports.

Read — Can view transfer
maps, the Transfer Log, and
duplicates.

None — Cannot transfer
records.

Note: The Transfer access right
cannot be applied to a view
protocol or Lab Loader protocol.

Manage access rights

Manage access rights control access to Lab Loader activities that are also

accessible from Manage.
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Enter access rights

To perform Error Log editing in a source protocol, the user must have at least
NoDelete access to the Enter Unmerged protocol access right, as well as Full
access to the Manage Other access right.

System parameters and user preferences

System parameters define characteristics of the work environment for all users
of an Oracle database instance to which the users connect through the Clintrial
software.

You set system parameters in Admin.

What are user preferences?

User preferences are a subset of system parameters. Each user can change the
default values of the parameters for use in their account by changing the user
preferences. Default values for user preferences come from corresponding
system parameters.

Your Clintrial software administrator will set default user preferences in Admin
when the Clintrial software is installed. You can change the default Lab Loader
user preferences in Lab Loader.
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Lab Loader system parameters

Lab Loader has two system parameters that affect the behavior of Lab Loader.
The following table describes these system parameters:

System parameter: Description:

CTL_DUPFLAG- LOC Indicates the record to which a duplicate flag should be
attached.

DATA — The flag should be attached to the duplicate
record in the DATA table of the destination protocol when
duplicate records are found during data transfer.

UPDATE — The flag should be attached to the duplicate
record in the UPDATE table of the destination protocol
when duplicate records are found during data transfer.

CTL_TEST MODE This system parameter affects the action Lab Loader takes
with records in the source panel after a successful transfer.

Yes — The Start Data Transfer window displays a check
box labeled Delete Records After Transfer. If you check
this check box, records that are successfully transferred
from the source protocol to the destination protocol are
deleted from the source protocol. If you clear this check
box, the records remain in the source protocol.

No — The Delete Records After Transfer check box is not
displayed and records are always deleted after transfer.

This system parameter also sets the default user
preference.
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Manage system parameters

The Manage user parameter ERRLOG DISPLAY ITEM allows you to indicate
an additional item to be displayed on the Error Log. It is used for non-context
items. That is, items in Type 0 panels. This additional item is only displayed on
the Error Log when the Error Log is viewed by panel.
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This user parameter is also available as a user preference, and can be changed by
any user at any time during a session without restarting the
Clintrial software.

This user parameter performs the same function as the ERRORLOG ITEM item
attribute used for context items. That is, items in Type 1-4 panels.
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Overview

What are lab normal ranges?

Lab normal ranges (also called reference values) are laboratory test values that
serve as reference values for subsequent laboratory test results. Lab normal
ranges are laboratory test results that are indicative of a healthy state, or are
average, typical, or usual. Laboratory test results that are outside of the lab
normal ranges may be considered abnormal, unusual, or unhealthy.

You use lab normal ranges as a basis for comparison when you evaluate lab data
for a subject. For example, consider the following lab normal ranges:

Age: Hemoglobin Level: Unit:
Adult males 14t0 18 g/dL
Elderly males 12.4t0 14.9 g/dL
Adult females 12to 16 g/dL
Elderly females 11.7 to 13.8 g/dL
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Now, consider the following test results:

Age Hemoglobin
Subject: Age: Unit: Sex: Level: Unit:
ANA101 52 YR M 15.2 g/dL
ANA102 47 YR F 14.7 g/dL
ANA103 68 YR M 11.7 g/dL
ANA104 65 YR M 12.8 g/dL
ANA105 70 YR F 13.1 g/dL

In comparison to the lab normals, subject ANA103 has a hemoglobin level that
is outside of the normal range.

Storing lab normal ranges

Lab normal ranges are typically stored in a Type 0 panel. A Type 0 panel stores
data that is not related to a particular subject or visit. Neither a subject identifier
nor a visit identifier is required for a Type 0 panel.

Using Lab Loader, you must first batch load lab normal ranges into a Type 0
panel. You can then validate and merge the data. You edit and maintain the lab
normal ranges using Enter.

How do you use lab normals?

Using the Clintrial software, you can perform the following tasks associated with
lab normals:

» Batch load, validate, and merge lab normal ranges that vary by age, sex, and
weight

» Compare clinical data to lab normal ranges to determine the normalcy status
of test results
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» Convert test results into Systéme International (SI) units
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Workflow

LAB_NORMAILS MEDIKA_CLINICAL
Type 4 - Lab Loader Type 1 - Clinical Data
Source Protocol Destination Protocol

Data is transferred from the
source protocol and source
panel to the destination
protocol and destination
panel
LAB > LAB_NORMS

panel panel

Patient Age, Height, and
W eight is obtained from
demography information in
MEDIKA_CLINICAL

Derivations on
LAB NORMS panel can
look up lab normal ranges
and perform unit
Type 2 - Coding Thesaurus conversions

Derivations on LAB panel
can look up lab normal

ranges and perform unit CTL REFERENCE

conversions

CTL_NORMAL RANGE
panel

\

A

CTL_UNIT_CONVERSION
panel

Sample lab normals protocols

In addition to the MEDIKA CLINICAL sample study protocol, the following
protocols are provided with the Clintrial software to help you set up and
maintain lab normal ranges:

* CTL_REFERENCE — Thesaurus protocol set up to contain lab normal
ranges and SI unit conversion factors.

« LAB_NORMALS — Source protocol containing clinical data to be
prepared, and then transferred into MEDIKA CLINICAL.
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The protocols must be imported before you perform the Lab Loader server
installation. When you import CTL_REFERENCE, you must ensure that the
protocol remains named CTL_REFERENCE, as the PL/SQL functions provided
refer to the CTL_REFERENCE protocol.

For more information on importing CTL_ REFERENCE and LAB NORMALS,
see the Server Installation section in Getting Started.

CTL REFERENCE protocol

CTL_REFERENCE is intended as an example of a thesaurus (Type 2) protocol
to assist you in setting up lab normal ranges. The derivations on the source
protocol (LAB_NORMALS) and the destination protocol

(MEDIKA_ CLINICAL) perform lab normal range lookups on
CTL_REFERENCE. However, you can also use CTL_REFERENCE as a
thesaurus protocol for your own source protocol and destination protocol.

CTL_REFERENCE contains two study books:
+ CTL NORMAL RANGE — Set up to contain lab normal ranges.

*+ CTL_UNIT _CONVERSION — Set up to contain units, multiplication
factors, and additive constants for converting the normalcy status into SI
units.

The following table describes the fields provided in the
CTL NORMAL RANGE study book:

Item: Description:

Lab ID A unique laboratory identifier, such as the lab name.

Test The name of the lab test.

Start Date The date after which the associated lab normal ranges are effective.

. ‘ o

High The highest acceptable value for the test result. g_
g

Low The lowest acceptable value for the test result. o
&
=

Unit The unit of measure for the test. g

Sex The sex for which the lab normal range is applicable.

Age Low The lowest age value for which the lab normal range is applicable.
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Item: Description:

Age High The highest age value for which the lab normal range is applicable.

Age Unit The unit of measure for the age.

Wt Low The lowest weight value for which the lab normal range is applicable.

Wt High The highest weight value for which the lab normal range is
applicable.

Wt Unit The unit of measure for the weight.

Batch loading lab normal ranges

Sample control files for batch loading data are provided with the Clintrial
software to help you batch load lab normal ranges into CTL_ REFERENCE. You
can also modify the control files as necessary to batch load lab normal ranges
into your own thesaurus protocol. You must batch load data into

CTL REFERENCE through Manage.

Additionally, sample lab normal ranges are provided with the Clintrial software.
The data is intended as an example of a valid set of lab normal ranges. You can

import the sample lab normal ranges using Design.

You must batch load the sample data or your own data using Manage.

LAB NORMALS protocol

LAB NORMALS is a Lab Loader (Type 4) source protocol provided with the
Clintrial software. You batch load lab data into LAB_ NORMALS, manipulate
the data, and then transfer the data into the MEDIKA CLINICAL destination
protocol. The derivations on LAB_ NORMALS and on MEDIKA CLINICAL
(also provided with the Clintrial software) perform lab normal range lookups on
CTL_REFERENCE.
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Developing lab normal ranges

Lab normal ranges are often dependent upon one or more items, such as age, sex,
and weight. If the lab normal range is dependent upon an item, then the item is a
factor in determining the normal range of values for a test result. For example,
the age of the subject is a factor in determining the lab normal ranges for blood
pressure. Blood pressure results in adults differ significantly from blood pressure
results in children. Therefore, age is a factor in determining lab normal ranges
for blood pressure.

Lab normal ranges can also be dependent upon the specific lab from which they
are obtained. Each lab may have a slightly different methodology for obtaining a
set of lab normal ranges. As such, a lab may provide values that differ slightly in
comparison to lab normal ranges provided by other labs. Therefore, the lab from
which the lab normal ranges are obtained can be a factor.

In CTL_REFERENCE, you can maintain lab normal ranges that vary for the
following items:

+ Lab

+ Lab test

» Effective date
*  Sex

« Age

*  Weight

Consider the following set of lab normal ranges:

Age: Sex: Hemoglobin Level: Unit:

Less then 7 days M/F 17 to 22 g/dL

1 week M/F 15t0 20 g/dL

1 month M/F 11to 15 g/dL g
(=n

Children MF  1lto13 g/dL g‘
&

Adult M 1410 18 g/dL e
-

Elderly M 12.4t0 14.9 g/dL

Adult F 12to 16 g/dL
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Age: Sex: Hemoglobin Level: Unit:

Elderly F 11.7 to 13.8 g/dL

As shown, age and sex are factors for hemoglobin. Using the Clintrial software,
you can then enter a set of lab normal ranges that vary by age and sex.

In CTL_REFERENCE, you can enter the following lab normal ranges:

Lab ID Test Start Date High Low Unit Sex AgelL. AgeH AgeU WtL WtH WtU
NATIONAL HEMG 12/01/01 22 17 g/dL . 0 0019 YR 0 LB
NATIONAL HEMG 12/01/01 20 15 g/dL . 0.019 0.082 YR 0 LB
NATIONAL HEMG 12/01/01 15 11 g/dL . 0.082 3.000 YR 0 LB
NATIONAL HEMG 12/01/01 13 11 g/dL . 3.000 18.000 YR 0 LB
NATIONAL HEMG 12/01/01 18 14 g/dL M 18.000 65.000 YR 0 LB
NATIONAL HEMG 12/01/01 149 124 gdL M 65.000 YR 0 LB
NATIONAL HEMG 12/01/01 16 12 g/dL  F 18.000 65.000 YR 0 LB
NATIONAL HEMG 12/01/01 138 11.7 gdL F 65.000 YR O LB
Conditions

The following section describes the conditions that must be met when you
develop lab normal ranges.

Same test unit must be used

You must enter the same test unit for all records for the same lab ID, test, and
start date. If the test unit is not the same for all records containing the same lab
ID, test, and start date, then you should not enter a unit.
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Age must be entered for all records

If age is a factor, then you must enter an age for all records containing the same
lab ID, test, and start date. If age is not a factor, then you must enter 0 in the Age
low field.

Weight must be entered for all records

If weight is a factor, then you must enter a weight for all records containing the
same lab ID, test, and start date. If weight is not a factor, then you must enter 0 in
the Wt low field.

Sex must be entered for all records

If sex is a factor, then you must enter a sex for all records containing the same
lab ID, test, and start date. If sex is not a factor, then you must enter a period (°.”)
in the Sex field.

Complete set of lab normal ranges must be entered

You must provide a complete set of lab normal ranges for every lab ID, test, and
start date. That is, if age, sex, or weight are factors, then you must ensure that
data for all possible ranges of age, sex, and weight is entered for every lab ID,
test, and start date.

For example, if the age range is 18-25 years, then you must enter data for the
following year ranges:

* 0-18 years
o 18-25 years
» 25 years and up

Next low value must equal previous high value

For age and weight, the next low value must be equal to the previous high value.

Consider the following partial example:

Agel. AgeH AgeU WtL WtH WtU

3.000 18.000 YR 0 LB

18.000 65.000 YR 0 LB

Developing lab normal ranges 413
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In the example, the AgeL in record two is equal to the AgeH in record one.

For more information on conditions, see the next section.

Validating lab normals

When you have batch loaded or interactively entered a set of lab normal ranges,
you must validate and then merge the data. To be a valid set of lab normal
ranges, all records must have passed validation, and all records must have been
merged into the DATA table.

CTL_REFERENCE contains a set of rules and derivations that are applied to

data during validation. The following table describes the rules that are applied to
the data during validation:

Rule Name: Rule Action: Description:

CTLSCHK_OVERLAP_RANGES REJECT Ensures that there are no overlapping lab normal ranges.

CTLSCHK MISSING RANGES REPORT Ensures that there are no missing lab normal ranges.

CTL$CHK_AGE_RANGE REJECT Ensures that the high age value is greater than the low age
value.
CTL$SCHK_WT RANGE REJECT Ensures that the high weight value is greater than the low

weight value.

CTL$CHK_TEST RANGE REJECT Ensures that the high test value is greater than the low test
value.
CTL$CHK_TEST UNIT REPORT Ensures that the test unit of a record is the same as the test

unit in other records containing the same lab ID, test code,
and start date.

CTLSCHK OVERLAP RANGE
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The CTL$CHK _OVERLAP_RANGE rule ensures that no overlapping lab

normal ranges exist. An overlapping range exists when at least one of the

following conditions is met:

*  More then one record exists in which the Lab ID, Test, Start Date, Age Low,
and Weight Low are the same, and:
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— One record contains “.” for Sex, and another record contains M or F for
Sex.

* More than one record exists in which the Lab ID, Test, and Start Date are the
same, and the age ranges overlap each other

*  More than one record exists in which the Lab ID, Test, and Start Date are the
same, and the weight ranges overlap each other

Consider the following examples:

Example 1

The following example shows two records in which the sex overlaps, where the
lab ID, test, start date, age low, and weight low are the same, and two nondistinct
values are entered for sex:

Lab ID Test Start Date High Low Unit Sex AgeL AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 18 14 g/dL . 18.000 65.000 YR 0 LB

NATIONAL HEMG 12/01/01 18 14 g/dL M 18.000 65.000 YR 0 LB
Example 2

The following example shows two records in which the age overlaps:

Lab ID Test Start Date High Low Unit Sex AgeL AgeH AgeU WtL WtH WtU
NATIONAL HEMG 12/01/01 18 14 gdlL M 18.000 65.000 YR 0 LB
NATIONAL HEMG 12/01/01 18 14 g/dL M 20.000 70.000 YR O LB
Example 3 =
1Y)
In the following example, the weight range in record 2 overlaps the weight range <
in record 1: =
=
&
Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU %
-
NATIONAL HEMG 12/01/01 149 124 gdL M 65.000 YR 0 150 LB
NATIONAL HEMG 12/01/01 149 124 gdL M 65.000 YR 130 200 LB
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Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 149 124 g/dL M 65.000 YR 200 LB

CTLSCHK MISSING_RANGES

The CTL$CHK_MISSING RANGES rule ensures that a complete set of lab
normal ranges exists. Lab normal ranges are missing when one or more of the
following conditions are met:

* No value is entered for Sex.

* Sex is a factor, and both sexes are not represented.
* No value is entered for Age.

* Age is a factor, and not all age ranges are entered.
* No value is entered for weight.

»  Weight is a factor, and not all weight ranges are entered.

Consider the following examples:

Example 1

In the following example, not all weight ranges are entered:

Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 100 140 LB
NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 140 180 LB

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 180 240 LB

To be complete, the weight ranges for Females, aged 18 to 65, must also include:
+ 0-100LB
* 240 LB and above
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Example 2

In the following example, no value is entered for Age Low:

Lab ID Test Start Date High Low Unit Sex AgeL AgeH AgeU WtL WtH WtU
NATIONAL HEMG 12/01/01 13 11 g/dL F 18.000 YR 0 LB
NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 0 LB
NATIONAL HEMG 12/01/01 16 12 g/dL F 65.000 YR 0 LB

CTLSCHK AGE_RANGE

The CTLSCHK AGE RANGE rule ensures that the Age High value in all
records is greater than the associated Age Low value.

Consider the following example:

Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 0
NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 0 LB

NATIONAL HEMG 12/01/01 16 12 g/dL F 65.000 YR 0 LB

In record one, the Age high value is not greater than the associated Age Low
value.

CTL$CHK WT RANGE

The CTLSCHK WT RANGE rule ensures that the Weight High value in all
records is greater than the associated Weight Low value.

Consider the following example:

JI9peoT qe|

Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 140 100 LB
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Lab ID Test Start Date High Low Unit Sex Agel. AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 140 180 LB

In record one, the Weight High value is not greater than the associated weight
low value.

CTLSCHK _TEST RANGE

The CTLSCHK TEST RANGE rule ensures that the test High value is greater
than the associated test Low value.

Consider the following example:

Lab ID Test Start Date High Low Unit Sex AgelL AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 12 16 g/dL F 18.000 65.000 YR 100 140 LB
NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 140 180 LB

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 180 240 LB

In record one, the High value is not greater than the low value.

CTL$CHK TEST UNIT

The CTL$SCHK _TEST_UNIT rule ensures that all records with the same Lab ID,
Test, and Start Date contain the same Unit value.

Consider the following example:

Lab ID Test Start Date High Low Unit Sex AgelL AgeH AgeU WtL WtH WtU

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 100 140 LB
NATIONAL HEMG 12/01/01 16 12 gL F 18.000 65.000 YR 140 180 LB

NATIONAL HEMG 12/01/01 16 12 g/dL F 18.000 65.000 YR 180 240 LB
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In record two, the test unit is not the same as the test unit in record one and in
record three.

Using lab normal ranges

You use lab normal ranges to determine the normalcy status of test results. The
normalcy status is a value that indicates the measure of normality of the test
result as compared to the lab normal ranges.

The following table describes the normalcy statuses:

Status: Full Status: Description:

L Below normal The test result is below the lowest acceptable
value in the lab normal ranges.

H Above normal The test result is above the highest acceptable
value in the lab normal ranges.

N Normal The test result is within the lowest acceptable
value and the highest acceptable value in the lab
normal ranges.

Null Null A Null normalcy status indicates either:

* No lab normal range is defined for this test,
or

+ Lab normal ranges do not apply to this test.

Normalcy statuses are returned during validation when validation is run on
clinical data in LAB_ NORMALS. Derivations that are executed during
validation compare the test results in the clinical data to the lab normal ranges in
CTL REFERENCE, and then return a normalcy status based on the comparison.
If the patient’s age, height, or weight are factors, then the patient’s demography
information is obtained from the DMG panel in MEDIKA CLINICAL before
determining a normalcy status. Derivations are provided with

LAB NORMALS.
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The following example shows the normalcy status, as calculated during

validation:
1. LAB [UPDATE) _ O] %]
Restriction: | |
Fiter: | |
Si Unit Lab Unit Momalcy 5t Result Si Result Test Date Test Code Lab Id SUBJEC Page Vizit ﬂ
T o B | 20 [12/14/2001 [HEMG NATIONA  [ANATOZ 10 [p :
4| | b|>
| | LA

Calculating normalcy status

You can calculate a normalcy status for all records in your own source protocol.
To calculate normalcy status, you must first create a source protocol and a
destination protocol. If test results will vary by age, sex, and weight, then you
must create the following items:

*  Sex

o Age

* Age units

*  Weight

*  Weight units

These items must exist on the same panel.

Converting units into SI units

You can convert test results from standard units into Systéme International (SI)
units during validation. An S/ unit is a standardized unit of measure from the
International System of Units. The International System of Units is a system of
presenting units of measure in universally recognized formats.

To convert test results, you must first enter the Units, Test, Multiplication Factor,
and Additive Constant in the CTL_UNIT CONVERSION study book of the
CTL_REFERENCE protocol. During validation, the derivations in

LAB NORMALS look up the appropriate unit to be converted, and then return
the test results in SI units. The conversions must be in the following format:

a*X+b
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where a and b are constants, and X is the value to be converted.

The following table describes the fields provided in the
CTL_UNIT_CONVERSION study book:

Item: Description:

From The standard unit to be converted from.
To The SI unit to be converted to.

Test Code The name of the lab test.

Multiplication The factor by which to multiply the test results. (a, in the preceding
Factor example.)

Additive Constant The constant to add to the product. (b, in the preceding example.)

For example, to convert hemoglobin results from standard units (g/dL) into SI
units (g/L), you would enter the following:

Multiplication Additive
From: To: Test Code: Factor: Constant:

gdlL gL HEMG 10 0

After validation, the following results would be visible in Enter:

1. LAB [UPDATE) [_[O] %]
Restriction: | |
Fiter: | |
Si Unit Lab Unit Momalcy 5t Result Si Result Test Date Test Code Lab Id SUBJEC Page Vizit ﬂ
T o B | 20 [12/14/2001 [HEMG NATIONA  [ANATOZ 10 [p : =
1=
=2
| | NE g
o | Ll &
&
In the example, the test result in standard units is 20 g/dL. When converted -

during validation, the result in SI units is 200 g/L.
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Overview

When you start the batch load, you must select a control file for the Clintrial
software to use during the batch load. A control file is a file that describes how
data from an input file will be batch loaded into the source protocol. It functions
as the interface between the input file and the Clintrial software database tables,
and specifies the location where the Clintrial software should store the data. In
Lab Loader, this initial storage location is a panel in a source protocol.

The Clintrial software creates a default control file, which you use as a starting
point for creating your own control file.

Note: You can also create your own control file using any text editor. You are
not required to use the Clintrial software default control file.

Creating control files

To create a control file, from the Load menu, select Control File >> New. The
Clintrial software displays the Select options for control file dialog box. In the
Select options for control file dialog box, select the panel for which you are
creating the control file, and the file format for the corresponding data input file.
The panels must be installed to appear in this dialog box:

= Select options for control file

Panel

File Format
@ Fixed Format
) Variable Format

I 118 I | Cancel I | Help I

424  Chapter 30: Control Files



There are two types of input file formats:

Fixed format

In a fixed format input file, the data values have a specified length, and each
value begins at a fixed location in the record. No delimiters separate the
values.

Variable format

In a variable format input file, the data values do not have to be a specified
length, and may not begin at the same location in each record. Delimiters that
you specify, such as commas, separate the values.

After you specify the panel and file format, the Clintrial software uses the
information to create a default control file.

Note: The default control file is a starting point. You must revise the control file
to match the structure of your input file.

The default control file lists all of the items in the selected panel. If the control
file is in fixed format, the default control file also estimates the fixed location for
the item values based on the item length.

You must edit the default control file to correspond to the structure of the input
file rather than to the structure of the Clintrial software panel. For example, you
may need to:

The following sections provide examples of the default control files the Clintrial
software creates, and describe ways you can edit these files.

For more information on creating control files, see the Oracle SQL*Loader
documentation.

Rearrange the order of the items in the control file.
Change the delimiter in a variable format control file.
Change an item’s fixed size in a fixed format control file.

Add conversion instructions, such as instructions for converting date
formats.

Adjust the ENCLOSED BY clause to change the character used to indicate
character strings.

Delete items for which the input file does not contain values.
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Fixed format control files

In a fixed format input file, each data value begins at a fixed location in the
record. The corresponding fixed format control file must specify the location of
the data value, so that the correct values are stored in the corresponding items.

When you create a default fixed format control file, the Clintrial software
assumes that every item will be used. Thus, the Clintrial software lists all of the
items in the panel, and provides a default location for the data value, based on
the item length.

The following example shows a fixed format control file for the LAB panel in
the XYREXEL LAB SOURCE protocol:

-- Control file for loading data into:
--  XYREXEL LAB SOURCE.LAB UPDATE

LOAD DATA

APPEND
INTO TABLE XYREXEL LAB _SOURCE.LAB_UPDATE

TRAILING NULLCOLS
(STATUS constant 3,
CT RECID sequence (count),
SUBJECT _ID constant 0,
SUBJECT position(1:8) NULLIF SUBJECT=BLANKS,
LAB position(11:20)  "RTRIM(LTRIM(:LAB))",
TEST position(21:28)  "RTRIM(LTRIM(:TEST))",
- INVESTIGATOR position(29:36)
% "RTRIM(LTRIM(:INVESTIGATOR))",
]
S AGE position(37:44)  NULLIF PAGE=BLANKS,
'g% VISITNO position(45:54)  NULLIF VISITNO=BLANKS
)
VISITDATE position(55:68)  DATE "YYYYMMDDHH24MISS"
NULLIF VISITDATE=BLANKS,
TEMPERATURE position(69:77)  NULLIF TEMPERATURE=BLANKS

)
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Note: You do not need to batch load every character from an input file into the
Clintrial software source protocol. To skip a character, adjust the position
numbers so that the character’s position is not specified.

Variable format control files

In a variable format input file, no item has a fixed length, so the item values may
occur at a different location in every record. Variable format records use a
delimiter, such as a comma, to separate the item values.

When you create a default variable format control file, the Clintrial software lists
all of the items in the panel, and specifies a default delimiter.

The following example shows a variable format control file for the LAB panel in
the XYREXEL LAB SOURCE protocol:

-- Control file for loading data into:
-~ XYREXEL_LAB_SOURCE.LAB_UPDATE

LOAD DATA

APPEND
INTO TABLE XYREXEL_LAB_SOURCE.LAB_UPDATE

-- Note: Change @ to your file's separator character and adjust the 'ENCLOSED BY'
clause

FIELDS TERMINATED BY ', OPTIONALLY ENCLOSED BY "™

TRAILING NULLCOLS
v
o
(STATUS constant 3, =
CT_RECID sequence (count), g
SUBJECT ID constant 0, g-
SUBJECT "RTRIM(LTRIM(:SUBJECT))", e
LAB "RTRIM(LTRIM(:LAB))",
TEST "RTRIM(LTRIM(:TEST))",
INVESTIGATOR NULLIF INVESTIGATOR=BLANKS,
PAGE NULLIF PAGE=BLANKS,
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VISITNO NULLIF VISITNO=BLANKS,

VISITDATE DATE "MM/DD/YYYY" NULLIF VISITDATE=BLANKS,
TEMPERATURE NULLIF TEMPERATURE=BLANKS
)

Delimiters

A variable format control file must indicate the delimiter that is used in the input
file.

For example, if the input file is a comma-separated (.csv) file, then the delimiter
is a comma. In the control file, you must replace the default delimiter (@) with a
comma:

FIELDS TERMINATED by *,

Trailing null values
By default, a control file includes the following line:
TRAILING NULLCOLS

This line indicates that if the control file includes more items than are in the
input file, then those items should be given the value Null when the record is
batch-loaded.

Date format

The control file must specify the date format that is used in the input file.

For example, if the input file contains the date 03-17-1999 00:00:00, then the
control file must specify the date format of the item as:

DATE “MM-DD-YYYY HH24:MI:SS”
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Character strings

The control file must specify the character that is used to indicate character
strings in the input file. In the control file, enclose the character in single
quotation marks.
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For example, if the double quotation mark is used to indicate character strings in
the input file, then the control file must specify:

OPTIONALLY ENCLOSED by

NULLIF clause

For items of the data type NUMBER or DATE, the default control file contains a
NULLIF clause. The default NULLIF clause treats an item as Null if the value in
the input file is blank.

You can edit the NULLIF clause in the control file so that an item is treated as
Null if the value in the input file is another value; for example, a period (.).

LTRIM and RTRIM clauses

For items of the data type TEXT, the default control file includes the
following:

* An LTRIM clause, which trims leading blanks
* An RTRIM clause, which trims trailing blanks

Saving control files

During the course of a clinical study, you may receive data multiple times from a
lab. This data will most likely be in the same format each time, and you can use
the same control file to batch load the data. You can create control files to batch
load this data once, and then store the control files in a database table, referred to
as the control file library.

After the files are saved to the control file library, you and other users with the
correct privileges can use these control files to batch load data. You do not have
to recreate the control files each time you receive data from a specific lab.

To save a control file to the control file library, from the File menu, select Save
to Library.

Saving control files 429
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Saving to a file

The NLS LANG setting of Windows operating system on the computer you are
using for the Clintrial Client is set as either ANSI or Unicode. The Oracle
database uses the client's NLS LANG setting to determine the character set of
control files and scripts that the client is sending and to determine if character set
conversion is necessary. If the NLS LANG client setting is not the same as the
control file, data integrity and consistency might be compromised.

By default, the Windows NLS LANG setting is in ANSI format. However, by
default, Lab Loader saves control files in Unicode format.

The ANSINLS LANG settings for the Windows English and Japanese clients
are:

+ AMERICAN_AMERICA . WESMSWIN1252
* JAPANESE JAPAN.JA16SJIS or
» JAPANESE JAPAN.JA16SJISTILDE

To save the control file to your computer when you are not using Unicode, open
the control file, and then from the File menu, select Save as... and choose ANSI
format.

If the Oracle client is not configured to use Unicode format, to use a control file
it must be saved as a file on your computer in ANSI format. You cannot directly
access control files in the control file library during a batch load.

Note: The default Save behavior in Lab Loader saves the control file to the
control file library.

If you have a control file or data file saved in UTF-8 format, the client
NLS LANG must be configured to use Unicode. Otherwise, data can't be loaded
to Source Protocol.

The Unicode NLS_LANG settings for the Windows English and Japanese
clients are:

» UTF-8 - AMERICAN AMERICA.AL32UTF8
» UTF-8 - JAPANESE JAPAN.AL32UTF8
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Copying control files

You can copy an existing control file from the control file library to serve as the
starting point for creating a new control file. All control files that exist in the
control file library for protocols in the current protocol’s searchlist are available
to copy.

To copy a control file, from the Load menu, select Control File >> Copy.
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Overview

A transfer map indicates data to be transferred from a source protocol to a
destination protocol by establishing a direct connection from the source items to
the destination items. A transfer map specifies which data will be transferred,
and indicates the location where you want the data to be stored.

Lab Loader stores the transfer maps you create in a table in the database. These
maps are available to any user with the correct access rights to use when
transferring data.

Note: The transfer map is owned by the source protocol in which it is created. If
you delete the source protocol, then any transfer maps owned by the protocol are
also deleted.

How transfer maps are identified

Transfer maps are uniquely identified by five values:
e The map name

* The source protocol

* The source panel

* The destination protocol

e The destination panel

Each transfer map references the data in a specific source panel and a specific
destination panel. You cannot:

* Transfer data from more than one source panel at a time.
* Transfer data to more than one destination panel at a time.

» Transfer data into different destination protocols at the same time.

Creating transfer maps

To create a transfer map, from the Transfer menu, select Map >> New. In the
Select Source and Destination dialog box, specify the transfer map identification
information, and then click OK.
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Note: To create a transfer map, the current protocol must be set to the source
protocol. The source protocol must be Type 4 - Lab Loader.

434  Chapter 31: Transfer Maps



A Transfer Map window opens, in which you indicate the mapping of the
destination and source items:

. Transfer Map - XYREXEL [_ (O] x]
Destination Protocol:  XYREXEL Source Protocol: XYREXEL_LAB_SOURCE
Destination Panels: ’ADVEHSE . Source Panel:  LAB

Destination Panel.Item Source Panel.ltem

ITDestination Pratocol] [ =l

LAB. L&E [LaE =
LAB.TEST [TEST =l

L4E. TEMPER&TURE [TEMPERATURE =

LAB VISITDATE [¥ISITDATE =
Destination Type: YARCHARZ2[20] Source Type:

Map Description

PLR - =yrexel_Lab Src to Xyrexel transfer map

If the destination panel and source panel are similar in structure, then you can
use the Auto Map command to map the source items to the destination items
automatically. The Clintrial software chooses a source item for each destination
panel item by matching data types and item names. To automap the items, from
the Edit menu, select Auto Map.

To clear the selections you made and begin again, from the Edit menu, select
Clear.

When you are mapping the items, consider the following:
* The underlying types of source and destination items must be the same.

* A source panel item cannot be larger than the destination panel item to which
it is mapped. However, the destination panel item can be larger than the
source panel item.

If the source panel item is larger than the destination panel item, then the
source item will not be available for selection in the Source Panel Item drop-
down list.

* The subject item, block key item, and page key item for the destination
protocol must be mapped, if any of the destination panels is Type 1-4.

* All items marked Mandatory in the destination panels must be mapped.
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How to transfer data to multiple protocols

When you transfer data, Lab Loader transfers all of the records from a source
panel into the destination panels referenced in the transfer map. However, if you
are storing records for multiple destination protocols in one source panel, then
you must transfer only the records for one destination protocol at a time.

The transfer map contains a transfer map item called [Destination

Protocol] that allows you to differentiate records belonging to different
protocols. You can map this transfer map item to a source item that contains the
name of the destination protocol. If the destination protocol name matches the
source item value in a record, then the record is transferred. If the destination
protocol name does not match the source item value, then the record is not
transferred.

If you do not map the [Destination Protocol] item, then all records in the source
panel are transferred.

How to transfer job ID data

When you transfer data, the Clintrial software assigns an internal job ID number
to the records that are transferred as part of a specific process. You may want to
store this job ID in the destination panel to help identify records transferred at
the same time.

The transfer map includes a source item called [Job ID], which you can map to
an item in the destination protocol. The [Job ID] item is a TEXT data item.

For example, if you map the [Job ID] source item to an item in the destination
panel called JOB_ID, and the Clintrial software assigns the job ID 72 to the
transfer process, then all records that transfer successfully will have the value 72
in the JOB_ID item.

Copying transfer maps

The Clintrial software allows you to copy existing transfer maps and use the
copy as the basis for creating a new map. You can copy a transfer map from the
current protocol or from any protocol in the current protocol’s searchlist.
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Copying transfer maps is helpful when:

* You have two source panels with similar structures, and you want to transfer
data from these panels into a destination panel.
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* You want to use the same mapping of items from a source panel to context
items of different destination protocols.

How transfer maps are copied

When you copy a transfer map, the amount of mapping information that is
preserved in the new map depends on the destination panel:

» If the destination panel for the original map and the newly copied map is the
same, then mappings for which source items exist are carried over from the
original map to the new map.

+ Ifthe destination panel for the original map and the newly copied map are
different, then only mappings for context items are preserved. All other
mapping expressions are deleted from the new map.

Transfer map status

When you save a transfer map, Lab Loader checks to see if the map is valid. A
map is valid if:

* The source and destination protocols both exist.

* All source and destination panels referenced by the map exist and are
installed.

* Each of the items mapped from source panels and items mapped to
destination panels exist within their panels.

* All items match in size and type. Destination items can be larger than source
items, but source items cannot be larger than destination items.

* The subject item, block item, and page item are mapped, if any of the
destination panels is Type 1-4.

* All mandatory items in the destination panels are mapped.

You can save transfer maps before you have completed editing them. For
example, you can save a transfer map before you have mapped all of the
mandatory items in the destination panel. These transfer maps are assigned the
status Incomplete. You must finish editing incomplete transfer maps before you
can use them to transfer data.
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Maps can also have a status of Old. This status can occur if the source panel or
the destination panels have been modified since the map was last saved. When
you open an Old map, Lab Loader checks to see that the items referenced by the
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map still exist and still match in size and data type. You can edit Old transfer
maps before you use them, or you can compile the map, which changes the map
status of Old to a status of Valid if the map is still valid.

Note: You must set the protocol to the source protocol to edit the transfer map.

Maps must have the status Valid or Old to be used for transferring data.

About compiling the transfer map

You can compile a transfer map to ensure that the map is valid. Compiling the
map checks that the source and destination panels are still installed, and that
source and destination items still exist. In this manner, you can easily see if
something has changed.

To compile a transfer map, from the Transfer menu, select Map >> Check. The
Select Map to Check dialog box opens:

& Select Map to Check [ x|
Map Hame Destination Protocol Source Panel Status

Map Description

FLR - Xyrexel_Lab_Src toxpresel transfer map

Dismiss | LCompile | Help

Select a map name and click Compile.

R
)
=
]
=)
N Transfer Map statuses
=
3 The following table summarizes the possible statuses for transfer maps:
Status: Description:
Valid (0) The map was valid when it was last edited or used for data transfer.
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Status: Description:

Invalid (1) The map is invalid. This status can occur when:

* The destination protocol, destination panel, source protocol, or
source panel has been deleted after the map was created

» The data types for mapped items no longer match
* A mapped item has been deleted

0Old (2) One of the source or destination protocols or panels has been edited
more recently than the map.

Incomplete (3) The map was saved before it was completed. For example, the map
was saved, but not all key items were mapped.
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Overview

This chapter describes how Lab Loader works differently in a Multisite
environment, and contains the following sections:

+ Configuring a replication environment for a Lab Loader protocol
* Transfer maps in a replication environment
*  Working with lab data in a replication environment

* Transferring lab data in a replication environment

Configuring a replication environment for a Lab Loader
protocol

To use Lab Loader to transfer laboratory data from a source protocol into a
destination protocol that is in a replication environment, you must configure a
replication environment for the Lab Loader protocol that overlaps the sites in the
destination protocol’s replication environment.
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The following figure shows two overlapping replication environments, one for a
clinical data protocol and one for the Lab Loader protocol:

Clinical Data Protocol (CD): Replication Master

Lab Loader Protocol (L): Replication Subordinate

Clinical Data Clinical Data
Protocol (CD): Protocol (CD):
Replication Replication

Subordinate Subordinate

Lab Loader Lab Loader
Protocol (L): = Protocol (L):
Replication Replication

Subordinate Subordinate

®

I_I_I_l
R

Clinical Data Protocol (CD): Replication Subordinate

Lab Loader Protocol (L): Replication Master

The remainder of this section discusses:
+ Distributing a Lab Loader protocol

» Distributing transfer maps and control files

Distributing a Lab Loader protocol

You distribute Lab Loader protocols just as you distribute clinical data protocols,
which is described in Multisite.
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Note: If you try to distribute a Lab Loader protocol to a site that does not have
Lab Loader installed, the distribution fails.
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Note: We strongly recommend that you distribute the protocol
CTL_REFERENCE and replicate its data to any site running the validations
using that data. Also, Lab Loader must be installed on all the sites to access the
functions.

Distributing transfer maps and control files

When you distribute a Lab Loader protocol, the transfer maps and control files
for that protocol are also distributed.

You can only modify or add transfer maps and control files at the Distribution
Master site, before the first distribution of the Lab Loader protocol, or when the
Lab Loader protocol is open for revision.

For more information on opening a protocol for revision, see Multisite.

& Caution: To create transfer maps and control files, you must ensure that the
Distribution Master site for the Lab Loader protocol contains the panel metadata
for the clinical data protocol into which you will transfer data. Therefore, you
must distribute the clinical data protocol to the Lab Loader protocol’s
Distribution Master site before creating transfer maps and control files.

Transfer maps in a replication environment

This section describes rules for transfer maps when the Lab Loader protocol is in
a replication environment.

Mapping the destination protocol name

You must map the destination protocol name to the same column in the source
protocol panel for all transfer maps, or all transfer maps must implicitly have the
same destination protocol by not specifying the pseudo item “destination
protocol”.
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Mapping the subject_item

If the destination panel is Type 1-4, you must map the subject_item to the same
column in the source protocol panel for all maps.
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Destination panels
If the Lab Loader protocol is in a replication environment, all destination panels
in a single transfer map must be either:
* A single Type 0 panel, or
* Subject-related panels (Type 1-4)

Working with lab data in a replication environment

This section contains the following information:
» Batch loading lab data
+ Validating data

& Caution: Before you can process batch-loaded lab data in a Lab Loader
protocol, for Type 1-4 destination panels, you must ensure that all data in the
enrollment panel of the destination protocol has been replicated to the batch-
loading site. For Type 0 destination panels, you must ensure that all rows in the
panels have been replicated to the batch-loading site.

Batch loading and screening lab data

You must batch load and screen lab data into the Lab Loader protocol at the
Replication Master site for the Lab Loader protocol.

The Replication Master site initially owns the batch-loaded lab data through the
screening process.

Validating data

In a replication environment, you validate batch-loaded lab data at the batch-
loading site.

This section describes what happens during the validation process for:
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* Type 1-4 destination panels

* Type 0 destination panels
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Type 1-4 panels

For destination panels of Type 1-4, the validation process:

1. Identifies the subject for the lab data record, by using the first appropriate
transfer map found to identify the destination protocol.

2. Identifies the site that owns the subject by using the enrollment panel of the
destination protocol.

3. Transfers ownership of the lab data record, as well as any attached item flags
and notes, to the site that owns the corresponding subject.

If a record belongs to an unenrolled subject, the record fails validation. Records
in the Error Log that have failed validation remain at the Replication Master site
and are not replicated.

& Caution: 1t is possible for Lab Loader records that are grouped in an
observation to get transferred to different sites because the subjects in the
observation’s records are different.

The following figure shows the validation process for lab data in
Type 1-4 destination panels:

If subject is

Identify the unenrolled, a

. record is added to
subject for the lab #
record. the Error Log of

the Lab Loader

source protocol.
Identify the site

that owns the
subject.

L/

Transfer
ownership of the
lab record and its
flags and notes to
the site that owns

the subject.
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Type 0 panels

For destination panels of Type 0, the validation process:

1. Identifies the observation for the lab data record.
2. Identifies the site that owns the observation.

3. Transfers ownership of the lab data record, as well as any attached flags and
notes, to the site that owns the corresponding observation.

If a record belongs to an observation that does not exist, the record becomes the
first record in a new observation that is owned by the batch-loading site.

The following figure shows the validation process for lab data in a Type 0
destination panel:

If observation
Identify the does not eX|sF, a
new observation

observation for # is created, owned
the lab record. by the batch-

loading site.

Identify the site
that owns the
observation.

L/

Transfer
ownership of the
lab record and its
flags and notes to
the site that owns
the observation.
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Transferring lab data in a replication environment

This section contains the following information related to transferring lab data in
a replication environment:

* Replicating lab data
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* Transferring replicated lab data
*  Workflow

Replicating lab data

A

After lab data is validated at the Replication Master site for the Lab Loader
protocol, the lab data then replicates to the sites that own the corresponding
subjects.

When setting up replication for a Lab Loader protocol, you should set replication
restrictions so that each site only receives lab data records for the subjects that it
owns.

Caution: If you do not set such replication restrictions, and a site receives lab
data for subjects that it does not own, replication and transfer performance will
decrease.

Transferring replicated lab data

>

You transfer replicated lab data at the site in the replication environment that
owns the Lab Loader record.

Transfer failures

When a record fails to transfer, the ownership of the record, as well as the
ownership of the flag that gets attached to identify this transfer failure and any
other flags and notes attached to the record, transfers back to the site where the
record was batch-loaded, which is the Lab Loader protocol’s Replication Master
site. You must resolve transfer errors at this Replication Master site and then
perform the transfer again.

Caution: If any record in an observation defined in the Lab Loader source
protocol fails to transfer, ownership of all records in the observation is
transferred back to the Lab Loader protocol’s Replication Master site.

Transfers with errors

If a record transfers successfully with Report errors, the ownership of the record,
as well as the error records generated, remains at the site that owns the subject in
the clinical data protocol. You must resolve these errors at the site that owns the
subject.
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Transfer errors caused by change of subject ownership

When the ownership of a subject in a clinical data protocol changes between the
times of validation and the transfer of lab data, the lab records for that subject
fail to transfer, and ownership of these records is returned to the batch-loading
site.

Once replication has updated these records at the batch-loading site, you must:
1. Ensure that the Replication Master site has an up-to-date Enrollment panel
for the clinical data protocol.

2. Rerun validation on the lab data. Validation then correctly identifies the site
that owns the subject and reassigns ownership to the lab data record.

Workflow

The following figure shows the workflow for transferring replicated lab data:

Transfer
Validation ownership of lab
record.

3

Lab record rep-
o licates to site that
Replication owns the subject
or observation.

3

Record is

transferred to

Transfer clinical data
protocol. g
Success l l Failure =n
Errors generated Record and flag g
during transfer ownership is )
are owned by the transferred back to %
transferring site. batch-loading site. =
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